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Proprietray Information and Software 
License 

This document and the information contained in it is proprietary and confidential information of 
ALPINION MEDICAL SYSTEMS (hereinafter called Alpinion) and may not be reproduced, copied in whole 

or in part, adapted, modified, disclosed to others, or disseminated without the prior written consent of 

Alpinion. This document is intended to be used either by customers, and is licensed to them as part of 

their Alpinion equipment purchase. Use of this document by unauthorized persons is strictly prohibited. 

Alpinion provides this document without warranty of any kind, implied or expressed, including, but not 

limited to, the implied warranties of merchantability and fitness for a particular purpose. 

Alpinion has taken care to ensure the accuracy of this document. However, Alpinion assumes no liability 

for errors or omissions and reserves the right to make changes without further notice to any products 

herein to improve reliability, function, or design. Alpinion may make improvements or changes in the 

products or programs described in this document at any time. 

Unauthorized copying of this document, in addition to infringing copyright, might reduce the ability of 

Alpinion to provide accurate and current information to users. 
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Original Documentation 

The original document was written in English and published in PDF File. 

The English version of the user documentation is intended for the countries of the European Union, 

North or South America, Asia as well as other worldwide countries where the products are sales and 

used. In addition, the English version of the user documentation is designed so that the majority of 

people who are familiar with English can read and correctly understand the instructions. 

The user documentation is translated into other languages so that most people who are familiar with 

languages other than English can read the instructions and understand them correctly. The translated 

user documentation is intended for users who speak the language of the country where they sell and use 

the product. 

Please note that the authoritative source of information is the English version. If there is any conflict 

between the translated versions and the English, the latter takes precedence. 
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Precautions For Use 

Be sure to read this manual and fully understand the operation of the product and the relevant safety 
information before using the product. 

 

• Keep this manual near the product and refer to it when using the product. 

• The contents and specifications described in this manual may be changed without notice. 

• All important safety information in the "2. Safety" should be read and thoroughly understood before 
operating the unit. 

• Be sure to read and fully understand the safety precautions identified by the following flag words and 

icons which precede the precautionary statement. 

 
WARNING 

WARNING indicates that a specific hazard is known to exist which through inappropriate 
conditions or actions may cause severe or fetal personal injury or substantial property damage. 

 
 

CAUTION 

CAUTION indicates that a potential hazard may exist which through inappropriate conditions or 
actions will or can cause minor poersonal injury or property damage such as loss of patient or 
system data. 

 
NOTE 

NOTE indicates precautions or recommendations that will help you operate the product more 
effectively. 

 

• This product is intended for use by, or by the order of, and under the supervision of a licensed 

physician qualified to direct the use of the device. 

• This product is intended for ultrasound diagnosis and cannot be used in your PC environment. We are 

not responsible for any problems that occur in such situations. 
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Regulatory Requirements 

Classifications 

• Type of protection against electrical shock: Class I 

• Degree of protection against electrical shock (Patient connection): Type BF equipment 

• Degree of protection against harmful ingress of water: Ordinary equipment and all of applied parts 

(IPX7, IPX8) except ECG meet ingress protection level according to IEC 60529. 

• Degree of safety of application in the presence of a flammable anesthetic material with air or with 

oxygen or nitrous oxide: Equipment not suitable for use in the presence of a flammable anesthetic 

mixture with air or with oxygen or nitrous oxide. 

• Mode of operation: Continuous operation 

 

 

Electromechanical safety standards met 

• MDR 2017/745 

• EN ISO 10993-1:2009 (ISO 10993-1:2009) 

• EN ISO 10993-10:2013 (ISO 10993-10:2010) 

• EN ISO 10993-5:2009 (ISO 10993-5:2009) 

• EN ISO 13485:2016 (ISO 13485:2016) 

• EN ISO 14971:2019 (ISO 14971:2019) 

• EN ISO 15223-1:2021 (ISO 15223-1:2021) 

• EN 1041:2008+A1:2013 

• EN 55011:2016+A1:2017 (CISPR 11:2015/AMD1:2016) 

• EN 55032:2015 (CISPR 32:2015) 

• EN 60601-1:2006+A2:2014 (IEC 60601-1:2005/AMD1:2012/COR1:2014) 

• EN 60601-1-2:2015 (IEC 60601-1-2:2014) 

• EN 60601-1-6:2010+A1:2015 (IEC 60601-1-6:2010/AMD1:2013) 

• EN 60601-2-37:2008+A11:2011+A1:2015 (IEC 60601-2-37:2007/AMD1:2015) 

• EN 61000-3-2:2014 (IEC 61000-3-2:2018) 

• EN 61000-3-3:2013 (IEC 61000-3-3:2013) 

• EN 61000-4-11:2004 (IEC 61000-4-11:2004) 

• EN 61000-4-2:2009 (IEC 61000-4-2:2008) 

• EN 61000-4-3:2006+A1:2008+A2:2010 (IEC 61000-4-3:2006/AMD2:2010) 
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• EN 61000-4-4:2012 (IEC 61000-4-4:2012) 

• EN 61000-4-5:2014 (IEC 61000-4-5:2014) 

• EN 61000-4-6:2014 (IEC 61000-4-6:2013) 

• EN 61000-4-8:2010 (IEC 61000-4-8:2009) 

• EN 62304:2006+A1:2015 (IEC 62304:2006/AMD1:2015) 

• EN 62366-1:2015 (IEC 62366-1:2015) 

• MEDDEV 2.12/2 Rev.2 

• MEDDEV 2.7.1 Rev.4 

• NEMA UD2:2004 (R2009) 

• Medical Devices Regulations (SOR/98-282) 

• 의료기기법, 의료기기법 시행령, 의료기기법 시행규칙 
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Contact Information 

Sales or customer service representatives are available regionally to help answer your questions. For 
additional information or assistance, please contact your local distributor or Alpinion representative. 

 
 

Europe countries 

Authorized EU Reperesentative 
 

ALPINION MEDICAL Deutschland GmbH 

Alpinion Medical Deutschland GmbH Lilienthalstrasse 17a 

85399 Hallbergmoos Germany 

+49 (0) 811 99 82 86 0 
 
 
 

North or South America countries 

Authorized US Reperesentative 

ALPINION USA (Kevin Chun) 

21222 30th Dr SE Ste C-122 Bothell, WA 98021, United States 

+1 425 949 1059 
 
 
 

Asia countries 

ALPINION MEDICAL SYSTEMS Co., Ltd. 

ALPINION MEDICAL SYSTEMS Co., Ltd. 

5FL, I Dong, 77, Heungan-daero 81beon-gil, 

Dongan-gu, Anyang-si, Gyeonggi-do, Republic of Korea 

+82 (2) 3282 0903 

 

ALPINION GuangZhou Medical Systems 

ALPINION GuangZhou Medical Systems 

#1302, Victory Plaza No.103 Tiyu, West Road, TianHe District 

Guangzhou, Guangdong, China 

+86 (20) 3867 8286 
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Other worldwide countries 

For all other worldwide countries, please contact your local Alpinion distributor or the appropriate 

support resource listed on Alpinion website at http://www.alpinion.com. 

 
 
 

Manufacturer 
 

ALPINION MEDICAL SYSTEMS Co., Ltd. 

5FL, I Dong, 77, Heungan-daero 81beon-gil, 

Dongan-gu, Anyang-si, Gyeonggi-do, Republic of Korea 

Telephone: +82 2 3282 0903 Fax: +82 2 851 5593 www.alpinion.com 

Copyright © ALPINION MEDICAL SYSTEMS Co., LTD, All rights reserved. 

 

 

This product complies with regulatory requirements of the following European Medical Device 

Regulation 2017/745 concerning medical devices. 

http://www.alpinion.com/
http://www.alpinion.com/
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Revision History 

The revision history of this manual is as follows. 

 

Rev Date (YYYY/MM/DD) Description 

Rev. 0 2021/11/01 Initial Release 

Rev. 1 2022/09/08 Updated for Rev. 1 release 

   

   

   

   

 
Please verify that you are using the latest revision of this document. If you need to know the latest 

revision, contact your local agent or local Alpinion sales representative. 
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Introduction 

 
 
 
 

This chapter describes the information concerning indications for use, contraindications, 
and how this documentation is organized. 
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Overview 
This user manual is intended to assist you with the safe and effective operation of your system. Before 
attempting to operate the system, read this manual and strictly observe all instructions. 

Keep this manual with the system at all times. Periodically review the procedures for operation and 
safety precautions. 

Disregarding information on safety is considered abnormal use. 

Not all features, products, transducers, or peripherals described in this manual may be available 
or cleared for sale in all markets. Please contact your local Alpinion representative to get the latest 
information. 

 
 

Documentation 
 

CAUTION 
Safety instructions must be reviewed before operating the unit. 

X-CUBE 60 documentation consists of various manuals: 

• The User Manual (TRANSLATED) provides information needed by the user to operate the 
system safely. It describes the basic functions of the system, safety features, operating modes, 
measurements/calculations, transducers, and user care and maintenance. 

• The Quick Guide/Online Help (TRANSLATED) provides information needed by the user to perform an 
ultrasound exam step-by-step. 

• The Reference Manual (ENGLISH ONLY) contains data tables, such as Obstetric and Cardiology 
references. 

• The Service Manual (ENGLISH ONLY) supplies block diagrams, lists of spare parts, descriptions, 
adjustment instructions or similar information which helps qualified technical personnel in repairing 
those parts of the system which have been defined as repairable. 

The X-CUBE 60 manuals are written for users who are familiar with basic ultrasound principles and 
techniques. They do not include sonographic training or detailed clinical procedures. 

 

 
NOTE 

• The manuals are provided in electronic format on the USB flash memory media. 

• The USB flash memory media includes English and all translations. 

• The screen images in this manual are only for illustrational purposes. Actual screen display may differ 
slightly from that shown in this manual. 



 

 

  

Indications for Use 

The X-CUBE 60 diagnostic ultrasound system is intended for use by, or by the order of, and under the 
supervision of, a licensed physician who is qualified for the evaluation of soft tissue and blood flow in 
the clinical applications of Fetal; Abdominal(renal & GYN/pelvic); Pediatric; Small Organ(breast, testes, 
thyroid); Neonatal Cephalic; Adult Cephalic; Trans-rectal; Trans-vaginal; Musculo-skeletal(Conventional); 
Musculo-skeletal(Superficial); Cardiac(adult& pediatric); Peripheral Vessel(PV); and Urology(including 
prostate). 

And, in the imaging modes of 2D(B) mode; Harmonic mode(HAR); M mode; Color M mode; Anatomical 
M mode; Color Flow Doppler(CF) Mode; Power Doppler(PD) Mode; Directional PD mode; Pulsed Wave 
Doppler(PWD) Mode; Continuous Wave Doppler(CWD) Mode; High PRF Doppler mode; Tissue Doppler 
Imaging(TDI) Mode; 3D/4D mode. 

The X-CUBE 60 is intended to be used in a hospital or medical clinic. 
 
 

Intended Use 

The X-CUBE 60 is intended for use by a qualified physician for ultrasound evaluation. 
 
 

Operator Profile 

The X-CUBE 60 is intended for use by a qualified and trained physician or sonographer with at least basic 
ultrasound knowledge for ultrasound evaluation. 

The operator must have read and understood the user manual. 
 
 

 

Contraindication 

Do not operate the system for an ophthalmic purpose or any use affecting the patient’s eye by the 
acoustic beam. 

 
 

 

Prescription Device 

United States law restricts this device to sale or use by, or on the order of a physician. 
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2 
Safety 

 
 
 

 

This chapter describes the safety and regulatory information relevant for operating this 
ultrasound system. 
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Safety Precautions 
You should make sure the safety precautions during all phases of operation, service, and repair of the 
X-CUBE 60 ultrasound system. If you fail to comply with these safety precautions or specific warnings 
in this manual, you violate safety standards in terms of design, manufacture, and intended use of this 
system. ALPINION MEDICAL SYSTEMS Co., LTD. does not have liability for your failure to comply with 
these requirements. 

 
 

Precaution Levels 

You can view various levels of safety precautions on your equipment, and each level of caution can be 
identified by one of the following flag words and icons which precede the precautionary statement. 

 
 

WARNING 
WARNING indicates that a specific hazard is known to exist which through inappropriate conditions 
or actions may cause severe or fetal personal injury or substantial property damage. 

 

 
CAUTION 
CAUTION indicates that a potential hazard may exist which through inappropriate conditions or 
actions will or can cause minor personal injury or property damage such as loss of patient or system 
data. 

 
 

NOTE 

NOTE indicates precautions or recommendations that will help you operate the product more 
effectively. 
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Patient Safety 
The precautions listed can seriously affect the safety of patients undergoing diagnostic ultrasound 
examinations. 

 
 

Patient Identification 

When entering patient data, always ensure that the patient's name and ID number are correct. Make 
sure that all saved data and hard copy prints contain the patient ID correctly. Identity errors could lead to 
incorrect diagnosis. 

 
 

Patient Data 

Make sure that the ultrasound diagnostic system is not used to store the patient data and images for the 
long term. The user is responsible for the data on the system and is strongly recommended to perform a 
regular backup. 

It is advisable to back up the system data to the hard drive prior to any service repairs. It is always 
possible to lose the patient data during the system failure and repair. Alpinion Medical Systems is not 
responsible for any lost patient data. 

 
 

Diagnostic Information 

The images and calculations provided by the diagnostic ultrasound system are intended for experienced 
users and should not be considered as the sole and incontrovertible basis for clinical diagnosis. 

Users are encouraged to study the literatures and make their own professional conclusions regarding the 
clinical utility of the system. 

The user should be familiar with product specifications, system accuracy and stability limitations, and 
consider these limitations before making decisions based on quantitive values. 

Equipment malfunction or incorrect settings can result in measurement errors or failure to detect details 
within the image. The user must become thoroughly familiar with the equipment operation in order to 
optimize its performance and recognize possible malfunctions. 

 
 

CAUTION 
The system provides calculations (eg, estimated fetal weight) and charts based on published scientific 

literature. It is the user's responsibility to select the appropriate chart and clinical interpretation of the chart 
and calculations. The user should consider contraindications when using calculations and charts in scientific 

literature. In addition, the diagnosis, decision for further examination, and medical treatment must be 
performed by a qualified physician in accordance with Good Clinical Practice guidelines. 

 

 
CAUTION 
Be certain to ensure the patients' privacy data and confidentiality. 
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Mechanical Hazards 

The use of damaged transducers or improper use and manipulation of the endocavity transducers may 
result in injury or increase the risk of infection. Inspect transducer often for sharp, pointed, or rough 
surface damage that could cause injury or tear protective barriers. 

Never use excessive force when manipulating endocavity transducers. 
 
 

CAUTION 
Look for any damage that would allow liquid to enter the transducer. If any damage is found, do not use the 
transducer until it has been inspected and repaired/replaced by ALPINION Service Representative. 

 

 
CAUTION 
Ultrasound transducers are sensitive instruments which can easily be damaged by rough handling. Take 
extreme care when handling or storing transducers. A damaged housing, lens or cable can result in patient 
injury or transducer malfunctions. 

 

 
CAUTION 
Do not use the system with defibrillator. The system does not include a defibrillation-proof applied part for 
ECG. 

 
 

ALARA (As Low As Reasonably Achievable) 

Ultrasound can have harmful effects on tissues, potentially causing patient injuries. Always minimize 
exposure time and keep ultrasound levels low when there is no medical benefit. Follow the principle of 
ALARA (As Low As Reasonably Achievable), increasing acoustic output only when needed to achieve a 
diagnostic quality image. Observe the acoustic output display and make sure you are familiar with all 
controls affecting the output level. 

 
 

Training 

It is recommended that all users receive proper training in applications before performing them in 
a clinical setting. ALPINION provides training assistance, if needed. Please contact the local Alpinion 
representative for training assistance. 
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Equipment and Personnel Safety 
The concerns listed below can seriously affect the safety of equipment and personnel during a diagnostic 
ultrasound examination. 

Do not use the equipment if a safety problem is known to exist. Have the unit repaired and performance 
verified by qualified service engineer before returning to use. 

 
 

WARNING 
The system voltage may cause serious injury or damage to the system. 

• Installing the system yourself may cause damage to the system or electrical shock. 

To avoid damage to the system and avoid electrical shock, only qualified ALPINION service engineer must 

install the system. 

• When you observe that the system causes any malfunction, you must stop operating the system and take 
proper action for patients. After that, contact ALPINION service engineer. 

• Do not modify this system such as system components, or software. When you modify the system, it may 
cause safety hazards. Only qualified ALPINION service engineer must modify the system. 

• Always make sure you turn off the system power and unplug the power cord from the power outlet before 
cleaning up and disinfecting the system. 

 

 
WARNING 
For patient safety, you must locate the system to easily unplug the power cord from the power outlet when a 
malfunction or an error occurs. 

 

 
WARNING 
Always use peripherals and accessories approved by ALPINION. You must securely connect peripherals and 
accessories to the system. 

 

 
WARNING 
The ultrasound diagnostic system is not intended to be used as a data storage device. The user is responsible 
for the data on the system and is strongly recommended to perform a regular backup. 

 

 
WARNING 
To avoid injury: 

• Do not remove the covers of a system yourself to avoid damage to the system and unexpected electrical 
shock. Only qualified ALPINION service engineer must repair or replace components. 

• You must make sure grounded integrity of the power outlet and system regularly. 
• To avoid risk of electric shock, you must connect the system to the supply mains with the protective earth. 

• Do not allow water or liquids on or above the system. Dripping water or liquids into the system may cause 
electrical shock and damage to the system. 

 

 
WARNING 
Always make sure that you do not operate the system in the presence of flammable or explosive liquids,  
vapors or gases. Malfunctions in the system, or sparks generated by fan motors, can electrically ignite these 

substances. Operators should be aware of the following points to prevent such explosion hazards. 

• If flammable substances are detected in the environment, do not plug in or turn on the system. 

• If flammable substances are detected after the system has been turned on, do not attempt to turn off the 
system, or to unplug it. 

• If flammable substances are detected, evacuate and ventilate the area before turning off the system. 
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CAUTION 

Do not use this system if a safety problem is known to exist. Have the unit repaired and performance verified 
by qualified service personnel before returning to use. 

 

 
CAUTION 
• Your ultrasound system is not intended for diagnosing and monitoring ECG. 
• Do not use the system for cardiac operation. 

 

 
CAUTION 
Always use approved ECG cables and recommended electrodes by ALPINION. 

 

 
CAUTION 
Always use transducers approved or recommended by ALPINION. 

 

 
CAUTION 
Do not touch the patient and any of the connectors on the system simultaneously, including transducer 
connectors. 

 

 
CAUTION 
Do not load non-system software on the system computer. 

 
 
 

Caution for Moving the System 

Before moving the system, check that the brakes on the wheels are unlocked. Also, make sure to retract 
the monitor arm completely so that it is secured in a stationary position. 

 
Be careful when moving the system. Failure to follow these precautions can result in serious injury and/ 
or system damage. 

 
 

CAUTION 
To avoid serious injury and/or system damage when transporting from one area of use to another: 

• Two or more people are required when moving the system on inclines or long distance. 

• Secure the monitor and accessories for transport. 

• Be sure the pathway is clear. 

• Always use the handle at the rear of the console. 

• Move the system slowly and carefully. 

• Avoid collisions with walls or door frames. 

• Always place the system on horizontal ground and engage the wheel brakes. 
• Do not move the system when the brakes are engaged. 



Equipment and Personnel Safety 2-7 

 

 

  

Caution for Using Monitor 

When adjusting the height or position of the monitor, do not place a finger, hand or object on the joint of 
the monitor or monitor arm to avoid injury or system damage. 

 
CAUTION 
• When moving the system, be sure to lock the monitor arm. 

• When rotating the monitor, be sure to release the lock. Rotating a locked monitor may cause damage to 
the internal cable of the system. 

 
 

Caution for Using Control Panel 

When adjusting the height or position of the control panel, make sure nothing is within the range of 
motion to avoid injury or system damage. 

 
CAUTION 
• Do not push the control panel with excessive force. 

• Do not lean against the control panel. 

• Do not sit on the control panel. 

• Do not apply too much pressure to the control panel. 
• Do not lift the system using the handles on the control panel. 

 
 

Caution for Using Touch Screen 

When adjusting the tilt angle of the touch screen, pay attention to the back space of the touch screen. 
Do not place a finger, hand or object within the range of motion to avoid injury or system damage. 

 
CAUTION 
Do not push the touch screen with excessive force. 
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Anti-Virus Program 
Since the X-CUBE 60 ultrasound systems are integrated into your IT-network, ALPINION MEDICAL 
SYSTEMS Co., LTD wants to make sure that you are aware of the proactive measures we are taking to 
secure the system. Below are measures we have implemented to secure the X-CUBE 60 ultrasound 
systems. 

• Use of Windows* Embedded Standard 10, a componentized version of Windows 10 specifically made 
for embedded systems. Only the components required are used for the X-CUBE 60 scanners, thereby 
reducing the OS attack surface. Please note that Windows Embedded Standard 7 is NOT the same 
operating system as Windows 10. 

• Disable the user’s ability to access the internet and Windows desktop. 

• Disable, or make inaccessible, functionality that is typically used as malware vectors for spreading 
viruses (e.g. email services, web browsers). 

• Disable the AutoRun functionality on removable media. 

ALPINION MEDICAL SYSTEMS Co., LTD believes that this Defense in Depth strategy using the combination 
of the security measures above and the security standards of Microsoft’s Windows Embedded Standard 
10 will provide security against malware, especially for a system used in a professional, hospital grade 
networking environment that itself should provide a high level of security measures. 

Finally, a few points as to why ALPINION MEDICAL SYSTEMS Co., LTD do not use the anti-virus software. 
Commercial anti-virus software is commonly used on general-purpose computers to detect the presence 
of malicious software (e.g. virus, Trojan horse, worm). Anti-virus software is useful on general-purpose 
computers as they typically cannot be sufficiently hardened against the attack vectors used by malicious 
software. 

The X-CUBE 60 ultrasound systems however are single purpose devices that have controlled intended 
use, and thus are well hardened. For the X-CUBE 60 ultrasound systems, the potential patient safety and 
security risks introduced by using commercial anti-virus software would outweigh the security benefits. 
Such risks include: 

• Real-time anti-virus scanning can affect ultrasound system performance. 

• The effectiveness of anti-virus software depends on regular updates of the virus definitions files. This 
would typically require internet connectivity for the ultrasound system. 

• The anti-virus software itself is a popular attack vector. 

• Disruptive nature of the support of the anti-virus software throughout the life cycle of the medical 
device. The operating system of a medical ultrasound system is part of a medical device that requires 
a special and controlled release process. Any update of the anti-virus software would require a 
change of the system software. 

Due to the cited risks, the use of commercial anti-virus software is not part of the X-CUBE 60 ultrasound 
systems product security strategy. 
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Cybersecurity 
Threats to cybersecurity are getting stronger. Threats from computer viruses and malicious software 
such as worms, Trojans, Ddos attacks, and other malware are increasing. Multiple levels of vigilance and 
defense are required to prevent damage to systems, personal information, and various data from such 
malicious software. This section describes how X-CUBE 60 ultrasound system manage user-level risk for 
cybersecurity. 

 

 

User Account 

• User account management includes account creation, maintenance, and account suspension and 
deletion. It is recommended to use the ultrasound system through an individual user account. 

• User accounts are created, maintained, and deleted by users with administrator privileges. When 
received from the factory, the system has 1 user account with administrator privileges. 
(Check the [Admin] account in System Preset > Administrator > Users) 

• When you receive your ultrasound system, we recommend that you perform the following steps to 
manage your system's user account. 

– Register the password for the "Admin" account. 

– Create a user account and register a password. 

– Disable Auto Login function of "Admin" account. 
 

NOTE 

For details, please refer to "Administration" on page 5-53 

• The user's password can be changed directly by the user at login or while logged in, or by the system 
administrator through settings. 

• When automatic login is enabled, you can use the ultrasound system without entering a user ID and 
password. 

• For privacy and security reasons, we do not recommend using this feature on your ultrasound system. 
This feature is included on par with previous versions of the product. 

 

Windows Defender 

• Windows Defender is integrated into the ultrasound system as part of the system's layered defenses. 
Windows Defender monitors your system for known malicious software signatures and behavioral 
patterns, and updates them periodically through OS Update Patches to improve their detection. 

• Operating System level security patches, including Windows Defender, are made through authorized 
service access by authorized engineers. 



2-10 Safety and Regulatory Information 

 

 

Removable Media 

• For administrator accounts and general users, direct access to the system is restricted as follows to 

protect the ultrasound system. 

– Restrict access to system storage and file system 

– Limit remote desktop connection 

– Restrictions on changing network settings and firewall settings 

– Restrictions on settings related to other system configurations 

• Only engineers authorized by ALPINION MEDICAL SYSTEMS may use the field service key to gain 
special access to the ultrasound system. Through this service access, engineers can perform service 
tasks by accessing system areas that administrators and general users cannot access. 

• Data stored on removable media such as USB storage devices, CDs and DVDs is stored unencrypted. 

• Data may include personal information and personal medical and health information. As a result, 
these storage devices and the data on them must be physically protected and processed in 
accordance with the regulations and guidelines for the processing of personal data.We recommend 
storing data anonymously, unless it conflicts with the purpose of storing data on removable media. 

• Data anonymization reduces the risk of personal information being disclosed in case of loss or neglect 
of removable media. 

• The ultrasound system supports USB-attached storage devices. USB storage devices are used for: 

– Export / Import of patient data and images 

– Backup of patient data 

– Backup / Restore of user settings 

• The media autoplay function (AutoPlay) is disabled to prevent automatic execution of the software 
inside the removable media connected to the ultrasound system. 

 

 

Security Support 

In the event of a cybersecurity breach, immediately discontinue use of the ultrasound system. 
Disconnect from the network and remove any attached removable media. After that, turn off the power 
and request technical support through the security manager. 
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Electrical Safety 
The X-CUBE 60 ultrasound system is categorized as a Class I device. 

 
 

Prevention of Electrical Shocks 
 

WARNING 
Do not modify the AC power connector plug of the system to prevent electrical shock. 

 

 
WARNING 
Do not remove the panels or covers of a system to prevent system damage and electrical shock. 

 

 
WARNING 
Do not replace the fuse or power cord by yourself. An ALPINION MEDICAL service engineer or an authorized 
agent must perform the replacement. Replacing the fuse or power cord by yourself will avoid your warranty. 

 

 
WARNING 
Do not clean or disinfect a system before turning off and unplug the system from the power outlet. 
Otherwise, it could result in electrical shock and damage to the system. 

 

 
WARNING 
Do not place water or liquids on the system. Dripping water or liquids into the system may cause electrical 
shock and damage to the system. 

 

 
WARNING 
Using an extension cord setup to provide power to the imaging system, or to the system's peripheral devices 
may compromise the system grounding and cause your system to exceed leakage current limits. 

 

 
WARNING 
The system voltage may cause serious injury or damage to the system. When you observe that the system 
causes any malfunction, you must stop operating the system and take proper action for patients. After that, 
contact ALPINION service engineer. 

 

 
WARNING 

Different voltage power between your system and other devices may cause electrical shock. According to the 

IEC requirements (Refer to IEC 60601-1-1 and clause 16 of the 3 Ed. of IEC 60601-1, respectively), you must 

use the equipotential cable (equipotential bonding) to connect additional devices to your system. Contact  

your ALPINION MEDICAL service engineer. 
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CAUTION 
Do not use aerosol spray cleaners on the monitor to prevent electrical shock and damage to the system. 

 

 
CAUTION 
Using spray cleaners on the system drips cleaning fluid into the system. It damages components in the 
system. 
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Transducer Safety 
The following recommendations help to prevent preventable transducer damage and serious injuries. 

 
 

Handling and Care Precautions 

Care precautions 
 
 

CAUTION 
Failure to follow the precautions listed below can result in transducer damage and/or electric shock due to 
damaged electrical insulation. 

• Do not apply excessive bending or pulling force to the transducer cable. 
• Do not kink, tightly coil, or apply excessive force on the transducer cable. 

 
Handling precautions 

 
 

WARNING 
Do not use damaged or defective transducers. Injury to the operator or patient may occur if cracks, cuts,  

sharp edges or exposed wiring exist. Cleaning and/ or gel solutions may leak into the transducer resulting in  
electrical shock. Discontinue use, immediately disconnect the ultrasound transducer and notify the ALPINION  

Service Representative. 
Failure to follow these precautions can result in serious injury. 

 

 
CAUTION 
After each use, inspect the transducer’s lens, cable, and casing. Look for any damage that would allow liquid 
to enter the transducer. If any damage is found, do not use the transducer until it has been inspected and 
repaired/replaced by ALPINION Service Representative. 

 
Electrical shock hazard 

 
 

WARNING 
Do not drop the transducers. If a transducer has dropped on the floor or on any other hard surface, 
immediately disconnect the transducer from the ultrasound system. Do not use the transducer any more. 
There is a risk of electric shock due to damaged electrical insulation. 

 

 
WARNING 
Prior to each use, visually inspect the transducer lens and case area for cracks, cuts, tears, and other signs of 
physical damage. Do not use a transducer which appears to be damaged until you verify functional and safe 
performance. 

 

 
WARNING 
Do not immerse the transducer into any liquid beyond the immersion level. Never immerse the transducer 
connector into any liquid. 
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WARNING 
Do not kink, tightly coil, or apply excessive force on the transducer cable. There is a risk of electric shock due 
to damaged electrical insulation. 

 

 
WARNING 
Before inserting the connector into the transducer port, inspect the transducer connector pins. If a pin is  
bent, do not use the transducer until it has been inspected and repaired/replaced by a ALPINION Service 
Representative. 

 
 
 

Special Handling Instructions 
 

WARNING 
Protective barriers may be required to minimize disease transmission. Transducer sheaths are available for 
use with all clinical situations where infection is a concern. 

 

 
WARNING 
Do not use an expired transducer sheath. Before using transducer sheaths, verify whether the term of 
validity has expired. Failure to follow these instructions could lead to exposure to infectious agents. 

 

 
WARNING 
Devices containing latex may cause severe allergic reactions in latex sensitive individuals. 

 

 
CAUTION 
Do not use pre-lubricated condoms as a sheath. In some cases, they may damage the transducer. 

 

 
CAUTION 
Only use approved coupling gels and cleaning/disinfection agents. Failure to follow the precaution can result 
in transducer damage. 

 

 
CAUTION 
Adequate cleaning and disinfection is necessary to prevent disease transmission. 

• The user is responsible to ensure adequate cleaning and disinfection of ultrasound transducers. 
Transducers are not sterile when delivered. 

• High-level disinfection is recommended for surface transducers and is required for endocavity transducers. 
• Transducers must be cleaned and disinfected before they are replaced or disposed. 
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Biopsy Safety 

Precautions Concerning the Use of Biopsy Procedure 
 

WARNING 

Do not freeze the image during a biopsy procedure. The image must be live to avoid a positioning error. 

Biopsy guidezones are intended to assist the user in determining optimal transducer placement and  

approximate the needle path. However, actual needle movement is likely to deviate from the guideline. 

Always monitor the relative positions of the biopsy needle and the subject mass during the procedure. 

 
 
 

WARNING 

Biopsy procedures should not be used for In vitro fertilization (IVF), Chronic villus sampling (CVS), and 

Percutaneous umbilical blood sampling (PUBS). 

 
 
 

CAUTION 

The use of biopsy devices and accessories that have not been evaluated for use with this equipment may not 

be compatible and could result in injury. 

 
 
 

CAUTION 

The invasive nature of biopsy procedures requires proper preparation and technique to control infection and 

disease transmission. Equipment must be cleaned as appropriate for the procedure prior to use. 

• Follow the transducer cleaning and disinfection procedures and precautions to properly prepare the 

transducer. 
• Follow the manufacturer's instructions for the cleaning of biopsy devices and accessories. 

• Use protective barriers such as gloves and transducer sheaths. 

• After use, follow proper procedures for decontamination, cleaning, and waste disposal. 

Failure to follow these instructions could lead to exposure to infectious agents. 

 
 
 

CAUTION 

Improper cleaning methods and the use of certain cleaning and disinfecting agents may cause damage to the 

plastic components that will degrade imaging performance or increase the risk of electric shock. For details, 

"Transducer Safety" on page 2-13. 

 
 
 

CAUTION 

A biopsy must only be performed by physicians with adequate experiences under all circumstances the 

necessary safety precautions and sterility measures have to be respected. 
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System Symbols and Labels 
The following is a list of system symbols and labels for safety. They indicate that you must refer to the 
manual for specific information to avoid personal injury or damage to the product. 

 

Safety Symbols/ Labels Location Explanation 

 

 

On the power button of the control 

panel 

 
System on/off/stand-by 

 

 

On the system rating label for 
overseas, transducer label, and ECG 

port 

 

Patient applied part meets the isolation 
requirements for type BF equipment 

 

 

 

On the ECG port 
 

ECG triggered display 

 
 
 
 

 

 
 
 
 

On the transducer label 

This symbol indicates that the 
transducer meets immersion 
requirements. Depending on the 

transducer model, the immersion label 
may differ. 

Immersion-proof device: Protected 
against the effects of non-continuous 

immersion in water 

 
 
 

 

 
 
 

On the transducer label 

This symbol indicates that the 

transducer meets immersion 
requirements. 

Submersion-proof device: Protected 
against the effects of continuous 

immersion in water 

 

 

 

 

 
On the multi-caution label, rating 
label for overseas, transducer label, 

and gel warmer label 

This symbol indicates that when the 

end-user wishes to discard this product, 
it must be sent to separate collection 

facilities. Please contact an authorized 
representative of the manufacturer 

for information concerning the 

decommissioning of your equipment. 

 

 

 

On the multi-caution label, rating 
label for overseas, and system 

packing box 

This system complies with regulatory 
requirements of European Medical 

Device Regulation 2017/745 regarding 
medical device. 

 

  

 

On the multi-caution label, gel 
warmer label, and I/O panel 

 

Consult instructions for use (or consult 
operating instructions) 

 

 

 
 

Various locations on labels 

Attention (Caution) – consult 
accompanying documents if complete 
information cannot be provided on the 

label 

 
 

 

On the rating label for overseas: 

Adjacent to the AC power and the 
AC power outlet 

 

Alternating current in accordance with 

IEC 60878-01-14 
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Safety Symbols/ Labels Location Explanation 

 

 

 

Adjacent to the AC power outlet 
 

Push-push button 

 

 

 
Adjacent to the AC power 

 
Equipotentiality 

 
 

On the right side of the touch 

screen 

 

Universal Serial Bus 

 

 

 
 

On the multi-caution label 

 

This symbol indicates that the 

transducer should not be used in the 
MRI scanner room. 

 

 
On the system rating label for 
overseas and transducer label 

Date of manufacture 

See ISO 8601 for date format 

 
 

 

 
On the system rating label for 

overseas and transducer label 

Symbol for manufacturer 

This symbol shall be accompanied 
by the name and the address of the 
manufacturer. 

 

 
On the system rating label for 

overseas and transducer label 

 

Serial Number 

 

 

 

On the multi-caution label 
To ensure safety of user, moving and 
delivering system shall be performed by 

at least 2 persons. 

 

 

 
On the LCD caution label and multi- 

caution label 

 
Do not forcibly push the monitor or the 

system when the casters are locked. 

 

 

 
 

On the LCD caution label 

Do not press or place loads on the 

monitor when folded. Otherwise, 
monitor and (or) professional arm could 
be damaged. 

 

 

 
 

On the multi-caution label 

 

Do not use mobile transmitter such 

as mobile phone, radio receiver, 
broadband power line, etc. 

 

 

 

 
On the LCD caution label 

 
Be very careful not to injure yourself or 

damage the system when rotating the 
monitor arm. 

 

 

 

 
Rear of the LCD monitor 

 

 
Caution label 
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Safety Symbols/ Labels Location Explanation 

 

 

 
 

Top of the monitor arm 

 
Care against pinch shall be taken. (In 
accordance with IEC 60878) 

 

 

 
 

Rear of the system body 

 
 

Multi-caution label 

 

 

 
 

Right cover of the system body 

 
 

No gender detection label 

 

 

 
Top (or side panel) of the system 

body 

 

Safety working load label 

 

 

 
 
 

 
Bottom of the control panel 

 
 
 

 
System rating label for overseas 

 

 

 
 
 

 
Bottom of the control panel 

 
 
 

 
System rating label for domestics 

 

 

 
On the cable port of the gel warmer 

 
Gel warmer voltage label 

 

 

 
 

Rear of the gel warmer 

 
 

Gel warmer label 

 

 

 
 

Transducer 

 

Name of transducer manufacturer, 
WEEE symbol, indicating separate 

collection, Certification mark 
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Safety Symbols/ Labels Location Explanation 

 

 

 
 

Transducer 

 
Transducer name, Serial, IPX Rating, 

Caution mark 
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Electromagnetic Compatibility (EMC) 
This equipment generates, uses, and can radiate radio frequency energy. The equipment may cause radio 
frequency interference to other medical and non-medical devices and radio communications. To provide 
reasonable protection against such interference, this product complies with emissions limits for a Group 
1, Class Medical Devices Regulation as stated in EN 60601-1-2. 

Electrical medical equipment requires special precautions regarding EMC and must be installed and 
implemented according to the EMC information provided in the user manual. 

AII types of electronic equipment may characteristically cause electromagnetic interference with other 
equipment, transmitted either through air or connecting cables. The term Electromagnetic Compatibility 
(EMC) indicates the capability of the equipment to curb electromagnetic influence from other 
equipment, while at the same time not affecting other equipment with similar electromagnetic radiation. 

Radiated or conducted electromagnetic signals can cause distortion, degradation, or artifacts in the 
ultrasound image which may impair the ultrasound unit’s essential performance. 

There is no guarantee that interference will not occur in a particular installation. If this equipment is 
found to cause interference (which may be determined by turning the equipment on and off), the user 
(or qualified service personnel) should attempt to correct the problem by one or more of the following 
measure(s): 

• Reorient or relocate the affected device(s). 

• Increase the separation between the equipment and the affected device. 

• Power the equipment from a source different from that of the affected device. 

• Consult the point of purchase or service representative for further suggestions. 

Use of accessories, transducers and cables other than those specified may result in increased emission or 
decreased immunity of the equipment. 

The manufacturer is not responsible for any interference caused by using other than recommended 
interconnect cables or by unauthorized changes or modifications to this equipment. Unauthorized 
changes or modifications could void the users’ authority to operate the equipment. 

Devices which intrinsically transmit radio waves, such as cellular phones, radio transceivers, mobile radio 
transmitters, radio-controlled toys, etc., should preferably not be operated near the equipment. Keep the 
power to these type devices turned off when near the equipment. 

 

NOTE 

Use of devices that transmit radio waves near the equipment could cause it to malfunction. See 
"Recommended separation distances" on page 2-24 for information about the recommended minimum 

separation distances between portable and mobile RF communications equipment and the ultrasound unit. 

The system or its components should not be used adjacent to or stacked with other equipment. If 
adjacent or stacked use is necessary, the system or its components should be observed to verify normal 
operation in the configuration in which it will be used. 

The medical staff in charge of this equipment is required to instruct technicians, patients, and other 
people who maybe around this equipment to fully comply with the above requirement. 
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Electromagnetic Compatibility Tables 

Electromagnetic emissions 

This system is suitable for use in the following environment. The user must assure that it is used only in 
the electromagnetic environment as specified. 

 

Guidance and manufacturer’s declaration–electromagnetic emissions 
 

Emissions test Compliance Electromagnetic environment - guidance 

 
RF emissions 
CISPR 11 

 
 

Group 1 

The X-CUBE 60 uses RF energy only for its 
internal function. Therefore, its RF emissions 
are very low and are not likely to cause any 
interference in nearby electronic equipment. 

 
RF emissions 
CISPR 11 

 

Class A 

The X-CUBE 60 is suitable for use in all 
establishments, other than domestic 
establishments and those directly connected 
to the public low-voltage power supply 
network that supplies buildings used for 
domestic purposes, provided the following 
warning is heeded: 
WARNING: The EMISSIONS characteristics 
of this equipment make it suitable for use in 
industrial areas and hospitals (CISPR 11 class 
A). If it is used in a residential environment 
(for which CISPR 11 class B is normally 
required) this equipment might not offer 
adequate protection to radio-frequency 
communication services. The user might 
need to take mitigation measures, such as 
relocating or reorienting the equipment. 

 
Harmonic emissions 
IEC 61000-3-2 

 

Class A 

 
 

Voltage fluctuations / flicker 
emissions 
IEC 61000-3-3 

 
 
 

Complies 
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Electromagnetic immunity 

This system is suitable for use in the following environment. The user must assure that the system is used 
according to the specified guidance and only in the electromagnetic environment listed. 

 

Guidance and manufacturer’s declaration-electromagnetic immunity 
 

 

Immunity test 
 

IEC 60601 Test level 
 

Compliance level 
Electromagnetic environment 

-guidance 

Electrostatic 
discharge (ESD) 

 
IEC 61000-4-2 

 

±8 kV Contact 

 
±2,4,8,15 kV air 

 

±8 kV Contact 

 
±2,4,8,15 kV air 

Floors should be wood, concrete or 
ceramic tile. If floors are covered 
with synthetic material, the relative 

humidity should be at least 30 %. 

Electrical fast 

transient/burst 

 
IEC 61000-4-4 

±2 kV for power 

supply lines 

±1 kV for input/output 

lines 

±2 kV for power 

supply lines 

±1 kV for input/output 

lines 

 

Mains power quality should be that 

of a typical commercial or hospital 
environment. 

 

Surge 

 
IEC 61000-4-5 

±0.5,1 kV line(s) to 

line(s) 

±0.5,1,2 kV line(s) to 

earth 

±0.5,1 kV line(s) to 

line(s) 

±0.5,1,2 kV line(s) to 

earth 

 

Mains power quality should be that 

of a typical commercial or hospital 
environment. 

 
 
 

 
Voltage dips, short 
interruptions and 

voltage variations 
on power supply 

input lines 

 
IEC 61000-4-11 

< 0 % Uт 

(> 95 % dip in Uт) for 

0.5 cycle 

 
0 % Uт 

(60 % dip in Uт ) 

for 1 cycle 

 
70 % Uт 

(30 % dip in Uт) 

for 25 cycle, 30 cycle 

 
<0 % Uт 

(> 95 % dip in Uт ) for 
250 cycle, 300 cycle 

< 0 % Uт 

(> 95 % dip in Uт) for 

0.5 cycle 

 
0 % Uт 

(60 % dip in Uт ) 

for 1 cycle 

 
70 % Uт 

(30 % dip in Uт) 

for 25 cycle, 30 cycle 

 
<0 % Uт 

(> 95 % dip in Uт ) for 
250 cycle, 300 cycle 

 
 

 
Mains power quality should be 
that of a typical commercial or 

hospital environment. If the user 
of the X-CUBE 60 image intensifier 

requires continued operation during 

power mains interruptions, it is 
recommended that the X-CUBE 60 
image intensifier be powered from 

an uninterruptible power supply. 

Power frequency 
(50/60 Hz) 

magnetic field 

 
IEC 61000-4-8 

 

 
30 A/m 

 

 
30 A/m 

 

Power frequency magnetic fields 
should be at levels characteristic 

of a typical location in a typical 

commercial or hospital environment. 

NOTE Uт is the a.c. mains voltage prior to application of the test level. 
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Guidance and manufacturer’s declaration-electromagnetic immunity 
 

 

Immunity test 
IEC 60601 test 

level 
Compliance 

level 

 

Electromagnetic environment -guidance C 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

level 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Electromagnetic 

environment - 
guidance 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Vrms 
 
 
 

 
3 V/m 

Portable mobile RF communications equipment 

should be used no closer to any part of the X-CUBE 
60, including cables, than the recommended 

separation distance calculated from the equation 
applicable to the frequency of the transmitter. 

 
Recommended separation distance 

 

   80 MHz to 800 MHz 

 
   800 MHz to 2.5 GHz 

where P is the maximum output power rating of the 
transmitter in watts (W) according to the transmitter 
manufacturer and d is the recommended separation 

distance in meters (m). 

 
Field strengths from fixed RF transmitters, as deter- 

mined by an electromagnetic site survey, a should 
be less than the compliance level in each frequency 

range. b 

Interference may occur in the vicinity of equipment 
marked with the following symbol : 

NOTE 1) At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land  
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically  

with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site 
survey should be considered. If the measured field strength in the location in which the EUT is used exceeds  

the applicable RF compliance level above, the EUT should be observed to verify normal operation. If abnormal 
performance is observed, additional measures may be necessary, such as re-orienting or relocating the X-CUBE 

60. 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
c See examples of calculated separation distances in next table. 
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Recommended separation distances 

The X-CUBE 60 is intended for use in an electromagnetic environment in which radiated RF disturbances 
are controlled. The customer or the user of the X-CUBE 60 can help prevent electromagnetic interference 
by maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the X-CUBE 60 as recommended below, according to the maximum output power of 
the communications equipment. 

 
CAUTION 
Portable and mobile RF communications equipment (e.g. peripherals such as antenna cables and external  
antennas, two-way radio, cellular phones, wireless computer networks) should be used no closer than 30 

centimeters (12 inches) to any part of this system including cables provided by or designated by ALPINION 
MEDICAL SYSTEMS. 

 

Recommended separation distances between portable and mobile RF communications equipment 
and the ultrasound unit 

 

 
 

Rated maximum output 
power of transmitter [W] 

Separation distance according to frequency of transmitter [m] 

150 kHz to 80 MHz 80 MHz to 800 MHz 
 

 
 

800 MHz to 2.5 GHz 
 

 

 

 

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 
metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where p is the 
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1) At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2) These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 

and reflection from structures, objects and people. 

 

 

Wireless Adapter Specification 

• Wireless Standard: IEEE 802.11b/g/n 2.4GHz, IEEE 802.11a/n/ac 5GHz 

• Frequency:2.4GHz, 5GHz 

• Wireless Security: WEP, WPA/WPA2, WPA-PSK/WPA2-PSK 

• Wireless Operation: For details, please refer to "Connectivity" on page 5-38. 
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Immunity and compliance level for system 
 

 

Immunity test 
Frequency of Interest 

[MHz] 

 

Actual Immunity Level 
 

Compliance Level 

Conducted RF 
IEC 61000-4-6 

 

0.15 MHz to 80 MHz 
 

3 Vrms 
 

0.3 Vrms 

 

Radiated RF 
IEC 61000-4-3 

80 MHz to 800 MHz 3 V/m 1 V/m 

800 MHz to 2.5 GHz 3 V/m 3 V/m 
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Diagnostic Ultrasound Indications for Use Format 

X-CUBE 60 Ultrasound System 

Indications for Use (Describe) 

The X-CUBE 60 diagnostic ultrasound system is intended for use by, or by the order of, and under the 
supervision of, a licensed physician who is qualified for the evaluation of soft tissue and blood flow in 
the clinical applications of Fetal; Abdominal(renal & GYN/pelvic); Pediatric; Small Organ(breast, testes, 
thyroid); Neonatal Cephalic; Adult Cephalic; Trans-rectal; Trans-vaginal; Musculo-skeletal(Conventional); 
Musculo-skeletal(Superficial); Cardiac(adult& pediatric); Peripheral Vessel(PV); and Urology(including 
prostate). 

And, in the imaging modes of 2D(B) mode; Harmonic mode(HAR); M mode; Color M mode; Anatomical 
M mode; Color Flow Doppler(CF) Mode; Power Doppler(PD) Mode; Directional PD mode; Pulsed Wave 
Doppler(PWD) Mode; Continuous Wave Doppler(CWD) Mode; High PRF Doppler mode; Tissue Doppler 
Imaging(TDI) Mode; 3D/4D mode. 

The X-CUBE 60 is intended to be used in a hospital or medical clinic. 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal N N N  N N N N N 

Abdominal N N N  N N N N N 

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric N N N  N N N N N 

Small Organ 
(breast, testes, thyroid) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Neonatal Cephalic N N N  N N N N  

Adult Cephalic N N N  N N N N  

Trans-rectal N N N  N N N N N 

Trans-vaginal N N N  N N N N N 

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Musculo-skeletal 
(Superficial) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Intravascular          

Cardiac Adult N N N N N N N N  

Cardiac Pediatric N N N N N N N N  

Intravascular (Cardiac)          



Diagnostic Ultrasound Indications for Use Format 2-27 

 

 

 

 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel N N N N N N N N  

Urology (including prostate) N N N  N N N N N 
 

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with L3-8H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P  P P P P  

Small Organ 
(breast, testes, thyroid) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Musculo-skeletal 
(Superficial) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel P P P  P P P P  

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 



Diagnostic Ultrasound Indications for Use Format 2-29 

 

 

X-CUBE 60 with L3-12X Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P  P P P P  

Small Organ 
(breast, testes, thyroid) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Musculo-skeletal 
(Superficial) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel P P P  P P P P  

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with L3-15H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Musculo-skeletal 
(Superficial) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel P P P  P P P P  

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211299; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with SC1-7H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal P P P  P P P P  

Abdominal P P P  P P P P  

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P  P P P P  

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate) P P P  P P P P  

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with SC2-11H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal P P P  P P P P  

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P  P P P P  

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric P P P  P P P P  

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with P1-5CT Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal P P P P P P P P  

Abdominal P P P P P P P P  

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P P P P P P  

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic P P P P P P P P  

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult P P P P P P P P  

Cardiac Pediatric P P P P P P P P  

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K213523; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with SVC1-8H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal P P P  P P P P P 

Abdominal P P P  P P P P P 

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric P P P  P P P P P 

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate) P P P  P P P P P 

N = new indication; P = previously cleared FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with CW2.0 Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult    P      

Cardiac Pediatric    P      

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with CW5.0 Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult    P      

Cardiac Pediatric    P      

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 



Diagnostic Ultrasound Indications for Use Format 2-37 

 

 

X-CUBE 60 with CW8.0 Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult    P      

Cardiac Pediatric    P      

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with EV2-11H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal P P P  P P P P  

Trans-vaginal P P P  P P P P  

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate) P P P  P P P P  

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 



Diagnostic Ultrasound Indications for Use Format 2-39 

 

 

X-CUBE 60 with EC2-11H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal P P P  P P P P  

Trans-vaginal P P P  P P P P  

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate) P P P  P P P P  

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X-CUBE 60 with VE3-10H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

         

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal P P P  P P P P P 

Trans-vaginal P P P  P P P P P 

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

         

Musculo-skeletal 
(Superficial) 

         

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel          

Urology (including prostate) P P P  P P P P P 

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 



Diagnostic Ultrasound Indications for Use Format 2-41 

 

 

X-CUBE 60 with L10-25H Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal          

Abdominal          

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric          

Small Organ 
(breast, testes, thyroid) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Neonatal Cephalic          

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Musculo-skeletal 
(Superficial) 

 

P 
 

P 
 

P 
  

P 
 

P 
 

P 
 

P 
 

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel P P P  P P P P  

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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X- CUBE 60 with SL3-19X Transducer 

Intended Use: Diagnostic ultrasound imaging or fluid flow analysis of the human body as follows: 

 
 

 
Clinical Application 

Mode of Operation 

 
B 

 
M 

 
PWD 

 
CWD 

 

Color 
Doppler 

 

Power 
Doppler 

Tissue 
Harmonic 
Imaging 

 

Combined* 
(Specify) 

 

Other** 
(Specify) 

Ophthalmic          

Fetal N N N  N N N N  

Abdominal N N N  N N N N  

Intra-operative (Specify)          

Intra-operative (Neuro)          

Laparoscopic          

Pediatric N N N  N N N N  

Small Organ 
(breast, testes, thyroid) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Neonatal Cephalic N N N  N N N N  

Adult Cephalic          

Trans-rectal          

Trans-vaginal          

Trans-urethral          

Trans-esoph. (non-Card.)          

Musculo-skeletal 
(Conventional) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Musculo-skeletal 
(Superficial) 

 

N 
 

N 
 

N 
  

N 
 

N 
 

N 
 

N 
 

Intravascular          

Cardiac Adult          

Cardiac Pediatric          

Intravascular (Cardiac)          

Trans-esoph. (Cardiac)          

Intra-cardiac          

Peripheral vessel N N N  N N N N  

Urology (including prostate)          

N = new indication; P = previously cleared by FDA K211300; E = added under appendix 
* Combined: B/Color Doppler, B/PWD, B/Color Doppler/PWD; **Other: 3D, 4D 
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Acoustic Output 
The X-CUBE 60 ultrasound system shows the acoustic output display (e.g. Mechanical Index (MI), 
Thermal Index (TI)) on the upper right side of the screen. This acoustic output display allows you to 
monitor the acoustic levels generated by the system. For more information on Acoustic Output, See "2. 
Acoustic Output" in the X-CUBE 60 Reference Manual. 

Two standards for the acoustic output display are as follows: 

• AIUM/NEMA UD3 Standards for Real-time Display of Thermal and Mechanical Acoustic Output 
Indices on Diagnostic Ultrasound equipment. 

• IEC 60601-2-37, Mechanical Electrical Equipment – Part 2-37: Particular Requirements for the Safety 
of Ultrasound Medical Diagnostic and Monitoring Equipment. 

 

WARNING 
You should use the X-CUBE 60 ultrasound system at the lowest mechanical/thermal index setting necessary to 
generate clinically acceptable images. 

 



2-44 Safety and Regulatory Information 

 

 

Acoustic Output Display (Mechanical/Thermal indices) 

The X-CUBE 60 ultrasound system displays Mechanical index (MI) and Thermal index (TI) on the upper 
right side of the screen. 

The acoustic output display has three values as follows: 

• Mechanical Index (MI) 

• Thermal Index (TI) 

• Power value 

MI is used as an indicator of the mechanical bio-effect such as cavitation in the tissue. TI represents the 
ratio of total power to the power required to raise tissue by 1°C. The power value informs you of where 
the system is operating within the range of available output power. 

One of the following TI values display on the screen based on the application and type of tissue. 

• Soft Tissue Thermal Index (TIS) 

• Bone Thermal Index (TIB) 

• Cranial Bone Thermal Index (TIC) 

The TI and MI are displayed all the times. The MI and TI display start at a value of 0.4 and increments in 
steps of 0.1 (values less than 0.4 are displayed as < 0.4). 

 
 

Controls Affecting Acoustic Output 

The potential for producing mechanical bioeffects (MI) or thermal bioeffects (TI) can be influenced by 
certain controls. The power control has the most significant effect on Acoustic Output. Indirect effects 
may occur when adjusting controls. 

Controls that can influence MI and TI are detailed under the bioeffects portion of each control in the "6. 
Imaging Modes". Always observe the acoustic output display for possible effects. 

 
WARNING 
Be sure to have read and understood control explanations for each mode used before attempting to adjust 
the power control or any control that can affect Acoustic Output. 

 
To minimize exposure time and keep ultrasound levels low, operate your system by using the ALARA (As 
Low As Reasonably Achievable) principle, increasing output only when you needed to obtain diagnostic 
image quality. It is recommended that all users receive ALARA training program. The ALARA training 
program by ALPINION application specialists provides you with basic ultrasound principles, possible 
biological effects, the derivation and meaning of the indices, ALARA principles, and examples of specific 
applications of the ALARA principle. 
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Principle of ALARA 

The principle of ALARA, which stands for As Low As Reasonably Achievable, is to keep the radiation 
exposure at the minimum level necessary to obtain the diagnostic information. This principle is widely 
practiced in medical x-ray protection where exposure at any level is potentially harmful. Historically, 
ALARA was initiated as a cautious approach for dealing with uncertain hazards but has since become the 
principle method for reducing the risk of injury from hazards that do not have safe minimum threshold. 

While no minimum thresholds for harmful bioeffects have been established with the use of diagnostic 
ultrasound, the principle of ALARA can be readily implemented on equipment incorporating an output 
display. As the operator adjusts the equipment to optimize the image quality, the display interactively 
updates to indicate the effect on output. 

Controls that have no noticeable impact on image quality should be set to minimize the output while 
controls that improve the image quality and also increase acoustic output should be set no higher than 
needed to achieve a diagnostic quality image. 
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Introduction 

System Specifications 

The X-CUBE 60 ultrasound system provides excellent quality and reliability as well as these specific 
features: 

 
Table 3-1 System specifications 

 

 
 

Physical Dimensions 

• Height: 1310/1670 mm 

• Width: 560 mm 

• Depth: 780 mm 

• Weight: 70 kg (not including options) 

 
 
 
 
 

 
Clinical Applications 

• Abdomen 

• Obstetrics(OB) 

• Gynecology(GYN) 

• Cardiology 

• Small Parts 

• Musculoskeletal(MSK) 

• Vascular 

• Urology 

• Emergency Medicine(EM) 

• TCD 

• Breast 

• Appendix 

 
 
 
 
 
 
 

Available Imaging Modes 

• 2D mode 

• Harmonic mode (HAR) 

• M mode 

• Color M mode 

• Anatomical M mode (AMM) 

• Color Flow Doppler (CF) mode 

• Power Doppler (PD) mode 

• Directional PD mode 

• Pulsed Wave Doppler (PWD) mode 

• Continuous Wave Doppler (CWD) mode 

• High PRF Doppler mode 

• Tissue Doppler Imaging (TDI) mode 

• 3D/4D mode 

 
 
 
 

 
Image Processing Technology 

• Xpeed™ 

• Full SRI™ 

• Spatial Compounding Image (SCI) 

• Panoramic 

• Live HQ™ 

• Needle Vision™ Plus 

• Contrast Enhanced Ultrasound (CEUS) 

• ECG 

• Elastography 

• X+ MicroView 



 

 

  
 

 
 

Image Processing Technology (cont.) 

• Filter Method Tissue Harmonic Image (FTHI) 

• Pulse Inversion Tissue Harmonic Image (PTHI) 

• Raw Data Processing 

• Post Processing 

 
 
 
 
 
 
 
 

Operable Transducers 

 
Pencil Doppler 

• CW2.0 

• CW5.0 

• CW8.0 

 

 
Linear Array 

• L3-8H 

• L3-12X 

• L3-15H 

• SL3-19X 

• L10-25H 

Sector Phased Array • P1-5CT 

Convex Array 
• SC1-7H 

• SC2-11H 

Endocavity 
• EV2-11H 

• EC2-11H 

Volume Convex • SVC1-8H 

Volume Endocavity • VE3-10H 

 
 
 
 
 

 
Measurement Package 

Including reports for: 

• Abdomen 

• Obstetrics(OB) 

• Gynecology(GYN) 

• Cardiology 

• Vascular 

• Urology 

• Pediatrics 

• Small Parts 

• Breast 

• Musculoskeletal(MSK) 

• Emergency Medicine(EM) 
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Basic Measurements 

 
 
 

2D Mode 

• Distance, Ellipse, Trace 

• Area, Circumference 

• %Stenosis 

• Volume 

• Angle 

• A/B Ratio 

• Volume Flow Area 

 
 
 

M Mode 

• A/B Ratio 

• Distance 

• Time 

• Slope 

• %Stenosis 

• HR 

 
 
 

 
Doppler Mode 

• Velocity 

• Time 

• PI 

• Trace 

• Acceleration 

• S/D Ratio 

• RI 

• Auto Trace 

 
 
 
 
 
 
 

Connectivity 

• Verification 

• DICOM Storage 

• DICOM Print 

• DICOM Storage commitment 

• DICOM Media 

• DICOM Worklist 

• DICOM MPPS 

• DICOM Q&R 

• DICOM Structured Report (OB-GYN) 

• DICOM Structured Report (Echocardiography) 

• DICOM Structured Report (Vascular) 

• Cube View™ 

• Network Storage 

• Wireless LAN (Option) 

 
 
 

 
User Interface 

• English 

• German 

• French 

• Spanish 

• Italian 

• Russian 

• Portuguese 

• Chinese 

 

NOTE 

Not all features, transducers, optional supplies or peripherals described in this document may be available or 
cleared for sale in all markets. Please contact your local agent or local Alpinion sales representative to get the 
latest information. 
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Console Overview 
This system consists of monitor, control panel, console, peripheral devices and transducers. 

 
 

Front View 
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4 3 
5 7 
6 8 

9 
 
 

10 
11 

 
 

12 
 
 
 
 

 
Figure 3-1 Front View 

 

No. Component No. Component 

1 Monitor 7 Transducer cable hook 

2 Touch screen 8 Front handle 

3 Gel warmer 9 Control panel up/down button 

4 Transducer holder 10 CW port 

5 Control panel 11 ECG port 

6 Control panel swivel button 12 Transducer port 
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Rear View 
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Figure 3-2 Rear View 

 

No. Component No. Component 

1 Transducer holder 5 AC outlet 

2 Speaker 6 System On/Off switch 

3 Power cord wrap hook 7 AC inlet 

4 I/O panel 
  

 
NOTE 

When connecting an external monitor to your system, use the monitor with 1366 x 768 or higher resolution. 
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Side View 
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Figure 3-3 Side View 

 

No. Component No. Component 

1 Monitor arm 5 Body base 

2 Rear handle 6 Caster lock 

3 Body cover 7 Caster 

4 Side tray 
  

 
 
 

Peripheral area 

In the middle of the system, you can place optional peripherals such as black and white printer and color 
printer. 

 
CAUTION 
The peripheral area is only for peripheral devices. Do not place transducers or the footswitch in the 
peripheral area to prevent damaging them from accidentally falling off. 
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Monitor and Touch Screen 
 
 
 
 
 
 
 

 

1 

2 

3 
 

 

4 
 
 

Figure 3-4 Monitor Buttons 

 

No. Component No. Component 

1 Up ( ) button 3 Down ( ) button 

2 Mode/Select ( ) button 4 Touch screen Brightness buttons 

 

 
CAUTION 
The LED lamp may overheat. Be careful not to directly touch it to avoid injury. 
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I/O Panel 

I/O panel located on the rear side of a system includes video input and output, audio input and output, 
Ethernet, power and control connections for a printer. See Figure 3-5 below for more details. 

 
CAUTION 
• Each outer (case) ground line of peripheral/accessory connectors are earth grounded. Signal ground lines 

are not isolated. 

• For compatibility reasons, use only ALPINION approved transducers, peripherals or accessories. 

• Be sure to plug the power supply cable of the peripherals to the connector panel of the system to avoid 
unexpected electrical shock. 

• Do not connect any transducer or accessories without approval from ALPINION. 
 

1 2 3 4 5 6 7 8 
 
 
 
 

 

Figure 3-5 I/O Panel 

 

No. Component No. Component 

1 USB port (4 ports) 5 Audio out port (Right) 

2 HDMI port 6 Video input port 

3 Ethernet port 7 S-Video output port 

4 Audio out port (Left) 8 VGA port 

 

 
CAUTION 
• The connection of equipment or transmission network other than as specified in these instructions can 

result in electric shock hazard. 

• Connected peripherals must meet IEC standard (An equipment that processes data: IEC 60950/EN 60950, 
a medical equipment: IEC 60601-1/EN 60601-1). For product configuration, it must meet the safety 

requirements of product standard IEC/EN 60601-1 or system standard IEC 60601-1-1/EN 60601-1-1. 

• The operator shall not contact the parts (SIP/SOP) and the patient simultaneously. 

• When connecting a cable to the ethernet (LAN) port, always use the optional LAN isolator (EN-20G by 
EMO system or any similar isolator complying with IEC/EN 60601-1) to protect your system from electrical 
damage. 

 
 

NOTE 
If power consumption of the external storage media such as USB HDD exceeds 1A, you should use a Y-cable 
that makes the external storage media receive power from two USB ports at the same time. 

 
 

NOTE 
USB 3.0 devices that are not compatible with Windows 10 OS may not be recognized and operated when 

connected to the USB 3.0 port on the control panel or at the rear of the system. Connect the device to the 

USB 2.0 port located at the rear of the system or contact the manufacturer of the USB 3.0 device. 
 
 

NOTE 
You should connect DVD-RW to the X-CUBE 60 via the USB 3.0 port located at the rear of the system or on the 
control panel. 
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Footswitch (Option) 

The optional tri-pedal footswitch that is connected with the rear panel of your system performs specific 
functions easily instead of pressing function keys on the control panel. 

The each pedal of the footswitch may have different functions depending on the assigned settings such 
as Freeze, P1, P2, P3, P4 and Rec/Pause. 

You can configure its functionality via Utility > Setup > SystemPreset > User Setting > Print/Foot Switch. 
 

 

 
 
 
 
 

Wireless LAN (Option) 

Figure 3-6 Tri-pedal Footswitch 

 

A Wireless Network is available on the X-CUBE 60. When the WLAN is active, the status bar displays an 
icon appears in the status bar to indicate whether the WLAN is installed or disconnected. 

For adjusting a wireless LAN connection, see "Network" on page 5-42. 

Using unrecommended wireless LAN adapter may cause system malfunction. To prevent system 
malfunction, only use wireless LAN adapters approved or recommended by ALPINION. 

 

NOTE 

Please contact your local agent to get the latest information on compatible wireless LAN adapters. 

CAUTION 
Do not place or store the footswitch in the peripheral area on the system to prevent damaging the footswitch 
from accidently falling off. 
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Battery (Option) 

This system uses lithium ion batteries. The lithium ion battery provides power if AC power is not available 
or the power cable is unplugged. 

The system battery is a purchasable option. If this option is not purchased, the battery icon is not 
displayed. 

 
CAUTION 
The battery is used to ensure quick system startup and easy movement of the system only. You cannot 

perform scans while in Battery Power mode. For more information on Battery Powr mode, please refer to 
"Battery Power Mode" on page 4-7. 

 
 

NOTE 

• The battery is designed to work with X-CUBE 60 systems only. Use only the batteries authorized by 

Alpinion Medical Systems. 

• The battery may need to be replaced. Only ALPINION MEDICAL service personnel have access to the 
embedded battery. Please contact your local service representatives for replacement. 
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System Options 
In addition to the standard features available on your system, other features are available as purchasable 
options. Available option types include imaging features, advanced quantification software, protocols, 
and connectivity features. 

 

NOTE 

Some options may not be available in certain countries. 

 
 

Optional Function 

• CV M&R • Stress Echo • STIC 

• DICOM 3.0 Connectivity • Cube Strain™ • CEUS 

• DICOM SR (OB) • Live HQ™ • Silhouette View 

• DICOM SR (Adult Echo) • Elastography • STL 3D Printing 

• DICOM SR (Vascular) • Cube View™ • X+ MicroView 

• DICOM Query • Needle Vision™ Plus • X+ Assistant 

• Auto IMT • Auto NT • X+ Auto Biometry 

• CW • X+ 3D4D • X+ Auto Follicle 

• Anatomical-M • X+ Volume Advance • X+ Auto IVC 

• Panoramic • Cube Note • TI-RADS 

• Tissue Doppler Image • AutoEF • BI-RADS 

 

For further information about options, please refer to the relevant chapters in this manual. 
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Peripheral Devices 
Before using the peripherals or accessories, you should consider the following requirements. 

 
WARNING 
Observe all warnings and cautions given in the operation manual of peripheral device. 

 
CAUTION 
For compatibility reasons, use only ALPINION approved peripherals or accessories. DO NOT connect any 
peripherals or accessories without approval by ALPINION. 

 
 

Peripheral Update for EU Countries 

The following is intended to provide the users in EU countries with updated information concerning the 
connection of the X-CUBE 60 to image recording and other devices or communication networks. 

The X-CUBE 60 has been verified for overall safety, compatibility and compliance with the following on- 
board image recording devices: 

• Color Printer 
Manufacturer: Sony Corporation 
Model: UP-D25MD, UP-25MD 

• B/W Printer 
Manufacturer: Sony Corporation 

Model: UP-D898MD, UP-X898MD 

• B/W Printer 
Manufacturer: Mitsubish Electric Corporation 
Model: P95DW-N 

• DVD-RW 
Manufacturer: Hitachi-LG Data Storage, Inc. 
Model: GP65NB60 

 
The X-CUBE 60 has also been verified for compatibility, and compliance for connection to a local area 
network (LAN) via the rear panel Ethernet connection, provided the LAN components are IEC/EN 60950 
compliant. 

The X-CUBE 60 may also be used safely while connected to devices other than those recommended 
above if the devices and their specifications, installation, and interconnection with the system conform 
to the requirements of IEC/EN 60601-1-1. 
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Accessories 
The following accessories are not included in the CE certification. 

Before using the accessories, you should consider the following requirements. 

 
CAUTION 
For compatibility reasons, use only ALPINION approved accessories. DO NOT connect any accessories without 
approval by ALPINION. 

 
 

Basic Accessories 

The X-CUBE 60 has the following basic accessories: 
 

• X-CUBE 60 console • User Manual, Reference Manual (Soft copy) 

• Sonic gel • Quick Guide (Soft copy) 

 
 

Optional Supplies and Accessories 

The following tables show optional supplies and accessories that have been verified to be compatible 
with the system. 

 

NOTE 

The user manual refers to optional supplies and accessories that can be compatible with the system. It might 
be possible that some optional supplies or accessories are NOT available in certain countries. 

 
 

Biopsy Kit 

• L3-12 Biopsy Starter Kit (for L3-8H, L3-15H) 

• L3-12X Biopsy Starter Kit (for L3-12X, SL3-19X) 

• SC1-6 Biopsy Starter Kit (for SC1-7H) 

• EV2-11H Reusable Starter Kit (for EV2-11H, EC2-11H) 

• VE3-10H Disposable Starter Kit (for VE3-10H) 

• VE3-10H Reusable Starter Kit (for VE3-10H) 

 

Console Accessory 

• Tri-pedal footswitch 

• ECG Cable 

• Side tray 

• Endocavity transducer holder 
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Image Display 
The image display consists of an ultrasound image, application information, patient information, and 
indicators. 

 

Figure 3-7 Image Display 

 

 
1 

Hospital logo & name 12 Image area 

Current date & time 13 Image parameter 

2 Patient ID, Patient name 14 Clipboard indicator 

3 Operator ID, Transducer name 15 Image clipboard 

4 Mechanical index, Thermal index 16 System message area 

5 Zoom reference window 17 Trackball controls and status 

6 Labeled measurement menu  
18 

Clipboard icons: Thumbnail Preview, Trash 
can, Single & Dual layout format, Scroll Up/ 

Down/Home/End 7 Report 

8 Gray/Color scale bar  
 

 
19 

 
Status bar: Symbol lock, Caps lock, USB 
connection, Network connection, Wireless 

network connection, User defined key, Data 
backup status, Cube View connection, DVR 

status, Windows Defender, Battery status 

9 Focal zone marker 

10 Depth scale marker 

11 Transducer orientation marker 

    14 

11 

  13 

 
12 15 

 
10 

 

17 18 
19 16 
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Screen Saver 

Screen saver mode automatically activates to save the system power when you do not operate the 
system and the system stays in idle for a specified time. To deactivate this mode and return to normal 
operating mode, press any key on the control panel. 

 

NOTE 

To configure the screen saver settings, go to Utility > Setup > SystemPreset > System > General > Monitor. 
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Control Panel 
 
 

 

 

 

Figure 3-8 Control Panel Layout 

 

1 Power On/Off control 3 Soft keys 

2 USB port 4 Trackball 
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Table 3-3 Key description 
 

Control Control Name Description 

 

 

 

User-Defined Keys 
(U1–U4) 

 
Access user-defined functions. 

The function for each key can be assigned in Utility > Setup > 

SystemPreset > User Setting > User Defined Key. 

 

 

 
M 

 
Activate M mode. 

 

 

 
PW 

 
Activate PW mode. 

 

 

 
CF 

 
Activate CF mode. 

 

 

 
2D 

 
Activate 2D mode. 

 

 

 

CW 
Activate Continuous Wave (CW) Doppler mode. This control is 
optional. 

 

 

 

3D4D 
 

Activate 3D or 4D mode. 

 

 

 
Select 

 
Select the desired function from the context menu on the screen. 

 

 

 

 
 

 
Angle 

Adjust the angle. 

• In 2D or Color mode, rotate to adjust the angle steer. 

• In CW or PW mode, rotate to adjust the Doppler angle correct. 

• In Body Pattern mode, rotate to adjust the transducer angle. 

• In Arrow mode, rotate to adjust the arrow angle. 

• In CW or PW mode, press to adjust the auto angle. 
 

 

 

Clear 
Delete the arrow, annotation, body patterns and measurement 

results displayed on an image. 

 

 

 
Depth 

 
Adjust the scanning depth of an image. 

 

 

 
Focus 

 
Change location and number of focus on the area of interest. 

 

 

 
Zoom 

Turn the Zoom mode on. 

• Rotate to activate Read zoom. 

• Press to activate Write zoom in Read zoom mode. 
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Control Control Name Description 

 

 

  

 
 
 

Set/Cur 

Set or Cursor function may be assigned to these keys. The 
function for each key can be assigned in Utility > Setup > 

SystemPreset > System > Control Panel > Key > Set the Cursor 
and Set keys. 

• Set: Select an item or value using the trackball. 

• Cursor: Display the cursor on the screen. 
 

 

 
Body Pattern 

Activate the annotation function in order to add body patterns to 

an image. 

 

 

 
Text 

Activate the annotation function in order to type text on an 

image. 

 

 

 
Caliper 

Start basic measurements such as distance, circumference, area, 
and volume. 

 

 

 
Measure 

 
Start measurements by application. 

 

 

 

 

 
Priority 

Adjust the priority of Trackball. 

• In 2D mode, press to select the priority between the width 
and tilt functions. 

• In Duplex or Triplex mode, press to select the priority between 

ROIs of the activated imaging modes. 
 

 Single, Dual, Quad View an image in dual or quad screen. 

 

 

 
P1, P2, P3, P4 

Control the designated recording device or perform alternative 
storage. To configure these keys, go to Utility > Setup > 

SystemPreset > User Setting > Print/Foot Switch. 
 

 

 

Freeze 

 

Pause and resume scanning. 

 
 
 

 

 

 
 
 

 
User-Defined Key 
(U5) 

You can use this control as an user-defined hard key. The function 
for the key can be assigned in Utility > SystemPreset > Setup > 
User Setting > User Defined Key. 

 

   TIPS 
• Exit: Exit current screen (mode) and return to the 

previous screen (mode). 

• End Exam: End the current study and store patient and 
measurement data and clear all temporary data. 
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QWERTY Keyboard (Option) 
The QWERTY keyboard is available which you can enter text or perform special functions. 

 

Figure 3-9 Keyboard Layout 
 

 

Using the Special Keys 
 

Table 3-4 Special key description 
 

Control Control Name Description 
 

 

 

Quick ID 
 

Access the Quick ID screen. 

 

 

 

Patient Browser 
 

Access the E-View screen. 

 

 

 

Image Preset 
 

Access the Image Preset screen. 

 

 

 

System Preset 
 

Access the System Preset screen. 

 

 

 

DICOM Spooler 
 

Access the DICOM Spooler. 

 

 

 

Symbol Lock 
 

Lock all keyboard symbol keys. 

 

 

 

New Preset 
 

Create your own user preset. 

 

 

 

DVR 
 

Access the DVR menu. 

 

 

 

Eject 
 

Eject a media. 

 

 

 

Initial 
 

Restore the default settings of the current function. 

 

 

 

Help 
 

Access the electronic manual. 



 

 

 

Control Control Name Description 
 

 

 

Biopsy 
 

Show the biopsy guideline. 

 

  

 

Speaker Volume 
 

Turn up/down the speaker volume. 

 

 

 

Reverse 
 

Flip the image 180 degrees left/right. 

 

 

 

Clear All 
 

Clear your input or cancel your selection. 

 

 

 

Hide 
 

Hide the current menu screen. 

 

 

 

Xpeed 
Activate Xpeed to automatically optimize image parameters on 

the live screen. 
 

 

 

Arrow 
 

Show the arrow pointer on the screen. 
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Touch Screen 
Your ultrasound system has the touch screen that enables you to easily access menus or adjust options 
on the current monitor display. 

The exam function controls are accessed from a Shortcut bar at the top of the touch screen. 

The scanning mode controls are organized in tab pages. For each tab, two pages may be accessed by 
swiping laterally anywhere on the touch screen. 

At the bottom of the touch screen, there are six rotary/push buttons. The functionality of these buttons 
changes based on the active mode/function. 

 
 
 

A 
 
 
 

 
B 

 
 
 
 
 
 
 
 

 

D 
 
 
 
 

Figure 3-10 Touch Screen 

 
Table 3-5 Touch screen description 

 

No Control Description 

 

A 
 

Workflow Area 
Contain tools that enable the major workflow activities for starting, performing, 

and completing an exam. 

1 Shortcut Bar Quick access to different functions on the system. 

B Tabs Contain mode-specific or application-specific controls in different tabs. 

2 Scanning Modes Tab Select the tab to activate scanning mode. 

 

C 
 

Controls 
The main area of the touch screen, which shows the controls for the currently 

selected tab in the current mode or application. 

3 Touch Menus Touch buttons with mode/function specific controls. 
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No Control Description 

 

4 
 

Page Indicator 
Switch to the previous/next page of the touch menu screen. To move to the 

previous/next page, touch the "dot"or swipe from right to left/left to right. 

5 Power Preset 1-5 Show up to five (5) Preset buttons configured at System Preset. 

 
 

D 

 
 

Soft Key Labels 

Display the labels for the current functions of the soft keys. Some modes and 
applications have two rows of labels, while some have no soft keys. 

You can select the functions assigned to the soft keys by touching the labels or 
by pressing or rotating the knob below the label. 

 
6 

 
Soft Menus 

Rotary/Push buttons with mode/function specific controls. 

• Press the button to switch between controls. 

• Rotate the dial to adjust the value. 

7 TGC TGC slide controls 

8 Virtual Keyboard Display Virtual keyboard 

 
 
 

Shortcut Bar 

The Shortcut bar gives quick access to different functions on the system. The default functions available 
on the Shortcut bar depend on the examination category selected. Additional functions are available by 
touching Utility. 

 

Figure 3-11 Shortcut Bar_Utility 
 

Table 3-6 Exam functions on the Shortcut bar 
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Function Description 

Patient Access the Patient screen. 

Transducer Select the desired transducer, application, and preset. 

Scan Enter scanning mode screen. 

E-View Access the E-View screen. 

Report Access the Report screen. 

X+ Compare View dual image of a selected exam image and a live scan image. 

X+ Assistant Access the X+ Assistant Manager page. 

 
 
 
 
 
 
 

Utility 

Access the Utility menus. 

• Hide Patient Info.: Remove patient information from the scan screen. 

• Show Parameter: Display the parameter in the scan screen. 

• Hide Parameter: Remove the parameter from the scan screen. 

• Active Parameter: In multi-layout image mode, display the parameter for the 
active image. 

• Setup: Activate system configuration menus. You can change the various settings 

of the system. 

• Eject: Eject a media. 

• DICOM Spooler: Access the DICOM Spooler. 

• DVR: Access the DVR menu. It contains the controls to operate the DVD recorder. 

• Help: Access the electronic manual. 

• NewPreset: Display the New Preset menu to add new preset. 

• Virtual Keyboard: Display Virtual keyboard 

End Exam End an examination. The system is ready for the next patient. 

 
 
 

Tab Pages 

The scanning mode controls are organized in Tab pages. The active mode can be changed by touching the 
corresponding tab. 

There are different types of control buttons. 
 

Control Button Description 

 

 

 
Press the button: Toggle the control between on and off states. 

Tap the control button to activate or deactivate the control. 

• Light blue = Activated 

• Gray = Deactivated 

 

 

 

Variable button: Control with variable adjustment. 

Tap  or  of the control button to adjust the parameter. 
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Soft Keys 

There are six rotary/push buttons at the bottom of the touch screen. The functionality of these keys 
changes, based on the active mode and function. 

 

 

 

Figure 3-12 The Rotary/Push Buttons 
 

The soft keys are used to select or adjust the functions in the soft menu. 
 

Control Button Description 

 

 

 

Press the soft key to select the function. 

• Light gray = Activated 

• Dark gray = Deactivated 

 

 

Press right or left side of the button or rotate the soft key clockwise or counter- 

clockwise to adjust the parameter. 

 
 

Virtual Keyboard 

The virtual keyboard is an alphanumeric keyboard supprted on touch screen for entering and editing 
information on the patient registration, report, or image. 

 

 

Figure 3-13 Virtual Keyboard 

Grab/Delete Font Size 

Index 10 
Home  

ON 

 
OFF 

Library 

Abdomen 

Application 

Abdomen 
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Transducers 
The X-CUBE 60 ultrasound system provides various types of transducers. Most of them have a state of 
art in transducer technology: single crystal transducers, composite transducers, and extreme fine pitch 
transducer, and real-time mechanical 4D transducers 

 
 

Moving and Storing Transducers 

Transducers should be placed inside their holders for moving short distances. For shipping or moving 
considerably a long distance, storing transducers in their carrying cases are strongly recommended. 
Storing them in carrying cases is not only to protect the transducers from physical damage such as 
shock or vibration, but also it will protect them from environmental damages such as humidity and 
temperature. 

 

NOTE 

For more information about transducer, see "Transducer" on page 12-2. 



 

 

 

 

4 
Getting Started 

 
 
 

 

This chapter introduces the followings: 
 
 

Operating Requirements ................................................................................. 4-2 

Powering the System ....................................................................................... 4-4 

Moving and Transporting the System ............................................................. 4-9 

Adjusting the Control Panel ........................................................................... 4-12 

Adjusting the Monitor and Touch Screen ...................................................... 4-13 

Connecting/Disconnecting the Transducer ................................................... 4-16 

Activating/Deactivating the Transducer ........................................................ 4-18 

Starting an Exam ............................................................................................ 4-19 

Retrieving and Editing Archived Information ................................................ 4-28 



 

 4-2 Getting Started 
 

Operating Requirements 
The ultrasound system must operate in the appropriate environment according to the requirements 
described in this section. Make sure that the requirements have been met before using the system. 

 
 

WARNING 
All the warnings and cautions in the "2. Safety" should be read and understood before operating the system. 

 
CAUTION 
Do not install the system by yourself. Only ALPINION MEDICAL SYSTEMS service engineer should install the 
system. 

 
NOTE 

Only qualified sonographers or physicians should perform scanning with the system. 
 
 
 

Electrical Requirements 

You should use a system with the specified power outlet as follows: 

• 100–120 VAC, 600 VA, 50–60 Hz 

• 200–240 VAC, 600 VA, 50–60 Hz 

 
WARNING 
Operating the system with the wrong voltage range causes damages on the system, voiding the factory 
warranty. 

 

 

Operating Environment 

You should use this system in proper environment to prevent it from radio wave interference, dust and 
gas. 

Make sure the area, which your system is installed, is well-ventilated, with a temperature, humidity, and 
pressure requirements. If the system is exposed to inappropriate temperature, humidity, or pressure, 
adapt your system to normal range of environment for a few hours. 

 
 

WARNING 
Operating the system within the inappropriate environment might cause unexpected problems. 
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Environmental Requirements 

The ultrasound system requires constant maintenance of its operational environment. Different 
temperature and humidity requirements are specified for operation, storage and transportation. 

 
Table 4-1 Environmental requirements 

 

 Temperature Humidity Pressure 

Operation 10 – 35 °C 30 – 75 % 700 – 1060 hPa 

Storage -25 – 60 °C 20 – 90 % 700 – 1060 hPa 

Transportation -25 – 60 °C 20 – 90 % 700 – 1060 hPa 

 
 

CAUTION 
Before powering the system on, make sure that the system meets the operational conditions in temperature 
and humidity. 

 

 
Electromagnetic Interferences 

The ultrasound system is approved for use in hospitals, clinics and other environmentally qualified 
facilities, in terms of the prevention of radio wave interference. The use of this system in an 
inappropriate environment may cause electromagnetic interference to radios and TVs around the 
medical equipment. 

Take precautions to ensure that the system is protected from electromagnetic interference. 

• Operate the system at least 4.5 meters (15 feet) away from the equipment that emits strong 
electromagnetic radiation. 

• Special shielding may be required if the system is to be operated in the vicinity of radio broadcast 
equipment. 
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Powering the System 

Connecting the System to the Electrical Outlet 
 

WARNING 
• To avoid circuit overload and possible loss of critical care equipment, make sure you do not have other 

equipment operating on the same circuit. 
• The system’s power must be supplied from a separate, properly rated outlet to avoid risk of fire. 

1 Ensure that the wall outlet is of the appropriate type. 

2 If necessary, push the System On/Off switch to turn off the system power on the bottom rear of the 
system. 

3 Unwrap the power cable. 

4 Attach the power plug to the system and secure it in place. 

5 Push the power plug securely into the wall outlet. 
 

NOTE 

• Do not use an extension cord or adapter plug. 

• Ensure easy access to the wall outlet to disconnect the power plug in case an emergency should 
occur. 

6 Push the System On/Off switch to turn on the system power on the bottom rear of the system. 

 
Power On 

To power on the system, 

1 Make sure that the power cord is plugged into the power outlet. 
 

CAUTION 
Make sure that the system power is supplied from a separate and properly rated power outlet. 

2 Push the System On/Off switch to turn on the system power on the bottom rear of the system. 

3 Press the [Power On/Off] key on the control panel. 

4 The system boots up and the progress bar appears on the monitor. 

5 After initialization is completed, the scan screen appears. 

6 If the access control has been set by the system administrator, the System Log In window appears. 

7 Enter the operator's ID and password, and then click OK. 
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Power Up Sequence 

The System is initialized. During this time, the system boots up and the status is reflected on the monitor. 

After initialization is completed, the backlights of all controls on the control panel turn on and the default 
2D mode screen is displayed on the monitor. 

 

NOTE 

If no transducer is connected, the system goes into freeze mode. 
 
 

Figure 4-1 X-CUBE 60 Welcome Screen 
 
 

WARNING 
• When abnormal system shutdown occurs, the system requires at least 20 minutes to reboot due to 

overload protection mode activation. 

An abnormal system shutdown includes loss of power, forced shutdown and battery discharge during sleep 
mode. 

• If the system does not boot up, please unplug the power cord or push the System On/Off switch to turn 
off the system power on the bottom rear of the system. Keep the system for 20 minutes. Then, plug the  
power cord or push the System On/Off switch to turn on the system power and press the [Power On/Off] 
key on the control panel. The system boots up and the progress bar appears on the monitor. 
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System Protection 

If the system access control has been set by the administrator, you can access the patient data in the 
system only after you log on the system. 

 

NOTE 

To set the system to log on automatically, go to Utility > Setup > SystemPreset > Administration > Users and 
select the System Auto Login check box. 

 

Figure 4-2 System Log In Window 
 
 

 

Sleep Mode 

You can use Sleep mode when not in use. Sleep mode allows quick startup of the system. If the optional 
battery is installed on the system, the system can be moved between exam locations in Sleep mode. 

 
WARNING 
Sleep mode is not intended to replace the shutdown process. The system should be fully shutdown every day. 

 

To put the system in Sleep mode, 

– Press the [Power On/Off] key on the control panel and press Sleep. 

 
To awaken the system, 

– Press the [Power On/Off] key on the control panel. 
The system returns to full functionality. 

 

NOTE 

When moving the system in Sleep mode, make sure the power cable is connected to the AC power source 

before exiting from Sleep mode. 
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Battery Power Mode 

When AC power is lost or the power cable is unplugged, the system power is maintained by the battery. 

While in Battery Power mode, the system cannot scan or perform post-processing, but can quickly start 
up once the AC power is re-established. 

 
 
 

When in Battery Power mode 

In Battery Power mode, the system monitor, touch screen, and control panel are turned off immediately 
to minimize battery usage. 

 

NOTE 

To shut down the system while in Battery Power mode, plug in the power cable, exit from Battery Power 

mode, and then perform regular shut down operations. 

 

 

Recovering from Battery Power mode 

The system recovers from Battery Power mode when you plug the power cable to the wall outlet and 
press the [Power On/Off] key on the control panel. The system returns to full functionality. 

 

NOTE 

When recovering from Battery Power mode, the default application of the current transducer is activated. 
 

 

Viewing the current battery status 

There is a battery icon on the status bar. With the battery icon, you can easily check the battery’s current 
capacity. 

 
Table 3-2 Battery status icon 

 

Icon Status Note 
 

 Battery is fully charged (95 – 100 %) and charging 
 
 
 
 

AC power cable is plugged. 

 

 Battery is partially charged (40 – 94 %) and charging 

 

 Battery is partially charged (20 – 39 %) and charging 

 

 Battery is partially charged (1 – 19 %) and charging 

 

 Battery level (0 %) and charging 

 

 
Charging battery 

The battery is charged automatically when the system is connected to the wall outlet via the power cable 
and System On/Off switch is in the on position whether the system is turned on or off. 
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Power Off 
 

CAUTION 
Do not unplug the power cord during the system operation. Do not push the System On/Off switch before 
pressing the [Power On/Off] key. This may lead to data loss or system software damage. 

 
NOTE 

Depending on the power-off setting, you can activate Sleep mode or turn the system off immediately. The 
power-off setting can be configured in Utility > Setup > SystemPreset > System > General > Power Off. 

 

To power off the system, 

1 Press the [Power On/Off] key on the control panel. 

2 When the Power off dialog box appears, click Shutdown by using [Trackball]. 
 

NOTE 

If the system has not fully shut down in 60 seconds, press and hold down the [Power On/Off] key until 
the system shuts down. 
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Moving and Transporting the System 

Preparing the System to be Moved 
 

CAUTION 
• For your safety, you must follow the precautions carefully before moving or transporting the system. 
• Before moving the system, make sure that the peripherals in the storage area are installed securely. 

Before you move the system, use the following steps. 

1 Power off the system using the [Power On/Off] key on the control panel. 

2 Unplug the power cord from the power outlet. 

3 Disconnect all peripheral devices (e.g. printers or DVD) and the footswitch from the system. 

4 Loosely wind the power cable around the cable hook below the rear handle. 
 

CAUTION 
• To prevent damage to the power cord, DO NOT pull excessively on the cord or make sharp bends 

while wrapping. 

• Never allow the power cord to drag on the floor. 
• Never roll over the power cord with the wheels. 

5 Store all transducers or accessories in the proper spaces carefully. 
 

CAUTION 
DO NOT place transducers into the side tray when moving the system. This is not a storage space for 
transducers. 

6 Adjust the monitor and control panel to their lowest positions by using the Up/Down button. 
 

CAUTION 
To avoid injury or damage, make sure nothing is within the range of motion before adjusting the height. 
This includes both objects and people. 

7 Push the Swivel button and adjust the location of the control panel. 

8 Flip down the monitor. 

9 Lock the monitor arm firmly in place. 

10 Ensure that no loose items are left on the console and unlock the wheels. 
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Moving the System Safely 
 

CAUTION 
• For your safety, follow the precautions carefully when moving the system. 

• Do not attempt to move the system using cables or transducer connectors. 
• When you move the system with another person, take extra precaution not to injure feet. 

When moving the system, use the following procedure. 

1 Ensure that the control panel and monitor are in locked position. 
 

CAUTION 
Do not move the system if the control panel and monitor are in free position. 

2 Grasp the front or rear handle grip and push and pull. 

3 Take extra care when moving the system for long distances and on inclines. 
Ask for help, if necessary. 

4 Take extra care to move the system when crossing door or elevator thresholds. 

5 When you reach the destination, lock the front and rear casters. 

 
 

Transporting the System 

When transporting the system with vehicles, use the following procedure. 

1 Only use vehicles that are capable of transporting your X-CUBE 60 system. 

2 Load and unload the system to a vehicle parked on a level surface. 

3 Ensure that the transporting vehicle can handle the weight of the system plus the passengers. 

4 Ensure that the load capacity of the lift is capable of handling the weight of the system. 

5 Ensure that the lift is in good working order. 

6 Secure the system while it is on the lift so that it cannot roll. Use wood chocks, restraining straps, or 
other similar types of constraints. Do not attempt to hold it in place by hand. 

7 Employ two to three persons to load and unload safely from a vehicle. 

8 Load the system aboard the vehicle carefully and keep its center of gravity. Keep the system still and 
upright. (Do not lay the system down on its side.) 

9 Ensure that the system is firmly secured while inside the vehicle. Any movement, coupled with the 
weight of the system, could cause it to break loose. 

10 Secure the system with straps or as directed otherwise to prevent motion during the transport. 

11 Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds, and erratic 
stops or starts. 
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Wheels 

The wheels of the system are controlled by the pedals. Each wheel has an independent brake pedal. 

 
WARNING 
When two or more people are releasing the wheels, take extra precaution to prevent unexpected movement 
which could result in possible toe injuries. 

 
CAUTION 
• Examine the wheels frequently for any obvious defects that could cause them to break. 

• Never move the system with locked wheels. 

• If you temporarily left the system on a slope, you must use the brakes on the wheel. Do not leave the 
product on a slope. 

 

Pedal Position Function 

Front Swivel & Brake Lock 

Rear Swivel Lock 

 
 

Reinstalling the System at a New Location 

1 When the system is in place at a new location, lock the wheel brakes. 

2 Connect the system to the electrical outlet. 
 
 

NOTE 

If any damage is found or the system does not work properly after you move it, contact your ALPINION 
MEDICAL service engineer or an authorized agent. 
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Adjusting the Control Panel 
 
 
 
 
 
 
 
 
 
 

1 2 

 
Figure 4-2 Swivel and Up/Down Buttons 

 

No. Component No. Component 

1 Swivel button 2 Up/Down button 

 
 

Adjusting the Height of the Control Panel 

To raise/lower the control panel, 

1 Hold the front handle in two hands. 

2 Push and hold down the Up/Down button. 

3 Raise or lower the control panel. 

4 Release the Up/Down button at the desired height. 

 
 

Adjusting the Location of the Control Panel 

To swivel the control panel, 

1 Hold the front handle in two hands. 

2 Push and hold down the Swivel button. 

3 Move the control panel to the left or the right. 

4 Release the Swivel button at the desired position. 
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Adjusting the Monitor and Touch Screen 

Adjust the Monitor Position 

The position of monitor can be easily adjusted to fit your viewing by help of the monitor arm. When 
adjusting the position of the monitor and monitor arm, be sure to hold the monitor frame with both 
hands. 

 
To position the monitor, 

1 Turn the release knob clockwise to unlock the monitor. 

2 Grasp the monitor firmly with both hands and do one of the followings: 

– Tilt the monitor forward or backward 

– Swivel the monitor left and right 

– Pan the monitor forward or backward 
 
 

Default posture 
 

   
Folded 

 
 
 
 
 
 
 
 

Tilt forward 

Move up (Height adjust) 
 
 
 
 
 
 
 
 
 

Figure 4-3 Adjusting the Monitor Position 

Tilt backward 
 

 
Panning 
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Locking/Unlocking the Monitor 

To lock/unlock the monitor arm, 

1 If necessary, flip down the monitor. 

2 Turn the release knob clockwise to unlock the monitor. The monitor can be moved freely in all 
directions. 

3 Turn the release knob counter-clockwise to raise the lock and move the monitor into the parked 
position. 

 

Unlock Lock 

Figure 4-4 Locking the Monitor Arm 
 
 

 

Adjusting the Monitor's Contrast and Brightness 

To adjust the brightness of the monitor, 

1 Press the Mode/Select ( ) button on the monitor once. 

2 To increase the brightness, press the Up ( ) button. Press the Down ( ) button to decrease the 
brightness. Repeat step 2 until desired value reached. 

 
To adjust the contrast of the monitor, 

1 Press the Mode/Select ( ) button on the monitor twice. 

2 To increase the contrast, press the Up ( ) button. Press the Down ( ) button to decrease the 
contrast. Repeat step 2 until the desired value is reached. 
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Adjusting the Touch Screen's Contrast and Brightness 

To adjust the brightness of the touch screen, 

1 Press the Mode/Select ( ) button on the touch screen once. 

2 To increase the brightness, press the Up ( ) button. Press the Down ( ) button to decrease the 
brightness. Repeat step 2 until desired value reached. 

 
To adjust the contrast of the touch screen, 

1 Press the Mode/Select ( ) button on the touch screen twice. 

2 To increase the contrast, press the Up ( ) button. Press the Down ( ) button to decrease the 
contrast. Repeat step 2 until the desired value is reached. 
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Connecting/Disconnecting the Transducer 

Connecting the Transducer 

You can connect the transducer to the transducer port when the system is powered off or on. Make sure 
that you press the [Freeze] key on the control panel before connecting the transducer. 

 
CAUTION 
Do not touch the patient when connecting or disconnecting a transducer. 

 

1 Check if you press the [Freeze] key on the control panel. 

2 Insert the transducer connector into the transducer port. 
The CW transducer should be connected to CW port on the front panel of the console. 

 
CAUTION 
Do not forcibly insert the transducer connector to the system. Improper connection may cause 
damages to the system and transducer. 

3 Push the connector locking lever to the right to secure the transducer connector. 
 

NOTE 

When connecting the transducer, do not push the locking lever if resistance is felt. Remove the 
transducer connector and check for misaligned or damaged pins. If any damaged pins are found, do not 
use a transducer and contact your ALPINION MEDICAL service engineer or an authorized agent. 

4 Put the transducer in the transducer holder. 

 
CAUTION 
Do not allow the transducer head to hang free. Impact to the transducer head could result in 
irreparable damage. 

 
 

Disconnecting the Transducer 

You can disconnect the transducer from the transducer port when the system is powered off or on. Make 
sure that you press the [Freeze] key on the control panel before disconnecting the transducer. 

 
CAUTION 
Do not touch the exposed surface of the transducer connector when the transducer is removed. 

 

1 Check if you press the [Freeze] key on the control panel. 

2 Push the connector locking lever to the left to release the transducer connector. 

3 Pull out the transducer connector from the transducer port. 
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Transducer Element test 

The transducer element test is to determine whether the the transducer element working as intended. If 
the element test fails, the failing element(s) are reported in the system logfile. 

 
NOTE 
The transducer element test is atomatically executed during initial system boot and transducer change. 
If more than 3 elements failuers occurs consecutively, the following message appears in a pop-up window. 
"Please check the surface of the transducer. If there is no damage or contaminants, contact to the ALPINION 
MEDICAL SYSTEMS Service Engineer." 

ALPINION MEDICAL SYSTEMS Service Engineer will have to look through the logfile to determine which 
test failed. If the transducer element test failed, Service Engineer will then be able to identify the failing 
transducer element(s) and guide on further actions needed. 
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Activating/Deactivating the Transducer 

Activating the Transducer 

Use the following procedure to activate the transducer and application. 

1 Select Transducer on the touch screen. 
The dialog box for transducer and application selection appears. 

2 Select the desired transducer, application and preset on the touch screen. 
 

NOTE 

Default transducer for the selected preset or default preset for the selected transducer is selected 
automatically. 

3 Click Exit to complete the transducer selection. 
 

NOTE 

Selecting the Automatic Preset selection when changes the Transducer check box shows the default 
application and preset for the selected transducer. 

 
 

CAUTION 
Make sure that the transducer and application names displayed on the screen correspond to the actual 
transducer and application selection. 

 
 
 

Deactivating the Transducer 
 

NOTE 

Before deactivating the transducer, press the [Freeze] key on the control panel. An error may occur when you 

deactivate the transducer while the system is running. 

 
Use the following procedure to deactivate the transducer. 

1 Press the [Freeze] key on the control panel. 

2 Gently wipe the excess gel on the transducer surface. 

3 Place the transducer in its holder. 



Starting an Exam 4-19 

 

 

Starting an Exam 
You can start an exam by entering patient data into the system. The system uses a unique ID to identify 
each patient. You can enter an ID, or you can have the system create one automatically. 

The patient's name and ID number are retained with each patient's image, and are transferred with each 
image during archiving or hard copy printing. 

When completing the patient registration, you can acquire images, perform measurement and 
calculation, save images to the image archive, and send the images to a DICOM device. 

 
CAUTION 
Always verify the patient ID to avoid patient identification errors. Make sure that the patient ID is displayed 
correctly on the patient banner and report screen. 

 
 

Patient Screen 

The following components are shown on the screen: 
 

Figure 4-4 Patient Screen 
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Table 4-2 Patient screen 
 

No Function Description 

 

1 
 

X+ Assistant 
Use to to link an exam with X+ Assistant when the exam starts. 

• Protocol List: Provide a protocol list for the application. 

 
 
 

2 

 
 
 

Function selection 

• Worklist: Use to retrieve patient data from the worklist server. 

• New Patient: Use to clear patient entry screen in order to input a new 
patient’s data into the database. 

• Add Exam: Use to create a new study on an existing patient. 

• Start Exam: Start the exam for the patient. 

• Continuous Exam: Continues the exam for that patient if you select 
the last exam of the day. 

 
 

3 

 
 

Patient information 

• Patient ID: Identification code for a patient 

• Name: Patient's last, first, and middle name 

• Birth Date: Patient's birth date 

• Age: Patient's age 

• Sex: Female, Male, Other 

4 Application selection Select from 11 exam application categories. 

 

5 
 

Exam information 
Show the current/active exam information. All possible information 

needs to be entered. 

6 Patient list/Study list Display either patient or study list. 

7 Save & Exit, Exit Use to save all changes and exit the Patient screen. 

 

 
To enter the Patient screen, 

– Touch Patient on the touch screen. 
 

To enter the patient information, 

– Place the cursor on the text field you want to edit, and then enter the patient information using the 
alphanumeric keyboard. 

 
To navigate through each field on the Patient screen, 

– Use the [TAB] or [Enter] key on the QWERTY keyboard. You can use [Trackball] and the [Set] key on 
the control panel to move and fix the cursor. 

 
To automatically generate a patient ID with current date and time, 

– Go to Utility > Setup > SystemPreset > System > Patient Info and select the Auto ID Generation 
check box. 

– Press the [Quick ID] key on the QWERTY keyboard and select the Auto ID Generation check box on 
the Quick ID screen. 

– Select Quick Register on the touch screen. 
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Patient Menu 
 
 
 
 

 

Figure 4-5 Patient Touch Screen 

Table 4-3 Patient screen menus 

Function Description 

Quick Register Generate a patient ID automatically with current date and time. 

 

New Patient 
Use to clear patient entry screen in order to input a new patient’s data into the 

database. 

Start Exam Start the exam for the patient. 

Continue Exam Continue the exam for the patient if you select the last exam of the day. 

Add Exam Use to create a new study on an existing patient. 

 

Delete 
• Delete one or more patient records from Patient list. 

• Delete one or more studies from Study list. 

Lock/Unlock Lock the patient data or study to prevent move and delete functions. 

Patient List List the patients in the database. 

Study List Display the list of all the exams for the current patient. 

Hide List Hide the Patient list or Study list. 

Worklist Use to retrieve patient data from the worklist server. 

Auto Query Automatically queries the worklist server. 

Navigate Navigate through each field on the Patient screen. 

Search Select a search criteria. 

Scroll Up/Down Use to scroll through the Patient list/Study list. 

Select Page Use to move to the next page of the Patient list/Study list. 

Keyboard Use to show the virtual keyboard 

Exit Use to exit the Patient screen. 
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Starting a New Patient's Exam 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 The cursor positions on the Patient ID field. Enter the patient information using the alphanumeric 
keyboard. The Patient screen includes the following patient information fields. 

Table 4-4 Patient information 
 

Field Description Remarks 

 

Patient ID 
 

Identification code for a patient 
Maximum 64 characters are supported. Use a 
unique ID for each patient. 

 
Name 

 

Patient's last, first, and middle 

name 

Each of last name, middle name, and first name 

supports maximum 62 characters and the total 
name supports maximum 62 characters. 

 

Birth Date 
 

Patient's birth date 
Click the calendar icon and select a date on the 

calendar. You can also manually enter a date. 

 

Age 
 

Patient's age 
Automatically calculated when birth date is 
entered. You can also manually enter an age. 

Sex Female, Male, Other 
 

3 Select the desired application from exam application categories. When a category is selected, the 
measurement and category presets are displayed. 

4 Enter the required application information for the selected application. 

❚ ABD application 

No specific application data 
 

❚ OB and EM application 

Table 4-5 OB and EM application 
 

Field Description 

 
LMP/IVF 

Select LMP or IVF first to calculate EDD and enter the date of the last 

menstrual period (or In Vitro Fertilization). 

LMP or IVF is automatically calculated when you enter GA. 

 
 

EDD 

Estimated Date of Delivery. The system automatically calculates and 
displays EDD after entering GA, LMP or IVF. When you enter or change 

EDD, the system calculates and displays values for LMP/IVF and GA. 
EDD = LMP + 280 days 

 
 

GA 

GA is automatically calculated when you enter LMP, IVF or EDD. 
GA (Gestational Age) = Current date - LMP 

You can also type the GA weeks and days. LMP/IVF and EDD fields are 

updated accordingly. 

Fetus # Select the fetus number (up to 4 fetuses). 

Gravida Enter the number of pregnancy. 

Para Enter the number of childbirth. 
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Field Description 

Ectopic Enter the number of ectopic pregnancy. 

Aborta Enter the number of abortion. 

 

❚ GYN application 

Table 4-6 GYN application 
 

Field Description 

 

LMP 
Enter the date of the last menstrual period using the selected date 
format (ex – MM/DD/YYYY). 

Expected Ovulation Date Enter an expected ovulation date. 

Day of Cycle Enter a menstrual cycle. 

Gravida Enter the number of pregnancy. 

Para Enter the number of childbirth. 

Ectopic Enter the number of ectopic pregnancy. 

Aborta Enter the number of abortion. 

 

❚ Cardio application 

Table 4-7 Cardio application 
 

Field Description 

BSA Body Surface Area (Calculated, No input data) 

 

❚ Vascular application 

Table 4-8 Vascular application 
 

Field Description 

Left BP Blood pressure of left arm, using the systole over diastole measurement 

in mmHg 

Right BP Blood pressure of right arm, using the systole over diastole measurement 
in mmHg 

ABI Ankle Brachial Index 

 

❚ Urology application 

Table 4-9 Urology application 
 

Field Description 

PSA Enter the value of the Prostate-specific antigen. 

PPSA coef.(1) Enter the first value of the predicted PSA coefficient. 

PPSA coef.(2) Enter the second value of the predicted PSA coefficient. 



 

 4-24 Getting Started 
 

❚ Pediatrics application 

No specific application data 

 
❚ Small Part application 

No specific application data 

 

5 Enter the general application information. 

Table 4-10 General application information 
 

Field Description 

Height Enter the patient’s height using selected dimension (cm, ft, inch). 

Weight Enter the patient’s weight using selected dimension (kg, lb, oz). 

 

BP 
Enter the maximum/minimum blood pressure. 

Blood pressure in mmHg 

 
Accession # 

Maximum 16 characters 

Identification code indicating the sequence of the current study as related to 
other studies for this patient. Usually generated by a HIS or RIS server. 

 

Exam Comments 
Enter comments about the exam. 
Maximum 144 characters 

Indication Maximum 72 characters 

Performing MD Enter the name of the physician who diagnosed the patient. 

Referring MD Enter the name of the physician who requested the exam. 

Operator Enter the name of the sonographer who scanned the patient. 

 

Description 
Enter a description of the diagnosis. 
Maximum 64 characters 

 
 

NOTE 

• The measurement unit can be configured in Utility > Setup > SystemPreset > System > General > 

Location > Unit. 

• When you change the operator ID on the Patient screen, the Log in dialog box appears on the 
screen. Select the desired operator ID from the Operator ID field and enter a valid password into the 
Password field, and then click OK. 

6 Click Save & Exit or select Start Exam on the touch screen to save the patient and application 
information. The scan screen appears. 
If you click Exit, return to the scan screen without saving the patient and application information. 

 
CAUTION 
Always verify the identification with the patient to avoid patient identification errors. Make sure that 
the correct patient identification appears on all screens before printing out the patient information. 
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Quick ID 

With the Quick ID feature, you can quickly register a patient by entering the basic patient information. 
This feature is useful when you do not have enough time to register all patient information. 

 

1 Press the [Quick ID] key on the QWERTY keyboard. Or select Quick Register on the touch screen. 
The Quick ID screen appears. 

 

Figure 4-6 Quick ID Screen 
 

2 Enter the patient information: Patient ID, Name, Birth Date, Age and Sex. Only OB application shows 
the LMP and EDD fields. 

 

NOTE 

Using the [TAB] or [Enter] key on the QWERTY keyboard allows you to navigate through each field on 
the Quick ID screen. You can use [Trackball] and the [Set] key on the control panel to move and fix the 

cursor. 

3 Click OK to save the patient information. 
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Starting a New Exam on an Existing Patient 
 

NOTE 

When you register a patient, the study list appears on the display. If the patient is not registered, the patient 

list appears instead. 

 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 Select a search criteria (Patient ID, Patient Name, Birth Date, Sex, Exam Date, and Locked) from the 
Search drop-down list and enter a search keyword. 

 

NOTE 

To view all registered patients while entering a search keyword, click Clear. 

3 The list of patients who match the criteria is displayed in the patient list. 

4 Select a desired patient from the patient list. 

5 If necessary, enter or edit the patient information. 

6 Select Add Exam on the touch screen to create a new study. 

7 Select Start Exam on the touch screen to return to the scan screen. 

8 Perform an exam. 

9 Store the raw data to the clipboard. 

 
 

Ending an Exam 

When you end an examination, all images of the current study are saved in the local hard disk. 

– Press the End Exam key on user-defined key to save the current study. 

– Press the End Exam key on touch screen to save the current study. 

– Press the [End Exam] key on the QWERTY keyboard to save the current study. 

– You can also end a study by selecting New Patient on the Patient screen. 
 

NOTE 

You can return to the Patient screen after ending the current study. To configure, go to Utility > Setup > 

SystemPreset > System > General > After End Exam. 
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Retrieving Patient Information via Worklist 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 Select Worklist on the touch screen to view patient data from the default worklist server. 

3 To change the worklist server, select a source from the Source drop-down list. 
 

NOTE 

Before connecting to the worklist server, you need to configure worklist settings. To configure worklist 
settings, go to Utility > Setup > SystemPreset > Connectivity > Worklist. 

4 Select Worklist to retrieve patient data from the worklist server. 
The search results appear on the list. 

5 Select the patient you want to start a study. 

6 Select Transfer on the touch screen to transfer the selected study to the patient archive. 
 

NOTE 

Destination for transfer is always Local Archive HDD. 

7 Enter the required information and start an exam. 
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Retrieving and Editing Archived Information 

Searching for an Existing Patient 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 Select a search criteria (Patient ID, Patient Name, Birth Date, Sex, Exam Date, and Locked) from the 
Search drop-down list and enter a search keyword. 
If you select Exam Date, you can select a desired period (Today, Last Week, Last Month, and Last 3 
Months) and a specific date from the drop-down list. 

 

NOTE 

To view all registered patients while entering a search keyword, click Clear. 

3 The list of patients who match the criteria is displayed in the patient list. 

 
 

Sorting the List 

Sort the patient or study information by clicking the column names (e.g. Lock, Patient ID, Name, Birth 
Date, Sex, Image Size, Exam Type, Exam Date, and Exam #) of the patient or study list in ascending or 
descending order. 

 
 

Changing Patient Information or an Exam 

If patient information needs to be edited, you can modify the information on the Patient screen without 
erasing accumulated patient images, measurements, annotations, calculations and worksheets. 

 
CAUTION 
The user is responsible for patient data, diagnostic information or any other patient related information 
entered in the database. 

 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 Select a search criteria (Patient ID, Patient Name, Birth Date, Sex, Exam Date, and Locked) from the 
Search drop-down list and enter a search keyword. The system automatically searches to see if the 
patient is already in the database. 

3 The appropriate patient is displayed. 

4 Modify the patient information or the exam application category. 
 

NOTE 

Patient identification information cannot be modified. 

5 When you have finished, click Save & Exit to save the changes. 
A new study is automatically created on that patient. 



Retrieving and Editing Archived Information 4-29 

 

 

Locking a Patient or Study 

To prevent deleting or moving patient data, use Lock functionality. 

 

Locking the existing patient 

1 Search and select a patient from the patient list. 

2 Select Lock on the touch screen. 

3 You can see the locked patient with the lock icon in the patient list. 
 

NOTE 

When you select a locked patient, you can see all of the studies are locked. 

 

Locking the existing study 

1 Select a study from the study list. 

2 Select Lock on the touch screen. 

3 You can see the locked study with the lock icon in the study list. 
 

NOTE 

To unlock the locked patient or study, select Unlock on the touch screen. 
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Deleting the Existing Patient or Study 
 

CAUTION 
Before deleting a patient or study, make sure you have already backed up the patient data using Backup 
Patient Archive or export function. After deleting the patient or study, you CANNOT recover it. 

 
NOTE 

To select multiple patients from the patient list, press the [Set] key while the [Ctrl] or [Shift] key is pressed. 

 

Deleting the existing patient 
 

NOTE 

To switch between the patient list and the study list, use Patient List or Study List. 

 

1 Search and select a patient from the patient list. 

2 Select Delete on the touch screen. 

3 When the Message dialog box appears, click Yes to delete the selected patient. 
 

NOTE 

When the patient you want to delete is locked, you cannot delete the patient by using Delete. You have 

to unlock the locked patient before deleting it. 

 

Deleting the existing study 

1 Select a study from the study list. 

2 Touch Delete on the touch screen. 

3 When the Message dialog box appears, click Yes to delete the selected study. 
 

NOTE 

When the study you want to delete is locked, you cannot delete the study by using Delete. You have to 

unlock the locked study before deleting it. 
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This chapter describes the preset features that you can configure the default settings of 
your system. 
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Presets 
You can customize the system to increase efficiency and streamline your workflow. The preset menus 
provide the following functionality. 

• System Preset: View and set the configuration parameters of operating the system and maintaining 
the setup data. 

• Image Preset: View and set the exam and imaging parameters. 

 
 

Customizing the System 

To customize the system, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch a tab that has the information you want to change. 

4 Select the appropriate touch menu. 

5 Specify the settings for each item. 

6 When you have finished, click Save & Exit to save the changes and return to scanning. 
In some cases, you may need to reboot the system for the change to take effect. 
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System Preset 
The System Preset function is designed to set the configuration parameters of operating the system and 
maintaining the setup data. 

In each preset menu, you can configure default settings for its submenus. 
 
 

System Preset Display 
 

Figure 5-1 System Preset Display 
 
 

1 System presets 3 Exit 

2 Preset menus 4 Save & Exit 
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System Preset Touch Screen 

To access preset menus, select the desired menu on the touch screen. 
 

NOTE 

After changing some preset parameters, you may need to reboot the system. 
 

Figure 5-2 System Preset Touch Screen 
 
 

Table 5-1 System presets 
 

Preset Description 

 

System 
Customize the system configurations such as general settings, control panel, 

peripheral, patient info, and monitor calibration. 

Annotation Customize the comment and body pattern settings. 

 

Measurement 
Customize the labeled measurement for each study and create a new 

measurement and OB table. 

Report Customize the report and report print settings. 

User Setting Customize the user-defined settings. 

Connectivity Customize the DICOM device and service. 

Administration Create a user ID, activate the service browser, and view the option information. 

Backup / Restore Back up and restore data, and perform full backup for image data. 

Advanced Cardiac Customize the settings for the Stress echo and Cube strain™ functions. 
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General Workflow 

Accessing System Preset menus 

To access the preset menu, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the SystemPreset tab on the touch screen. 
The System Preset screen appears. 

4 Select the appropriate preset you want to specify. 

5 Select the preset menu on the touch screen. 

 

Changing System Preset parameters 

To change system parameters, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the SystemPreset tab on the touch screen. 
The System Preset screen appears. 

4 Select the appropriate preset you want to specify. 

5 Select the preset menu on the touch screen. 

6 Change values for the parameters you want to change. 
To change a parameter, do one of the following: 

– Enter the desired value using the keyboard in the text box. 

– Select the value from a drop-down list. 

– Select or clear a check box. 

– Click one value from a choice of two or more radio buttons. 

7 When you have finished, click Save & Exit to save the changes and return to scanning. 
In some cases, you may need to reboot the system for the change to take effect. 

 

NOTE 

• To restore the settings on the current menu screen, click Reset Default. 

• To restore all settings of the system preset, click Reset Default All. 
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System 
The System preset allows you to configure general system settings and to calibrate a monitor. 

 
The System preset contains the following submenus: 

• General 

• Control Panel 

• Peripheral 

• Patient Info 

• Monitor 
 

 

General 

The General menu allows you to configure the general system settings such as hospital name, system 
date and time, and screen saver. 

 

❚ Organization 

• Hospital: Enter a hospital name. 

• Department: Enter a department name. 

• Logo Path: Import a hospital logo to be shown on the top of the display. 
 

To import a hospital logo from a USB drive, 

1 Insert a USB driver that stores a hospital logo to the system. 

2 Click … to find the file path. 

3 When the file selection dialog box appears, select the logo file you want. 

4 Click OK. 
 

NOTE 

• The supported file formats are BMP, PNG, and JPG only. 

• You may not import a hospital logo from a CD or DVD. 

 
❚ Location 

• Language: Change the display language. 
 

NOTE 

After changing the language, you need to reboot the system. 

• Unit: Select a measurement unit, Metric or US. When you select US, all units are changed from 
centimeter to inch. 
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❚ Power Off 

• Power Off: Set how the system powers off when you press the [Power On/Off] key. 

– Shutdown dialog: Set to show the shutdown dialog box. 

– Immediately: Set to power off immediately. 

 
❚ Monitor 

• Enable screen saver: Set to activate Screen saving mode. 

• Delay: Specify the time of inactivity. 

 
❚ Date / Time 

• Date Format: Select the desired date format. 

• Time Format: Select the desired time format. 
 

To change the current date and time, 

1 Click Date / Time under Time Format. 

2 Click the Date and Time tab. 

3 Click Change date and time... to change the current date and time. 
Date and Time Settings screen appears. 

4 Change the current date and time. 

5 Click OK to save the changes. 
 

Figure 5-3 Date and Time 
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To change the time zone, 

1 Click Date / Time under Time Format. 

2 Click the Date and Time tab. 

3 Click Change time zone... to change the time zone. 
Time Zone Settings screen appears. 

4 Select your time zone from the drop-down list. 

5 To set Daylight Savings Time (DST), select the Automatically adjust clock for daylight saving 
changes check box. 

6 Click OK to save the changes. 
 

Figure 5-4 Time Zone 
 
 

❚ Transducer 

• Default Port: Select a default transducer port when the system powers on. 

 
❚ After End Exam 

• Status: Set to return to scanning or go to Patient screen when you touch End Exam on the touch 
screen. 

 
❚ Touch Screen 

• Volume: Adjust the volume of the touch screen. 

 
❚ System Defender 

• Real-time protection: Enable or disable the automatic protection feature which checks the system 
for suspicious activity in real-time. 

 

NOTE 

After turning on or off the real time protection feature, you need to reboot the system. 
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Control Panel 

The Control Panel menu provides options for trackball and the control panel keys. 
 

❚ Trackball 

• Trackball Travel Speed: Change the trackball speed (Slow, Medium, Fast). 

• Trackball Cine Speed: Change the speed for scrolling through cine sequences (Slow, Medium, 
Fast). 

 
❚ Key 

• Application: Select a default application that is used for the selected function on freezing. 

• Active Function on Freeze 2D: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in 2D mode. The selected function automatically activates when 
you press the [Freeze] key. 

• Active Function on Freeze M: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in M mode. The selected function automatically activates when 
you press the [Freeze] key. 

• Active Function on Freeze D: Select a function (Cine, Measurement, Body pattern, Arrow) to be 
activated after freezing an image in Doppler mode. The selected function automatically activates 
when you press the [Freeze] key. 

• Backlight Intensity: Set the brightness of the key backlight (High, Low, Off). 

• Set the Cursor and Set keys: Select the functions to assign to the [Set/Cur] keys on the left and 
right sides of the trackball on the control panel. 

– Cursor - Set: Assign Cursor to the left key and Set to the right key. 

– Set - Cursor: Assign Set to the left key and Cursor to the right key. 

– Set - Set: Assign Set to the left key and Set to the right key. 

– Set - Exit: Assign Set to the left key and Exit to the right key. 

– Exit - Set: Assign Exit to the left key and Set to the right key. 
 

NOTE 

TIC is available when you assign the functions to [Set/Cur] keys as Cursor - Set or Set - Cursor. 

• CCW Depth Control: Set to operate the [Depth] key when you rotate the key counter-clockwise. 

• Switch Dual(Quad) and P3(P4): Switch the key function between the [Dual] key and [P3] key, or 
between the [Quad] key and [P4] key. 

 
❚ Audio 

• 'Beep' sound only when the 'P1,P2,P3,P4'key are Pressed: Set to play a beep when you press the 
[P1], [P2], [P3], and [P4] keys. 
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Peripheral 

The Peripheral menu provides peripheral options for VCR, standard printer, and RS232C port. 
 

NOTE 

To configure the printer key function, go to User Setting > Print/Foot Switch. 
 

❚ VCR 

• VCR: Select the type of media (DVR media, USB). 

• VCR Format: Select the video format (NTSC or PAL, MPEG or AVI). 

• VCR Maximum Time (min.): Select the record length (1-20). (Only available for USB storage.) 

 
❚ Standard Printer( Report Only ) 

• Default Printer: Select a default standard printer that is used for printing reports and images. 

• Printer Paper: Select a printing paper for the default printer. 

• Refresh: Set the system to automatically refresh the printer list when you add a new printer. 
Select this option after installing a new printer is completed. 

 
❚ Printer Setting 

• Add Printers...: Add a new printer driver via USB serial port or Ethernet interface. Selecting this 
option activates Windows Add Printer wizard. 

• Cleanup Printer Jobs in Queue When System Bootup: Set to clear all printer jobs in queue when 
your system reboots. 

• : Click the setting icon to manage the printer list. 

❚ RS232C 

• COM: Select a RS232C port setting, DVR Control or Transfer Measurement. 
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Patient Info 

The Patient Info menu provides useful options related to patient management and E-View, and allows 
you to configure the patient banner display option. 

 

❚ Patient Information 

• Hide Patient Information: Select to hide patient information on patient banner. 

• Patient Banner Line1: Select the patient information to display patient banner line1 from the 
drop-down list. 

• Patient Banner Line2: Select the patient information to display patient banner line2 from the 
drop-down list. 

• Image View: Hide Banner: Select to hide patient banner on acquired data on E-view. 

 
❚ Patient Package Option 

• Auto ID Generation: Set the system to automatically create a new patient ID when you select New 
Patient. 

• Auto Search for Patient: Set the system to automatically search for the patient data when you 
enter the first letter of a patient ID in the Patient ID field. 

• Auto Logon: Set the system to log on automatically. 

• Auto Archiving Patient Data: Set the system to archive the patient data automatically. 

• Use Birthdate: Set the patient's age is calculated when enter the birth date. 

• Quick Worklist: Set the worklist is shown automatically when you touch Patient on the touch 
screen. 

• Keep last sorting method in patient list: Select to display the last sorting method on the Patient 
Package List screen. 

• Keep the last Column width of Patient List: Select to save the last column width when you change 
the column width of the patient list. 

• Auto Query for Worklist: Set the system to query the worklist server automatically. 

• Auto Start Exam for Worklist: Set the system to start an exam automatically from Worklist server. 

• The first letter of the patient name is always capitalized: Set the system to automatically 
capitalize the first letter of the patient name. 

• Hide the patient list on the patient registration Page: Set to hide patient list on the patient 
registration page. 

• Delete patient Data that has been transferred to PACS: Set the system to delete patient data that 
has been transferred to PACS automatically after selected amount of period. 

 
❚ Archive Option 

Select an archive to be used for saving data when you select End Study. You can also add and remove 
a storage media such as DICOM device, USB flash drive, USB hard disk, or Network storage. 

 

NOTE 

The default archive “Local Archive” cannot be deleted. 

 
❚ App. Storage 

Select to set PACS to transfer data by application. 
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Monitor 

The Monitor menu allows you to adjust the display pattern using gray bars and color bars. After the 
monitor adjustment, you need to check your peripherals. To adjust the monitor, see "Monitor and Touch 
Screen" on page 3-8. 

 

 

Figure 5-5 Gray & Color Bars 
 

NOTE 

After adjusting the monitor settings, you may need to verify the peripheral functions, such as standard printer 

and DVR. 
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Annotation 
The Annotation preset allows you to specify body pattern/text options and to define body pattern/text 
libraries on the context menu. The following menus are available: General, Body Pattern, and Text. 

 
The Annotation preset contains the following submenus: 

• General 

• Body Pattern 

• Text 
 

 

General 

The General menu allows you to configure the text and body pattern options. 
 

Figure 5-6 Annotation_General Display 
 
 

❚ Text Preset 

• Font Color: Select a font color for comment. 

• Keep arrow’s head position when trackball is moving: Set to fix the direction of the pointer head 
when you move [Trackball]. When this option is not selected, the direction of the pointer head 
changes with the movement of [Trackball]. 

• Erase Text when image is unfrozen: Set to erase all comments on the display when you press the 
[Freeze] key to return to scanning. 

• Erase Text when entering M mode or PW mode: Set to erase all comments on the display when 
you enter M mode or PW mode. 

• Erase Text when exiting M mode or PW mode: Set to erase all comments on the display when you 
enter M mode or PW mode. 

• Replace the Text: Set to replace the comment with the new text. 
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• Erase Text when entering Dual or Quad mode: Set to erase all comments on the screen when the 
display is changed to the dual or quad layout screen. 

 
❚ Body Pattern Preset 

• Erase bodypattern when image is unfrozen: Set to erase the body pattern on the display when 
you press the [Freeze] key to return to scanning. 

• Copy to active side in multiple image: Set to copy the body pattern on the selected image in the 
dual or quad layout screen. 

• Set as default position when Bodypattern is moved: Set to show the last position movement of 
the body pattern when you press the Move Pattern soft key. 

 

BodyPattern 

The BodyPattern menu allows you to define and change body pattern libraries. The left side of the 
Body Pattern menu shows all available body pattern libraries, and the right side shows the specific body 
patterns for the selected library. Once you have defined body patterns for a library, they are shown on 
the touch screen display of Body Pattern. 

 

NOTE 

To specify the default library per each preset, go to User Setting > Annotation. 
 

Figure 5-7 Body Pattern Libraries 
 
 

To add a body pattern, 

1 Select the library you want to add a body pattern from the library list. 

2 Use [Trackball] to select a body pattern, and press the [Set] key twice or click Add. 
The body pattern is shown on the bottom of the library. 

3 To change the position of the body pattern, select the body pattern and click Up/Down/Left/Right. 

4 Click Empty to make an empty space on the touch screen. 

5 Click TouchView to review the applied body marker on the touch screen. 
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6 Press the Save soft key and then click Yes to save the changes. 

 
To delete a body pattern, 

1 Select the library you want to delete a body pattern from the library list. 

2 Use [Trackball] to select a body pattern, and press the [Set] key. 

3 Click Delete to delete the body pattern. 

4 Press the Save soft key and then click Yes to save the changes. 

To change the location of a body pattern, 

1 Select the library you want from the library list. 

2 Use [Trackball] to select a body pattern, and press the [Set] key. 

3 Click Up, Down, Left, or Right to change the location of the body pattern. 

4 Press the save soft key and then click Yes to save the changes. 

 

Text 
 

The Text menu allows you to change and define the text libraries. The left side of the Text menu shows all 
available text libraries, and the right side shows the specific text for the selected library. For each library, 
you can define up to one column with twenty three rows. The defined text is shown on the context menu 
of the text mode. 

 
To add a text, 

1 Select the library you want from the library list. 
The system shows all texts saved in the library. 

2 Use [Trackball] to select a text, and press the [Set] key. 
The text is shown on the bottom of the library. 

3 Click Add to add the selected text. 

4 To change the text position, select the text and click Up or Down. 

5 Click Empty to make an empty space on the touch screen. 

6 Click TouchView to review the applied text on the touch screen. 

7 Press the Save soft key and then click Yes to save the changes. 

To create a new text, 

1 On the New Text field, press the [Set] key. 

2 Enter a new text and click Add. 
The new text is shown on the bottom right of the library. 
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To delete a text, 

1 Select the library you want from the library list. 

2 Use [Trackball] to select a text and press the [Set] key. 

3 Click Delete to delete the text. 

4 Press the Save soft key and then click Yes to save the changes. 

To change the text location, 

1 Select the library you want from the library list. 

2 Use [Trackball] to select a text and press the [Set] key. 

3 Click Up or Down to change the text location. 

4 Press the Save soft key and then click Yes to save the changes. 
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Measurement 
The Measurement preset allows you to specify measurement and calculation preset. 

 
The Measurement preset contains the following submenus: 

• General 

• Basic MEAS. 

• Labeled MEAS. 

• OB MEAS. 

• Advanced MEAS. 
 

 

General 

The General menu allows you to define the cursor and result window settings. 
 

Figure 5-8 Measurement_General Display 
 
 

❚ General 

• Repeat Measurement: Set to repeat the measurement. 

– Repeat: The selected measurement on the context menu is repeated. 

– None: The measurement is not repeated. 

– Default Measurement: The basic measurement is repeated (e.g. Distance). 

• Tissue Depth display(2D,M): Set to show the tissue depth (depth from the transducer surface) 
when moving the measurement cursor in 2D or M mode. 
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❚ Caliper 

• Caliper Type: Select a caliper type (Number or Symbol). 

• Caliper Size: Select a caliper size (Normal or Large). 

• Caliper Color: Select a color for the fixed measurement cursor. 

• Caliper Line Width: Select a line width of the caliper (Thin, Normal, or Thick). 

• Caliper Easy Guide: Select to activate Caliper Easy Guide while performing the measurement. 

• Ellipse cross line display: Set to show the cross line for ellipse. 

• Caliper line display: Set to show the caliper line when measurement is completed. 

• D mode caliper cross line display: Set to show the cross line of the caliper in D mode. 

• M mode caliper cross line display: Set to show the cross line of the caliper in M mode. 

• Copied caliper display in Live Dual: Set to show the copied caliper in Live Dual mode. 

 
❚ Result Window 

• Format: Select a window format (Wide or Narrow). 

• Direction: Select a window direction (Top down or Bottom up). 

• Font Color: Select a font color. 

• Position 2D: Select a default position of the result window in 2D mode (Left Top, Left Bottom, 
Right Top, or Right Bottom). 

• Position TimeLine: Select a default position of the result window in M and PW modes (Left Top, 
Left Bottom, Right Top, or Right Bottom). 

• Transparency: Set to show the window background transparent or opaque. 
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Basic MEAS. 

The Basic MEAS. menu shows all settings for the basic measurement in each application. Depending 
on the application, available settings may vary. You can define the basic measurement and default 
method for each basic measurement. You can control basic measurement by using the soft keys in each 
measurement mode. 

 

Figure 5-9 Basic Measurement Display 
 
 

To start the basic measurement setup, 

1 Select a measurement application. 

2 Select a measurement mode (2D, M, or Doppler). The basic measurement entries of the selected 
measurement mode appear on the table. 

 

NOTE 

The order of the basic measurement is the same as on the soft key menu. 

3 Specify Default Measure Key Sequence. 
For example) OB1, M mode: Select 2 Sequences (Distance, Time) or 3 Sequences (Distance, Time, 
Slope). 

4 When you select Distance, Time for 2 Sequences, the distance caliper will be shown by pressing the 
[Caliper] key once. The time caliper will be shown by pressing the [Caliper] key twice. 
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Labeled MEAS. 

The Labeled MEAS. menu shows all settings for the labeled measurement. You can control labeled 
measurement using the context menu in the measurement mode. 

 

Figure 5-10 Labeled Measurement Display 
 
 

To start the labeled measurement setup, 

1 Select a measurement application from the drop-down list. 

2 Select a measurement mode (2D, M, or Doppler). 

3 All of the available measurement lists appears on the left of the measurement window. The default 
measurements are shown on the context menu. 

4 To add a measurement to the context menu, select a measurement from the Available 
Measurement list and click Add. 

5 To delete a measurement from the context menu, select a measurement from the Default 
Measurement list and click Delete. 

6 To change the order of a measurement from the context menu, select a measurement from the 
Default Measurement list and click Up or Down. 

7 To enable automatic sequence measurement, select Auto Sequence. 
 

NOTE 

You can change the author in the OB measurement. 
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❚ Creating a new measurement 

To create a new measurement entry, 

1 Click New Measurement. 

2 Specify the following measurement information. 

• Measurement Name: Enter a measurement name. Make sure that the measurement name 
is unique. 

• Measurement Type: Select a measurement type among Distance, Area, Angle, Volume, and 
Disk volume from the drop-down list. 

• Caliper Type: Select a caliper type from the drop-down list. 

• Parameter: Set to show Parameter, Parameter Type, Unit, Precision and Method. You can 
modify Unit, Precision and Method by changing them from the drop-down list. 

 

NOTE 

Depending on the measurement mode, available measurement types and caliper types may differ. 

3 To save the settings, click OK and then Yes. 
You can see the new measurement in the Available Measurement list. 

 

❚ Creating a new parameter 

To create a new parameter on a defined measurement, 

1 Click New Parameter. 

2 Specify the following parameter information. 

• Parameter Name: Enter a parameter name. 

• Formula: Enter a calculation formula and click Check to verify that the syntax is correct. 

• Display Unit: Select a display unit from the drop-down list. 

• Display Precision: Select a display precision from the drop-down list. 
 

NOTE 

When you input parameters, suitable unit should be considered for calculation. 

3 To save the settings, click OK and then Yes. 
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❚ Creating a new calculation 

To create a new calculation, 

1 Click New Calculation. 

2 Specify the following calculation information. 

• Calculation Name: Enter a calculation name. Make sure that the calculation name is unique. 

• Formula: Enter a calculation formula and click Check to verify that the syntax is correct. 

• Display Unit: Select a display unit from the drop-down list. 

• Display Group: Select a display group from the drop-down list. The display group is shown 
on the Report page. 

• Display Precision: Select a display precision from the drop-down list. 

• Measurement: Select a measurement from the drop-down list. 
 

NOTE 

When you input parameters, suitable unit should be considered for calculation. 

3 To save the settings, click OK and then Yes. 

 
❚ Editing a measurement 

To edit a customized measurement, 

1 Select a measurement from the list and click Edit or double-click the measurement. 
The Edit Measurement window appears on the screen. 

2 Add or change the measurement by using New Parameter and Edit Parameter, and then change 
Unit, Precision and Method for report. 

3 Click OK and then Yes to save your changes. 
 

NOTE 

The default measurements cannot be edited. 
 

❚ Editing a parameter 

To edit the customized parameter, 

1 Select a parameter from the list and click Edit Parameter. 
The Edit Parameter window appears on the screen. 

2 Change the formula and output format such as Method, Unit, and Precision. 

3 Click OK and then Yes to save your changes. 
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❚ Editing a calculation 

To edit a customized calculation, 

1 Select a calculation from the list and click Edit or double-click the calculation. 
The Edit Calculation window appears on the screen. 

2 Add or change the calculation by using New Parameter and Edit Parameter, and then change 
Unit, Precision and Method. 

3 Click OK and then Yes to save your changes. 

 
❚ Deleting a measurement 

To delete a measurement entry, 

1 Select a customized measurement from the Available Measurement list. 

2 Click Del.Measurement. 

 
❚ Deleting a parameter 

To delete a customized parameter, 

1 Select a parameter from the list. 

2 Click Delete Parameter. 

 
❚ Deleting a calculation 

To delete a customized calculation, 

1 Select a customized calculation from the Available Measurement list. 

2 Click Del.Measurement. 
 

NOTE 

The default calculations cannot be edited or deleted. 
 

❚ Setting up the automatic sequence for EFW 

The automatic sequence feature allows you to perform EFW measurements in sequence. 

1 Go to Utility > Setup > SystemPreset > Measurement > Labeled MEAS.. 

2 Select an OB application from the Available Measurement list. 

3 Select an EFW folder and click Add. 

4 Double-click the selected measurement. 

5 Select the Auto Sequence check box on the top of the Default Measurement list. 
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❚ Creating new biometry measurement 

To see the different authors' measurement based on same biometry, 

1 Go to Utility > Setup > SystemPreset > Measurement > Labeled MEAS.. 

2 Select a biometry measurement from the Available Measurement list. 

3 Click Copy Biometry. 
You can see the copied measurement item in the Default Measurement list. 

4 To save the changes, click Save. 
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OB MEAS. 

The OB MEAS. menu allows you to define default OB presets such as OB type and OB graph. You can also 
register a user-defined OB table. 

 

Figure 5-11 OB Measurement Display 
 
 

❚ General 

• OB Type: Select an OB type (USA, Europe, Tokyo, Osaka or ASUM) from the drop-down list for the 
measurement and calculation. The default measurement list may differ depending on the selected 
OB type. 

• Default US Age Type(Hadlock): Select CUA (Composite Ultrasound Age) or AUA (Average 
Ultrasound Age). 

• Table Type (Hadlock): Select Hadlock82 or Hadlock84 for OB table. 

• OB Graph Single: Select EFW or Last for displaying OB graph as default. 

• Add 1 Week to EDD: Set to add additional week to estimate the date of delivery. 

• Deviation Type: Select Growth Percentile(%) or Standard Devaition(SD). 

 
❚ Calculations 

• EFW GP: Select an author name to calculate EFW GP (Estimated Fetal Weight Growth Percentile). 

• EFW Formula: Select Hadlock, Campbell, Hansmann, Merz, Osaka, Persson, Schild, Shepard, 
Shinosuka1, Shinosuka2, Shinosuka3, or Tokyo. 

• EFW (Hadlock Method): Select (HC, AC), (AC, FL), (AC, BPD), (AC, BPD, FL), (AC, FL, HC), or (AC, 
BPD, FL, HC). 

• EFW Unit: Change the measurement unit for EFW. 

• EFW GA: Select Table/Formula for calculating the gestational age from the EFW. 
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❚ Table Registration_Creating a new OB table 

To create a new OB table, 

1 Click New Table. 

2 Enter an author name. 
 

NOTE 

Author name always should be unique. 

3 Select options in the Biometry and Ref. Author fields. 

4 Select Fetal Age or Fetal Growth. 

5 When you selected Biometry and Ref. Author, the pre-defined values are shown on the table, 
and you can edit the table value. When you selected None from Ref. Author, the table will be 
reset. 

6 Select SD Format for a deviation type. 

7 Select Input Unit for input and Output Unit for output. 

8 Enter Min, Max, and Interval for range. The system creates default values on the table 
automatically. For the other options, you can manually enter or edit the values. 

9 To enter the value, move the cursor to the desired field and press the [Tab] key. 

– To move the row, click → or →. You can also press the [Enter] key to move to the next row. 

– To move to the column, click ↑ or ↓. 

10 To add additional line, click Insert. 

11 To delete a line, click Delete. 

12 To clear all values, click Clear All. 

13 When you have finished, click OK and then Yes to save your changes. 
 

NOTE 

You can import an OB table template as an Excel file which is created by PC. 
 

❚ Table Registration_Editing an OB table 

To edit an OB table, 

Once you have created your own table, you can edit the table by clicking Edit Table. You can only edit 
the table values, not the table type. The editing table procedure is the same as New Table. 

 

NOTE 

The default tables and equations cannot be edited. 
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❚ Table Registration_Creating new OB equation 

To create new equation, 

1 Click New Equation. 

2 Enter an author name. 
 

NOTE 

Author name should always be unique. 

3 Select an option in the Biometry field. 

4 Select Fetal Age or Fetal Growth for equation type. 

5 To make a formula, select formula components from the Inputs and Operators fields, and enter 
a formula in the formula field. 

6 Click Check to test the formula. If there are no errors, the “Syntax OK!” appears. If any error 
occurs on the formula, an error message appears in the formula field. 

7 Specify the input range for the Min and Max fields. 

8 Click OK and then Yes to save your changes. 

 
❚ Table Registration_Editing OB equation 

Once you have created your own equation, you can edit the equation by selecting Edit Equation. The 
editing equation procedure is the same as New Equation. 

 

❚ Available operators for equation 

The following table shows available operators for using equation. 

Table 5-2 Equation operator 
 

Operator Definition 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

( ) Parenthesis 

^ Caret 

sqrt Square root 

pi Pi 

log Logarithm 

ln Natural logarithm 

exp Exponential 

abs Absolute value 



5-28 Customizing the System 

 

 

❚ OB AutoCalculation: Set to perform the automatic OB calculation. Select the OB Table check box to 
select the OB calculations (AC*, HC*, AxT*, MAD*). 

 
❚ X+ Auto Biometry 

Set to perform the automatic fetal biometry calculation. Select the fetal biometry calculations (BPD, 
HC, AC, FL, Humerus). 

 

Advanced MEAS. 

The Advanced MEAS. menu allows you to define application parameters, especially the Doppler 
measurement. 

 

Figure 5-12 Advanced Measurement Display 
 
 

❚ Measurement Application 

Select an application to be defined. 
 

❚ Application Settings 

• HR Cycle: Select a heart rate cycle (1-10). 

• HR Method(ECG): Select HR Method (Manual or Automatic). 

• Default Location: Select a default location for the selected application (Off, Prox, Mid, or Dist). 

• Default Side: Select a default side (Left or Right). 

• Keep Result Window: Set to show the previous results of the measurements you performed on 
the Result window (Auto/On/Off). If you select Auto, the previous result for volume measurement 
is shown on the Result window. If you select On, the previous result for labelled measurement is 
shown on the Result window. 

• PI Calc Method: Select a parameter (ED or MD) to calculate PI (Pulsatility Index). 

• RI Calc Method: Select a parameter (ED or MD) to calculate RI (Resistivity Index). 

• Vol.flow Method: Select a parameter (TAmax or TAmean) to calculate Volume Flow. 
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❚ Measurement Unit 

• Distance: Configure the unit of measurement for all distances at one time (cm, cm2, cm3 or mm, 
mm2, mm3). 

• Velocity: Configure the unit of measurement for all velocities at one time (cm/s, m/s, or mm/s). 

 
❚ Modify Calcs 

• Manual Trace: Select the measurements to perform the manual calculation for the selected 
application. 

• Auto Trace(Calc): Select the measurements to perform the automatic calculation for the selected 
application. 

• Semi Auto Trace: Select the measurements to perform the semiautomatic calculation for the 
selected application. 

 

NOTE 

To set up the Auto trace direction, Auto trace method, and Auto trace sensitivity, go to ImagePreset > 

General. 
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Report 
The Report preset allows you to specify report and report print preset. 

 

Figure 5-13 Report Display 
 
 

 

Print 

❚ Print Logo 

Change the logo image when you print the report. 
 

❚ Print Section 

Set the print section for each application. 
 

❚ Print Header & Footer 

Set the options for print header and footer. 

– Select the Different First Page check box to set the header and footer for the first page differently. 

 

Patient Info 

❚ Patient Info Section 

Customize the Patient Information section for each application. 
 

❚ Preview Section 

Preview the Patient Information section. 
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Comments 

❚ Comments 

• Use Default Template on Cardiac Exam: Select to use default cardiac comments template. 

 

Report Order 

The Report Order menu allows you to edit the application-specific measurements displayed on the 
report. 
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User Setting 
The User Setting preset allows you to configure application specific setting and to configure 
programmable keys such as P1, P2, P3, P4, user-defined keys, and hot key. 

 

The User Setting preset contains the following submenus: 

• Annotation 

• Measurement 

• User Defined key 

• Print/Foot Switch 
 

 

Annotation 

The Annotation menu allows you to specify the default body pattern library to be shown in the Body 
Pattern menu. You can also specify the default text library to be shown when you use comments. 

 

Measurement 

The Measurement menu allows you to specify the default package measurement to be shown when you 
use the measurement. 

 

User Defined key 

The User Defined key menu allows you to specify user-defined keys. To assign functions onto numeric 
keys (0-9), select the Enable Hot Key check box and assign a key function. The following table shows the 
functions that you can assign for available keys. 

 

NOTE 

Numeric hot key function is only available with QWERTY keyboard. 
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Figure 5-14 User Setting_User Defined Key Display 
 
 

Table 5-3 User-defined key 
 

Key 

Function Key 

User key (1–5) Numeric key (0–9) 

Power Preset O O 

Transducer 1 O O 

Transducer 2 O O 

Transducer 3 O O 

Transducer 4 O O 

Quick ID O O 

Patient O O 

End Exam O O 

Report O O 

E-view O O 

Initial O O 

Exit O O 

PDI O O 

DPDI O O 

TDI O O 

Elasto O O 

Update O O 
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Key 

Function Key 

User key (1–5) Numeric key (0–9) 

Needle Vision™ O O 

3D O O 

4D O O 

STIC O O 

Panoramic O O 

StressEcho O O 

Cube Strain™ O O 

Full Screen O O 

X+ MicroView O O 

CEUS O O 

pSWE O O 

Arrow O O 

Clear All O O 

Virtual O O 

L/R Flip O O 

U/D Flip O O 

Quick Angle O O 

Auto Calc O O 

Simultaneous O O 

Full D O O 

Full M O O 

Biopsy O O 

DVR O O 

Rec/Pause O O 

Eject O O 

Cube View™ O O 

X+ Assistant O O 

Xpeed O O 

Tilt O O 
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❚ Assign Key 

To configure the User keys or numeric keyboard keys, 

1 Select the function from the Available Function list. 

2 Select the corresponding User key (User 1-5) or a numeric key (#0-9) from the Key list. 

3 The selected function is shown in the Function list. 

 
❚ Power Preset Touch 

Power Preset 1-5 on the touch screen allow you to quickly change the transducer and its preset. 
 

To configure the Power Preset, 

1 Select a Power Preset (Power Preset1-5) from the Key list. 
The dialog box for transducer and application selection appears. 

2 Select the desired transducer, application and preset on the touch screen. 

3 Click OK to complete the selection. 

4 The selected transducer, application and preset are shown in the corresponding Function list. 
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Print/Foot Switch 

The Print/Foot Switch menu allows you to define the optional footswitch and the print keys. 
 

To assign print keys, 

1 Select a print key (P1, P2, P3, P4) on the upper side of the display. 

2 Select the device you want to add under the device category on the left side of the display. 

3 Click >> on the middle of the display. 

4 To configure the multiple devices to the each print key, select devices as many as you want from the 
corresponding device categories. 

 

❚ Print key functions 

You can set the print keys to perform the following functions. 

• Image Type: Set the print key to save an image to the clipboard. When you press the [P1] key (or 
the assigned print key), the current image is moved to the clipboard. The image format depends 
on the saving option and current status (live or frozen). 

Table 5-4 Store format option 
 

Option Description 

 

Image Type 
Select a saving area (Single, Cine, Screen capture(Whole), Screen 
capture(Diagnostic)). 

• Print: Select the printer from the Available Printer list. 

• Standard Print: Set the print key to print the image via the standard printer. You can also print an 
image via other printers. 

Table 5-5 Print option 
 

Option Description 

Printer Direction Select a printing direction (Landscape or Portrait). 

Printer Area Select a printing area (Whole Screen, Diagnostic, or Full Diagnostic). 

Printer Quality Select a printing quality (Default, Low, Medium, or High). 

Printer Paper Select a printer paper. 

Enable Video Invert Set to print an image or the background in black. 

Hide image parameter when 

image printed 

 

Set to print an image with the image parameter hidden. 

• 3D/4D: Set the print key to export the complete volume data in volume file format. The stored 
volume data can be reviewed with the PC program. 

• Network Storage & Media: Set the print key to send an image to network storage, USB flash drive, 
USB hard disk. To configure the network storage setting, go to SystemPreset > Connectivity > 
General > Network Storage. 

• DICOM Server: Set the print key to send an image to a DICOM device. To configure the DICOM 
settings, go to SystemPreset > Connectivity > Storage or Print. 
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❚ Footswitch functions 

To assign functions for the each pedal of the footswitch, select a function from the corresponding list 
(Right, Center, Left). The following functions are available: 

 

• Freeze • M Mode 

• P1 • PW Mode 

• P2 • Update 

• P3 • Simultaneous 

• P4 • Measure 

• Dual • End Exam 

• Quad • Rec/Pause 

• CF Mode • Transducer 1–4 

• PD Mode • DPDI 
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Connectivity 
The Connectivity preset allows you to configure the network connection and DICOM protocols. DICOM 
is an abbreviation of Digital Imaging and Communications in Medicine. This is a standard protocol for 
handling, storing, printing, and transmitting information in medical imaging. Using the DICOM option, 
you can send or print images after connecting the system and PACS. 

 

NOTE 

• DICOM is an optional service. To use this service, you need DICOM installation. 

• To enter the connectivity screen, you must log in as an administrator. 

 
The Connectivity preset contains the following submenus: 

• General/Network Storage/CubeView™/CubeNote 

• Network 

• Storage 

• Print 

• Worklist 

• MPPS 

• DICOM Q&R 
 

 

General 

The General menu allows you to configure the general network connection settings such as computer 
name, AE title, and port number. 

 

NOTE 

To set up Internet Protocol, contact your hospital’s network administrator. 
 

Figure 5-15 Connectivity_General Display 
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To configure the general network connection settings, 

1 Enter a computer name in the Computer Name field. 

2 Enter an Application Entity (AE) title in the AE Title field. 

3 Enter a port number of your system in the Port No field. 

• Cleanup DICOM Spooler jobs in Queue when System Bootup: Set to delete all DICOM jobs in 
queue when system reboots. 

4 Press the Save soft key and then click Yes to save the changes. 

5 Reboot your system. 
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Network Storage 

The Network Storage menu allows you to customize options for sending backup data to Shared directory. 
You can add and edit a network storage device. 

 

To enter the Network Storage menu, 

– Go to General menu and click Network Storage on the bottom right of the display. 
 

To add a network storage device, 

1 Click New. 

2 Enter a name of the network storage device in the Destination Name field. 

3 Enter a shared directory path for the device in the Shared Dir field. 

4 Enter an ID of the device in the ID field. 

5 Enter a password of the device in the Password field. 

6 Select a device that is connected to the intra network driver. 

7 Click Verify to verify the network connection. 

To delete a network storage device, 

1 Select the destination name that you want to delete. 

2 Click Remove. 

3 Press the Save soft key. 

 
❚ Properties 

• Type: Select an image format to save images to network storage (JPEG, BMP). 

• 2D Cine: Save 2D cine images as WMV format. 

• 4D Volume Cine(*AVI): Save 4D volume images as AVI format. 



Connectivity 5-41 

 

 

Cube View™ 

The Cube View™ menu allows you to set up the network options for accessing to the Cube View Control 
Server. You can add and edit a Cube View Control server device. 

 

To enter the Cube View™ menu, 

– Go to General menu and click Cube View™ on the bottom right of the display. 
 

To add a Control Server device, 

1 Click New. 

2 Enter a name of the Cube View Control Server device in the Destination Name field. 

3 Enter an IP address of the Cube View Control Server device in the IP Address field. 

4 Enter a Port number of the Cube View Control Server device in the Port No field. 

5 Enter an access ID of Cube View Client in the ID filed. 

6 Enter a password of Cube View Client in the Password field. 

7 Click Verify to verify the Cube View Control Server connection. 

To delete a Cube View Control Server device, 

1 Select the destination name that you want to delete. 

2 Click Remove. 

3 Press the Save soft key. 

 
❚ Properties 

• Compression: Select an image compression type. (Lossy, Lossless) 

• Quality: If you selected LOSSY in the Compression field, select compressibility. 

• Enable Adjust Quality: Set whether to adjust a compression type and an image quality. 
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CubeNote 

The CubeNote menu allows you to set up the network options for accessing to the CubeNote Control 
Server. You can add and edit a CubeNote Control server device. 

 

To enter the CubeNote menu, 

– Go to General menu and click CubeNote on the bottom right of the display. 
 

To add a Control Server device, 

1 Enter a hospital code in the Hospital Code field. 

2 Enter a name of the CubeNote Control Server device in the Destination Name field. 

3 Enter an access ID of CubeNote Client in the ID filed. 

4 Enter a password of CubeNote Client in the Password field. 

5 Click Verify to verify the CubeNote Control Server connection. 
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Network 

The Network menu allows you to set up Internet protocol. You need a separate IP address for your 
system. 

 

NOTE 

To set up Internet Protocol, contact your hospital’s network administrator. 
 

❚ Local Area 

Specify the following IP address settings: 

• DHCP: Select the DHCP option for a dynamic IP address. 

• Use Following IP Address: Select this option to use a static IP address. 

– IP Address: Enter an IP address. 

– Subnet Mask: Enter the subnet mask. 

– Default Gateway: Enter the default gateway address. 

– Preferred DNS Server: Enter the preferred DNS server. 

– Alternate DNS Server: Enter the alternate DNS server. 

– Network Speed: Select the network speed. 

 
❚ Wireless 

To connect to the wireless network, 

1 Specify the IP address settings. 
 

NOTE 

The IP address settings are the same as the ones in Local Area menu. 

2 Select the desired SSID from the Wireless search list. 
 

NOTE 

The name of the connected wireless network must be English alphabet letters. 

3 Click Connect. 

4 Enter a password and click OK. 

 
You can see the connection status of wireless network by checking the icon in the status bar. 

Table 5-6 Wireless Network connection status 
 

Icon Description 

 

 

 

Disconnected to the USB Wireless module. 

 

 

 

Connected to the USB Wireless module but disconnected to the wireless network. 

 

 

 

Successfully connected to the wireless network. 
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DICOM (Digital Imaging and Communications in Medicine) 

DICOM is the abbreviation of Digital Imaging and Communications in Medicine. This is the industrial 
standard for communication of images and other information between medical devices on the network. 
Using the DICOM option, you can send or print images after connecting your ultrasound equipment and 
PACS. 

 

Common DICOM service parameters 

There are certain parameters that may need to be set up for each DICOM service. The parameters are 
described on the following DICOM services. 

 

NOTE 

• DICOM is an optional service. To use this service, you need DICOM installation. 

• To enter the connectivity screen, you must log in as an administrator. 

 
• DICOM Storage 

• DICOM Storage Commitment 

• DICOM Print 

• DICOM Worklist 

• DICOM MPPS 

• DICOM Q&R 

 
❚ Setting 

• Name: Enter a description for each service. 

• AE Title: Enter the Application Entity (AE) title of this service. 

• Port No: Enter a port number of the service. 

• Retry: Enter a maximum number of times to try when the system fails to connect to a destination 
device. 

• Retry Interval(s): Set the time interval of retry. 

• Timeout(s): Set the period of timeout when the retry connection is over. 

• Move AE Title: Enter the Application Entity (AE) title of this service. 
 

NOTE 

This parameter is only available for DICOM Q&R. If necessary, ask your PACS vendor for this 
information. 

• Move Port No: Enter a port number of this service. 
 

NOTE 

This parameter is only available for DICOM Q&R. If necessary, ask your PACS vendor for this 
information. 
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❚ Verify 

1 Select a destination. 

2 Click Verify to start verification. When the verification is completed, the one of the following 
icons is shown. 

 
Table 5-7 DICOM verification 

 

Icon Description 

 

 

 

Successfully connected 

 

 

 

Failed in connection 

 

 

 

In progress 

 
❚ View 

View allows you to view the connectivity architecture of your system such as configured DICOM 
service and network structured tree. 
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Storage 

DICOM Storage enables the system to send or receive ultrasound images in a format that can be 
interpreted by PACS. 

The Storage menu allows you to set up a DICOM Storage service. 
 

To add a DICOM storage device, 

1 Click New. 

2 Enter a name of the DICOM storage device in the Destination Name field. 

3 Enter a device’s IP address in the IP Address field. 

4 Enter the Application Entity (AE) title for a device in the AE Title field. 

5 Enter a port number in the Port No field. 

6 Click Verify to confirm the connection. 

7 Click OK. 

To remove a DICOM storage device, 

1 Select the destination name that you want to remove. 

2 Click Remove. 

3 Click Yes to confirm. 

 
❚ Properties 

• Enable Structure Report: Set to send a report with images. 

• Enable Raw data of Compact 3D/4D (Image Arena™): Set to send a 3D/4D image with raw data 
for Image Arena™. 

• Enable Multiframe: Set to save multi-frame cine images in the DICOM storage. 

• Compression: Select a default compression type. 

• Quality: Select a default image quality. 

• Monochrome: Set to send images in monochrome. If you select Monochrome or Color, you will 
be asked every time to determine sending images in monochrome or color. 

• Commitment: Set to receive notification from PACS when a study has been transferred 
successfully. When this option is enabled, you can specify the following information: 

– Properties: Select an associated storage. 

– Accepter: Specify the accepter’s settings such as AE title, port number, and timeout. 
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Print 

DICOM Print provides the ability to send or receive ultrasound image data to DICOM printers. 

The Print menu allows you to set up a DICOM Print service. 
 

❚ Properties 

• Format: Select a printing format that determines the number of images to be printed out in one 
page. 

• Priority: Select the printing job priority (HIGH, MED, or LOW). 

• Medium: Select a printing medium (CLEAR FILM, PAPER, or BLUE FILM). 

• Copies: Select the number of copies. 

• Orientation: Select a printing direction (LANDSCAPE or PORTRAIT). 

• Film Size: Select the dimensions of the film size (81NX101N or 101NX121N). 

• Film Destination: Select the film destination (MAGAZINE or PROCESSOR). 

• Magnification: Select how the print magnifies the image to fit it onto the film. 

– REPLICATE: Interpolate pixels are copied of adjacent pixels. 

– BILINEAR: Interpolate pixels are created by bilinear interpolations between the adjacent 
pixels. 

– CUBIC: Interpolate pixels are created by cubic interpolations between the adjacent pixels. 

– NONE: No interpolation 

• Trim: Set to show the trim box around images on the film (YES or NO). 

• Empty Image: Set how to show empty images (BLACK or WHITE). 

• Color: Select a color type (COLOR or GRAY). 

• Min Density: Enter the minimum density level of the film. 

• Max Density: Enter the maximum density level of the film. 

• Config. information: Enter a name of the specified image quality setting. 

• Film Session Label: Enter an organization name to be shown on the film label. 

• Smoothing Type: Select the printer’s magnification interpolation for the output. 

• Border: Select a border area between the images of the film (BLACK or WHITE). 
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Worklist 

DICOM Worklist provides a list of patients sorted by query parameters. 

The Worklist menu allows you to set up a DICOM Worklist service. 
 

Figure 5-16 Connectivity_Worklist Display 
 
 

To add a worklist, 

1 Click New. 

2 Enter a name of the DICOM storage device in the Destination Name field. 

3 Enter a device’s IP address in the IP Address field. 

4 Enter the Application Entity (AE) title for a device in the AE Title field. 

5 Enter a port number in the Port No field. 

6 Click Verify to confirm the connection. 

7 Click OK. 

To remove a worklist, 

1 Select the destination name that you want to remove. 

2 Click Remove. 

3 Click Yes to confirm. 
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❚ Search Criteria 

• DICOM Tag: Select information type that you want to define for search parameters such as 
Modality and Referring Physician’s name. 

• Value: Enter the value of the selected tag item. 

• Add to list: Add tag and value to the list of search criteria. 

• Remove: Remove tag and value to the list of search criteria. 

• Clear: Clear all tags from the list. 

 

MPPS (Modality Performed Procedure Step) 

DICOM MPPS provides the ability to send images to a DICOM server with transfer information. 

The MPPS menu allows you to set up a DICOM MPPS service. 

 

DICOM Q&R (DICOM Query/Retrieve) 

DICOM Query/Retrieve provides a list of patients sorted by query parameters. 

The DICOM Q&R menu allows you to set up a DICOM Query/Retrieve service. 
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Backup / Restore 
The Backup / Restore preset allows you to back up and restore the user data. You may lose user settings 
or patient information files such as patient’s basic information and scanned images because of physical  
shocks to the product or internal errors. Therefore, you should back up user settings and patient 
information data on a regular basis. 

You can select a storage media (CD, DVD, USB flash drive, USB hard disk, and network storage) to 
perform the backup. 

 

NOTE 

To save images permanently, avoid using the local hard disk. Regularly back up the image archive to a storage 

media. 

 
CAUTION 
Follow the suggested backup procedure in the manual. ALPINION MEDICAL SYSTEMS does not have the 
responsibility for data loss caused by the user’s carelessness. 

 

The Backup / Restore preset contains the following submenus: 

• User Backup 

• Image Backup 

• Full Backup 
 

 

User Backup 

The User Backup menu allows you to back up the each preset data. You can use a CD, DVD, USB flash 
drive and Local Archive for user preset backup. 

To select all user-defined presets, select the User Defined Configuration check box. 
 

• Image Preset: Set to back up or restore the Image preset only. 

• Service: Set to back up or restore the Service preset only. 

• Measurement: Set to back up or restore the Measurement preset only. 

• Annotation: Set to back up or restore the Text and Body Pattern preset only. 

• Connectivity: Set to back up or restore the Connectivity preset only. 

• Report: Set to back up or restore the Report only. 

• Others: Set to back up or restore other presets such as System and User settings. 
 

To back up the user preset data, 

1 Insert a blank media properly on your system. 

2 Select a media from the Media drop-down list. 

3 If you select USB from the Device drop-down list, enter the description in the Description field. 

4 Select the user preset you want to back up. 

5 Click Backup to start backup. The backup procedure begins. 

6 After the backup is completed, the last backup time and date appear next to the preset category. 
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To restore the user preset data, 
 

NOTE 

Make sure that the software version of the data is the same as the system’s software version. If NOT, you may 

not perform the restoration. 

1 Insert a media on your system. 

2 Select the user preset(s) you want to restore. 
If your media is USB flash drive, select the user preset(s) you want to restore from the backup list. 

3 Click Restore to start restoring. The restore procedure begins. 

 

Image Backup 

The Image Backup menu allows you to perform image backup using a storage media. Select your 
memory storage such as CD, DVD, USB flash drive, USB hard disk, and network storage. 

 
CAUTION 
• While restoring Image Archive data, some existing database may be overwritten on the local hard disk and 

you may not be able to restore the old data. Make sure that you use the appropriate media before the 
restoration proceeds. 

• Before restoring Image Archive, make sure that the software version is the same or compatible with the 
current system. The system may not proceed restoring if the version is different. 

• Do NOT turn the system off while backup is in progress. You may lose your image data. 

 
NOTE 

Use Restore on E-View to restore image data. 
 

❚ Media 

• Media: Select your default storage media. Available media are CD, DVD, USB flash drive, USB hard 
disk, and network storage. 

• Media Capacity: Select the media capacity. The system calculates the number of backup CDs that 
you need before performing the backup and informs you. 

 
❚ Image Archive Option 

• Backup period: Specify the starting and ending date to back up patient data for a certain period. 

• Image Move after Backup: Set to remove the backup image file after backup is completed. 

• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or DVD. 

• Finalization of CD/DVD: Set to finalize a CD or DVD after backup is completed. 

• Skip the data that has already backed up: Set to skip the data backup if the data has already been 
backed up. 

 

NOTE 

DICOMDIR is a DICOM file format which provides index and summary information for all the DICOM files on 
media. If you want to save studies to CD or DVD and view them on the PACS system, you should select this  
option. 
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To back up Image Archive, 

1 Configure Media. 

2 Configure Image Archive Option. 

3 Prepare unformatted CD(s). 

4 Click Backup to start backup Image archive. 
The media formatting starts and the instructional message appears. 

 
You can view and import backup media via E-View menu. 

 
To view the backup images, 

1 Insert your media. 

2 Go to E-View. 

3 Change the source to your media from the local hard disk. 

4 View the backup images of the study you want. 

 

Full Backup 
 

NOTE 

The USB hard disk drive is only available for the full preset backup. 

This full preset backup is for service purpose only. You can back up the system data such as user preset, 
image archive, and service configuration. 
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Administration 
The Administration preset contains the following submenus: 

• Service 

• Users 

• Options 

• System Info 

• Patient Data 
 

 

Service 

To activate the service browser, click Service Station. The Windows login screen appears. 
For more information, see the Service Manual. 

 

Users 

The Users menu allows you to define the user settings. 
 

To set the system to log on automatically, 

– Select the System Auto Login check box. 
 

To create a user ID, 

1 Click New. 

2 Enter a user ID in the ID field. You can enter up to 16 characters. 

3 Enter the patient information using the alphanumeric keyboard. 

4 Enter a new password in the New Password field. 

5 Enter the new password again in the Confirm field. 

6 Click OK to save your settings. 
 

NOTE 

• Use alphanumeric keys only for the user ID. Do not enter symbols such as asterisk (*), question mark (?), 
and slash (/). 

• After saving, you can edit all information except for the user ID. 

 
To delete a user ID, 

1 Select a user ID from the user list by using [Trackball]. 

2 Click Delete. 

3 Click Yes to save the changes. 
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To change the password, 

1 Select a user ID from the user list by using [Trackball]. 

2 Click Password. 

3 Enter the current password in the Old Password field. 

4 Enter a new password in the New Password field. 

5 Enter the new password again in the Confirm field. 

6 Click OK to save the changes. 

 

Options 

The Options menu allows you to view the status of optional functions that require license keys to be 
installed. The followings show the current status of the selected function. 

• Trial. 90 days remain.: The option is activated for 3 months after the activation. 

• Invalid: The option is not installed. 

• Permanent: The option is installed permanently. 
 

To add or delete a license key, go to Service Station. 

 

System Info 

The System Info menu allows you to view the current software and hardware versions of your system. 

 

Patient Data 

The Patient Data menu allows you to delete the patient data for a specified period. 

• Delete include Patient Information: Set to delete the patient information when you delete the 
patient data for a specified period. 
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Advanced Cardiac 
 

Protocol Editor 

The Protocol Editor preset allows you to manage protocols to be used for Stress Echo. You can add, copy, 
and delete protocols, stages, and views. 

 
❚ Adding a new protocol 

1 From the Protocols category, click Add. 

2 Enter a new protocol name and select OK. 

3 Select Add to add a new stage on the Stages category. 

4 Enter a stage name and specify the stage options (Capture mode, Clips per view, Preview, 
Capture length, Capture Delay(ms), Timer Type). 

5 Select OK. 

6 Select Add to add a new view on the Views category. 

7 Select a view name from the drop-down list and select OK. 

 
❚ Managing a protocol, stage, and view 

To change the order of the stages or views, 

– Select Up or Down to move a desired stage or view from the corresponding category. 
 

To copy a protocol, stage, or view, 

1 Select Copy to copy a desired protocol, stage, or view. 

2 Enter a name for the selection and select OK. 

To delete a protocol, stage, or view, 

1 Select Delete to delete a desired protocol, stage, or view. 

2 Select Yes to confirm the deletion. 

 

Image Compress 

The Image Compress menu allows you to set the compression strength of the stress echo images. 
Available options are High (30 %), Medium (50 %), Low (70 %), and Uncompress (100 %). 

 

Cube Strain™ 

The Cube Strain™ menu allows you to set the image capture time for the Cube strain™ function. 
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Image Preset 
The Image Preset allows you to configure the settings for displaying images and application-specific 
settings. 

 
The Image Preset contains the following submenus: 

• General 

• Application 

 
 

General Workflow 

Accessing Image Preset menus 

To access the Image Preset menu, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the ImagePreset tab on the touch screen. Or press the [Image Preset] key on the QWERTY 
keyboard. 
The Image Preset screen appears. 

 

Changing Image Preset parameters 

To change the Image Preset parameters, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the ImagePreset tab on the touch screen. Or press the [Image Preset] key on the QWERTY 
keyboard. 
The Image Preset screen appears. 

4 Select the preset menu on the touch screen. 

5 Select the desired transducer from the transducer list. 

6 Select the desired application from the application list. 

7 Change values for the parameters you want to change. 
To change a parameter, do one of the following: 

– Select the value from a dop-down list. 

– Select or clear a check box. 

8 When you have finished, click Save & Exit to save the changes and return to scanning. 
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Exiting Image Preset 

There are several methods to exit Image Preset. 

– Click Save & Exit or Exit. 

– Press the [Image Preset] on the QWERTY keyboard. 

– Press the [2D] key on the control panel. 
 

 

Creating a New Preset 

You can create a new preset by pressing NewPreset on touchscreen or [F7] key on the QWERTY 
keyboard. Once you have added a new preset, it appears in the application list of the transducer 
selection page, the Patient screen, and the Image Preset screen. This function is useful when you want 
to use user-defined presets easily. 

 
To create a new preset, 

1 Adjust the image parameter settings as you want, and then press the Utility > NewPreset on 
touchscreen or [F7] key on the QWERTY keyboard. 

2 Select the application that you want to add from the Application list. 

3 Enter a preset name in the Preset Name field. 

4 To show the automatic preset selection when you change the transducer, select the Automatic 
Preset selection when changes the transducer check box. 

5 Select Library Setting to assign default Measurement, Annotation, Body Pattern library for the 
preset. 

6 Select the library from the Body Pattern, Annotation and Measurement list. 

7 When you have finished, click OK. 

 
To overwrite an existing preset, 

1 Adjust the image parameter settings as you want, and then press Utility > NewPreset on 
touchscreen or the [F7] key on the QWERTY keyboard. 

2 Select the application that you want from the Application list. 

3 Enter the preset name that you want to overwrite on the Preset Name list. 

4 To show the automatic preset selection when you change the transducer, select the Automatic 
Preset selection when changes the transducer check box. 

5 When you have finished, click OK. 

6 Click Yes to confirm. 
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To delete a preset, 

1 Press Utility > Setup > ImagePreset on touchscreen or [Image Preset] key on the QWERTY 
keyboard. 

2 Select the preset that you want to delete from the Preset Name list, and then press the Delete 
Preset soft key. 

3 When the Delete dialog box appears, click Yes to confirm. 
 

NOTE 

The default presets cannot be deleted. 
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General 
The General menu allows you to configure the settings for displaying images. 

 

Figure 5-17 Image Preset_General Display 
 
 

• Hide Parameter: Hide the image information. 

• Show Khz Scale: When selected, displays the kHz scale on the left side of the Doppler spectrum. 

• Show M/D Cursor: Select to display M/D cursor in 2D mode. 

• Auto Angle Enable: Select to keep the angle constant with regard to the anatomy. 

• Auto Invert of Color and Spectrum: When selected, the Doppler timeline scale inverts along with the 
color ROI. 

• TGC Invert with Image Invert: When inverting the image, TGC curve is inverted simultaneously. 

• Join dual image for linear: Select to place linear transducer dual images directly next to each other. 

• Freeze Scan Image in dual: Select to carry over the live image’s imaging parameters to the other 
image after pressing [Freeze] key. 

• HPRF Enable: Select whether to enable HPRF, which is supported in PW Spectral Doppler mode. 

• Keep width in near depth image(linear): Show the full image of the linear transducer. When the sides 
of an ultrasound image are not visible at a low depth, use this function to view the entire image. 

• Horizontal Scale (Linear): Select to display width markers. 

• TGC Curve Display: Select to display TGC curve. 

• Auto Freeze(min): Automatically freezes the system after few minutes of inactivity. 

• Live Dual Default Layout: Select to set up the Live Dual default layout. 

• Live Dual Direction: Select to set up the Live Dual direction. 
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❚ Cine Loop Store 

• Application: Select the application to configure cine loop store from application list. 

• Cine Time Span(no ECG)[s]: Select the number of seconds of cine loop storage. The default is 3 
seconds. 

• Number of heart cycles: Select the number of heart cycles to store. 

• Cine Loop Store: Select to store a cine loop retrospectively or prospectively. (Prospective or 
Retrospective) 

 
❚ Probe Status 

• Probe Status Check: Select to check probe element status when changing probe. 

• Keep Probe Status Alert Messages: Select to display Probe status alert message when there is any 
failure on probe element. 

 
❚ Biopsy Guides 

• Show Center Lines: Display center biopsy guideline. 

• Show Outer Lines: Display outer biopsy guidelines. 

• Enable 0.5cm markers: Activate biopsy depth markers every 0.5cm. 

• Show Biopsy Mark on Simultaneous Mode: Display the Biopsy Guideline on the image while in 
Simultaneous Mode. 

 
❚ MI / TI 

Set the display of mechanical and thermal indices (MI/TI) for each application. 

• MI: Mechanical Index 

• TIB: Bone Thermal Index 

• TIC: Cranial Thermal Index 

• TIS: Soft Tissue Thermal Index 
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Application 
The Application menu allows you to specify the default application to be shown when the system starts 
up. You can also configure the default settings of transducer. 

 

Figure 5-18 Image Preset_Application Display 
 
 

❚ Configuration for Selected Transducer 

To specify a default application per transducer which starts automatically, 

1 Select the transducer from the Transducer drop-down list. 

2 Select the application from the Default Preset drop-down list. 

❚ Configuration Application 

To specify applications per transducer, 

1 Select the transducer from the Transducer drop-down list. 

2 Select application(s) from the User Preset list. 

3 If necessary, you can change the order of the applications. 
Applications are listed in the order in which they are displayed on the touch screen. 

– To change the order of the applications, select the application and click Up, Down, Top or 
Bottom. 

– Click Empty to make an empty space on the touch screen. 

 
❚ ECG Display 

Enable or disable ECG for each application. 



5-62 Customizing the System 

 

 

 



 

 

 

 

6 
Imaging Modes 

 
 
 

 

This chapter describes the general functions of the imaging modes. 
 
 

2D Mode .......................................................................................................... 6-2 
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Color Flow (CF) Mode .................................................................................... 6-22 

Power Doppler (PD) Mode ............................................................................ 6-32 

Micro Vascular Imaging (MVI) ....................................................................... 6-39 

Pulsed Wave Doppler (PWD) Mode .............................................................. 6-41 

Continuous Wave Doppler (CWD) Mode ....................................................... 6-50 

Tissue Doppler Imaging (TDI) Mode .............................................................. 6-55 

3D/4D Modes ................................................................................................ 6-57 
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2D Mode 
In 2D mode ultrasound, your transducer simultaneously scans a plane through the body that can be 
viewed as a two-dimensional image on the screen. Two-dimensional images and measurements of the 
anatomical structures of soft tissues such as internal organs and vascularities can be determined. 

 
 

2D Mode Display 
 

Figure 6-1 2D Mode Display 
 
 

 

General Workflow 

To perform an examination using 2D mode, 

1 Press the [2D] key on the control panel to start 2D mode. 

2 Use the following controls for image optimization: 

– [2D] key (rotate to adjust 2D mode gain) 

– [Depth] and [Focus] keys 

– TGC slide controls 
 

NOTE 

To reset the current image settings, press the [Initial] key on the QWERTY keyboard or Initial key on 
user-defined key. 

3 Use additional soft keys, if necessary. 

4 To enter another imaging mode, press the corresponding mode key. 

5 Press the [2D] key to return to 2D mode from another imaging mode. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

 

 

Figure 6-2 2D Mode Touch Screen 
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Gain 
 

Increase or decrease in the amount of echo information displayed in an image. It may have the effect of 
brightening or darkening the image if sufficient echo information is generated. 

 

❚ Adjusting the gain 

Increase or decrease the sensitivity of the instrument. You can use two controls to adjust gain: The 
overall gain control and TGC. To increase or decrease overall gain, rotate the [2D] key on the control 
panel. 

 
❚ Gain values 

Gain is shown as Gn on the display. Gain values may vary depending on the transducer, application, 
and frequency setting. 

Gain values are returned to the factory or user preset value when you change one of the followings: 
Transducer, application, or new patient. 

 
❚ Remarks 

Commonly, you need to decrease the gain when you increase the Power Output; to increase the gain, 
decrease the power output. Gain and TGC interact by adding together. 

 

Depth 

Increasing the depth enables the deeper structures to be visualized. You can decrease the depth if you 
do not need the bottom portion of the display. 

 

❚ Adjusting Depth 

To increase or decrease the depth, rotate the [Depth] key clockwise or counter- clockwise on the 
control panel. You can see the display and image parameters are automatically changed. 

 
❚ Depth values 

Maximum and minimum depth selections are dependent on the frequency of the transducer you are 
currently using. 

 
NOTE 

• You might adjust TGC and focus with depth adjustment. Adjusting depth erases real-time calculations 

of the graphic on the screen (but not the completed results on the worksheet page). 

• Incrementing depth depends on what transducer and application you use. When you change the 
transducer, application, preset, or click New Patient on the Patient screen, depth parameters are set to 
the factory or user preset settings. 

 
Xpeed™ 

Xpeed™ is an auto-optimizing technology that enables you to easily adjust an image’s the contrast 
resolution and brightness uniformity. For using this feature, you need an additional request to your local 
agent. 

 

❚ Activating Xpeed 

To activate or deactivate Xpeed, press Xpeed key on user-defined key or press the [Xpeed] key on the 
QWERTY keyboard. 



2D Mode 6-5 

NOTE 

 

 

To assign the Xpeed function to user-defined key, go to Utility > Setup > System > User Setting > User 

Defined key > Assign User Key or Assign Numeric Key and select the Xpeed. 

 

Time Gain Compensation (TGC) 

To compensate for weak signals or over-bright signals at various depths, you can adjust Time Gain 
Compensation (TGC) using the TGC slide controls on touch screen. The 2D control adjusts the overall 
receiver gain and compensates for the brightness of the image. 

 

❚ Adjusting TGC 

TGC slide control selectively adjusts the sensitivity (brightness) in depth. 

– Slide the slide control to the left to decrease the gain in the corresponding specific 2D depth. 

– Slide the slide control to the right to increase the gain in the corresponding specific 2D depth. 
 

❚ TGC values 

TGC compensates for attenuation in tissue by increasing the receiver gain as a function of time 
following each transmit pulse. 

 
❚ Centerline Positioning 

When selecting Center on touch screen, controlled TGC slide returns to centerline. 
 

NOTE 

The last TGC curve setting for each preset/probe is saved. 

 

Focus 

Convex array, linear array, and phased array transducers support multiple transmit focus zones, which 
you can select in 2D-mode images. Focal zone markers display on the left side of the image screen. 

 

❚ Focus Num 

Focus Num is used to control the number of focal points. 

• Adjusting Focus Num 
To increase or decrease the number of focal zones, press the [Focus] key on the control panel and 
then rotate the key clockwise or counter-clockwise. 

• Focus Num values 
Focal zone number may vary depending on the depth, zoom, transducer, application, and selected 
frequency setting. Focus Num values are returned to the factory or user preset value when you 
change one of the followings: Transducer, application, or new patient. 
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❚ Focus Pos 

Focus Pos is used to change the location of the focal point. A triangular focus marker indicates the 
depth of the focal point. 

• Adjusting the focus position 
To move the focal zone to the near/far field, rotate the [Focus] key on the control panel. 

• Focus Pos values 
Focal zone position may vary depending on the depth, zoom, transducer, application, and selected 
frequency setting. 

 
❚ Remarks 

Using multiple focal zones causes a reduction in the frame rate. The amount of frame rate reduction 
depends on the depth of view and the transducer. 

 

Dual/Quad Imaging 

Using Dual (or Quad) imaging, you can view two (or four) images at the same time on the display. Dual or 
quad imaging is available in all 2D live imaging modes, M mode, Color Flow mode, and TDI mode. 

 

❚ Activating Dual/Quad imaging 

To activate and exit the image layout, 

1 In 2D mode, Color Flow mode, or M mode imaging, press the [Dual] (or [Quad]) key on the 
control panel. The image is shown on the left of the display. 

2 Press the [Dual] (or [Quad]) key again to activate the second image. 

3 To switch between the two (or four) images, press the [Dual] (or [Quad]) key. 

4 Press the [2D] key to exit the dual (or quad) imaging. 

 

Priority 

The priority function has the following two options: Width, Tilt 
 

❚ Width 

Control the size or angle width of the 2D image sector. A smaller angle generally produces an image 
with a higher frame rate. 

You can widen or narrow the size of the sector angle to maximize the image's region of interest (ROI). 

• Adjusting the width 
To narrow or widen the ROI, press the [Priority] key on the control panel. Width is highlighted in 
the message line. Move [Trackball] left or right to decrease or increase the angle size. Then, press 
the [Priority] key to set the region of interest (ROI). 

• Width values 
Width values may vary depending on the transducer (not applicable for linear transducers) and 
application. 

 

❚ Tilt 

After the size or angle width of the 2D image sector is set, you can steer the image sector by using the 
tilt option. Press the [Priority] key to select the tilt function. Then move [Trackball] to tilt the angle. 
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NOTE 

 

 

The priority function may not be available with linear transducers. 

 

Up/Down (If Preset) 

Up/Down allows you to flip the image 180 degrees up/down. 
 

❚ Activating Up/Down 

To flip the image vertically, press the U/D Flip key on user-defined key. 
 

NOTE 

To assign the Up/Down flip function to user-defined key, go to Utility > Setup > System > User Setting > 

User Defined key > Assign User Key or Assign Numeric Key and select the U/D Flip. 

 
❚ Up/Down values 

Up/Down values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. 

 

Angle Steer 

In 2D mode, you can tilt an image left or right by using a linear transducer. 
 

❚ Adjusting Angle Steer 

To adjust the angle steer, rotate the [Angle] key clockwise or counter- clockwise on the control panel. 
The each level of the angle increment/decrement is 5 degrees. 

 

NOTE 

This function may not be available when Virtual Convex is applied to the current image. 

 

Reverse 

Reverse allows you to flip the image 180 degrees left/right. 
 

❚ Activating Reverse 

To flip the image horizontally, press L/R Flip key on user-defined key or press the  key on the 
QWERTY keyboard. 

 

NOTE 

To assign the Left/Right flip function to user-defined key, go to Utility > Setup > System > User Setting > 

User Defined key > Assign User Key or Assign Numeric Key and select the L/R Flip. 
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Harmonic 

Tissue Harmonic Imaging (THI) is a system feature that can enhance the contrast resolution with fine 
tissue differentiation, benefiting patients with poor images. THI creates images from received signals 
using the harmonics of the transmitted frequency. 

For certain applications, Filtered THI (FTHI) can be used to optimize temporal resolution. The frame rate 
of FTHI is higher than THI between similar images. To use the FTHI function, you need an additional 
request to your local agent. 

 
For certain applications, Pulse Inversion THI (PTHI) can be used to optimize lateral and contrast 
resolution. The frame rate of PTHI is half of THI between similar images. To use the PTHI function, you 
need an additional request to your local agent. 

 

❚ Adjusting FTHI 

To adjust FTHI, 

1 Select Harmonic on the touch screen. 2D HAR appears next to 2D image parameters. 

2 To change the frequency of FTHI, rotate the Frequency soft key clockwise or counter-clockwise. 

3 To exit THI, select Harmonic again. 
 

❚ Adjusting PTHI 

To adjust PTHI, 

1 Press INV on the touch screen. 2D INV appears next to 2D image parameters. 

2 To change the frequency of PTHI, rotate the Frequency soft key clockwise or counter-clockwise. 

3 To exit THI, slect INV again. 

 
❚ Harmonic values 

Harmonic values are On and Off. 
 

NOTE 

Changing multi-frequency resets those parameters which are presettable by frequency to their preset 

values for the current harmonic frequency. Multi frequency values are returned to the factory or user 
preset value when you change one of the followings: Transducer, application. 

 

TDI (Tissue Doppler Imaging) 

TDI switches to Tissue Doppler Imaging (TDI) mode. For more information on Tissue Doppler Imaging 
(TDI), see "Tissue Doppler Imaging (TDI) Mode" on page 6-55. 

 

❚ Activating TDI 

To switch to TDI mode, select TDI on the touch screen. 

 
❚ TDI values 

TDI values are On and Off. 
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Live Dual 

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time. 

 

Figure 6-3 Live Dual Display 
 

The following combination imaging modes are available: 

– 2D(BW), 2D(BW) 

– 2D(BW), Color Flow(CF) 

– 2D(BW), Power Doppler(PD) 

– Color Flow(CF), 2D(BW) 

– Power Doppler(PD), 2D(BW) 
 

NOTE 

You can set up the Live Dual Default Layout in Image preset menu. In Live Dual, the current imaging mode 
takes priority over the default layout values. 

 

❚ Activating Live Dual 

To activate Live Dual, select Live Dual on the touch screen. You can change the imaging mode by 
pressing the [CF] key. 

 

NOTE 

Live Dual may not be available when the image is frozen or rotated 90/270 degrees. 

 
❚ Live Dual values 

Live Dual values are On and Off. 
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Virtual Convex 

On linear transducers, Virtual Convex provides a larger field of view in the far field. 
 

❚ Activating Vrtual Convex 

To activate Virtual Convex, select Virtual on the touch screen. The rectangular frame provided by a 
linear transducer is changed to a trapezoidal shape. 

To deactivate Virtual Convex, select Virtual again. 

 
❚ Virtual Convex values 

Virtual Convex values are On and Off. Virtual Convex allows for a wider field of view. This is available in 
2D mode, Color Flow mode, and Doppler mode. 

 

Line Density 

Line Density optimizes 2D mode frame rate or spatial resolution for the best possible image. A lower 
line density is useful in fetal heart beat, adult cardiac applications and in clinical Radiology applications 
requiring significantly higher frame rates. A higher line density is useful in obtaining very high resolution 
(e.g. thyroid, testicles). 

 

❚ Adjusting the line density 

Line Density changes the vector density and frame rate. To adjust the line density, select < or > of 
LineDensity on the touch screen. 

 
❚ Line Density values 

Line Density values may vary depending on the transducer and application. The values are returned 
to the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. A lower line density is useful in fetal heart beat, and adult cardiac. 

 

Full SRI™ 

Full SRI™ is a more powerful SRI feature that allows you to adjust the SRI level according to your image 
condition or imaging mode. The full SRI feature is available in 2D, 3D, and 4D modes. For using this 
feature, you need an additional request to your local agent. 

 

❚ Adjusting Full SRI 

To adjust Full SRI, select < or > of FullSRI on the touch screen. 

 
❚ Full SRI values 

Full SRI values are 0 to 10. 
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Spatial Compound 

Spatial Compound allows you to combine different steering frames to form a single frame at real-time 
frame rates. 

 

❚ Adjusting the spatial compound 

To adjust the spatial compound, select < or > of Spt.Comp on the touch screen. 

 
❚ Spatial Compound values 

Spatial compound values may vary depending on the transducer and application. The values are 
returned to the factory or user preset value when you change one of the followings: Transducer, 
application, or new patient. 

 

NOTE 

The spatial compound function may not be available with phased array transducers. 

 

Rotation 

In 2D mode, you can rotate an image clockwise by 90 degrees. 
 

❚ Adjusting the rotation 

To adjust the rotation, select < or > of Rotation on the touch screen. 

 
❚ Rotation values 

Rotation values are 0, 90, 180, and 270. 

 

S-FOV 

On convex transducers, S-FOV provides larger field of view in the far field. 
 

❚ Activating S-FOV 

To activate or deactivate S-FOV, select  on the touch screen. 

 
EX-FOV 

On endocavity transducers, EX-FOV provides wide angle field of view. 
 

❚ Activating EX-FOV 

To activate or deactivate EX-FOV, select on the touch screen. 
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Sepia 

Sepia function is used to activate the sepia map. 
 

❚ Activating the sepia map 

To activate or deactivate the sepia map, select Sepia on the touch screen. 

 
❚ Sepia values 

Sepia values are On and Off. 

 

PRF (Pulse Repetition Frequency) 

In Multi-frequency mode, PRF function is s used to reduce noise artifacts in the image. When you 
activate PRF, the frame rate decreases and the noise artifacts are filtered. 

 

❚ Activating PRF 

To activate or deactivate PRF, select PRF on the touch screen. 

 
❚ PRF values 

PRF values are On and Off. 

 

VelocityUs 

VelocityUS allows you to change the transmitted speed of sound for various tissue types. 
 

❚ Adjusting VelocityUS 

To adjust the transmitted speed of sound, select < or > of VelocityUS on the touch screen. 

 
❚ VelocityUS values 

VelocityUS values are 1460, 1480, 1500, 1520, and 1540. 
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Frequency 

You can adjust the operating frequency of the transducer. The selected frequency is displayed in the 
Image Parameter. 

Changing the frequency value on the display is selecting different transmit patterns associated with that 
value, including transmit pulse shape, frequency and transmit sequence. 

 

❚ Adjusting the frequency 

To adjust the frequency, rotate the Frequency soft key clockwise or counter-clockwise. 
 

NOTE 

Changing the frequency may not be available when the image is frozen. 

 
❚ Frequency values 

Frequency values may vary depending on the transducer and application. 
The values are returned to the factory or user preset value when you change one of the followings: 
Transducer, application, or new patient. 

 

Dynamic Range 

Dynamic Range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. 

 

❚ Adjusting the dynamic range 

To adjust the dynamic range, rotate the DR soft key clockwise or counter-clockwise. 
 

NOTE 

When the dynamic range is set high, the image is softer and more low-level data is visible. 

 
❚ Dynamic Range values 

Dynamic Range values are 30 dB to 320 dB. Dynamic Range operates in real-time, freeze, Cine, and 
Cine timeline, but is not available during the VCR playback. It also affects Gain. 
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Gray Map 

Gray Map provides you with the system maps for 2D, M, and Doppler modes. 
 

❚ Adjusting the gray map 

To adjust the gray map, rotate the Gray Map soft key to clockwise or counter-clockwise. 

 
❚ Gray Map values 

Gray maps gradually change from the least contrasty or softest to the most contrasty. Gray Map values 
may vary depending on the transducer. 

 

Colorize 

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. 

 

❚ Adjusting the colorize 

To adjust the colorize, rotate the Colorize soft key clockwise or counter-clockwise. 

 
❚ Colorize values 

Colorize values are 0 to 42. 

 

Image Size 

Image SIze allows you to specify the 2D image size. 
 

❚ Adjusting the image size 

To adjust the image size, rotate the Image Size soft key clockwise or counter-clockwise. 

 
❚ Image Size values 

Image Size values are 70% to 130%. The each level of increment/decrement is 5 percentage. 

 

Reject 

Low echo information will not be displayed on the screen below the adjusted rejection level. 

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display. 

 

❚ Adjusting the rejection 

To adjust the rejection values, rotate the Reject soft key clockwise or counter-clockwise. 
 

NOTE 

When you increase the rejection, low-level echoes are rejected and appear in the 2D image. 

 
❚ Reject values 

Reject values are 0 to 10. 
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Power 

Power controls the amount of acoustic power applied in all modes. 
 

❚ Adjusting the power 

To adjust the power, rotate the Power soft key clockwise or counter-clockwise. 

 
❚ Power values 

Power values are 1 to 100. 

 

Edge Enhance 

Edge Enhance demonstrates subtle tissue differences and boundaries by enhancing the gray scale 
differences corresponding to the edges of structures. This function allows your system to display the 
outline of tissues or an organ more clearly. 

 

❚ Adjusting Edge Enhance 

To adjust Edge Enhance, rotate the Edge Enhance soft key clockwise or counter-clockwise. 
 

NOTE 

Edge Enhance may not be available in freeze mode or in Cine mode. 

 
❚ Edge Enhance values 

Edge Enhance values are 0 to 10. 

 

Persist 

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. 

 

❚ Adjusting the persistence 

To adjust the persistence, rotate the Persist soft key clockwise or counter-clockwise. 

 
❚ Persist values 

Persist values may vary depending on the transducer and application. The values are returned to the 
factory or user preset value when you change one of the followings: Transducer, application, or new 
patient. 
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M Mode 
The M mode display is formed by using a stationary ultrasound beam, yielding distance/motion versus 
time information for reflections along a single ultrasound beam line. M mode provides a display format 
and measurement capability that represents tissue displacement (motion) occurring over time along a 
single vector. 

In M mode, you can learn the movement of an area of anatomy. First, you position the M-line in the 2D 
image on the anatomy of Interest. Then you can display information about movement along that line in 
M mode trace. M mode trace can be helpful when you perform measurements, especially measuring the 
heart rate. 

 
 

M Mode Display 
 
 

 

Figure 6-4 M Mode Display 
 
 

 

General Workflow 

To perform an examination using M mode, 

1 On the control panel, press the [M] key to activate M mode. 

2 Move the M-line to the anatomy of interest by using [Trackball]. 

3 Rotate the [M] key to change the initial gain for M mode. 

4 To change the sweep speed, select < or > of Sweep on the touch screen. 

5 To review the M mode trace, press the [Freeze] key, and use [Trackball] to scroll forward or 
backward. 

6 To exit M mode, press the [2D] key. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

Figure 6-5 M Mode Touch Screen 
 
 

Gain 
 

With the Gain control, you can adjust the brightness of M mode image. The adjustment of the Gain 
control determines the amount of amplification applied to the received echoes. All received echoes are 
amplified with the same gain value regardless of the scan depth. The M Gain function influences the M 
trace only. 

To adjust the brightness of the entire image, rotate the [M] key on the control panel. 

• Rotate the [M] key clockwise to increase the brightness. 

• Rotate the [M] key counter-clockwise to decrease the brightness. 

 

Frequency 

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 6-13. 

 

TGC Slide Controls 

In M mode, the TGC slide controls have the same functions in 2D mode. See "Time Gain Compensation 
(TGC)" on page 6-5 for more information. 

 

Depth 

In M mode, the depth function is the same as the one in 2D mode. See "Depth" on page 6-4 for more 
information. 
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Cine 
 

In M mode, image trace information can be recalled. When freezing an image, a certain time frame 
(M information of the last examination sequence) is stored in the loop memory. The sequence can be 
reviewed second by second. 

 

Full Timeline 

Full Timeline expands the display to full timeline display. 
 

❚ Activating the full timeline 

To activate or deactivate the full timeline, select Full M on the touch screen. 

 
❚ Full Timeline values 

Full Timeline values are On and Off. 

 

Display Format 

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. 

 

❚ Adjusting the display format 

To adjust the display format, select < or > of Display Format on the touch screen. 
 

NOTE 

This function can not be adjusted when Full M is activated. 

 
❚ Display Format values 

Display Format values are as follows: Vert. 1:1, Vert. 1:2, Vert. 2:1, Horiz. 1:1, Horiz. 1:2, Horiz. 2:1. 

 

Power 

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 6-15. 

 

Dynamic Range 

Dynamic Range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 6-13. 

 

Gray Map 

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 6-14. 



M Mode 6-19 

 

 

Sweep Speed 

During M mode imaging, you can adjust the sweep speed of the display. 
 

❚ Adjusting the sweep speed 

To increase or decrease the sweep speed, rotate the Sweep soft key clockwise or counter-clockwise. 

 
❚ Sweep Speed values 

Sweep Speed values are 0 to 6. 

 
❚ Remarks 

You can speed up or slow down the timeline to see more or fewer occurrences over time. 

 

Colorize 

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 6-14. 

 

Reject 

Low echo information will not be displayed on the screen below the adjusted rejection level. 

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display. 

For adjusting the rejection, see "Reject" on page 6-14. 

 

M Mode zoom 

When the system is in M mode, you can magnify a portion of the reference image using M mode zoom 
function. 

To adjust the M mode zoom, 

1 In M mode or 2D mode with the M-line displayed, press the [Zoom] key on the control panel to 
activate Write zoom. To activate Read zoom, rotate the [Zoom] key. 

2 Use [Trackball] to position the zoom box and M line in the zoomed image, and press the [Set] key. 

3 Use [Trackball] to adjust the size of the zoom box, and press the [Set] key. 

4 To zoom out, press the [Exit] key. 
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Anatomical M Mode 

Anatomical M mode allows you to move or rotate an M line and review an image on the desired region. 
For using this feature, you need an additional request to your local agent. 

 
 

 

Figure 6-6 Anatomical M Mode Display 
 

To activate Anatomical M mode, 

1 In M mode, select Anatomical M on the touch screen. 
The cursor line of the Anatomical M mode appears in the middle of a 2D image. 

2 Use [Trackball] to move the cursor line (left/right/up/down). 

3 Rotate the [Angle] key on the control panel to rotate the angle. 
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M color mode 

M color mode is a combination mode of M mode and Color Flow mode which color flow information 
overlays the M mode image by using the velocity and color map. The color flow wedge is shown on 
the M-mode timeline. The color map in this mode is the same as in Color Flow mode, but the size and 
position of the color flow window depends on the 2D mode image. 

 
 

 

Figure 6-7 Color M Mode Display 
 

To activate M color mode, 

1 Press the [M] key, and then press the [CF] key. 

2 To switch to Color Flow mode, press the [M] key. 
To return to M color mode, press the [M] key again. 
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Color Flow (CF) Mode 
Color Flow mode is useful when you see the flow in a broad area. Color flow allows visualization of the 
flow in the CF ROI whereas Doppler mode provides spectral information in a smaller area. 

Color Flow mode is also used as a stepping stone to Doppler mode. Use Color Flow mode to locate flow 
and vessels before activating Doppler mode. 

 
 
 

CF Mode Display 
 

Figure 6-8 CF Mode Display 
 
 

 

General Workflow 

To perform an examination using CF mode, 

1 Press the [CF] key on the control panel. The CF window appears over the 2D mode image. 

2 Move the cursor to the CF window by using [Trackball]. 

3 Use [Trackball] to change the position of the color ROI. 

4 Press the [Set] key and use [Trackball] to change the size of the color ROI. 

5 Press the [Set] key to move the color ROI to the left or right. 

6 Press the [Freeze] key to hold the image in the memory. 

7 Record color flow images, if necessary. 

8 To exit Color Flow mode, press the [CF] or [2D] key. 
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The combination imaging modes of Color Flow Mode and Power 
Doppler Mode 

The following combination imaging modes are available: 

– 2D mode with Color Flow or Power Doppler 

– 2D mode with color and zoom 

– 2D/Doppler mode with Color Flow or Power Doppler 
 

Color Flow Imaging Parameters 

Use the ultrasound system controls and soft key selections to change the settings for imaging 
parameters. The system increases the lighting intensity of the control or key associated with the active 
function. 

 

Positioning, sizing, and steering the ROI 

When you press the [CF] key in 2D mode, the color window or ROI appears on the image. 

The initial location and the shape of the window depend on the active transducer and default imaging 
depth. 

 

Changing the size and position of the color ROI 

1 Press the [CF] key on the control panel. The system places the ROI, outlined in solid yellow, on the 
image. 

2 Use [Trackball] to reposition the ROI. 

3 To resize the ROI, press the [Set] key and move [Trackball]. The system outlines the ROI with a 
dotted yellow line with solid corners. 

4 Press the [Set] key to set the size. 

5 To exit Color Flow mode, press the [CF] or [2D] key. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

Figure 6-9 CF Mode Touch Screen 
 
 

Gain 
 

Gain amplifies the overall strength of echoes processed in the Color Flow window or spectral Doppler 
timeline. 

 

❚ Adjusting the gain 

– Rotate the [CF] key clockwise to increase the gain; rotate the key counter- clockwise to decrease 
the gain. 

– Rotate the [CF] key to adjust the receive gain for color without affecting the 2D mode image gain. 
 

❚ Gain values 

Gain values may vary by transducer, application, and multi-frequency setting. Gain value is shown as 
Gn on the display. Gain values are returned to the factory or user preset value when you change one 
of the followings: Transducer, application, or new patient. 
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TDI (Tissue Doppler Imaging) 

TDI switches to Tissue Doppler Imaging (TDI) mode. For more information on Tissue Doppler Imaging 
(TDI), see "Tissue Doppler Imaging (TDI) Mode" on page 6-55. 

 

❚ Activating TDI 

To switch to TDI mode, select TDI on the touch screen. 

 
❚ TDI values 

TDI values are On and Off. 

 

X+ MicroView (Micro Vascular Imaging) 

X+ MicroView switches to Micro Vascular Imaging (MVI) mode. For more information on Micro Vascular 
Imaging (MVI), see "Micro Vascular Imaging (MVI)" on page 6-39. 

 

❚ Activating MVI 

To switch to MVI mode, select X+ MicroView on the touch screen. 

 
❚ MVI values 

MVI values are On and Off. 

 

PD (Power Doppler Imaging) 

PD switches to Power Doppler Imaging mode. For more information on Power Doppler Imaging mode, 
see "Power Doppler (PD) Mode" on page 6-32. 

 

❚ Activating PD 

To switch to PD mode, select PD on the touch screen. 

 
❚ PD values 

PD values are On and Off. 

 

Live Dual 

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time. For activating or adjusting the Live Dual, see "Live Dual" on page 6-9. 

 

Variance 

Variance allows you to select variance color maps. 

 
❚ Activating Variance 

To activate or deactivate variance color maps, select Variance on the touch screen. 

 
❚ Variance values 

Variance values are On and Off. 
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Color Only 

Color Only hides the 2D image from the display so that you can see the color image only. 
 

❚ Activating Color Only 

To activate or deactivate Color Only, select ColorOnly on the touch screen. 

 
❚ Color Only values 

Color Only values are On and Off. 

 

Hide Color 

Hide Color hides the color image from the display so that you can see the 2D image only. 
 

❚ Activating Hide Color 

To activate or deactivate Hide Color, select Hide Color on the touch screen. 

 
❚ Hide Color values 

Hide Color values are On and Off. 

 

Angle Steer 

You can tilt the ROI of the color flow image to the left or right by using a linear transducer. 

❚ Adjusting Angle Steer 

To adjust the angle steer, select < or > of Angle Steer on the touch screen. The each level of the angle 
increment/decrement is 5 degrees. 

 

NOTE 

This function may not be available when the virtual convex function is applied to the current image. 

 

Line Density 

Line Density optimizes the Color Flow mode frame rate or spatial resolution for the best possible 
color image. A lower line density is useful in fetal heart beat, adult cardiac applications and in clinical 
Radiology applications requiring significantly higher frame rates. A higher line density is useful in 
obtaining very high resolution (e.g. thyroid, testicles). 

 

❚ Adjusting the line density 

To adjust the line density, select < or > of LineDensity on the touch screen. 

 
❚ Line Density values 

Line Density values may vary depending on the transducer and application. The values are returned 
to the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. A lower line density is useful in fetal heart beat, and adult cardiac. 
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Flow State 

Flow State adjusts the PRF of the color image. 
 

❚ Adjusting the flow state 

To adjust the flow state, select < or > of Flow State on the touch screen. 

 
❚ Flow state values 

Flow state values are Low, Mid, and High. The flow state values may vary depending on the transducer 
and application. 

 

Blend 

Blend superimposes a translucent color image over a 2D image in the color image area. You can adjust 
the transparency of the color image to demonstrate the tissues behind the color. 

 

❚ Activating Blend 

To activate or deactivate Blend, select Blend on the touch screen. 

 
❚ Blend values 

Blend values are On and Off. 

 
❚ Remarks 

If you activate Blend, Blend Level is enabled on the touch screen. 

 

Blend Level 

Blend Level allows you to specify the blending ratio between the 2D image and the color image. 
 

❚ Adjusting the blend level 

To adjust the blend level, select < or > of Blend Level on the touch screen. 

 
❚ Blend Level values 

Blend Level values are 1 to 25. 

 
❚ Remarks 

A lower value gives the 2D image greater prominence. 
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Adaptive Blend 

Adaptive Blend superimposes a translucent color image over a 2D image in the color image area. You can 
adjust the transparency of the color image (easily, rapidly) to demonstrate the tissues behind the color. 

 

❚ Activating Adaptive Blend 

To activate or deactivate Adaptive Blend, select Adaptive Blend on the touch screen. 

 
❚ Adaptive Blend values 

Adaptive blend values are On and Off. 

 
❚ Remarks 

If you activate Adaptive Blend, Adaptive Level is enabled on the touch screen. 

 

Adaptive Blend Level 

Adaptive Blend Level allows you to specify the blending ratio between the 2D image and the color image. 
 

❚ Adjusting the adaptive blend level 

To adjust the adaptive blend level, select < or > of Adaptive Level on the touch screen. 

 
❚ Adaptive Blend Level values 

Adaptive Blend Level values are 1 to 25. 

 
❚ Remarks 

A lower value gives the 2D image greater prominence. 

 

Invert (Color Invert) 

Invert allows you to view blood flow from a different perspective, e.g., red away (negative velocities) and 
blue toward (positive velocities). You can invert a real-time or frozen image. 

 

NOTE 

• Invert reverses the color map, NOT the color scale. 

• While viewing an inverse image, be careful not to confuse over scan direction or left/right image reversal. 

 
❚ Activating Invert 

To reverse the color flow, select Invert on the touch screen. 
In Triplex mode, both Color Flow and Doppler mode velocity scales are inverted. 

 
❚ Invert values 

Invert values are On and Off. 
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Frequency 

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 6-13. 

 

Power 

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 6-15. 

 

PRF (Pulse Repetition Frequency) 

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). 

 

❚ Adjusting the PRF 

To raise or lower the velocity scale, rotate the PRF soft key clockwise or counter-clockwise. 

 
❚ PRF values 

PRF values may vary depending on the transducer and application. The values are returned to the 
factory or user preset value when you change one of the followings: Transducer, application, or new 
patient. PRF is in kHz. 

 

Smooth 

Smooth allows you to make a color image smoother by enhancing connection in the axial direction. 
 

❚ Adjusting Smooth 

To adjust Smooth, rotate the Smooth soft key to clockwise or counter-clockwise. 

 
❚ Smooth values 

Smooth values are 0 to 22. 

 

Color Map 

Color Map allows you to change the color map used for Color Flow mode, Power Doppler mode and 
Tissue Doppler Imaging mode. 

 

❚ Adjusting the color map 

To adjust the color map, rotate the Color Map soft key clockwise or counter-clockwise. 

 
❚ Color Map values 

Color Map values are 0 to 28. 
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Ensemble 

Ensemble allows you to select the density of the scan line. With increasing the number of ensemble, the 
frame rate decreases. 

 

❚ Adjusting Ensemble 

To adjust Ensemble, rotate the Ensemble soft key clockwise or counter-clockwise. 

 
❚ Ensemble values 

Ensemble values are 6 to 16. 

 

Baseline 

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing. 

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum. 
 

❚ Adjusting the baseline 

To adjust the baseline, rotate the Baseline soft key. 

 
❚ Baseline values 

Zero velocity follows the baseline. The total scale range remains the same. Values may vary by 
transducer and application. Baseline values are returned to the factory or user preset value when you 
change one of the followings: Transducer, application, or new patient. 

 

Persist 

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. For adjusting the persistence, see "Persist" on page 6-15. 

 

Wall Filter 

Wall Filter filters out clutter signals caused from vessel movement. 
 

❚ Adjusting the wall filter 

To raise or lower the wall filter, rotate the WF soft key clockwise or counter-clockwise. 

 
❚ Wall Filter values 

Wall Filter values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change the following: Transducer, application, new patient. 
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Threshold 

Threshold assigns the grayscale level at which color information stops. 
 

❚ Adjusting the threshold 

To increase or decrease the grayscale threshold, rotate the Threshold soft key clockwise or counter- 
clockwise. 

 
❚ Threshold values 

Threshold values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change one of the followings: Transducer, application, or 
new patient. 
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Power Doppler (PD) Mode 
Power Doppler imaging is another way of color flow mapping technology which maps the strength of the 
Doppler signal from the blood flow. Power Doppler mode, unlike Color Flow mode, displays color flow 
imaging by using the number of reflectors that are moving. Therefore, this mode has no aliasing and is 
able to measure the slow blood flow. 

 
 

PD Mode Display 
 

Figure 6-10 PD Mode Display 
 
 

 

General Workflow 

To perform an examination using PD mode, 

1 Press the PDI key on user-defined key. Or in CF mode, select PD on the touch screen. 
The Power Doppler window appears over the 2D mode image. 

2 Use [Trackball] to change the position of the color box. 

3 Press the [Set] key and use [Trackball] to change the size of the color box. 

4 Press the [Set] key. 

5 Press the [Freeze] key to hold the image in the memory. 

6 Record color flow images, if necessary. 

7 To exit Power Doppler mode, press the [2D] key. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

Figure 6-11 PD Mode Touch Screen 
 
 

Gain 
 

Gain amplifies the overall strength of echoes processed in the Color Flow window or spectral Doppler 
timeline. 

 

❚ Adjusting the gain 

– Rotate the [CF] key clockwise to increase the gain; rotate the key counter- clockwise to decrease 
the gain. 

– Rotate the [CF] key to adjust the receive gain for color without affecting the 2D mode image gain. 
 

❚ Gain values 

Gain values may vary by transducer, application, and multi-frequency setting. Gain value is shown as 
Gn on the display. Gain values are returned to the factory or user preset value when you change one 
of the followings: Transducer, application, or new patient. 

 

TDI (Tissue Doppler Imaging) 

TDI switches to Tissue Doppler Imaging (TDI) mode. For more information on Tissue Doppler Imaging 
(TDI), see "Tissue Doppler Imaging (TDI) Mode" on page 6-55. 

 

❚ Activating TDI 

To switch to TDI mode, select TDI on the touch screen. 

 
❚ TDI values 

TDI values are On and Off. 
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X+ MicroView (Micro Vascular Imaging) 

X+ MicroView switches to Micro Vascular Imaging (MVI) mode. For more information on Micro Vascular 
Imaging (MVI), see "Micro Vascular Imaging (MVI)" on page 6-39. 

 

❚ Activating MVI 

To switch to MVI mode, select X+ MicroView on the touch screen. 

 
❚ MVI values 

MVI values are On and Off. 

 

CF (Color Flow Imaging) 

CF switches to Color Flow mode. For more information on Color Flow mode, see "Color Flow (CF) Mode" 
on page 6-22. 

 

❚ Activating CF 

To switch to CF mode, select CF on the touch screen. 

 
❚ CF values 

CF values are On and Off. 

 

Live Dual 

Live Dual is a feature that enables you to view the 2D image and activate other function at the same 
time. For activating or adjusting the Live Dual, see "Live Dual" on page 6-9. 

 

Color Only 

Color Only hides the 2D image from the display so that you can see the color image only. 
 

❚ Activating Color Only 

To activate or deactivate Color Only, select Color Only on the touch screen. 

 
❚ Color Only values 

Color Only values are On and Off. 

 

Hide Color 

Hide Color hides the color bar and the ROI box from the screen. 
 

❚ Activating Hide Color 

To activate or deactivate the hide color, select Hide Color on the touch screen. 

 
❚ Hide Color values 

Hide color values are On and Off. 
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Directional Power Doppler Imaging (DPDI) 

DPDI (Directional Power Doppler Imaging) function shows information on the intensity and direction of 
blood flow. 

 
 

 

Figure 6-12 DPDI Display 
 

❚ Activating DPDI 

To activate or deactivate DPDI, select DPDI on the touch screen. 

 
❚ DPDI values 

DPDI values are On and Off. 

 

Angle Steer 

In Power Doppler mode, you can tilt an image left or right by using a linear transducer. 
 

❚ Adjusting the angle steer 

To adjust the angle steer, select < or > of Angle Steer on the touch screen. The each level of the angle 
increment/decrement is 3 or 5 degrees depending on the linear transducer type. 

 

NOTE 

This function may not be available when the virtual convex function is applied to the current image. 

 

Line Density 

Line Density optimizes the Color Flow mode frame rate or spatial resolution for the best possible 
color image. A lower line density is useful in fetal heart beat, adult cardiac applications and in clinical 
Radiology applications requiring significantly higher frame rates. A higher line density is useful in 
obtaining very high resolution (e.g. thyroid, testicles). For adjusting the line density, see "Line Density" on 
page 6-26. 
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Flow State 

Flow State adjusts the PRF of the color image. 
 

❚ Adjusting the flow state 

To adjust the flow state, select < or > of Flow State on the touch screen. 

 
❚ Flow State values 

Flow State values are Low, Mid, and High. The flow state values may vary depending on the transducer 
and application. 

 

Blend 

Blend superimposes a translucent color image over a 2D image in the color image area. You can adjust 
the transparency of the color image to demonstrate the tissues behind the color. 

 

❚ Activating the blend 

To activate or deactivate Blend, select Blend on the touch screen. 

 
❚ Blend values 

Blend values are On and Off. 

 
❚ Remarks 

If you activate Blend, Blend Level is enabled on the touch screen. 

 

Blend Level 

Blend Level allows you to specify the blending ratio between the 2D image and the color image. 
 

❚ Adjusting the blend level 

To adjust the blend level, select < or > of Blend Level on the touch screen. 

 
❚ Blend Level values 

Blend Level values are 1 to 25. 

 
❚ Remarks 

A lower value gives the 2D image greater prominence. 
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Adaptive Blend 

Adaptive Blend superimposes a translucent color image over a 2D image in the color image area. You can 
adjust the transparency of the color image (easily, rapidly) to demonstrate the tissues behind the color. 

 

❚ Activating Adaptive Blend 

To activate or deactivate Adaptive Blend, select Adaptive Blend on the touch screen. 

 
❚ Adaptive Blend values 

Adaptive Blend values are On and Off. 

 
❚ Remarks 

If you activate Adaptive Blend, Adaptive Level is enabled on the touch screen. 

 

Adaptive Blend Level 

Adaptive Blend Level allows you to specify the blending ratio between the 2D image and the color image. 
 

❚ Adjusting the adaptive blend level 

To adjust the adaptive blend level, select < or > of Adaptive Level on the touch screen. 

 
❚ Adaptive Blend Level values 

Adaptive Blend Level values are 1 to 25. 

 
❚ Remarks 

A lower value gives the 2D image greater prominence. 

 

Invert (Color Invert) 

Invert allows you to view blood flow from a different perspective, e.g., red away (negative velocities) and 
blue toward (positive velocities). You can invert a real-time or frozen image. For activating or deactivating 
the invert, see "Invert (Color Invert)" on page 6-28. 

 

Frequency 

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 6-13. 

 

Power 

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 6-15. 
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PRF (Pulse Repetition Frequency) 

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 6-29. 

 

Smooth 

Smooth allows you to make a color image smoother by enhancing connection in the axial direction. For 
adjusting the smooth, see "Smooth" on page 6-29. 

 

Color Map 

Color Map allows you to change the color map used for Color Flow mode and Power Doppler mode. 
Color map values are 0 to 28. For adjusting the color map, see "Color Map" on page 6-29. 

 

Ensemble 

Ensemble allows you to select the density of the scan line. With increasing the number of ensemble, the 
frame rate decreases. For adjusting the ensemble, see "Ensemble" on page 6-30. 

 

Baseline 

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing. 

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum. 

For adjusting the baseline, see "Baseline" on page 6-30. 

 

Persist 

Persistence provides a visible smoothing effect to the 2D-mode image by persisting lines of image data 
for each frame of imaging. For adjusting the persistence, see "Persist" on page 6-15. 

 

Wall Filter 

Wall Filter filters out clutter signals caused from vessel movement. For adjusting the wall filter, see "Wall 
Filter" on page 6-30. 

 

Threshold 

Threshold assigns the grayscale level at which color information stops. For adjusting the threshold, see 
"Threshold" on page 6-31. 



Micro Vascular Imaging (MVI) 6-39 

 

 

Micro Vascular Imaging (MVI) 
Smaller vessels can be imaged using Micro Vascular Imaging (MVI), which is optimized for visualization of 
low velocity and small diameter blood vessels. MVI is used to detect and visualize micro-vasculature by 
providing higher sensitivity and higher spatial resolution. 

 
 

Transducer Compatibility 

Micro Vascular Imaging (MVI) is available on Convex, Volume Convex and Linear transducers. The 
transducers that support the Micro Vascular Imaging are as follows: 

• Convex: SC1-7H, SC2-11H 

• Volume Convex: SVC1-8H 

• Linear: L3-8H, L3-12X, L3-15H, L10-25H, SL3-19X 

• Endocavity: EC2-11H, EV2-11H 

 

 

MVI Mode Display 
 

Figure 6-13 Micro Vascular Imaging (MVI) Display 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

 

 

 
 

Figure 6-14 MVI Mode Touch Screen 
 
 

 

General Workflow 

To perform an examination using MVI mode, 

1 In CF mode, select PD on the touch screen. 
PD mode is activated. 

2 Select X+ MicroView on the touch screen. 
Micro Vascular Imaging (MVI) is activated. 

3 To deactivate Micro Vascular Imaging (MVI), select X+ MicroView on the touch screen. 
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Pulsed Wave Doppler (PWD) Mode 
Pulsed Wave Doppler (PWD) is a Doppler mode that measures velocity in a PW sample volume and 
displays that information in a spectral trace with an audio output. 

Doppler is intended to provide measurement data concerning the velocity of moving tissues and fluids. 
PW Doppler lets you examine the blood flow data selectively from a small region called the sample 
volume. 

Doppler equipment is commonly used for detecting and evaluating the blood flow in arteries and 
veins. The Doppler effect is used in medical ultrasound to detect moving reflectors and to measure and 
characterize the blood flow. 

 
 

PWD Mode Display 
 

 

Figure 6-15 PWD Mode Display 
 
 

 

General Workflow 

To perform an examination using PWD mode, 

1 In 2D mode, press the [PW] key on the control panel. 

2 Adjust the position and the size of the sample volume. 

3 To change the sample volume size, select SV on the touch screen. 

4 To adjust the angle-to-flow correction, rotate the [Angle] key on the control panel. 

5 To change the sweep speed, select Sweep on the touch screen. 

6 To exit PW Doppler mode, press the [PW] or [2D] key. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

 

 

 
 

Figure 6-16 PWD Mode Touch Screen 
 
 

PW Doppler angle 

Angle between the direction of reflector motion and the direction of propagation of the ultrasound 
beam. 

 

PW Doppler effect 

Phenomenon whereby there is a change in the perceived frequency of a sound source relative to the 
transmitted frequency when there is a relative motion between a sound source and the listener. 



Pulsed Wave Doppler (PWD) Mode 6-43 

 

 

Angle Correct 

Estimate the flow velocity in a direction at an angle to the Doppler vector by computing the angle 
between the Doppler vector and the flow to be measured. 

 

NOTE 

When the Doppler mode cursor and angle correct indicator are aligned (the angle is 0), you cannot see the 
angle correct indicator. 

 
❚ Adjusting Aangle Correct 

Flow toward the transducer is mapped above the baseline and vice versa. 

To adjust the angle relative to the transducer face, rotate the [Angle] key on the control panel. The 
velocity scale changes when you adjust angle correct. 

 
❚ Angle Correct values 

Angle Correct values are -89 to 89. 

 

Auto Angle 

Auto Angle allows you to adjust the angle by 60 degrees. 
 

❚ Adjusting Auto Angle 

To adjust the PW Doppler angle, select Auto Angle on the touch screen. 
 

NOTE 

This function may not be available when the virtual convex function is applied to the current image. 

 
❚ Auto Angle values 

Auto Angle values are -60, 0, and 60. 

 

Simultaneous 

In simultaneous mode of 2D and Doppler modes, you can pause a Doppler image and move the image to 
the 2D live screen by adjusting the Doppler gate. 

 

❚ Activating the simultaneous mode 

To activate or deactivate the simultaneous mode, select Simultaneous on the touch screen. 

 
❚ Simultaneous values 

Simultaneous values are On and Off. 
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Invert 

Invert vertically inverts the spectral trace without affecting the baseline position. 
 

❚ Activating Invert 

To invert the spectral trace, select Invert on the touch screen. The plus (+) and minus (-) signs on 
the velocity scale are reversed when the spectrum is inverted. Positive velocities display below the 
baseline. 

 
❚ Invert values 

Invert values are On and Off. 

 

Full Timeline 

Full Timeline allows you to expand the display in full timeline. 
 

❚ Activating Full Timeline 

To expand the display in full timeline, select Full D on the touch screen. 

 
❚ Full Timeline values 

Full Timeline values are On and Off. 

 

Auto Update 

When the Doppler mode cursor on the 2D-mode image moves, 2D image is updated. 
 

❚ Activating Auto Update 

To activate Auto Update, select Auto Update on the touch screen. 

 
❚ Auto Update values 

Auto Update values are On and Off. 

 

Doppler sample volume length 

Size the sample volume gate. 
 

❚ Adjusting the sample volume length 

To increase or decrease the gate size, select < or > of SV on the touch screen. You can adjust the 
sample volume gate length whenever the sample volume gate appears on the display. 

 

NOTE 

Adjustments to the sample volume gate size are made from the center point of the sample volume 
position. 

 
❚ Sample volume length values 

Sample volume length values may vary depending on the transducer and application. Sample 
volume gate size values are returned to the factory or user preset value when you change one of the 
followings: Transducer, application, or new patient. 
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AutoCalc 

Activate the calculation automatically when the AutoCalc is in Frozen or Live. 
 

❚ Adjusting AutoCalc 

To adjust the AutoCalc, select < or > of AutoCalc on the touch screen. 

 
❚ AutoCalc values 

AutoCalc values are OFF, Frozen, and Live. 

 

AutoCalc Cycle 

AutoCalc Cycle is used to adjust the number of cycles. 

 
❚ Adjusting the AutoCalc Cycle 

To adjust the AutoCalc Cycle, select < or > of AutoCalc Cycle on the touch screen. 
 

NOTE 

This function can be adjusted when AutoCalc is activated. 

 
❚ AutoCalc Cycle values 

AutoCalc Cycle values are 1 to 5. 

 

Wall Filter 

Wall Filter filters out clutter signals caused from vessel movement. 
 

❚ Adjusting the wall filter 

To raise or lower the wall filter, select < or > of WF on the touch screen. 

 
❚ Wall Filter values 

Wall Filter values may vary depending on the transducer and application. The values are returned to 
the factory or user preset value when you change the following: Transducer, application, new patient. 

 

Display Format 

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. 

 

❚ Adjusting the display format 

To adjust the display format, select < or > of Display Format on the touch screen. 
 

NOTE 

This function can not be adjusted when Full D is activated. 

 
❚ Display Format values 

Display Format values are as follows: Vert. 1:1, Vert. 1:2, Vert. 2:1, Horiz. 1:1, Horiz. 1:2, Horiz. 2:1. 
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Angle Steer 

Angle Steer tilts the sample volume for the Doppler spectrum. This function is only for linear transducers. 
 

❚ Adjusting Angle Steer 

To adjust the angle steer, select < or > of Angle Steer on the touch screen. The each level of the angle 
increment/decrement is 5 degrees. 

 

NOTE 

This function may not be available when Virtual Convex is applied to the current image. 

 
❚ Angle Steer values 

Angle Steer values are -20, -15, -10, 0, 10, 15, and 20. 

 

Direction 

Direction is used to specify the part of the spectrum to calculate when using AutoCalc. 

 
❚ Adjusting the direction 

To adjust Direction, select < or > of Direction on the touch screen. 
 

NOTE 

This function can be adjusted when AutoCalc is activated. 

 
❚ Direction values 

Direction values are Both, Below, and Above. 

 

Method 

Method is used to trace the average mean and peak velocities in realtime or frozen images. 

 
❚ Adjusting Method 

To adjust Method, select < or > of Method on the touch screen. 
 

NOTE 

This function can be adjusted when AutoCalc is activated. 

 
❚ Method values 

Method values are Max, Mean, and Both. 
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Sensitivity 

Sensitivity is used to adjust the trace to follow the waveform for signal strength. 

 
❚ Adjusting Sensitivity 

To adjust Sensitivity, select < or > of Sensitivity on the touch screen. 
 

NOTE 

This function can be adjusted when AutoCalc is activated. 

 
❚ Sensitivity values 

Sensitivity values are -10 to 10. 

 

Frequency 

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 6-13. 

 

Power 

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 6-15. 

 

PRF (Pulse Repetition Frequency) 

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 6-29. 

 

HPRF (High Pulse Repetition Frequency) 

High Pulse Repetition Frequency (HPRF) is a special operating mode of PW Doppler. HPRF function is 
used when detected velocities exceed the processing capabilities of the currently selected PW Doppler 
scale, or when the selected anatomical site is too deep for the selected PW Doppler scale. 

 

❚ Activating HPRF (High PRF) 

The system automatically switches to HPRF mode when the velocity scale factor or sample volume 
gate depth exceeds certain limits. When HPRF function is activate, multiple sample volume gates 
appear on the Doppler mode cursor. 

 

NOTE 

To set the system automatically switch to HPRF mode, go to Utility > Setup > ImagePreset > General and 
select the HPRF Enable check box. 

 
❚ Remarks 

Make sure that more than two sample volume gates are not located in a blood vessel. If the sample 
volume gates are placed together in the same area, all Doppler signals appear in the spectrum, 
causing noise. 
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Gray Map 

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 6-14. 

 

Dynamic Range 

Dynamic Range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 6-13. 

 

Sweep Speed 

Sweep Speed allows you to adjust the sweep speed of the Doppler spectrum. 
 

❚ Adjusting Sweep Speed 

To increase or decrease the sweep speed, rotate the Sweep soft key clockwise or counter-clockwise. 

 
❚ Sweep Speed values 

Sweep Speed values are 0 to 6. 

 
❚ Remarks 

You can speed up or slow down the timeline to see more or fewer occurrences over time. 

 

Colorize 

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 6-14. 

 

Baseline 

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing. 

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum. 

For adjusting the baseline, see "Baseline" on page 6-30. 

 

Reject 

Low echo information will not be displayed on the screen below the adjusted rejection level. 

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display. 

For adjusting the rejection, see "Reject" on page 6-14. 
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Sound 

Sound adjusts the Doppler sound volume. 
 
 

CAUTION 
Doppler audio sounds may change abruptly. Adjust the volume of sound in smaller increments to avoid 
startling the patient. 

 
❚ Adjusting Sound 

To adjust Sound, rotate the Sound soft key clockwise or counter-clockwise. 

 
❚ Sound values 

Sound values are 0 to 100. 

 
❚ Remarks 

Audio sounds of the blood flow in a vessel can be used to check the proper position of the transducer. 
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Continuous Wave Doppler (CWD) Mode 
Continuous Wave Doppler (CWD) mode allows you to view the velocity and direction of a blood flow at 
a certain position. As you move the Doppler cursor, images on the Doppler line appear by time order. 
For using this feature, you need an additional request to your local agent. It also requires CWD mode- 
supported transducers such as a phased array transducer or Doppler pencil transducer. 

 
 

CWD Mode Display 
 
 

 

Figure 6-17 CWD Mode Display 
 
 

 

General Workflow 

To perform an examination using CWD mode, 

1 Make sure that the dedicated transducer is connected to your system. 

2 In 2D mode, press the [CW] key on the control panel. 
When a CWD transducer is connected to your system, CWD mode is automatically activated. 

3 To adjust the angle-to-flow correction, rotate the [Angle] key on the control panel. 

4 To change the sweep speed, select Sweep on the touch screen. 

5 To exit CWD mode, press the [CW] or [2D] key. 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

 

 

Figure 6-18 CWD Mode Touch Screen 
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Angle Correct 

Estimate the flow velocity in a direction at an angle to the Doppler vector by computing the angle 
between the Doppler vector and the flow to be measured. 

 

NOTE 

When the Doppler mode cursor and angle correct indicator are aligned (the angle is 0), you cannot see the 
angle correct indicator. 

 
❚ Adjusting Angle Correct 

Flow toward the transducer is mapped above the baseline and vice versa. To adjust the angle relative 
to the transducer face, rotate the [Angle] key on the control panel. The velocity scale changes when 
you adjust angle correct. 

 
❚ Angle Correct values 

Angle Correct values are -89 to 89. 

 

Auto Angle 

Auto Angle allows you to adjust the angle by 60 degrees. For activating or deactivating Auto Angle, see 
"Auto Angle" on page 6-43. 

 

Invert 

Invert vertically inverts the spectral trace without affecting the baseline position. For activating or 
deactivating Invert, see "Invert" on page 6-44. 

 

Full Timeline 

Full Timeline allows you to expand the display in full timeline. 
 

❚ Activating the full timeline 

To expand the display in full timeline, select Full CW on the touch screen. 

 
❚ Full Timeline values 

Full Timeline values are On and Off. 

 

AutoCalc 

Activate the calculation automatically when the AutoCalc is in Frozen or Live. For adjusting the AutoCalc, 
see "AutoCalc" on page 6-45. 

 

AutoCalc Cycle 

AutoCalc Cycle is used to adjust the number of cycles. For adjusting the AutoCalc Cycle, see "AutoCalc 
Cycle" on page 6-45. 
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Direction 

Direction is used to specify the part of the spectrum to calculate when using AutoCalc. For adjusting the 
direction, see "Direction" on page 6-46. 

 

Method 

Method is used to trace the average mean and peak velocities in realtime or frozen images. For adjusting 
the method, see "Method" on page 6-46. 

 

Sensitivity 

Sensitivity is used to adjust the trace to follow the waveform for signal strength. For adjusting the 
sensitivity, see "Sensitivity" on page 6-47. 

 

Wall Filter 

Wall Filter filters out clutter signals caused from vessel movement. For adjusting the wall filter, see "Wall 
Filter" on page 6-45. 

 

Display Format 

Display Format changes the horizontal/vertical layout between 2D mode and Doppler mode or timeline 
only. You can select how to have your Doppler time line and anatomy displayed. For adjusting the display 
format, see "Display Format" on page 6-45. 

 

Frequency 

In Multi-frequency mode, you can change the frequency of the transducer. The frequency function is the 
same as the one in 2D mode. For adjusting the frequency, see "Frequency" on page 6-13. 

 

Power 

Power controls the amount of acoustic power applied in all modes. For adjusting the power, see "Power" 
on page 6-15. 

 

PRF (Pulse Repetition Frequency) 

PRF function is used to adjust the velocity scale to accommodate faster/slower blood flow velocities. 
Velocity scale determines the pulse repetition frequency (PRF). For adjusting the PRF, see "PRF (Pulse 
Repetition Frequency)" on page 6-29. 

 

Gray Map 

Gray Map provides you with the system maps for 2D, M, and Doppler modes. For adjusting the gray map, 
see "Gray Map" on page 6-14. 
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Dynamic Range 

Dynamic Range is useful for optimizing tissue texture in different anatomy. Dynamic range should be 
adjusted so that the highest amplitude edges appear as white while lowest levels (such as blood) are just 
visible. For adjusting the dynamic range, see "Dynamic Range" on page 6-13. 

 

Sweep Speed 

Sweep Speed allows you to adjust the sweep speed of the Doppler spectrum. For adjusting the sweep 
speed, see "Sweep Speed" on page 6-48. 

 

Colorize 

Colorize is the colorization of a conventional 2D mode image or Doppler Spectrum to enhance the user's 
ability to discern 2D mode, M mode, and Doppler mode intensity valuations. Colorize is NOT a Doppler 
mode. For adjusting the colorize, see "Colorize" on page 6-14. 

 

Baseline 

Baseline adjusts the Color Flow or Doppler spectrum baseline to accommodate higher velocity blood 
flow to eliminate aliasing. 

Baseline adjusts the alias point. The default baseline is at the midpoint of the spectrum. 

For adjusting the baseline, see "Baseline" on page 6-30. 

 

Reject 

Low echo information will not be displayed on the screen below the adjusted rejection level. 

The rejection function determines the amplitude level below which echoes are suppressed (rejected). 
Rejection set to high leads to bad tissue display. 

For adjusting the rejection, see "Reject" on page 6-14. 

 

Sound 

Sound adjusts the Doppler sound volume. For adjusting the sound, see "Sound" on page 6-49. 
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Tissue Doppler Imaging (TDI) Mode 
Tissue Doppler Imaging (TDI) mode allows you to view the status of the myocardium by measuring the 
velocity of the tissue movement on the Doppler image. This mode only is available for adult cardiac 
application. 

 
 

The combination imaging modes of TDI mode 

The following combination imaging modes are available: 

• PW tissue Doppler 

• Color 2D tissue Doppler 

 

 

TDI Mode Display 
 

Figure 6-19 TDI Mode Display 
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Image Optimization Controls 

Select an option on the touch screen, or rotate the corresponding soft key to select the following imaging 
functions. 

 

Figure 6-20 TDI Mode Touch Screen 
 
 

 

General Workflow 

To perform an examination using TDI mode, 

1 In 2D mode, press the [CF] Key on the control panel. CF mode is activated. 

2 Select TDI on the touch screen. 
Color 2D tissue Doppler mode is activated. 

3 To activate PW tissue Doppler mode, press the [PW] key. 

4 To exit TDI mode, select TDI on the touch screen. 
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3D/4D Modes 
3D/4D imaging modes are useful for imaging structures that cannot be obtained in 2D mode for better 
understanding of complex structures. 

Example of fetal face in multiplanar sections and surface rendering. 
 

 
The following table describes 3D and 4D modes: 

 

Mode Description 

3D Reconstruct 3D image with obtained one volume image. 

4D Obtain the 3D volume data on real time and rendering this. 

 

 
NOTE 

• 3D/4D imaging modes are optional that you need to request additionally. If this mode is not available, the 

3D and 4D menus on the touch screen are deactivated. 

• Standard transducers cannot be used for 3D/4D modes. Only SVC1-8H and VE3-10H support 3D/4D 
modes. 
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Available Features in 3D/4D Modes 

The following features are available in 3D/4D modes: 

• Most of 2D controls 

• Text and Arrow 

• Measurement 

 
The following post-processing controls are available in 3D/4D modes: 

• Zoom 

• Cine (Only for 4D mode) 
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Volume Setup 

Operational controls for 3D/4D modes 

The following table describes the key functions in 3D/4D modes. 
 

Table 6-1 3D/4D operational controls 
 

Control Description 

 
Freeze 

In 3D/4D setup mode, press to obtain a 3D or 4D image. 
In 3D mode, press to switch to 3D/4D setup mode. 

In 4D mode, press to switch to 3D mode. Press again to return to 4D mode. 

Angle In 3D or 4D mode, rotate along the X axis; up and down rotation. 

PW In 3D or 4D mode, rotate along the Y axis; left and right rotation. 

CF In 3D or 4D mode, rotate along the Z axis; clockwise and counter-clockwise rotation. 

 

 
M/Depth 

In 3D or 4D mode, move parallel. 

• PlaneA: Left/Right 

• PlaneB: Up/Down 

• PlaneC or 3D: Forward/Backward 

Single Show a 3D image. 

Dual Show one reference image and one 3D image. 

Quad Show three reference images and one 3D image. 

 
 

Priority 

Set/Cur 

While or after acquiring the volume data, press to change the function. The activated 
function is shown on the bottom right of the display: 

• Priority: Cine, Cine Calc., Move, ROI, Curved ROI, Line1,2,3, Light Direction 

• Set: Run and Stop (Cine or Cine Calc.), Image and Axis (Move), Pos and Size (ROI), Initial 
(Curved ROI), Pos and Rot (Line1,2,3) 

• Cursor: Cursor (Display remains blank.) 

 
 
 

 
Trackball 

Adjust the position, light direction, and the size of the ROI. 

When the [Priority] key is pressed, use to perform the activated function: 

• Cine or Cine Calc.: Use to move the cine frame. 

• Move: Use to move the image. 

• ROI: Use to adjust the clipping box size of ROI. 

• Curved ROI: Use to change the contour of the clipping line. 

• Cursor: Use to move the cursor to the desired location. 

• Light Direction: Use to change Light Direction in LiveHQ. 
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Volume Acquisition 

Setting up for volume acquisition 

You can optimize the image and select settings for the volume acquisition by using the following imaging 
parameters. 

 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6-21 Imaging Parameters for Volume Acquisition (3D/4D) 

Table 6-2 Volume acquisition parameters 
 

Preset Parameter Description 

View Types MPR, Sectional Planes, Multi Slice 

 

 
Display Format 

Change the display layout. 

• 1x1: One rendered volume image 

• 1x2: One rendered volume image and one slice image 

• 2x2: One rendered volume image and three slice images 

User Preset Show the user preset values such as surface and spine. 

Render Direction Adjust the view direction of the ROI. 

 
 

Quality 

Change the line density to adjust image quality and acquisition time. 

• Low: Low quality and fast acquisition time 

• Mid: Better quality but slower acquisition time than the low quality 

• H1: Better quality but slower acquisition time than the medium quality 

• H2: Best quality and the slowest acquisition time 

 
 

Volume Angle 

Set the range of the volume sweep. The range of angle varies depending on the transducer 
in use. 

• Volume Convex: 15, 30, 45, 60, 75 

• Volume Endocavity: 10, 30, 45, 60, 75, 90, 105, 120 

 
NOTE 

The imaging parameters are returned to their factory values when you change the transducer. 
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Region of Interest (ROI) and Rendering Box 

After the system enters 3D/4D imaging mode, a 2D image with ROI displays on the screen. A line that 
shows the upper edge position of VOI is inside ROI. 

The render box determines the size of the volume to be rendered. Therefore, objects that are not inside 
the box will not be included in the render process and cut out. 

 

Figure 6-22 Region of Interest (ROI) 

 

1 Region of Interest (ROI) 3 2D image 

2 Rendering Box (Cut plane) 4 Trackball controls and status 

 
To adjust the ROI of the display, 

1 Obtain a 2D image and optimize the image for the best quality. 

2 If necessary, obtain a CF image and optimize the image for the best quality. 

3 Press the [3D/4D] key on the control panel. 

4 Touch the 3D or 4D tab on the touch screen. 
The yellow-colored ROI appears on the display. 

5 Use [Trackball] to move the ROI to the desired position. 

6 Press the [Set] key set the trackball to Size. 

7 Use [Trackball] to adjust the size of the ROI. 

8 Press the [Priority] key set the trackball to Curved ROI. 

9 Use [Trackball] to adjust the line of the Curved ROI. 

10 If necessary, press the [Set] key to set the trackball to Initial to reset the curved line to a straight 
line. 

 

 

 

 



Acquiring a 3D image 
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To acquire a 3D image, 

1 Connect the appropriate 3D/4D-compatible transducer. 

2 Touch Transducer on the touch screen and select a transducer and preset. 

3 Obtain a 2D image and optimize the image for the best quality. 

4 Press the [3D/4D] key on the control panel. 

5 Touch the 3D tab on the touch screen. 
The yellow-colored ROI and soft menus for 3D mode appear. 

6 Define the Volume of Interest (VOI) to be scanned. 
Use [Trackball] to move the VOI and press the [Priority] key to re-size and re-position the VOI. 
Only the area defined within the VOI is rendered. 

7 Select one of the preset settings for data acquisition and display. 

8 Rotate the Volume Angle soft key to set the transducer scanning angle. 

9 Rotate the Quality soft key to adjust image quality and acquisition time. 

10 Rotate the Render Direction soft key to change the direction of the image view. 

11 Select the desired display format on the touch screen to change the display layout. 

12 Select one of the preset settings for data acquisition and display. 

13 To start acquiring the image, select Start on the touch screen to acquire the image data. 
Or, you can also press the [Freeze] key on the control panel. 

14 After you acquire the volume data, the 3D mode screen appears. 
 

NOTE 

If the image stops during scanning an image, start acquiring the 3D volume of interest again. 
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Acquiring a 3D Color image 

To acquire a 3D Color image, 

1 Connect the appropriate 3D/4D-compatible transducer. 

2 Touch Transducer on the touch screen and select a transducer and preset. 

3 Obtain a 2D image and optimize the image for the best quality. 

4 Press the [CF] key on the control panel to activate Color Flow. 

5 Press the [3D/4D] key on the control panel. 

6 Touch the 3D tab on the touch screen. 
The yellow-colored ROI and soft menus for 3D mode appear. 

7 Define the Volume of Interest (VOI) to be scanned. 
Use [Trackball] to move the VOI and press the [Priority] key to re-size and re-position the VOI. 
Only the area defined within the VOI is rendered. 

8 Select one of the preset settings for data acquisition and display. 

9 Rotate the Volume Angle soft key to set the transducer scanning angle. 

10 Rotate the Quality soft key to adjust image quality and acquisition time. 

11 Rotate the Render Direction soft key to change the direction of the image view. 

12 Select the desired display format on the touch screen to change the display layout. 

13 Select one of the preset settings for data acquisition and display. 

14 To start acquiring the image, select Start on the touch screen to acquire the image data. 
Or, you can also press the [Freeze] key on the control panel. 

15 After you acquire the volume data, the 3D Color mode screen appears. 
 

NOTE 

If the image stops during scanning an image, start acquiring the 3D volume of interest again. 



Acquiring a 4D image 
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To acquire a 4D image, 

1 Connect the appropriate 3D/4D-compatible transducer. 

2 Touch Transducer on the touch screen and select a transducer and preset. 

3 Obtain a 2D image and optimize the image for the best quality. 

4 Press the [3D/4D] key on the control panel. 

5 Touch the 4D tab on the touch screen. 
The yellow-colored ROI and soft menus for 4D mode appear. 

6 Define the Volume of Interest (VOI) to be scanned. 
Use [Trackball] to move the VOI and press the [Priority] key to re-size and re-position the VOI. 
Only the area defined within the VOI is rendered. 

7 Select one of the preset settings for data acquisition and display. 

8 Rotate the Volume Angle soft key to set the transducer scanning angle. 

9 Rotate the Quality soft key to adjust image quality and acquisition time. 

10 Rotate the Render Direction soft key to change the direction of the image view. 

11 Select the desired display format on the touch screen to change the display layout. 

12 To start acquiring the image, select Start on the touch screen to acquire the image data. 
Or, you can also press the [Freeze] key on the control panel. 

13 After you acquire the volume data, the 4D mode screen appears. 

14 To magnify the volume, rotate the [Zoom] key on the control panel. 
 

NOTE 

If the image stops during scanning an image, start acquiring the 3D volume of interest again. 
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Changing the view type 

You can change the view type after acquiring volume data by selecting a view type menu. 
 

To change view type, 

– Select a view type (MPR, Sectional Planes or Multi Slice) on the touch screen. 

– Touch the desired view type (MPR, Sectional Planes or Multi Slice) tab on the touch screen. 
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Volume Visualization 

Changing the view type 

You can change the view type after acquiring volume data by selecting a view type menu. 
 

To change view type, 

– Select a view type (MPR, Sectional Planes or Multi Slice) on the touch screen. 

– Touch the desired view type (MPR, Sectional Planes or Multi Slice) tab on the touch screen. 
 

 

MPR (Multi-Planar Rendering) 

MPR (Multi Planar Rendering) shows a single volume data. The system automatically displays the volume 
and MPRs during the 4D imaging volume acquisition, after the 3D volume acquisition, or during the 
review of retrieved volumes. 

 

Figure 6-23 MPR Display 

 

1 A Plane: Sagittal Plane 4 Volume Image 

2 B Plane: Transverse Plane 5 Trackball controls and status 

3 C Plane: Coronal Plane 
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Defining Volume of Interest (VOI) and viewing planes 

You can define a data to be displayed in the volume quadrant by enabling the VOI (Volume of Interest) 
and then resizing and repositioning the VOI in relation to the acquired volume data. The system displays 
the VOI in the volume and the related view plane in each orthogonal MPR. 

The view plane is the side of the VOI represented by a solid or dotted line. 
 
 

Changing the view line (Clipping box line) of the VOI 

To adjust the VOI size, 

1 Select the desired reference plane (A, B, C) on the touch screen. 
The selected plane appears on the display. 

2 Press the [Priority] key to set the trackball to ROI. 

3 Press the [Set] key to set the trackball to Pos. 

4 Adjust the view line by using [Trackball]. 
The size of the volume image changes according to the view line. 

 
 

Changing the volume of a plane 

You can change the volume of a plane by curving the VOI. 
 

To change the volume of a plane, 

1 Press the [Priority] key to set the trackball to Curved ROI. 

2 Adjust the curved line by using [Trackball]. 
The volume image changes according to the curved line. 

3 If necessary, pres the [Set] key to reset the three-point curved line to a straight line. 
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Customizing the render settings 

After acquiring the volume data, imaging parameters appear on the touch screen. Imaging parameters 
allow you to optimize the volume tissue components. 

 

 

 
 

Figure 6-24 Rendering Parameters 
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The following table describes the rendering imaging parameters. 
 

Table 6-3 Rendering parameters 
 

Parameter Description 

 

 
Display Format 

Select the display format. 

• Single: The 3D image is displayed in full screen view. 

• Dual: One 2D image and one 3D image are displayed. 

• Quad: All 2D and 3D images are displayed. 

Live HQ Activate the Live HQ imaging, and display the Live HQ menu. 

Silhouette Adjust the Silhouette. 

 

Clear Face 
Activate the Clear Face function. 

Recognize the fetal face and remove the shading obstacle data automatically. 

 

Easy Cut 
Activate the Easy Cut function, and display the Easy Cut menu. 

Electronically edit images by cutting away unwanted structures on the ROI. 

Initial Reset the current 3D or 4D settings. 

Edit ROI Select to adjust the size of the Region of Interest (ROI). 

ColorMap Select the desired color map. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Render Setup 

Render setting For better image, be familiar with the following render 

settings: 

• Surface: It is possible to combine the gradient and 
texture shading. This is done by calculating each 
weighted sum of the colors derived for gradient and 

texture shading. 

• Depth: Superimpose the tint map on the volume 

image to improve the stereoscopic sensation and the 
contrast of the image. 

• Max: Maximum intensity projection. Represent a 
3D image in maximum intensity. This option can be 
useful for observation of bone structure. 

• Min: Minimum intensity projection. Represents a 
3D image in minimum intensity. This option can be 
useful for observation of vessels or cavities in the 

human body. 

• Light, Light2: Represent the highlight and shadow 
on the surface of the image. An image area close to 

viewer is shown bright; an image area distant from 
the viewer is shown shaded. 

• XRay: Represent a 3D image in average intensity. An 
image is shown like an X-ray image. 

Render setting 

(only for 3D Color) 
• Gray: Display the gray values in the ROI. 

• Color: Display the color values in the ROI. 

• Mix: Display both gray and color values in the ROI. 

Render Direction Adjust the direction of the image view. 

• Up/Down 

• Lt/Rt 

• Front/Back 
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Parameter Description 

 
Alpha Mode 

Select the imaging preset for OB or GYN examination. 

• 0: OB 

• 1: GYN 

Preset Reload the presets for the selected application. 

Cine Manual selection of single volume frames. 

Cine Calc. Display the Cine Calculations menu. 

3D Print Save the 3D images on a removable media. 

Ref. Plane Select a reference image from A, B, C or 3D. 

3D Orientation Change the orientation of the image on the display. 

Smooth Adjust the smooth to apply a low-pass filter. 

Brightness Adjust the overall brightness of volume. 

Opacity Adjust the opacity to eliminate darker gray shades, background noise. 

Contrast L Adjust the contrast of the dark part of the volume image. 

Contrast H Adjust the contrast of the bright part of the volume image. 

Threshold Adjust the threshold to define structures of interest. 

Transparency Set the transparency of the 3D image. 

Tissue Priority 
(only for 3D Color) 

Adjust the mixing ratio to hide the color on the sectional planes. 

 

3D SRI 
Adjust the 3D SRI on the MPR view. 

Obtain a clearer image by eliminating noise and enhancing boundaries. 

 

2D SRI 
Adjust the 2D SRI on the MPR view. 

Obtain a clearer image by eliminating noise and enhancing boundaries. 

 

Color Render 

(only for 3D Color) 

Select the render setting for 3D Color. 

• Gray 

• Color 

• Mix 

Ref. Slice Move the reference slice to the left and the right in parallel. 

 

Vol.Sync 
• On: Rotate the MPR image and the volume image simultaneously. 

• Off: Rotate the MPR image and the volume image separately. 

Quality Change the line density to adjust image quality and acquisition time. 

Volume Angle Adjust the range of the volume sweep. 

DR Adjust the dynamic range. 

Gray Map Select the desired gray map. 

2D Colorize Colorize the 2D image. 

3D Color Map Select the desired color map. 
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Creating presets 

Presets contain a selection of predefined rendering parameters. Thus desired combination of filter can 
be set at once. All of rendering settings support changing the preset. 

On the touch screen, select Define Preset. When the User Preset Setting dialog box appears, the 
following options are available: 

• Default All: Recover all user preset to default factory setting. 

• Reset: Recover the user preset to default setting. 

• Overwrite: Overwrite an existing preset with a new preset. 

• Rename: Change the name of an existing preset. 

• Save: Save the current preset. 

• Cancel: Cancel saving the user preset. 
 

NOTE 

You can apply the preset after acquiring volume data or scanning a live image. 
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Cine 
 

Cine function allows you to save and work with the acquired volume images. Depending on the memory 
and volume size up to volumes can be displayed. The advantage of working with 4D VolCine is that 
during the acquisition the user can concentrate on the acquisition itself. After acquisition you have the 
possibility to review and work on the acquired volumes. 

 

NOTE 

Cine may not be available in 3D mode. 
 

Table 6-4 Cine parameters 
 

Parameter Description 

Full Run/Stop Start or stop the playback of the full cine clip. 

Clip Run/Stop Start or stop the playback of the selected cine clip defined by start and end volume. 

 
Loop Mode 

Selec the loop mode. 

• Display images from start to end 

• Display images from start to end and backwards 

Vol.byVol. Select cine volumes. 

Start Select the starting cine number. 

End Select the ending cine number. 

Speed Change the playback speed. 

 

 
Cine Calc. (Cine Calculation) 

Cine Calculation function allows the volume image to be rotated automatically according to specific 
orientation and customized angle. When volume acquisition is paused, you can review the volume data 
in Cine mode. 

 
To get an overall 3D impression of the rendered object a certain number of calculated views are 
displayed in a sequence. The rendered object rotates or moves in front of the observer. 

 
Table 6-5 Cine Calc. parameters 

 

Parameter Description 

Rot Axis Define the axis the image is rotated around to create the cine sequence. 

Rotate Angle Define the amount of rotation of the whole cine sequence. 

Step Angle Define the amount of rotation between adjoining 3D images. 

Calculate Cine Seq. Start the calculation of the cine sequence. 
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Easy Cut 

Easy Cut allows you to electronically edit images by cutting away unwanted structures on the ROI. 
 

Figure 6-25 Easy Cut 
 
 

❚ Easy Cut Parameters 

The following Easy Cut parameters are available: 

Table 6-6 Easy Cut parameters 
 

Parameter Description 

Trace Inside Structures within the contour will be discarded. 

Trace Outside Structures outside the contour will be discarded. 

Box in All information inside the box will be cut. 

Box out All information outside the box will be cut. 

Elipse In Content inside the elipse will be cut. 

Elipse Out Content outside the elipse will be cut. 

Eraser Small All information inside the small circle will be cut. 

Eraser Medium All information inside the medium circle will be cut. 

Eraser Large All information inside the large circle will be cut. 

Depth Adjust the depth to cut. 

 

Cut Type 

(only for 3D Color) 

Select the cut type for 3D Color mode. 

• Gray: All gray information inside the circle will be cut. 

• Color: All color information inside the circle will be cut. 

• Both: All gray and color information inside the circle will be cut. 

Undo/Redo Select to undo or redo. 

Redo All Select to redo all. 

Remove All Select to remove all. 
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❚ Easy Cut Workflow 

To operate Easy Cut, 

1 Select MPR on the touch screen. 

2 Select Easy Cut on the touch screen. 

3 Select the desired Easy Cut parameters and press the [Set] key to start. 

4 Use [Trackball] to define the region, and then press the [Set] key again to cut the image. 
The portion is removed. 

5 If necessary, select Undo to undo the last cut. 
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Live HQ 

Live HQ is used to create a realistic volume rendering image using the virtual light source. 

This function is turned on or off by selecting Live HQ on the touch screen. 

 

Figure 6-26 Live HQ Display 
 

Figure 6-27 Live HQ Parameters 
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❚ Live HQ Parameters 

The following Live HQ parameters are available: 

Table 6-7 Live HQ parameters 
 

Parameter Description 

 
Live HQ 

This function enables you to represent a realistic live image. 

• On: Apply the Live HQ preset. 

• Off: Apply the previous preset. 

 

Light Direction 
Adjust the direction of the light for the Live HQ function. 

Move [Trackball] to adjust the direction of the light. 

Render Direction Adjust the direction of the image view. 

Front Scale Adjust the front depth scale of the Live HQ function. 

Back Scale Adjust the back depth scale of the Live HQ function. 

HQ Scatter Adjust scattering for the Live HQ function. 

3D Color Map Select the desired color map. 

 
❚ Live HQ Workflow 

To operate Live HQ, 

1 Select MPR on the touch screen. 

2 Select Live HQ on the touch screen. 

3 Select Render Setup on the touch screen. The Live HQ Render Setup menus appear on the touch 
screen. 

4 Adjust the Live HQ image by using the Live HQ parameters. 

5 Adjust the direction of the light by using [Trackball]. 
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Clear Face 

The Clear Face function allows you to easily separate solid tissue in front of the fetal face. 

This function is turned on or off by selecting Clear Face on the touch screen. 

 

Figure 6-28 Clear Face Display 
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Silhouette 

The Silhouette function allows you to clearly outline the structure of interest and simultaneously display 
the inner core and structure. 

This function is turned on or off by selecting Silhouette on the touch screen. 
 

Figure 6-29 Silhouette Display 
 
 

❚ Silhouette Parameters 

The following Silhouette parameters are available: 

Table 6-8 Silhouette parameters 
 

Parameter Description 

Silhouette 1, 2 Select the Silhouette imaging mode. 

Mix Adjust the transparency of the image. 

Level Adjust the level of the transparency of the image. 

 
❚ Silhouette Workflow 

To operate Silhouette function, 

1 Select MPR on the touch screen. 

2 Select Silhouette on the touch screen. 

3 Select Render Setup on the touch screen. 
The Silhouette Render Setup menus appear on the touch screen. 

4 Adjust the Silhouette image by using the Silhouette parameters. 
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Sectional Planes 

Sectional planes represent three different planes of the same 3D volume. There are three separate 
planes, A (Longitudinal), B (Transverse) and C (Coronal). 

Sectional Planes supports following view types: Multi Plane, AnySlice, and Cubic View. 
 

1 
 
 
 
 
 
 

 
2 3 4 

 
 
 
 
 
 

Figure 6-30 Sectional Planes display 

 

1 Sectional Planes 3 AnySlice 

2 Multi Plane 4 Cubic View 
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Multi Plane 

Multi Plane provides three separate views of the same image: Longitudinal, Transverse, and Coronal. It 
supports the Cine Calc. to review the sliced images. 

 

NOTE 

The volume data is not displayed in Multi Plane mode. 
 

Figure 6-31 Multi Plane 
 

Figure 6-32 Multi Plane Parameters 
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Multi Plane parameters 

The following table describes the Multi Plane parameters. 
 

Table 6-9 Multi Plane parameters 
 

Parameter Description 

Display Format Select the display format. 

 

Ref. Plane 
Select a reference image from A, B, or C. The selected image will be highlighted 

with orange-colored frame. 

Thickness Select the slice thickness. 

Cine Manual selection of single volume frames. 

Cine Calc. Display the Cine Calculations menu. 

 
Multi Plane workflow 

To operate Multi Plane, 

1 Select Sectional Planes on the touch screen. 

2 Select Multi Plane on the touch screen. 

3 Rotate the Thickness soft key to adjust the slice thickness. 

4 Select a plane type via Ref. Plane to select a reference image. 

5 Select Cine Calc. to activate the cine calculation. 
The slice playback menu appears on the touch screen. 

6 Rotate the Start soft key to take the first slice. 

7 Rotate the End soft key to take the last slice. 

8 Rotate the Speed soft key to set the playback speed for cine images. 

9 Select Full to start the playback of the full cine clip. 
Or select Clip to start the playback of the selected cine clip. 

10 Select Full again to stop the playback of the full cine clip. 
Or select Clip again to stop the playback of the selected cine clip. 
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AnySlice 

AnySlice allows you to observe the sectional images after drawing a curved line on the selected image in 
MPR mode. 

 

Figure 6-33 AnySlice 
 
 

AnySlice parameters 

The following table describes the AnySlice parameters. 
 

Table 6-10 AnySlice parameters 
 

Parameter Description 

Display Format Select the display format. 

 

Ref. Plane 
Select a reference image from A, B, or C. The selected image will be highlighted 
with orange-colored frame. 

Ref. Line Select a reference line from 1, 2, or 3. 

Thickness Select the slice thickness. 
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AnySlice workflow 

To operate AnySlice, 

1 Select Sectional Planes on the touch screen. 

2 Select AnySlice on the touch screen. The “  ” mark appears. 

3 Select a reference line via Ref. Line on the touch screen. 
Or, press the [Priority] key to set the trackball to Curved ROI. 

4 Use [Trackball] to draw a curved line on a reference image. 

5 If you have finished drawing a line, press the [Set] key. 

6 Optimize the image for observation by using parameters on the touch screen. 

 

AnySlice screen 

The reference image is displayed on the screen. The reference image is always placed on the upper left 
corner of the screen. 

When more than one line is used to observation, each line is indicated by different color and number. 
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Cubic View 

In Cubic View, the display shows Sagittal, Transverse, and Coronal plane images in volume data. 
 

Figure 6-34 Cubic View 
 

Figure 6-35 Cubic View Parameters 
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Cubic View parameters 

The following table describes the Cubic View parameters. 
 

Table 6-11 Cubic View parameters 
 

Parameter Description 

Display Format Select the display format. 

 

Ref. Plane 
Select a reference image from A, B, or C. The selected image will be highlighted 

with orange-colored frame. 

Mode1, 2 Select the desired cube. 

SlicePlaneA, B, C Adjust the cube size. 

Niche Rot. X, Y, Z Rotate the cube along the X, Y, or Z axis. 

Ref. Slice Move the reference slice to the left and the right in parallel. 

 
Cubic View workflow 

To operate Cubic View, 

1 Select Sectional Planes on the touch screen. 

2 Select Cubic View on the touch screen. 

3 Adjust the cube size by using the following methods: 

a. Using Trackball, 

(1) Select a reference image via Ref. Plane on the touch screen. 

(2) Select the Move item by pressing the [Priority] key on the control panel. 

(3) Select the Axis item by pressing the [Set] key on the control panel. 

(4) Adjust the volume size using [Trackball] key. 

 
b. Using the soft key, 

– Rotate the SlicePlaneA, SlicePlaneB, or SlicePlaneC soft key. 

4 Rotate the cube along the X, Y, or Z axis by using Niche Rot. X, Niche Rot. Y, or Niche Rot. Z soft key. 

 
 

NOTE 

• In Cubic View, the dual image layout may not be available. 

• You can rotate X, Y, and Z axes with the corresponding keys on the control panel. 

• The volume review function is the same as the function in MPR. 
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Multi Slice 

Multi Slice shows parallel cut slices (planes) which are aligned along the X, Y, or Z axis of volume’s 
bounding box. The each texture is shown as an individual view. The reference image is distinguished with 
a dotted axis line. 

 

NOTE 

• The image layout keys (Single, Dual, and Quad) may not work for this view type. 

• Multi Slice can be used when the display format is 3 x 3 or 4 x 4. 
 
 

Figure 6-36 Multi Slice 
 

Figure 6-37 Multi Slice Parameters 



3D/4D Modes 6-87 

 

 

Multi Slice parameters 

The following table describes the Multi Slice parameters. 
 

Table 6-12 Multi Slice parameters 
 

Parameter Description 

 

Display Format 
Set the layout of slice images. The number of slices that can be displayed 
simultaneously on the screen varies based on this setting. 

Ref. Plane Select a reference image from A, B, or C. 

Thickness Select the slice thickness. 

Gray Map Displays the gray map selections on the screen. 

Pitch Set the distance between multiple slices. 

2D Colorize Colorize the 2D image. 

 
 

Prev./Next 

Change the page on the screen. It is useful when the total number of slice images 
exceeds the number allowed by the current display layout. 

– Rotate the Prev./Next soft key clockwise for next images. 

– Rotate the Prev./Next soft key counter-clockwise for previous images. 

Oblique Angle Adjust the angle of the dotted axis lines on the refetence image. 

2D SRI Activate or deactivate SRI on the Multi Slice view. 

 

ActiveView 
Select a slice image to observe. The selected slice will be highlighted with orange- 

colored frame. 

Guide View Display the current plane in single image. 

 

Initial 
Select to delete the oblique image and reset the position information for Ref. 

Image. 
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General workflow 

To operate Multi Slice, 

1 Acquire the volume data. 

2 Touch the Multi Slice tab on the touch screen. 
The Multi Slice soft menus appear on the touch screen. 

3 Observe the interested structure through multiple slices. 
The reference image always displays and indicates which slices you are currently viewing as solid 
lines. 

– A solid line indicates the slice appears on the monitor. 

– A dotted line indicates the slice did not appear on the monitor. 

4 Set the distance between slices by rotating the Pitch soft key. 

5 If necessary, select the reference image via Ref. Plane. 

6 Select the proper image layout via DIsplay Format according to the size of the target structure. 
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VOCAL (Virtual Organ Computer-aided Analysis) 

VOCAL (Virtual Organ Computer-aided Analysis) allows you to measure the volume of tissues in 3D/4D 
modes. 

 

Figure 6-38 VOCAL Display 
 

Figure 6-39 VOCAL Touch Screen 
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VOCAL_Stage 1, 2 

In VOCAL Define mode, you can specify how slice and contour lines are retrieved. 
 

Table 6-13 VOCAL parameters_Stage1 
 

Parameter Description 

 
 

 
Segment Mode 

Specify the method to outline the object. 

• Sphere: Draw a sphere-shaped outline. After creating a spherical object, edit its 
contour to make it into the desired shape. 

• Manual: Draw an outline of the object manually. The number of manually 
generated contours depends on the selected segment angle. 

• Auto: An outline of the object is created automatically. 

 
 

Structure 

Structure is only available with the Auto method. You can select Hypo or Hyper. 

• Hypo: Typically for hypo-echoic lesions, breast tumors, irregular shaped internal 
structures not surrounded by fluid. 

• Hyper: Typically for solid lesions and structures such as uterus, endometrium, 
kidney, prostate, thyroid, fibroadenoma, lymph nodes, etc. 

 

Segment Angle 
Specify the angular spacing between contour traces. (10°, 15°, 30°) 
It defines how many contours have to be generated. 

Next Stage Select to move to the next stage when you’re ready to perform the trace. 

 
Table 6-14 VOCAL parameters_Stage2 

 

Parameter Description 

Frame Select the frame to draw an outline of the object. 

 

Reset 
Remove the trace from the image. 

The VOCAL data are deleted, and the system returns to Stage 1. 

Prev Stage Select to move to the previous stage. 

Next Stage Select to move to the next stage. 

 

 
1 Acquire the volume data. 

2 Touch the VOCAL tab on the touch screen. 
The VOCAL soft menus appear on the touch screen. 

3 Select the volume calculation method via Segment Mode. 

4 Specify the angular spacing between contour traces via Segment Angle. 

5 If necessary, specify the structure via Structure. 

6 Select Next stage on the touch screen. 

7 If the Segment Mode is set to Manual, 

a. Use [Trackball] to trace the anatomy and press the [Set] key 

b. The trace is performed on each image slice, separated by the segmental angle. 
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c. Rotate the Frame soft key until you have completed the total of the required rotations. 

d. After you’ve completed the trace target, select the Next Stage on the touch screen. 

8 The VOCAL image appears in the lower, right-hand corner of the display. 

 

VOCAL_Stage 3 

In VOCAL Edit Mode, you can modify or redraw the existing contour lines. And you can set the Shell Type 
and Shell Thickness. 

 
Table 6-15 VOCAL parameters_Stage3 

 

Parameter Description 

 
 

Render Type 

Set the shell of an object based on its contour line. 

• Surface: VOCAL data are represented using the method of expressing the 
exterior of images by curves. 

• Wire: Represent VOCAL data with dots and lines. 

 
 

 
Shell Type 

Set the shell type. 

• Off: Select if you do not want a shell around the VOCAL image. 

• In : Select Inside if you want a shell inside the volume. 

• Out: Select Outside if you want a shell outside the volume. 

• In-Out: Select Symmetric if you want half of the shell thickness inside and half 
outside the volume’s perimeter. 

Rotate X, Y, Z Rotate the VOCAL image along the X, Y, or Z axis. 

Rotate Reset Reset the rotation of the VOCAL image. 

Edit Frame Select the frame to edit the trace. 

Shell Thickness Adjust the thickness of the shell. 

 

 
1 If necessary, edit the VOCAL image. 

You can apply the shell type, adjust its thinkness, rotate the VOCAL image, or restart the VOCAL. 

– Apply a shell type via Shell Type. 

– Adjust the thickness of the shell by rotating the Shell Thickness soft key. 

– Adjust the plane A with X, Y, Z rotation to achieve the correct measuring plane. 

2 After you’ve completed editing VOCAL image, select the Next Stage on the touch screen. 

3 The calculated VOCAL image and the measurement result are displayed on the screen. 
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VOCAL_Stage 4 

You can optimize the VOCAL data for review. The calculated VOCAL image and the measurement result 
are displayed on the screen. 

 
Table 6-16 VOCAL parameters_Stage4 

 

Parameter Description 

 
 

Render Type 

Set the shell of an object based on its contour line. 

• Surface: VOCAL data are represented using the method of expressing the 
exterior of images by curves. 

• Wire: Represent VOCAL data with dots and lines. 

• Volume: Represent VOCAL data with Silhouette imaging or Live HQ imaging. 

Rotate Reset Reset the rotation of the image. 

Prev Stage Select to move to the previous stage 

3D Color Map Select the desired color map. 
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STIC (Spatial Temporal Image Correlation) 

With STIC (Spatial Temporal Image Correlation), the fetal heart or vascularity can be visualized in 3D/4D 
modes. This acquisition method is designed for beating (fetal heart) as well as blood perfused organs. 

 

NOTE 

STIC is an optional feature. For using these feature, you need an additional request to your local agent. 

 

STIC setup mode 

All touch screen/control panel keys and trackball controls are same as in 3D/4D mode. Therefore only the 
STIC relevant controls are described here: 

 
Table 6-17 STIC Imaging options 

 

Parameter Description 

Acq. Time Adjust the acquisition period (7–20 sec). Only available in STIC. 

 
Volume Angle 

Adjust the volume angle. Only available in STIC. 

• Volume Convex: 15 - 80 

• Volume Endocavity: 10 - 95 

 
STIC acquisition mode 

In STIC mode, you can acquire 3D images through an acquisition interface. 
 

1 Obtain a 2D image and optimize the image for the best quality. 

2 If necessary, obtain a CF image and optimize the image for the best quality. 

3 On the control panel, press the [3D/4D] key. The yellow-colored ROI and soft menus for 3D or 4D 
mode appear. 

4 Touch the STIC tab on the touch screen. 

5 Rotate the Render Direction soft key to change the direction of the image view. 

6 Rotate the Acq. Time soft key to set the aquisition period. 

7 Rotate the Volume Angle soft key to change the sweep angle. 

8 Perform the scan. 
 

NOTE 

Make sure you perform the scanning coutinuously until the fetal heart rate is calculated. 

9 When you have finished, press the [Freeze] key on the control panel to acquire the image data. 

10 The fetal heart rate is calculated, and the dialog box appears. 

11 If you accept the calculated fetal heart rate, click Yes and go to MPR view. 

12 If you do not accepted the calculated fetal heart rate, click No and perform the image acquisition 
again. 
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STIC visualization mode 

In STIC mode, all settings and view types of 3D/4D modes are available. 
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Saving a 3D/4D Image 

You can save 3D or 4D volume data in the system memory. 

To save an image or volume data, 

1 Acquire a 3D or 4D volume image. 

2 Press the [P1] key (or the assigned print key) on the control panel to save the still image. 
Press the [P2] key (or the assigned print key) on the control panel to save the volume data. 

 

NOTE 

• To assign the print keys for saving an image or volume data, go to Utility > Setup > SystemPreset > User 

Setting > Print/Foot Switch. 

• Saving a real-time image may not be available in 4D mode. 

 
To review an image or volume data, 

– On the touch screen, select Review, and then select an image. You can also click a saved thumbnail 
image on the right side in 2D mode. 

 

NOTE 

After saving a video or volume data, you can configure the render settings. 
 
 
 

Exiting 3D/4D Mode 

To exit 3D or 4D mode, 

– Press the [2D] key on the control panel. 
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7 
Scanning and Display 
Functions 

 

This chapter consists of information about the scanning/display functions. 
 
 

Freezing Images ............................................................................................... 7-2 

Zooming Images .............................................................................................. 7-3 

Full Screen ....................................................................................................... 7-4 

Screen Split ...................................................................................................... 7-5 

Cine Images ..................................................................................................... 7-6 

Annotating Images ........................................................................................ 7-10 
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Freezing Images 
Condition in which 2D, M, Doppler, and Color flow image data are retained in a scan converter’s memory 
for examination and/or photograph as well as for video recording. 

 
 

Freezing an image 

1 While scanning an image, press the [Freeze] key on the control panel to freeze the image. 
You can also freeze an image with the right pedal of the footswitch, if supported. 

2 To reactivate the image, press the [Freeze] again. 
To enter Cine mode, use [Trackball]. 

 
NOTE 

• Deactivating the [Freeze] key allows you to erase all measurements including calculations from the 
screen (Not from the worksheet). 

• Selecting a new transducer unfreezes the image. 

• To configure the each pedal of the footswitch, go to Utility > Setup > SystemPreset > User Setting > 

Print/Foot Switch. 

• To configure the [Freeze] key function after freezing an image, go to Utility > Setup > SystemPreset > 
System > Control Panel > Key > Active Function on Freeze. 

 
 

Processing an image 

In freeze mode, you can process 2D, Color Flow (CF) or Doppler mode image. The following controls are 
available: 

 

2D mode CF mode PD mode PWD mode 

Zoom Threshold Threshold Baseline 

Reverse Baseline Baseline Gain 

Gain Invert Invert Sweep speed 

Dynamic range Color map Color map Invert 

Up/Down Gain Gain Colorize 

Colorize Blend Blend Gray map 

Gray map Adaptive Blend Adaptive Blend Auto Angle 

Full SRI Colorize Colorize Angle Correction 

Edge Enhance 
  

Reject 

Reject 
  

Dynamic Range 

   
Auto Calc. 
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Zooming Images 
You can magnify a region of interest (ROI) in a live image or in Cine mode. The zoom option magnifies the 
ROI on the display. There are two zoom functions that you can use: Read zoom and Write zoom 

 
 

Read zoom 

Read zoom allows you to manipulate the negative picture and enlarge it. You can use Read zoom after 
using Write zoom. 

To activate Read zoom, rotate the [Zoom] key on the control panel. 
 
 

Write zoom 

Writing zoom allows you to use the telephoto lens to bring the image closer before acquiring an image. 
You can use Write zoom after using Read zoom. 

To activate Write zoom, press the [Zoom] key on the control panel while scanning a live image. 
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Full Screen 
Full Screen allows you to view magnified images in full screen. 

 
 

Full Screen Display 
 

 
 

Figure 7-1 Full Screen Display 
 
 

To activate and exit the Full Screen mode, 

1 On the touch screen, select Full Screen in the 2D tab. 
The magnified image is displayed in full screen. 

2 To exit the Full Screen mode, select Full Screen again. 
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Screen Split 
Screen Split allows you to view active images as the dual display view. 

 

Figure 7-2 Dual Mode Display 
 
 

To operate the Screen Split function, 

1 Press the [Dual] key on the control panel. 

2 To display other active images, press the [Dual] key again. 
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Cine Images 
The Cine function is available in all imaging modes. During the real-time imaging, the system places the 
most recently acquired images as well as the image currently on the screen into a cine memory buffer. 

Cine image review functions as a storage and enables you to review the sequence of images in the 
system memory. Cine review is available by pressing the [Freeze] key. Moving [Trackball] to the left or 
right scrolls through the cine sequence. 

Images from a cine sequences can be measured and annotated. You can play back cine images to 
simulate a real-time motion, or review an image at one time. 

 

NOTE 

Cine is useful for focusing on images during a specific part of the heart cycle or to view short segments of a 
scan session. 

 
 
 

Using Cine 

You can acquire and save a loop from the current exam. The cine loops are identified by the video icon ( 
) located in the bottom right corner of the thumbnail. 

 

Figure 7-3 Cine Mode Display 
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Cine Gauge Bar 
 

Figure 7-4 Cine Gauge Bar 

 
 

1 
Current number of seconds/total number of 

seconds 

 

4 
 

Cine gauge 

2 Current frame 5 Start frame 

3 Current frame number/total frame number 6 End frame 

 
 
 

Cine Touch Screen 
 

 

Figure 7-5 Cine Touch Screen 
 

Table 7-1 Cine touch screen description 
 

Parameter Description 

Run/Stop Start/Stop the cine loop review. 

Move First Frame Move to the first frame of cine loop. 

Move Last Frame Move to the last frame of cine loop. 

Select All Frame Select all frames of the cine loop. 

Rate Adjust the cineloop playback speed. 

Cycle Select Select the heart cycle to review. 

Edit Start Frame Define new beginning point of a cine loop. 

Edit End Frame Define new ending point of a cine loop. 
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Parameter Description 

Frame by Frame Review the cine image frame by frame manually. 

 
 
 

Activating Cine 

To activate cine, 

1 Press the [Freeze] key on the control panel. The cine controls appear. 

2 Use the cine controls to play the cine loop. 

 
 

Previewing a Cine Loop 

1 Press the [Freeze] key on the control panel. 
Or select the cine loop thumbnail on the clipboard. 

 

NOTE 

The cine loops are identified by the video icon ( ) located in the bottom right corner of the thumbnail. 

2 Touch the Cine tab on the touch screen. 

3 Use [Trackball] to scroll through the cine sequences. 

4 To view the cine loop frame by frame, rotate the Frame by Frame soft key. 

5 Select Move First Frame on the touch screen to take the first frame. 

6 Select Move Last Frame to take the last frame. 

7 If necessary, edit the cine loop. 

– Rotate the Edit Start Frame soft key to define new beginning point of a cine loop. 

– Rotate the Edit Edit Frame soft key to define new ending point of a cine loop. 

8 Rotate the Cycle Select soft key to select the heart cycle to review. 

9 Select Run/Stop on the touch screen to run the cine loop. 

10 Press the print key on the touch screen to store the cine loop. 

11 Select Run/Stop again to stop the cine loop. 

12 Press the [Freeze] or [2D] key to return to scanning. 
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Adjust the Cine Loop Speed 

Rotate the Rate soft key to set the speed of the cine loop playback. 
 
 

Recalling a Cine Loop 

To recall a cine loop from the clipboard, 

1 Press the [Cursor] key to obtain the cursor. 

2 Using [Trackball] to move the cursor over the thumbnail image you want to reload. 

3 Double-click the thumbnail image you want to reload. 
 

NOTE 

The cine loops stored on the clipboard are identified with the video icon ( ). 
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Annotating Images 
The annotation feature provides the capability to type the comments of free text or insert the pre- 
defined comments from the comment library. It also provides the user with arrow marks to point to parts 
of the image. 

You can place text labels and arrow marks on an image to identify anatomical structures and positions 
and also annotate an image with a body marker image that indicates the part of the anatomy that you 
are scanning. 

 

NOTE 

The annotation feature is available in live-acquisition mode and in freeze mode. 
 
 
 

Annotation Display 
 

Figure 7-6 Annotation Display 
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Annotation Controls 
 

Figure 7-7 Annotation Touch Screen 
 
 

 

General Workflow 

To activate and exit Annotation mode, 

1 Press the [Text] key on the control panel. 

2 To configure the default position of the comment cursor, use [Trackball] to place the comment 
cursor to the desired location of the image screen and select Set Home on the touch screen. 

3 The system automatically searches for the word you want in the text bar. 

4 After activating the text mode, a vertical bar type cursor appears on the screen. Use [Trackball] to 
move the cursor. 

 

NOTE 

The default text color is yellow. The color selection can be changed to any of the colors available on the 
system. 

5 When a specific comment or comment group is selected, the color turns to green. Once the 
comment is set or fixed, the color returns to yellow or to the user-selected color. 

6 Delete characters or all comments, if necessary. 

– To delete comments by character, select Back Space on the touch screen. 

– To delete comments by word, rotate and press the Grab/Delete soft key. 

– To delete the comments only, press the [Clear] key right after pressing the [Text] key. 

– To delete the arrow marks only, press the [Clear] key right after pressing the [Arrow] key. 

– To delete all comments as well as arrow marks, press the [Clear] key after entering the scan 
mode. 

7 Rotate the Grab/Delete soft key to move a group of words on the screen. 

8 To exit Annotation mode, press the [Text] key again. 



7-12 Scanning and Display Functions 

 

 

Inserting Annotations 

Inserting directional arrow pointers 

1 Press the [Arrow] key on the control panel. 
An arrow pointer appears on the image screen. The green-colored pointer indicates that it is active 
and movable. 

2 Use [Trackball] to move the pointer to the desired position of the screen. The pointer head 
direction can be controlled as you move [Trackball]. 

3 Adjust the length, thickness, or the angle of the pointer, if necessary. 

– To select the type of the pointer you want, rotate the Arrow Type soft key. 

– To change the size of the pointer you want, rotate the Arrow Size soft key. 

– To adjust the direction of the pointer head, rotate the Arrow Angle soft key. 

4 Press the [Set] key to fix the placement of the pointer and the direction of the pointer head. 
The GREEN color turns to YELLOW (or the default color if changed). 

 
 

Annotating images using the library 

To reduce the amount of time spent annotating an image, store frequently-used comments in the 
comment library. 

1 Press the [Text] key on the control panel. 

2 Rotate the Application soft key to select the desired application. 

3 Rotate the Library soft key to select the desired comment library. 

4 Select the desired comment on the touch screen. 

5 Use [Trackball] to move the selected comment to the desired position of the screen. 

6 When you have finished, press the [Set] key. 
 

 

Annotating images with typed words 

1 Press the [Text] key on the control panel. 

2 Type the desired comment using the QWERTY keyboard or Virtual keyboard. 
Press the [Enter] key to change or add line. 

 

NOTE 

To complete a comment automatically, rotate the Auto-Complete (on) soft key. 

3 To change the font size of comments, rotate the Font Size soft key. 

4 Use [Trackball] to move the comment to the desired position of the screen. 

5 When you have finished, press the [Set] key. 
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Editing Annotations 

Moving text 

You can move the entered text to the desired place. 

1 To select the desired comment or comment group, rotate the Grab/Delete soft key. 
The selected comment color turns to green. 

2 Use [Trackball] to move the selected comment to the desired position of the screen. 

3 When you have finished, press the [Set] key to fix the position. 
 

 

Replacing text 

1 To select the desired comment, rotate the Grab/Delete soft key. 
The selected comment color turns to green. 

2 Type a new comment to replace the selected comment. Or select the desired comment on the 
touch screen. 

3 When you have finished, press the [Set] key. 
 

 

Adding text 

1 Place the comment cursor onto the desired text position to correct the comment and press [Set] 
key. 

2 Select Back Space on the touch screen to delete comment by character, if necessary. 

3 Type a new text to add to previous comments. 

4 When you have finished, press the [Set] key. 

 
 

Deleting Annotations 

To delete all fixed text and pointers, 

– Press the [Clear] key on the control panel. 

– Press the [Clear All] key on the QWERTY keyboard. 
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Body Pattern 

Body Pattern is an additional way to annotate the image. Body patterns are small graphic images 
represent the anatomy being examined. Using body patterns and transducer marker, you can indicate the 
scan position and the position of the transducer during the examination. 

 

Figure 7-8 Body Pattern Display 
 
 

Figure 7-9 Body Pattern Touch Screen 
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Inserting a body pattern 

1 To activate Body Pattern, press the [Body Pattern] key on the control panel. 
A list of body patterns appears on the touch screen. 
A default body pattern is displayed automatically when Body Pattern is activated. 

 

NOTE 

The body pattern list can be configured in Utility > Setup > SystemPreset > Annotation > BodyPattern. 

2 Rotate the Library soft key to select the desired application. 
 

NOTE 

The body pattern list that appears on the touch screen will vary depending on the selected application. 

3 Select the desired body pattern on the touch screen. 
The body pattern with a transducer marker is shown on the screen. 

4 To reposition the body pattern, press the Move Pattern soft key. 

5 Use [Trackball] to adjust the position of the body pattern and press the [Set] key. 

6 Rotate the Probe Size soft key to select the desired size of transducer marker. 
The selected transducer marker appears on the screen. 

7 Rotate the Probe Angle soft key to adjust the angle of the transducer marker. 

8 Use [Trackball] to adjust the position of the transducer marker and press the [Set] key. 
 

 

Deleting a body pattern 

To delete a body pattern, 

– Press the [Clear] key on the control panel. 

– Press the [Clear All] key on the QWERTY keyboard. 
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General Measurements and 
Calculations 

 

This chapter describes how to perform general measurements, calculations and report 
functions. 

 

Overview.......................................................................................................... 8-2 

Basic Measurements ....................................................................................... 8-6 

Patient Worksheets (Reports) ....................................................................... 8-29 
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Overview 
Measurements and calculations based on ultrasound images are intended to complement other clinical 
procedures available to the physician. The accuracy of the measurement is determined not only by the 
system precision, but also by the use of the proper medical protocol by the user. 

 
WARNING 
The system provides calculations (eg, estimated fetal weight) and charts based on published scientific  
literature. It is the responsibility of the user to select the appropriate chart and clinical interpretation of the 

calculations and charts. The user should consider the contraindications for the use of calculations and charts 
described in the scientific literature. The diagnosis, decision of further examination and medical treatment 
should be performed by a qualified person following good clinical practice. 

 
 

Measurement Display 
 

Figure 8-1 Measurement Menu Display 
 
 

1 Measure reference window 5 Graph 

2 Labeled measurement 6 Result window 

3 Direct keys 7 Mini Report 

4 Report 
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Direct key 

With the Direct key feature, you can quickly access measurement menus by simply pressing 
alphanumeric keys on the QWERTY keyboard. There are total of 16 available keys: A, S, D, F, G, H, J, K, L, 
Z, Y, C, V, B, N, M 

 

NOTE 

Direct key feature is only available with QWERTY keyboard. 

1 Press the [Caliper] key on the control panel. 

2 From the labeled measurement menu, press an alphanumeric key to access the menu you want. 
You can see the corresponding direct key on the right side of the menu. 

 

3 Repeat step 2 until the desired menu appears. 

 

Measurement result window 

After performing the measurement, the system automatically makes the calculation related to 
the performed measurement, and the measured values and calculated values are displayed in the 
measurement result window. 

The measurement result window can be moved so that the result window does not obscure the 
ultrasound image. 

You can change the window status by selecting one of the following icons: 

 
Table 8-1 Measurement result window 

 

Icon Description 

 

 

 
Change the background type (e.g. transparent or opaque) of the Result window. 

 

 

 
Change the position of the Result window. 

 

 

 
Display the Mini Report. 
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Measurement Controls 
 

Figure 8-2 Measurement and Display Controls 
 

The following table describes the measurement and display controls. 
 

No Control Description 

1 Result Window Show or hide the measurement result window. 

2 Result Font Size Select a font size for the measurement results. 

3 Graph Access OB Graph page (applies only to OB). 
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General Workflow 

To select or change a measurement type, 

– Select the desired measurement type on the touch screen. 
 

NOTE 

The type of measurement depends on the current scan mode. 
 

To adjust the font size for the measurement results, 

– Rotate the Result Font Size soft key. 

 
To show or hide the result window, 

– Rotate the Result Window soft key. 

 
To modify a measurement result, 

1 Click the result value you want to change from the Result window. 
The caliper is activated. 

2 Use [Trackball] to change the measurement value and press the [Set] key. 

– To switch the caliper mark of the current value, press the [Caliper] key when the caliper is 
active. 

– To activate the caliper of another value, press the [Priority] key repeatedly until the desired 
value is highlighted. 

 
To delete a measurement result, 

1 Click the result value you want to delete from the Result window. 
The caliper is activated. 

2 Press the [Clear] key on the control panel. 

 
To return to scanning, 

– Press the [2D] key on the control panel. 
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Basic Measurements 
Each application has a basic study. The basic studies provide you quick access to measurements such as 
volume, angle, A/B ratio, and % stenosis. The particular measurements available in each basic study vary, 
depending on the application and the mode. This section describes measurements, organized by mode. 

 
To begin the basic studies, 

1 Press the [Caliper] key on the control panel. 
The Basic tab appears on the touch screen. 

2 Select the desired basic measurement on the touch screen. 
If you select the measurement folder, the sub menus are displayed. You can select the 
measurement on the touch screen. 

3 Perform the measurement. 

 
 

Basic Measurement Units 

Table 8-2 Basic measurement unit 
 

Mode Measurement Unit Abbreviation 

 
 
 
 

2D mode 

Distance 

Area 
Circumference 
Angle 

%Stenosis 
Volume 

Disk Volume 
Volume Flow Area 

centimeters 

centimeters2 
centimeters 
degree 

percent 
milliliter 

milliliter 
centimeters2 

cm 

cm2 
cm 
deg 

% 

ml 
ml 

cm2 

 

 
M mode 

Distance 
Time 

Slope 

%Stenosis 
HR 

centimeters 
milliseconds 

centimeters per second 
percent 

beats per minute 

cm 
ms 

cm/s 

% 

bpm 

 
 

 
D mode 

Velocity 

PG 

Time 

VTI 

Acceleration 
HR 

Volume Flow 

centimeters per second 
millimeters mercury 

millisecond 
centimeters 

centimeters per second2 

beats per minute 

Volume milliliter per minute 

cm/s 
mmHg 

ms 

cm 
cm/s2 
bpm 

ml/min 
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Measurement Formula 
 

Table 8-3 Measurement formula 
 

Mode Measurement Method Formula 

 
 
 
 
 
 
 
 
 
 

2D 

 
Circumference 

 
Ellipse 

 

 

Area Ellipse A= π(D1)(D2)/4 

 
 

%Stenosis 

 
2 Diameter 

2 Area 

%Steno= 

(1- min(D1, D2)/max(D1, D2))X100 

%Steno= 

(1- min(A1, A2)/max(A1, A2)X100 

 

 
Volume 

1 Distance 

2 Distance 

3 Distance 

Ellipse 

Distance + Ellipse 

V= πD13/6 

V= D1X D2Xmin(D1, D2)Xπ/6 
V= πD1XD2XD3/6 

V= D1XD2Xmin(D1, D2)Xπ/6 
V= πD1XD2XD3/6 

 
Disk Volume 

 

 

Volume Flow Area A= π/4XD2 

 
M 

Slope S= (D1-D2)/∆T 

HR HR= Cycle number/∆T*60 

 
 
 

 
D 

Acceleration Accel= (V1-V2)/∆T 

PI PI= (PS-ED)/Vmean 

RI RI= (PS-ED)/PS 

HR HR= Cycle number/∆T*60 

 

Volume Flow 
 

Distance 
Vol. Flow= AXTAmax (or TAmean)X60/ 1000 
(A=π/4XD2) 
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Basic Measurements 

The basic measurements are available in the following imaging modes: 

• 2D mode 

• M mode 

• Doppler mode 

 

2D mode measurements 

The basic 2D mode measurements include the following measurement parameters: 

• Tissue depth 

• Distance 

• Circumference and Area 

• Angle 

• Volume 

• Stenosis 

• A/B Ratio 

• Disk Volume 

• Histogram 

• Elasto Size Compare 

• Elasto Strain Ratio 

• Volume Flow Area 

 
❚ Tissue depth 

Selecting this option in the system preset enables depth to be automatically measured when the first 
measurement marker appears on the image. 

The Result window shows the distance from a point on the transducer-skin interface to the marker 
until the first marker is anchored. 

 

NOTE 

To configure the tissue depth, go to Utility > Setup > SystemPreset > Measurement > General > Tissue 
Depth display(2D,M). 
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❚ Distance 

• 1 Distance 

• 3 Lengths 

• Trace 
 

NOTE 

Measurement error is within 5% of the distance you measured for all transducers. 
 

1 Distance 

1 Select Distance on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 Press the [Set] key to fix the point. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

5 The measured value is fixed, and the distance (D) is shown on the Result window. 

 
3 Lengths 

1 Select Distance on the touch screen. The start point appears. 

2 Draw three straight lines using [Trackball], and press the [Set] key. 

3 Move the fourth point, and then press the [Set] key. 

4 The measured value is fixed, and three distances (D1, D2, D3) are shown on the Result window. 

 
Trace 

1 Select Distance on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The end point appears. 

3 Move the end point gradually along the circumference of the target object using [Trackball]. 

4 When the start point and the end point are connected with a line, press the [Set] key to 
complete the measurement. 

5 The measured value is fixed, and the distance (D) is shown on the Result window. 
 

NOTE 

To configure the distance, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Distance 

> Default method. 
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❚ Circumference and Area 

• Ellipse 

• Trace 

• Spline 

 
Ellipse 

1 Select Ellipse on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point, and press the [Set] key. The ellipse 
appears. 

4 Use [Trackball] to adjust the height of the ellipse, and press the [Set] key again. 

– To increase the height, move [Trackball] up and right. 

– To decrease the height, move [Trackball] down and left. 

5 The measured value is fixed. The two diameters (D1, D2), the circumference (C), and the area 
(A) are shown on the Result window. 

 

Trace 

1 Select Trace on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to move the end point gradually along the circumference of the target object. 

4 When the start point and the end point are connected with a line, press the [Set] key to 
complete the measurement. 

5 The measured value is fixed. The circumference (C) and the area (A) are shown on the Result 
window. 

 

Spline 

1 Select Spline on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The second point appears. 

3 Set the third and subsequent points in the same way. 

4 Press the [Set] key twice at the same point to fix the end point. 

5 The measured value is fixed. The circumference (C) and area (A) are shown on the Result 
window. 
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❚ Angle 

• 3 Points 

• 2 Lines 

• 2 Lines (Axis) 

• 3 Lines(BA) 

• 3 Lines(AB) 

 
Angle 3 Points 

1 Select Angle on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point. 

4 Press the [Set] key. The third point appears. 

5 Use [Trackball] to move the third point to the end point of the angle measurement. 

6 Press the [Set] key. The angle between the two lines appears. 

7 The angle (Angle) is shown on the Result window. 

 
Angle 3 Lines 

1 Select Angle on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
TThe first point is fixed, and the second arrow-shaped point appears. 

3 Use [Trackball] to move the marker to the second point. 

4 Draw the baseline, and press the [Set] key to fix the baseline. 
The third point appears. 

5 Draw the remaining two straight lines to cross the baseline as the same way. The α angle and β 
angle appear. 

6 Press the [Set] key at the end point of the third straight line to fix the measured value. 
The two angles (Alpha, Beta) are shown on the Result window. 

 

NOTE 

To configure the angle, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Angle > 

Default method. 
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❚ %Stenosis 

• 2 Distances 

• 2 Ellipses 

• 2 Traces 

• Trace+Ellipse 

• Ellipse+Trace 

 
Two diameters percent stenosis calculation 

1 Select %Stenosis on the touch screen. The start point appears. 

2 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key. 

3 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key. 

4 The two diameters (D1, D2) and the diameter percent stenosis (%Steno(Diam)) are shown on 
the Result window. 

 

Two ellipses percent stenosis calculation 

1 Select %Stenosis on the touch screen. The start point appears. 

2 Measure the outer area (A1) of the stenosis using [Trackball], and press the [Set] key. 

3 Measure the inner area (A2) of the stenosis using [Trackball], and press the [Set] key. 

4 The two ellipses (A1, A2) and the diameter percent stenosis (%Steno(Area)) are shown on the 
Result window. 

 

NOTE 

To configure the %Stenosis, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > 

%Stenosis > Default method. 
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❚ Volume 

• 1 Distance 

• 2 Distances 

• 3 Distances 

• Ellipse 

• Distance+Ellipse 

 
3 Distance volume 

1 Select Volume on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

4 Measure the second and third distances in the same manner. 
When the three distances are measured, the volume is calculated. 

5 The measured value is fixed. The three distances (D1, D2, D3) and the volume (Vol) are shown 
on the Result window. 

 

NOTE 

When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 

shown on the Result window. For the volume of two distance (D2), measure one and two distances (D1, 
D2) and press the [Clear] key. 

 

Ellipse 

1 Select Volume on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point and press the [Set] key. The ellipse 
appears. 

4 Use [Trackball] to adjust the height of the ellipse, and press the [Set] key again. 

– To increase the height, move [Trackball] up and right. 

– To decrease the height, move [Trackball] down and left. 

5 The measured value is fixed. The two distances (D1, D2) and the volume (Vol) are shown on the 
Result window. 

 

NOTE 

To configure the volume, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Volume > 

Default method. 
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❚ Disk Volume 

• Trace 

• Spline 

 
Trace 

1 Select DiskVolume on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to create a trace of the structure with the second point. 

4 Press the [Set] key to complete the trace. 
The start and end points of the trace are connected, and a line representing the long axis 
appears. 

5 Press the [Set] key again. The volume is calculated. 

6 The area (A), the circumference (C), the diameter (D), and the volume (V) are shown on the 
Result window. 

 

Spline 

1 Select DiskVolume on the touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. The second point 
appears. 

3 Set the third and subsequent points in the same manner. 

4 Press the [Set] key twice to complete the trace. 
The start and end points of the trace are connected, and a line representing the long axis 
appears. 

5 Press the [Set] key again. The volume is calculated. 

6 The area (A), the circumference (C), the diameter (D), and the volume (V) are shown on the 
Result window. 

 

NOTE 

To configure the disk volume, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Disk 

Volume > Default method. 
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❚ A/B Ratio 

• 2 Distances 

• 2 Ellipses 

• 2 Traces 

• Ellipse+Trace 

• Trace+Ellipse 

 
Two diameters ratio 

1 Select A/B Ratio on the touch screen. The start point appears. 

2 Measure the first diameter (D1) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second diameter (D2) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two distances (D1, D2) and A/B ratio (A/B Ratio) are shown on the 
Result window. 

 

Two ellipses ratio 

1 Select A/B Ratio on the touch screen. The start point appears. 

2 Measure the first area (A1) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second area (A2) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two ellipses (A1, A2) and A/B ratio (A/B Ratio) are shown on the 
Result window. 

 

NOTE 

To configure the A/B ratio, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > A/B 

Ratio > Default method. 
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❚ Histogram 

HIistogram is a function that the gray scale distribution within a marked Region of Interest (ROI) will 
be graphically displayed on the screen. 

 

1 Select Histogram on the touch screen. 

2 Use [Trackball] to move the caliper to the corner of the area where you want to measure the 
histogram. 

3 Press the [Set] key. 

4 Use [Trackball] to move the caliper diagonally to the opposite side of the area. 

5 Press the [Set] key. The measured value is shown on the Histogram window. 
To view the histogram, go to the Histogram window. 

 

NOTE 

To configure the histogram, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > 

Histogram. 

 
CAUTION 
Do not change the gain control of the 2D image after performing the histogram measurement. Your 
change may not be applied on the histogram. 

 

❚ Elasto Size Compare 

Elasto Size Compare applies the measured data in 2D mode to Elastography mode. Size of lesion in 2D 
mode and Elastography mode can be compared to have more accurate diagnose result. 

 

NOTE 

For details, see "Elasto Size Compare" on page 11-44. 
 

❚ Elasto Strain Ratio 

Elasto Strain Ratio provides quantitative information. It is calculated by comparing the strain of a 
lesion to the surrounding normal tissue. Soft tissue will have higher strain values than stiff tissue. It is 
displayed as a real-time color map of the relative elasticity. 

 

NOTE 

For details, see "Elasto Strain Ratio" on page 11-45. 
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❚ Volume Flow Area 

• Distance 

 
1 Select Volume Flow Area on the touch screen. 

2 Use [Trackball] to move the marker to the start point. 

3 Press the [Set] key to fix the point. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

5 The measured value is fixed, and the volume flow area is shown on the Result window. 

 
NOTE 

• To calculate volume flow measurement, go to Utility > Setup > SystemPreset > Measurement > 
Advanced MEAS. > Modify Calcs and check Volume Flow from Semi Auto Trace or Auto Trace(Calc). 
Then, perform Auto Trace or Semi Auto Trace measurement in Doppler mode. 

• To configure the volume flow method, go to Utility > Setup > SystemPreset > Measurement > 
Advanced MEAS. > Vol.flow Method. 
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M mode measurements 

The basic M mode measurements include the following measurement parameters: 

• Distance 

• Time 

• Slope 

• %Stenosis 

• Heart rate (HR) 

• A/B Ratio 

 
❚ Distance 

• 1 Distance 

• 3 Lengths 

 
1 Distance 

1 Select Distance on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The measured value is fixed, and the distance (D) is shown on the Result window. 

 
3 Lengths 

1 Select Distance and then select 3 Lengths on the touch screen. 
The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 

3 Draw the first straight line using [Trackball], and press the [Set] key. 

4 Draw the second straight line using [Trackball], and press the [Set] key. 

5 Draw the third straight line using [Trackball], and press the [Set] key to complete the 
measurement. 

6 The measured value is fixed, and three distances (D1, D2, D3) are shown on the Result window. 
 

NOTE 

To configure the distance, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Distance 

> Default method. 



Basic Measurements 8-19 

 

 

❚ Time 

1 Select Time on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The time (T) is shown on the Result window. 

 
❚ Slope 

1 Select Slope on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window. 

 

❚ %Stenosis 

Two diameters percent stenosis calculation 

1 Select %Stenosis on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the larger vertical diameter (D1) of the stenosis using [Trackball], and press the [Set] 
key. 

3 Measure the smaller vertical diameter (D2) of the stenosis using [Trackball], and press the [Set] 
key. 

4 The diameters (D1, D2) and the diameter percent stenosis (%Steno(Diam)) are shown on the 
Result window. 

 

NOTE 

For diameter calculation, do not take a distance measurement from a longitudinal view. This may lead to 

an inaccurate assessment of %stenosis. 
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❚ A/B Ratio 

• Distance 

• Time 

 
Distance ratio 

1 Select A/B Ratio and then select Distance on the touch screen. The start point appears. 

2 The vertical line and the horizontal line are perpendicular to each other. 

3 Measure the first vertical diameter (D1) of the ratio using [Trackball], and press the [Set] key. 

4 Measure the second vertical diameter (D2) of the ratio using [Trackball], and press the [Set] key. 

5 The ratio is calculated. The two distances (D1, D2) and A/B ratio (Distance Ratio) are shown on 
the Result window. 

 

Time ratio 

1 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Time on the touch 
screen. The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first horizontal diameter (T1) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second horizontal diameter (T2) of the ratio using [Trackball], and press the [Set] 
key. 

4 The ratio is calculated. The two distances (T1, T2) and A/B ratio (Time Ratio) are shown on the 
Result window. 

 

NOTE 

To configure the A/B ratio, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > A/B 
Ratio > Default method. 

 

❚ Heart Rate (HR) 

1 Select HR on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the HR cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced MEAS. > HR 
cycle. 
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D mode measurements 

The basic D mode measurements include the following measurement parameters: 

• Velocity 

• Time 

• Acceleration 

• Resistivity Index (RI) 

• Pulsatility Index (PI) 

• VTI 

• Heart Rate (HR) 

• A/B Ratio 

• S/D Ratio 

• AC/DC 

• PHT 

• Auto Calc 

• Auto Trace/Semi Auto Trace/Trace 

 
❚ Velocity 

1 Select Velocity on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed. The velocity (Vel) and pressure gradient (PG) are shown on the 
Result window. 

 

❚ Time 

1 Select Time on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The velocity (Vel) and time (T) are shown on 
the Result window. 
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❚ Acceleration 

1 Select Acceleration on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed, and the acceleration is calculated. The acceleration (Accel), the 
acceleration time (AT), and maximum velocity (Vmax) are shown on the Result window. 

 

❚ Resistivity Index (RI) 

1 Select RI on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point and press the [Set] key again. 

4 The end point is fixed, and the resistive index is calculated. The peak systolic velocity (PS), end 
diastolic velocity (ED), and resistivity index (RI) are shown on the Result window. 

 

❚ Pulsatility Index (PI) 

1 Select PI on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Move the marker to the start point of the waveform using [Trackball], and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform, and press the [Set] key. 

4 The pulsatility index is calculated. 

5 The peak systolic velocity (PS), end diastolic velocity (ED), minimum diastolic velocity (MD), the 
maximum time-average velocity (TAmax), the resistivity index (RI), the pulsatility index (PI), and 
systole/diastole ratio (S/D) are shown on the Result window. 
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❚ Velocity-Time Integral (VTI) 

1 Select VTI on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Move the marker to the start point of the waveform using [Trackball], and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key. 

4 The velocity-time integral is calculated. The minimum, maximum, mean velocities (Vmin, Vmax, 
Vmean) and maximum and mean pressure gradients (PGmax, PGmean) are shown on the 
Result window. 

 

❚ A/B Ratio 

• Velocity 

• Time 

 
Velocity ratio 

1 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Velocity on the 
touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first point (V1) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second point (V2) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two velocities (V1, V2) and A/B ratio (Velocity Ratio) are shown on 
the Result window. 

 

Time ratio 

1 Select A/B Ratio on the touch screen. And select A/B Ratio and then select Time on the touch 
screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first time interval (T1) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second time interval (T2) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two time values (T1, T2) and A/B ratio (Time Ratio) are shown on the 
Result window. 

 

NOTE 

To configure the A/B ratio, go to Utility > Setup > SystemPreset > Measurement > Basic MEAS. > A/B 

Ratio > Default method. 
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❚ AC/DC 

1 Select AC/DC on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first oblique line (Accel) of the slope using [Trackball], and press the [Set] key. 

3 Measure the second oblique line (Decel.) of the slope using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The acceleration index (Accel), the acceleration time (AT), the 
deceleration index (Decel.), and deceleration time (DT) are shown on the Result window. 

 

❚ Heart Rate (HR) 

1 Select HR on the touch screen. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 

MEAS. > HR cycle. 
 

❚ Auto Calc 

1 In PW mode, select Auto Calc on the touch screen. 

2 Select Frozen or Live. 

3 If you select Live, the caliper and waveform trace automatically appear. 

4 If you select Frozen, press the [Freeze] key on the control panel to freeze the image. 
The caliper and waveform trace automatically appear. 

5 The calculated value is shown on the Result window. 
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Auto Calc options 

• Method: Select a trace method for Doppler spectrum. 

• Direction: Select a trace direction for Doppler spectrum. 
 

NOTE 

• To configure the auto trace options, press the [Image Preset] key and go to General. 

• To measure the maximum velocity, select Below or Above for the trace direction. 

• To edit the trace, use [Trackball]. 

 

 
Figure 8-3 Doppler 

 
 

❚ Auto Trace 

1 In PW mode, select the desired measurement item and then select Auto Trace on the touch 
screen. 
The Doppler spectrum is traced automatically and the results are displayed. 

2 If necessary, adjust the calculation cycle using [Trackball] and the [Caliper] key on the control 
panel. 

a. A green line appears at the right of the spectrum. 

b. Using [Trackball], move the line and readjust the end cycle. 

c. Press the [Caliper] key on the control panel. 
The line changes to gray. 

d. A green line appears at the left of the spectrum. 

e. Using [Trackball], move the line and readjust the start cycle. 

f. Press the [Set] key on the control panel. The line changes to gray. 

3 The calculated value is shown on the Result window. 
 

NOTE 

To configure the auto trace options, go to Utility > Setup > SystemPreset > Measurement > Advanced 

MEAS. > Modify Calcs > Auto Trace(Calc). 



8-26 Measurements and Reports 

 

 

❚ Semi Auto Trace 

1 In PW mode, select the desired measurement item and then select Semi Auto Trace on the 
touch screen. The start point appears. 

2 Use [Trackball] to move the marker to the start point of the waveform and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key. 

4 The calculated value is shown on the Result window. 
 

NOTE 

To configure the semi auto trace, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > Modify Calc > Semi Auto Trace. 

 

❚ Manual Trace 

1 In PW mode, select the desired measurement item and then select Trace on the touch screen. 
The start point appears. 

2 Use [Trackball] to move the marker to the start point of the waveform and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace one cycle of the waveform, and press the [Set] key. 

4 The calculated value is shown on the Result window. 
 

NOTE 

To configure the manual trace, go to Utility > Setup > SystemPreset > Measurement > Advanced MEAS. > 

Modify Calc > Manual Trace. 
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Measurement Accuracy 

The measurement values should always be accurate according to measuring caliper and point. 

Despite the high technical accuracy of the scan geometry and the measuring system of the X-CUBE 
60 expert equipment, one must, however, be aware of inaccuracies caused by the ultrasound beam 
properties and the physiological properties of the scanned structures, tissues and fluids. 

For the reason of improved lateral resolution you should choose the proper scan head for the depth 
range of the structure to be measured. 

 
Table 8-4 Measurement accuracy 

 

Mode Measurement Accuracy 

 
 
 
 
 

2D 

Depth ≤ 5 % 

Distance ≤ 5 % 

 
Circumference 

Ellipse ≤ 5 % 

Trace ≤ 5 % 

 
Area 

Ellipse ≤ 5 % 

Trace ≤ 5 % 

M Time ≤ 5 % 

D Velocity (30–70 cm/s) ≤ 15 % 

CF Velocity ≤ 15 % 
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Calculation accuracy 

Estimate the overall inaccuracy of a combined measurement and calculation by including the stated 
inaccuracy from the basic measurement accuracy statements. 

Calculation formulas and databases are provided as a tool to assist the user, but should not be 
considered an undisputed database, in making a clinical diagnosis. The user is encouraged to research 
the literature and judge the equipment capabilities on an ongoing basis in order to assess its utility as a 
clinical tool. 
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Patient Worksheets (Reports) 
In X-CUBE 60, a report can be generated based on the tests performed and the results analyzed during 
the examination. This report is generated using pre-selected templates and data stored in the system. 

 
To enter the Report screen, do one of the following: 

– Touch Report on the touch screen. 

– Select Report on the context menu. 
 

 

Report Screen Display 
 

Figure 8-4 Report Screen Display (OB) 
 
 

1 Measurement application selection 4 Worksheet 

2 Measurement mode selection 5 Image clipboard 

3 Function selection 6 Exit 
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Report Touch screen and Controls 
 
 
 
 
 
 
 

 

Figure 8-5 Report Touch Screen (OB) 

Table 8-5 Report/Worksheet controls 
 

Controls Description 

Report Access Worksheet page. 

Basic MEAS. View a worksheet of basic measurement. 

Preview Preview the report in print layout. 

Graph Access OB Graph page (applies only to OB). 

Anatomical Survey Access Anatomical Survey page (applies only to OB). 

Fetus Compare Compare between fetuses by viewing measurement and calculation values. 

2D/M/Doppler View a worksheet with data for a particular mode (2D, M, or Doppler). 

All View a worksheet with data for more than one mode. 

Comment View or edit comments. 

Delete Value Delete the current measurement value. 

Exclude Value Exclude or include measurement value. 

Print Print out the report to the default printer. 

Select AUA/CUA Select the ultrasound age calculation method (applies only to OB). 

Delete All Delete all measurement values for all modes from the report. 

Select Page View the next page. 

Exit Exit the Report screen. 
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Activating a Worksheet 

When the measurement is complete, all measurement results are recorded in the application-specific 
patient worksheet. 

The worksheet feature allows you to review, edit, delete, or print data from reports. All measurements 
and calculations performed during the inspection can be reviewed at any time using the worksheet. 

 

Figure 8-6 Worksheet Display 
 
 

1 Patient information 4 Measured values 

2 Measurement information 5 Value type: Average, Max, Min or Last 

3 Calculation information 
  

 

 

Viewing a worksheet 

To view a worksheet, do one of the following: 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 

The system displays the worksheet for the current exam. 

 
To view a worksheet of basic measurement, 

– Select Basic MEAS. on the touch screen. 
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To view a worksheet by application or measurement mode, 

– Select an application or a mode from the corresponding list or field on the top left of the display. 

• To view a worksheet with data for a particular mode, select a mode (2D, M, or Doppler) on the 
touch screen. 

• To view a worksheet with data for more than one mode, select All on the touch screen. 
 

If a worksheet has more data on a second page, to view the next page, 

– Rotate the Select Page soft key. 

 

Exiting the worksheet 

To exit Worksheet page and return to the scan mode, do one of the following: 

– Press the Exit key on user-defined key. 

– Select Exit on the touch screen. 
 

 

Editing a Worksheet 

Some fields on the worksheet are view-only, and others you can select or change. Use the trackball to 
easily see which fields you can select or change. When the cursor moves over a field that can be selected 
or changed, the field is highlighted. 

 

NOTE 

What you see on the screen varies depending on the selected measurement package. 

 

Changing the report data 

To change the measurement value, 

1 Use [Trackball] to move the cursor to the field that you want to change. 
The field is highlighted. 

2 Press the [Set] key. The field backlights. 

3 Type the new data in the field. 
The new data is displayed in green with an asterisk mark. 

 

NOTE 

The new data, displayed in green with an asterisk mark, is appended to the updated value and resultant 
value to indicate that it was manually entered. 

 

Deleting the report data 

To delete measurement values, 

1 Use [Trackball] to move the cursor to the field that you want to erase. The field is highlighted. 

2 Do one of the following: 

– Select Delete Value to delete the current value. 
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– Press the Delete All soft key to delete all values for all measurement modes from the report. 

– Press the [Clear] key on the control panel to delete all measurement values from the report. 

 

Excluding/Including the report data 

If you select a particular value on the report and select Exclude Value, the value is excluded from the 
result row, the resultant value is recalculated without the value, and the calculated values using the value 
is blank. 

 
To exclude or include measurement values, 

1 Use [Trackball] to move the cursor to the field that you want to exclude. 
The field is highlighted. 

2 Do one of the following: 

– Select Exclude Value to exclude the data. The excluded data is displayed in white. 

– Select Exclude Value again to include the data that you previously excluded. 

 

Selecting a type of value 

To select a method, 

1 Use [Trackball] to move the cursor over the value in the Method column and press the [Set] key. 

2 Select a method from the drop-down list. 

• Last: Last measurement that was taken 

• Aver: Average of the measurements taken 

• Max: Maximum measurement 

• Min: Minimum measurement 

3 The selected method is displayed in the column, and the value is updated accordingly. 

 

Adding comments 

To type a comment, 

1 Select Comment on the touch screen. The Comment screen appears. 

2 In the Comments field, type comments about the exam by using the QWERTY keyboard or Virtual 
keyboard. 

3 To close the Comment screen, click OK or select Comment on the touch screen. 
 

NOTE 

On the Patient screen, you can edit text in the Exam Comments field. 
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Printing a Report 

Reports summarize data obtained in the examination. They can contain data and images. 

Once generated, the report can be viewed, and images can be added. The examination data itself cannot 
be modified. Use the worksheet to review and adjust the data before generating the report. 

The completed report can be printed on a standard printer. 
 

Figure 8-7 Report Preview (OB) 
 
 

 

Previewing the report 

It provides report preview before print-out. 
 

To preview the report in print layout, 

– Select Preview on the touch screen, or select Preview on the context menu. 
You can preview a report to be printed. 

 

Images in the report 

To add an image to the report, 

1 Move the cursor to the desired image on the clipboard and press the [Set] key. 

2 Move the cursor where the selected image is to be inserted and press the [Set] key. 

 
To remove an image from the report, 

– Move the cursor to the desired image on the report and select Delete Image on the touch screen. 
 

To add image pages to the report, 

– Select Add Image Page on the touch screen. 
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To delete image pages from the report, 

– Select Delete Image Page on the touch screen. 
 

To add all the images on the clipboard to the report, 

– Select Add Image All on the touch screen. 
 

NOTE 

You cannot add more than 10 image pages to a report. 

 

Exporting the report to media 

To export the report to storage media as PDF format, 

1 Select PDF Export on the touch screen. The Save dialog box appears. 

2 Select a media from the Device field. 

3 Type a file name in the File Name field. 

4 Click Save. The progress bar appears during exporting files. 

 

Printing a report 

To print a report via a standard printer, 

– Select Print on the touch screen. 
 

To capture the Report screen, 

– Press the [P1], [P2], [P3] or [P4] key on the control panel. 
 

NOTE 

• A default standard printer can be configured in Utility > Setup > SystemPreset > System > Peripheral > 

Standard Printer. 

• The supported paper size for report is A4, Letter only. 

 

Transfering the report data 

You can transfer a measured data via the RS232C port. This function is only available for OB and GYN 
reports, and anatomical survey. 

 
To transfer the measured data, 

1 Go to Utility > Setup > SystemPreset > System > Peripheral > RS232C > COM and select the 
Transfer Measurement from the drop-down list. 

2 From the Report screen, select Transfer on the context menu. 
When the data is being transferred, the progress bar indicating the transfer appears on the display. 
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Abdomen 

Abdomen Measurements and Calculations 

2D mode measurements 

2D mode measurements display in the context menu and the abdomen report with measured result, 
when assigned. 

 
Table 9-1 2D mode measurement (Abdomen) 

 

Measurement Description 

Aorta Aorta Diameter 

Renal L Renal Length 

Renal Renal Volume 

Renal L Renal Length 

Renal H Renal Height 

Renal W Renal Width 

Renal Vol Renal Volume 

Aorta Aorta 

Renal A Renal Artery 

Hepatic A Hepatic Artery 

Portal V Portal Vein 

Splenic A Splenic Artery 

SMA Superior Mesenteric Artery 

IMA Inferior Mesenteric Artery 

Iliac A Iliac Artery 

Vessel Vessel 

Volume Flow Area Volume Flow Area 

%Stenosis Stenosis 

Volume Volume 

A/B Ratio A/B Ratio 

 
NOTE 

To configure the 2D mode measurement, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Abdomen > 2D > Default Measurement. 
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❚ Aorta Diameter 

1 Select Aorta on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the aorta diameter (Aorta) is shown on the Result window. 

 
❚ Renal Length 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Renal L. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the renal length (Rt or Lt Renal) is shown on the Result 
window. 
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❚ Renal Volume (1) 

You can measure the length, width, and height for the left and right renal. Each measurement is a 
typical distance measurement made in appropriate scan plane. 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurement is completed, the renal volume is calculated. 

5 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 

 

❚ Renal Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Renal Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

5 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

6 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key. 

• To configure the renal volume method, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Abdomen > Renal Vol > Edit. 
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M mode measurements 

M mode measurements display in the context menu and the abdomen report with measured result, 
when assigned. 

 
Table 9-2 M mode measurement (Abdomen) 

 

Measurement Description 

HR Heart Rate 

 
NOTE 

To configure the M mode measurement, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Abdomen > M > Default Measurement. 

 

❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 

MEAS. > HR cycle. 
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D mode measurements 

D mode measurements are shown in the context menu and in the abdomen report with measured 
result, when assigned. 

 
Table 9-3 D mode measurement (Abdomen) 

 

Measurement Description 

Aorta Aorta 

Renal A Renal Artery 

Hepatic A Hepatic Artery 

IVC Inferior Vena Cava 

Hepatic V Hepatic Vein 

Mid HV Middle Hepatic Vein 

MPV Main Portal Vein 

Portal V Portal Vein 

Splenic A Splenic Artery 

Splenic V Splenic Vein 

SMA Superior Mesenteric Artery 

SMV Superior Mesenteric Vein 

IMA Inferior Mesenteric Artery 

Iliac A Iliac Artery 

Iliac V Iliac Vein 

Vessel Vessel 

Renal V Renal Vein 

HR Heart Rate 

 
NOTE 

To configure the Doppler mode measurement, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Abdomen > Doppler > Default Measurement. 
 

To select a package measurement, 

1 Select a package measurement folder. 

2 Select the desired measurement from the measurement list. 
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In each package measurement for Doppler mode, you can use the following measurements. 

• Auto Trace 

• Semi Auto Trace 

• Manual Trace 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D or D/S Ratio (S/D or D/S) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Acceleration (Accel) 

• Acceleration Time (AT) 
 

NOTE 

To configure the package measurements for D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Abdomen > Doppler > Package measurement (double-click) > a default measurement. 
 

❚ Peak Systole, End Diastole, or Minimum Diastole (PS, ED, or MD) 

1 Select PS, ED, or MD on the context menu. The vertical line and the horizontal line are 
perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window. 

 
❚ PS/ED or ED/PS Ratio 

1 Select S/D or D/S on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window. 
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❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform, and press the [Set] key. 

4 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The end point is fixed, and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window. 

 

❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the maximum values of the desired portion for the spectrum. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window. 
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❚ Acceleration (Accel) 

1 Select Accel on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window. 

 

❚ Acceleration Time (AT) 

1 Select AT on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points is displayed. The acceleration time (AT) is shown on 
the Result window. 
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Abdomen Report 

The Abdomen report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the measurement value type, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Edit > Method. 
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Obstetrics 

Obstetric Measurements and Calculations 

2D mode measurements (OB1, OB2/3) 

2D mode measurements are shown in the context menu and in the OB report with measured result, 
when assigned. 

 
Table 9-5 2D mode measurement (OB) 

 

Measurement Description 

Fetal Biometry Fetal Biometry (Package) 

BPD Biparietal Diameter 

HC Head Circumference 

AC Abdominal Circumference 

FL Femur Length 

Humerus Humerus Length 

AD Abdominal Diameter 

OFD Occipito-frontal Diameter 

APAD Anteroposterior Abdominal Diameter 

TAD Transverse Abdominal Diameter 

MAD Middle Abdomen Diameter 

FTA Fetal Trunk Cross-Sectional Area 

APTD Antero-Posterior Trunk Diameter 

TTD Transverse Trunk Diameter 

ThC Thoracic Circumference 

Early Gestation Early Gestation (Package) 

CRL Crown-Rump Length 

GS Gestation Sac Length 

YS Yolk Sac Length 

BPD Biparietal Diameter 

AC Abdominal Circumference 

FL Femur Length 

NT Nuchal Translucency Length 

NB Nasal Bone Length 

IT Intracranial Translucency 
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Measurement Description 

MSD Mean Gestational Sac Diameter 

Fetal Long Bones Fetal Long Bones (Package) 

Humerus Humerus Length 

Radius Radius Length 

Ulna Ulna Length 

Tibia Tibia Length 

Fibula Fibula Length 

FL Femur Length 

CLAV Clavicle Length 

SL Spinal Length 

Fetal Cranium Fetal Cranium (Pacakge) 

CM Cisterna Magna 

BOD Binocular Distance 

NT Nuchal Translucency Length 

NB Nasal Bone Length 

CEREB Transverse Cerebellar Diameter 

IOD Inner Orbital Diameter 

Va Anterior Horn Lateral Ventricular Width 

Vp Posterior Horn Lateral Ventricular Width 

HEM Hemisphere Width 

CSP Cavum Septum Pellucidum 

NF Nuchal Fold 

IT Intracranial Translucency 

Lat Vent Lateral Ventricle 

FMF angle Frontomaxillary Facial Angle 

Fetal Others Fetal Others (Package) 

Foot Foot Length 

Ear Ear 

Umbilical V Umbilical Vein 

MP Middle Phalanx 

Renal L Renal Length 

Renal AP Renal Anterior-Posterior Diameter 
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Measurement Description 

Pelvis Pelvis 

Cardiac Axis Cardiac Axis 

Placenta Thick. Placenta Thickness 

AFI Amniotic Fluid Index 

Q1 Quadrant 1 

Q2 Quadrant 2 

Q3 Quadrant 3 

Q4 Quadrant 4 

MVP Maximal Vertical Pocket 

CTAR Cardio-Thoracic Area Ratio (Package) 

ThD ap Anterior-Posterior Thoracic Diameter 

ThD trans Transverse Thoracic Diameter 

HrtD ap Anterior-Posterior Heart Diameter 

HrtD trans Transverse Heart Diameter 

Thorax area Thoracic Area 

Heart area Heart Area 

Maternal Others Maternal Others (Package) 

Uterus Uterus Volume 

Ovary Ovary Volume 

Cervix L Cervix Length 

Placenta Thick. Placenta Thickness 

Fibroid Fibroid 

Cyst Cyst 

LL Liver Length 

RL Rib Length 

Scapular Scapular Length 

SC Splenic Circumference 

FB Fetal Bowel Diameter 

OOD Outer Orbital Diameter 

HA Head Area 

AA Abdominal Area 

Umb. A Diam. Umbilical Artery Diameter 
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Measurement Description 

APTD-TTD Anteroposterior Trunk Diameter & Transverse 

AxT Anteroposterior Trunk Diameter multiplied Diameter 

CTAR Cardiothoracic Area Ratio 

Ovary Ovary Volume 

Ovary L Ovary Length 

Ovary H Ovary Height 

Ovary W Ovary Width 

Ovary Vol Ovary Volume 

 

NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > OB > 2D > Default Measurement. 
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2D mode measurements (Fetal Echo) 

2D mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned. 

 
Table 9-6 2D mode measurement (Fetal echo) 

 

Measurement Description 

4-Chamber-view 4 chamber view (Package) 

Ventr. L Ventricle Length 

Ventr. W Ventricle Width 

Atrial L Atrial Length 

Atrial W Atrial Width 

Ventr. inl. Ventricle Inlet Diameter 

Ventr. Area Ventricle Area 

Wall Thick. Wall thickness 

Septum Septum 

TV orifice Tricuspid Valve Orifice 

MV orifice Mitral Valve Orifice 

Aortic Arch Aortic Arch (Package) 

Anulus Anulus 

Asc. aorta Diam. Ascending Aorta Diameter 

Desc. aorta Diam. Descending Aorta Diameter 

LVOT Left Ventricular Outflow Tract (Package) 

LVOT Diam. Left Ventricular Outflow Tract Diameter 

Outflow track Outflow Track (Package) 

PA Pulmonary Artery 

PV width Pulmonary Valve width 

Main PA Main Pulmonary Artery 

AV width Aortic Valve width 

Ao. root Diam. Aortic Root Diameter 

Ao. trunk Dim. Aortic Trunk Diameter 

Art. duct Diam. Arterial Duct Diameter 

RVOT Right Ventricular Outflow Tract (Package) 

RVOT Diam. Right Ventricular Outflow Tract Diameter 

Thorax Thorax (Package) 
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Measurement Description 

Heart diagonally Heart diagonally 

Thorax diagonally Thorax diagonally 

Cardiac Circum. Cardiac Circumference 

Thoracic Circum. Thorax Circumference 

Heart Area Heart area 

Thorax Area Thorax area 

Cardiac Axis Cardiac axis 

Venous Venous (Package) 

SVC Superior Vena Cava Diameter 

IVC Inferior Vena Cava Diameter 

Heart Heart (Package) 

LA Diam. Left Atrium Diameter 

LA L Left Atrium Length 

LVLd-A4C Left Ventricle - Diastolic major axis Dimension - Apical four chamber 

LVLs-A4C Left Ventricle - Systolic major axis Dimension - Apical four chamber 

LVLd-A2C Left Ventricle - Diastolic major axis Dimension - Apical two chamber 

LVLs-A2C Left Ventricle - Systolic major axis Dimension - Apical two chamber 

LVOT Diam. Left Ventricle Outflow Track - Cardiovascular Orifice Diameter 

RA Diam. Right Atrium Diameter 

RA L Right Atrium Length 

RVAWd Right Ventricle - Anterior Wall Diastolic Thickness 

RV L Right Ventricle Length 

RVDd Right Ventricle Diameter - End Diastole 

RVDs Right Ventricle Diameter - End Systole 

RVOT Diam. Right Ventricle Outflow Track - Cardiovascular Orifice Diameter 

Teichholz Left Ventricular Dimensions by Teichholz method (Package) 

IVSd Interventricular Septum - End Diastole 

LVIDd Left Ventricle Internal Dimension - End Diastole 

LVPWd Left Ventricle - Posterior Wall - End Diastole 

IVSs Interventricular Septum - End Systole 

LVIDs Left Ventricle Internal Dimension - End Systole 

LVPWs Left Ventricle Posterior Wall - End Systole 
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Measurement Description 

CT Cardiothoracic Area Ratio (Package) 

Cardiac Area Cardiac Area 

Thoracic Area Thoracic Area 

Arteries Arteries Package 

Ao. arch Diam. Aortic Arch Diameter 

Aorta Diam. Aorta Diameter 

Asc. aorta Diam. Ascending Aorta Diameter 

Thor. aorta Diam. Thoracic Aorta Diameter 

Trans. ao. arch Diam. Transverse Aortic Arch Diameter 

Duct. arch Diam. Ductal Arch Diameter 

DA Diam. Ductus Arteriosus Diameter 

Isthmus Isthmus 

PA Diam. Pulmonary Artery Diameter 

Lt. PA Diam. Pulmonary Artery Diameter - Systole - Left 

Rt. PA Diam. Pulmonary Artery Diameter - Systole - Right 

Umb. A Diam. Umbilical Artery Diameter 

Veins Veins Package 

SVC Diam. Superior Vena Cava Diameter 

IVC Diam. Inferior Vena Cava Diameter 

Lt. PV Diam. Pulmonary Vein Diameter - left 

Rt. PV Diam. Pulmonary Vein Diameter - right 

Umb. V Diam. Umbilical Vein Diameter 

 

❚ Gestational Sac (GS) 

1 Select GS on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the gestational sac length is shown on the Result window. 
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❚ Abdominal Circumference (AC) 

1 Select AC on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Move the marker to the second point using [Trackball]. The ellipse appears. 

4 Press the [Set] key. The end point appears. 

5 Move the marker to the second point using [Trackball], and press the [Set] key again. 

6 The measured value is fixed, and the abdominal circumference is shown on the Result window. 
 

NOTE 

You can measure the abdominal circumference by using the trace. To change the measurement method, 
go to Utility > Setup > SystemPreset > Measurement > Labeled MEAS. > OB > 2D > AC > Edit > Caliper 
Type. 

 

❚ Biparietal Diameter (BPD) 

1 Select BPD on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the biparietal diameter is shown on the Result window. 

 
❚ Head Circumference (HC), Occipito-frontal Diameter (OFD) 

1 Select HC on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point. The ellipse appears. 

4 Press the [Set] key. The end point appears. 

5 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 

6 The measured value is fixed. The head circumference and the occipito-frontal diameter are 
shown on the Result window. 

 
NOTE 

• To show or hide the OFD measurement, go to Utility > Setup > SystemPreset > Measurement 

> Labeled MEAS. > OB > 2D > HC > Edit. This setting is available only when you perform a HC 

measurement by using the ellipse. 

• You can measure the head circumference by using the trace. To change the measurement method, go 
to Utility > Setup > SystemPreset > Measurement > Labeled MEAS. > OB > 2D > HC > Edit > Caliper 

Type. 
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❚ Femur Length (FL) 

1 Select FL on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the femur length is shown on the Result window. 

 
❚ X+ Auto Biometry 

To measure the fetal biometry automatically, 

1 Select the Fetal Biometry folder on the touch screen. 

2 Select the desired measurement (e.g. BPD, HC, AC, FL or Humerus). 
The trace is generated automatically on the display, and the calculation process starts. 

3 The measured value is fixed, and the result is shown on the Result window. 
If the result is not correct, rotate the Mode soft key to select Manual, and then proceed with 
manual measurement. 

4 To complete the measurement, press the [Set] key. 
The measured value is fixed and summarized in the report. 

 

NOTE 

If the system was not able to detect the anatomy automatically, the following message appears in the 
message area: "No valid Auto measurement was found. Please proceed with manual measurement." 
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❚ Nuchal Translucency (NT) 

To measure the NT manually, 

1 Select NT on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the thickness of the nuchal translucency (NT) is shown on the 
Result window. 

 

❚ Automatic Nuchal Translucency Diameter (Auto NT) 

To measure the NT automatically, 

1 Acquire the magnified mid-sagittal view of the fetus by pressing the [Freeze] key on the control 
panel. 

2 Press the [Measure] key on the control panel. 

3 Select Auto NT on the touch screen. The start point appears. 
 

NOTE 

According to the fetal position, you can select Face Up or Face Down by rotating the NT Position 

soft key. 

4 Use [Trackball] to move the marker to the start point, and then press the [Set] key to fix the 
marker. The second point appears. 

5 Use [Trackball] to move the marker at the diagonal edge of the NT ROI to the end point, and 
then press the [Set] key. 
The nuchal translucency diameter (NT) is shown on the Result window. 

6 To complete the measurement, press the [Set] key. 
The measured value is fixed and summarized in the report. 

 

NOTE 

The Auto NT value is shown with an apostrophe mark (') on the worksheet. 

 
To measure the NT manually, 

– Select Manual by rotating the Caliper soft key, and make one distance measurement. 
 

NOTE 

After the automatic measurement is completed, you can make one distance measurement manually, if 
necessary, to cross check the result. 
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❚ Spinal Length (SL) 

1 Select SL on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the length of vertebrae is shown on the Result window. 

 
❚ Amniotic Fluid Index (AFI) 

To calculate the amniotic fluid index, measure the four quadrants of the uterine cavity. 

1 Select the AFI folder on the context menu. 

2 Select AFI-Q1. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. The first quadrant is completed. 

3 Perform 1 distance measurement. 
The AFI sum for AFI-Q1 is automatically shown on the Result window. 

4 Repeat step 3 to measure the second, third, and fourth quadrant (AFI-Q2, AFI-Q3, AFI-Q4). 

5 The total sum of your AFI measurements is shown on the Result window. 

 
❚ CTAR 

1 Select CTAR on the context menu. The start point appears. 

a. Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

b. Use [Trackball] to move the marker to the second point. The ellipse appears. 

c. Press the [Set] key. The end point appears. 

d. Use [Trackball] to move the marker to the second point and press the [Set] key again. The 
heart area (Heart Area) measurement is completed. 

2 Perform the thoracic area (Thorax Area) measurement in the same manner (a-d). 

3 When two ellipse measurements are completed, the measured value is fixed, and the measured 
value is shown on the Result window. 

 

NOTE 

The cardiothoracic area ratio measurement is available for the OB1 preset and OB2/3 presets (CTAR), and 

Fetal Echo preset (CT). 
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❚ Antero-Postero Trunk Diameter by Transverse Trunk Diameter (AxT) 

1 Select AxT on the context menu. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. The antero-postero trunk diameter 
(APTD) measurement is completed. 

2 Perform the measurement of the transverse trunk diameter (TTD) measurement in the same 
manner (a-d). 

3 When two distance measurements are completed, the measured value is fixed, and the 
measured value is shown on the Result window. 

 

❚ Left Ventricle – Teichholz Method 

The followings are Teichholz measurements: 

• Diastole – IVSd, LVIDd, LVPWd 

• Systole – IVSs, LVIDs, LVPWs 

 
1 Select the Teichholz(2D) folder on the context menu. 

2 Select Diastole or Systole. The start point appears. 

a. Use [Trackball] to move the start point to the interventricular septum. 

b. To fix the point, press the [Set] key. 

c. As you move [Trackball], the second point and a straight line appear on the display. 

d. Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed. 

3 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d). 

4 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window. 

 

NOTE 

When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement. 
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2D mode calculations (OB1, OB2/3) 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-7 2D mode calculations (OB) 

 

Calculation label Description Required measurements 

 

EFW 
 

Estimated Fetal Weight 
The required measurements vary depending 
on the selected authors. 

 

EFW GP 
 

Estimated Fetal Weight - Growth Percentile 
The values vary depending on the selected 

authors. 

GA Gestational ages by last menstrual period Calculation from the LMP data 

 

EDD 
Estimated date of delivery by last menstrual 

period 

 

Determined by LMP data 

 

U/S GA 
 

Gestational ages by ultrasound 
Determined from all Fetal Age 

measurements and calculations 

 

U/S EDD 
 

Estimated date of delivery by ultrasound 
Determined from all ultrasound 

measurements and calculations 

 

CI 
 

Cephalic Index 
BPD 
OFD 

 

HC/AC 
Ratio of Head Circumference to Abdominal 

Circumference 

HC 

AC 

 

FL/BPD 
Ratio of Femur Length to Biparietal 

Diameter 

FL 
BPD 

 

FL/AC 
Ratio of Femur Length to Abdominal 

Circumference 

FL 
AC 

 

FL/HC 
Ratio of Femur Length to Head 

Circumference 

FL 

HC 
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2D mode calculations (Fetal Echo) 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-8 2D mode calculations (Fetal echo) 

 

Calculation Label Description Required 

Teichholz Teichholz  

EDV End Diastolic Volume LVIDd 

ESV End Systolic Volume LVIDs 

SV Stroke Volume EDV, ESV 

EF Ejection Fraction EDV, ESV 

LV FS Fractional Shortening LVIDd, LVIDs 

CT Cardiothoracic Area Ratio CA, TA 

Thorax Thorax 
 

CTR Cardio-Thoracic Ratio Heart diagonally, Thorax diagonally 

CTCR Cardio-Thoracic Circumference Ratio Cardiac Circum., Thoracic Circum. 

CTAR Cardio-Thoracic Area Ratio Heart area, Thorax Area 

 
Define as: 

• Teichholz Method 

EDV= 7x(LVIDd³) / (2.4 + LVIDd) 

ESV= 7x(LVIDs³) / (2.4 + LVIDs) 

SV= EDV – ESV 

EF= (EDV - ESV) / EDV 

FS= (LVIDd - LVIDs) / LVIDd 

 
• EFW Authors 

Campbell (AC) 

Hadlock (AC, BPD) 

Hadlock 1 (AC, FL) 

Hadlock 2 (BPD, AC, FL) 

Hadlock 3 (HC, AC, FL) 

Hadlock 4 (BPD, HC, AC, FL) 

Hansmann (BPD, TTD) 

Merz (AC, BPD) 
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Osaka (BPD, FTA, FL) 

Persson (BPD, MAD, FL) 

Schild (HC, AC, FL) 

Shepard (AC, BPD) 

Shinozuka 1 (BPD, APTD, TTD, FL) 

Shinozuka 2 (BPD, FL, AC) 

Shinozuka 3 (BPD, APTD, TTD, SL) 

Tokyo (BPD, APTD, TTD, FL) 

Intergrowth21st (AC, HC) 

 
NOTE 

• To change the default EFW author, go to Utility > Setup > SystemPreset > Measurement > OB MEAS. > 

EFW Formula. 

• If a measurement of EFW formula is not shown on the context menu, the EFW formula setting may not 
be affected. This setting is only available when you set the measurement for EFW formula as default. 

• To add a measurement in the EFW formula as default, go to Utility > Setup > SystemPreset > 
Measurement > Labeled MEAS. > OB > Add measurement (Insert). 

 
❚ Estimated Fetal Weight (EFW) 

1 To measure estimated fetal weight, perform several OB measurements first. 

2 EFW based on the measured values is calculated and the result is shown. 
 

NOTE 

The EFW calculation method (author) is selected from the EFW formula. 

3 Perform the measurements required for EFW. 
When the measurements are completed, the EFW is automatically calculated. 

4 The each measurement and the estimated fetal weight are shown on the Result window. 
 

NOTE 

EFW is not calculated and shown if the selected measurement is not performed. 
 

❚ Composite Gestational ages (GA) and estimated date of delivery (EDD) by ultrasound 

When you perform the OB measurement, GA and EDD are calculated based on the measured values. 
 

NOTE 

To show or hide GA and EDD, go to Utility > Setup > SystemPreset > Measurement > Labeled MEAS. > OB 

> 2D > Edit. 
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M mode measurements (OB1, OB2/3) 

M mode measurements are shown in the context menu and in the OB report with measured result, 
when assigned. 

 
Table 9-9 M mode measurement (OB) 

 

Measurement Description 

Generic Generic (Package) 

Dist Distance 

Slope Slope 

Time Time 

HR Heart Rate 

%Steno(Dist) Two Distances Percent Stenosis 

FHR Fetal Heart Rate (Package) 

FHR Fetal Heart Rate 

Atrial FHR Atrial Fetal Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > OB > M > Default Measurement. 
 

❚ Heart Rate (HR) 

1 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 
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M mode measurements (Fetal Echo) 

M mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned. 

 
Table 9-10 M mode measurement (Fetal echo) 

 

Measurement Description 

4 Chamber view 4-Chamber-view (Package) 

Ventr. Dim. Ventricle Dimension 

Ventr. wall Ventricle Wall 

Atr. Dim. Atrium Dimension 

Septum Septum Dimension 

Biventric. inner Biventricle inner Dimension 

Biventric. outer Biventricle outer Dimension 

MV open exc. Mitral Valve Open 

TV open exc. Tricuspid Value Open 

Outflow track Outflow Track (Package) 

AV Diam. Aortic Valve Diameter 

PV Diam. Pulmonary Valve Diameter 

FHR Fetal Heart Rate (Package) 

FHR Fetal Heart Rate 

Atrial FHR Atrial Fetal Heart Rate 

Heart Left Heart Package (Package) 

LA Diam. Left Atrium Diameter 

AO Diam. Aorta Diameter - Systole 

LVET Left Ventricle Ejection Time 

DE Amp Slope D-E wave Amplitude and Slope 

EF Slope E-F wave Slope 

RADs Right Atrium Diameter - Systole 

RADd Right Atrium Diameter - Diastole 

RVAWd Right Ventricle Anterior Wall Diameter - Diastole 

RVAWs Right Ventricle Anterior Wall Diameter - Systole 

RV Diam. Right Ventricle Diameter 

PA Diam. Pulmonary Artery Diameter 

RVET Right Ventricle Ejection Time 
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Measurement Description 

Teichholz Left Ventricular Dimensions by Teichholz method (Package) 

IVSd Interventricular Septum - End Diastole 

LVIDd Left Ventricle Internal Dimension - End Diastole 

LVPWd Left Ventricle - Posterior Wall - End Diastole 

IVSs Interventricular Septum - End Systole 

LVIDs Left Ventricle Internal Dimension - End Systole 

LVPWs Left Ventricle Posterior Wall - End Systole 

 

❚ Diameter 

The followings are distance measurements: 

• Heart – LA Diam., AO Diam., RADs, RADd, RVAWd, RVAWs, RV Diam., PA Diam. 

 
1 Select the Heart folder on the context menu. 

2 Select a distance measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 The measured value is fixed, and the distance measurement is shown on the Result window. 

 
❚ Time 

The followings are time measurements: 

• Heart – LVET, RVET 

 
1 Select the Heart folder on the context menu. 

2 Select a time measurement on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 The time interval between the two points appears. The time measurement is shown on the 
Result window. 
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❚ Slope 

The followings are distance measurements: 

• Heart – DE Amp Slope, EF Slope 

 
1 Select the Heart folder on the context menu. 

2 Select DE Amp Slope or EF Slope. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 When the oblique line appears, the slope is calculated, and the slope measurement is shown on 
the Result window. 

 

❚ Fetal Heart Rate 

1 Select the FHR folder on the context menu. 

2 Select FHR. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 



9-30 Application Measurements and Calculations 

 

 

❚ Left Ventricle – Teichholz Method 

The followings are Teichholz measurements: 

• Teichholz – IVSd, LVIDd, LVPWd, IVSs, LVIDs, LVPWs 

 
1 Select the Teichholz folder on the context menu. 

2 Select a Teichholz measurement on the context menu. The start point appears. 

a. Move the start point to the interventricular septum by using the [Trackball]. 

b. To fix the point, press the [Set] key. 

c. As you move [Trackball], the second point and straight line appear on the display. 

d. Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed. 

3 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d). 

4 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window. 

 

NOTE 

When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement. 



Obstetrics 9-31 

 

 

M mode calculations 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-11 M mode calculations (Fetal echo) 

 

Calculation Label Description Required 

Teichholz   

EDV End Diastolic Volume LVIDd 

ESV End Systolic Volume LVIDs 

SV Stroke Volume EDV, ESV 

EF Ejection Fraction EDV, ESV 

FS Fractional Shortening LVIDd, LVIDs 

 
Define as: 

• Teichholz Method 

EDV= 7x(LVIDd³) / (2.4 + LVIDd) 

ESV= 7x(LVIDs³) / (2.4 + LVIDs) 

SV= EDV – ESV 

EF= (EDV - ESV) / EDV 

FS= (LVIDd - LVIDs) / LVIDd 
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D mode measurements (OB1, OB2/3) 

D mode measurements are shown in the context menu and in the OB report with measured result, when 
assigned. 

 
Table 9-12 D mode measurement (OB) 

 

Measurement Description 

Aorta Aorta 

Carotid Carotid Artery 

MCA Middle Cerebral Artery 

Umbilical A Umbilical Artery 

Uterine A Uterine Artery 

SMA Superior Mesenteric Artery 

Celiac A Celiac Artery 

Auto Trace Auto Trace 

Manual Trace Manual Trace 

PS Peak Systole (PS) Velocity 

ED End Diastole (ED) Velocity 

S/D S/D Ratio 

RI Resistive Index (RI) 

PI Pulsatility Index (PI) 

HR Heart Rate 

Ductus Ven Ductus Venosus 

IVC Inferior Vena Cava 

Manual Trace Manual Trace 

S Ventricular Systole 

D Early Ventricular Diastole 

a Atrial Contraction 

S.a.PLI Preload Index 

PI Pulsatility Index 

PVIV Peak Velocity Index for Veins 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > OB > Doppler > Default Measurement. 
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To select a package measurement, 

1 Select a package measurement folder. 

2 Select a desired measurement from the measurement list. 

 
In each Doppler package measurement, you can make the following measurements: 

• Auto Trace 

• Semi Auto Trace 

• Manual Trace 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D or D/S Ratio (S/D or D/S) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Acceleration (Accel) 

• Acceleration Time (AT) 
 

NOTE 

To configure the default measurement for each package measurement, go to Utility > Setup > SystemPreset 

> Measurement > Labeled MEAS. > OB >Doppler > a package measurement (double-click) > a default 
measurement. 

 

❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD) 

1 Select PS, ED, or MD on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window. 

 
❚ PS/ED or ED/PS Ratio 

1 Select S/D or D/S on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the start point (S or D) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second point (D or S) of the ratio using [Trackball], and cpress the [Set] key. 

4 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window. 
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❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform. 

4 To complete the measurement, press the [Set] key. 

5 The pulsatility index is calculated and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 When the end point is fixed, the resistive index is calculated and the resistivity index (RI) is 
shown on the Result window. 

 

❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the maximum value of the desired portion for the spectrum. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated, and the maximum time-average (TAmax) is shown on 
the Result window. 

 

❚ Acceleration (Accel) 

1 Select Accel on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and then press the [Set] key again. 

4 When the oblique line appears, the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window. 
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❚ Acceleration Time (AT) 

1 Select AT on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window. 

 

D mode measurements (Fetal Echo) 

D mode measurements are shown in the context menu and in the fetal heart report with measured 
result, when assigned. 

 
Table 9-13 D mode measurement (Fetal echo) 

 

Measurement Description 

Tricuspid Valve Tricuspid Valve 

E-Wave E-Wave ( Early Filling ) Velocity 

A-Wave A-Wave ( Atrial Contraction ) Velocity 

Vmax regurg. Maximum Velocity of Regurgitant Flow 

Mitral Valve Mitral Valve 

E-Wave E-Wave ( Early Filling ) Velocity 

A-Wave A-Wave ( Atrial Contraction ) Velocity 

Vmax regurg. Maximum Velocity of Regurgitant Flow 

IVRT Isovolumic Relaxation Time 

Main Pulmonary Artery Main Pulmonary Artery 

Manual Trace Manual Trace 

Vmax Maximum Velocity 

TPV Time to Peak Velocity 

Aorta Aorta 

Manual Trace Manual Trace 

Manual Trace Aol Aortic Isthmus(Aol) Manual Trace 

Vmax Maximum Velocity 

TPV Time to Peak Velocity 

Vmax AoI Aortic Isthmus(Aol) Maximal Velocity 

Ductus Art. Ductus Arteriosus 

Auto Trace Auto Trace 
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Measurement Description 

Manual Trace Manual Trace 

PS Peak Systole (PS) 

RI Resistive Index (RI) 

PS,ED RI,SD PS,ED RI,SD 

ED End Diastole (ED) 

PI Pulsatility Index (PI) 

TPV Time to Peak Velocity 

HR Heart Rate 

Umbilical V Umbilical Vein 

TAmax Maximum Time-Average Velocity 

Ductus Ven. Ductus Venosus 

Manual Trace Manual Trace 

S Ventricular Systole Velocity 

D Early Ventricular Diastole Velocity 

a Atrial Contraction Velocity 

S.a.PLI Preload Index 

PI Pulsatility Index 

PVIV Peak Velocity Index for Veins 

HR Heart Rate 

Pulmonary Valve Pulmonary Valve 

Manual Trace Manual Trace 

Vmax Maximum Velocity 

TPV Time to Peak Velocity 

Acc. Time Acceleration Time 

Eject. Time Ejection Time 

Aortic Valve Aortic Valve 

Manual Trace Manual Trace 

Vmax Maximum Velocity 

TPV Time to Peak Velocity 

Acc. Time Acceleration Time 

PR interval P-R interval Time 

Eject. Time Ejection Time 



Obstetrics 9-37 

 

 

 

Measurement Description 

FHR Fetal Heart Rate 

FHR Fetal Heart Rate 

LVOT Left Ventricular Outflow Tract 

Manual Trace Manual Trace 

Vmax Maximum Velocity 

PR interval P-R interval Time 

ICT Isovolumic Contraction Time 

Eject. Time Ejection Time 

IRT Isovolumic Relaxation Time 

RVOT Right Ventricular Outflow Tract 

Manual Trace Manual Trace 

Vmax Maximum Velocity 

ICT Isovolumic Contraction Time 

Eject. Time Ejection Time 

IRT Isovolumic Relaxation Time 

Pulmonary Vein Pulmonary Vein 

Vd Diastolic Velocity 

Vs Systolic Velocity 

A Rev.V Atrial Reversal flow velocity 

A Rev.Dur Duration of Atrial Reversal flow velocity 

Valves Valves Package 

MV E pt Mitral Valve E point Velocity 

MV A pt Mitral Valve A point Velocity 

AV Vmax Aortic Valve Peak Velocity 

PV Vmax Pulmonary Valve Peak Velocity 

FO Foramen Ovale Velocity 

Ventricles Ventricles 

IVCT Isovolumetric Contraction Time 

LVET Left Ventricle Ejection Time 

IVRT Isovolumetric Relaxation Time 

RVET Right Ventricle Ejection Time 

Arteries Arteries Package 
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Measurement Description 

Asc. aorta Vmax Ascending Aorta Velocity 

Thor. aorta Vmax Thoracic Aorta Velocity 

Trans. ao. arch Vmax Transversal Aortic Arch Velocity 

DA Vmax Ductus Arteriosus Velocity 

PA Vmax Pulmonary Artery Velocity 

Umb. A Vmax Umbilical Artery Velocity 

Veins Veins Package 

SVC Vmax Superior Vena Cava Velocity 

IVC Vmax Inferior Vena Cava Velocity 

Lt. PV Vmax Pulmonary Vein left Velocity 

Rt. PV Vmax Pulmonary Vein right Velocity 

Umb. V Vmax Umbilical Vein Velocity 

 

❚ Velocity 

The followings are velocity measurements: 

• Valves – MV E pt, MV A pt, AV Vmax, PV Vmax, FO 

• Arteries – Asc. aorta Vmax, Thor. aorta Vmax, Trans. ao. arch Vmax, DA Vmax, PA Vmax, Umb. A 
Vmax 

• Veins – SVC Vmax, IVC Vmax, Lt. PV Vmax, Rt. PV Vmax, Umb. V Vmax 

 
1 Select a velocity measurement on the context menu. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The measured value is fixed, and the velocity is shown on the Result window. 

 

❚ Time 

The followings are time measurements: 

• Ventricles – IVCT, LVET, IVRT, RVET 

 
1 Select a time measurement on the context menu. The start point appears. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears and the time measurement is shown on the 
Result window. 
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D mode calculations 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-14 D mode calculations 

 

Calculation label Description Required measurements 

E/A Mitral Valve E point /A point Ratio MV E pt 
MV A pt 

TEI-I TEI Index 

(Index of Myocardial Performance 

of Left Ventricle) 

IVCT 

IVRT 
LVET 

 
Define as: 

TEI-I = (IVCT+IVRT)/LVET 
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OB Report 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 

 

Report functions 

– See "Patient Worksheets (Reports)" on page 8-29 for more information. 

– To select CUA or AUA for gestational age, rotate the Select AUA/CUA soft key. 
 

NOTE 

To configure the default ultrasound age type, go to Utility > Setup > SystemPreset > Measurement > OB 
MEAS. > Default US Age Type(Hadlock) > AUA or CUA. 

– To select the fetus A, B, C, or D, rotate the Fetus A soft key. This function is for a multi-gestational 
patient. 

 

The OB report has three sections of information: 

• Patient information 

• Measurement information 

• Calculation information 

 

Patient information 

• ID 

• Name 

• Age 

• Exam date 

• Referring MD 

• LMP or IVF 

• GA(LMP) or GA(IVF), EDD(LMP) or EDD(IVF) 

• Determined from LMP or IVF data 

• GA(AUA) or GA(CUA), EDD(AUA) or EDD(CUA): If this field is checked, the system uses the 
measurement to calculate the ultrasound age. 

– AUA: Average Ultrasound age, regression calculation 

– CUA: Composite Ultrasound age, an arithmetric average 

• Fetus: For a multi-gestational patient, select a fetus (A, B, C, D) in this field. 
 

NOTE 

To edit the patient information, go to Patient screen. 
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Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–3rd: The three measurement values for each item are available. If you make more than three 
measurements, the report uses the last three. 

• GA: GA is calculated based on the measured values for the fetus. “##” appears when any of the 
values is out of range. 

• GP: The growth percentile of each measurement. The GP value is calculated by selecting LMP and 
AUA. 

• Range: The typical range of fetal age for this measurement. 
 

NOTE 

The GA range may not be shown when the range of OB reference (author) is set to none (unavailable). 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 

 

Calculation information 

• EFW: Show the parameters used to calculate EFW. This is followed by the calculation result. 

• EFW GP: Show the source used to calculate EFW GP. This is followed by the growth percentile. When 
you enter LMP, you can check the EFW GP value and reference (Hadlock, Brenner, Williams, Pittaluga). 

• Ratio: The remaining calculation information shows ratios for several measurements. 

• CI (Cephalic index): The value calculated by measuring BPD and OFD is displayed. 

– AC/HC 

– FL/BPD 

– FL/HC 

– FL/AC 

• EFW Range: The GP value is calculated by selecting LMP and AUA. 
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Fetal Heart Report 

To view a report, 

1 Select a package measurement folder. 

2 Select a desired package measurement. 
 

NOTE 

If any measurement is performed, it is shown as a check mark ( ) next to the package measurement. 

 

3 When the labeled measurements appear, you can create, edit, or delete values in a cell. You can 
also change the method item. 

 
The fetal heart report has two sections of information: 

• Patient information 

• Measurement information 

 

Patient information 

The patient information about the fetal heart report is the same as the OB report. See "Patient 
information" on page 9-40. 

 

Patient information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To set the selected method as default, press the Save As Default soft key. To set a method to be used for all 

measurements in the current measurement preset, press the Factory Default soft key. 
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OB Graph 

The OB graph shows curve graphs and bar graphs that indicate predicate fetal growth patterns according 
to the selected reference (author) for a measurement or calculation. 

OB graph allows you to access the fetal growth curve compared to a normal growth curve. When a 
patient has completed data from the previous studies, you can use the graph to look at fetal trending. 

For multi-gestational patients, you can compare the growth on the graphs. 

 

Figure 9-1 OB Graph 
 
 

Fetal growth – references 
 

Table 9-15 Fetal growth (reference) 
 

Display item name Description Reference (Author) name 

 
 
 

EFW 

 
 
 

Estimated Fetal Weight 

Brenner, Doubilet, Hadlock, Hansmann, 
Hansmann 86, Hobbins/Persutte, 
JSUM2001, Osaka, Persson 

Tokyo/Shinozuka, Tokyo, Williams, Yarkoni, 
Kiserud, EIK-NE2007, Marsal, Pittaluga, 

Gonzalez, Intergrowth21st 

 
 

AC 

 
 

Abdominal Circumference 

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, JSUM, Kurmanavicius, Lessoway, 

Merz, Nicolaides, Shinozuka, Tokyo, 
Kiserud, Verburg, Intergrowth21st 

AFI Amniotic Fluid Index Moore 

APAD Anteroposterior Abdominal Diameter Merz 

APTD Anteroposterior Trunk Diameter Hansmann 
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Display item name Description Reference (Author) name 

 

AxT 
Anteroposterior Trunk Diameter multiplied by 

Transverse Trunk Diameter 

 

Shinozuka, Tokyo 

BOD Binocular Distance Jeanty 

 

 
BPD 

 

 
Biparietal Diameter 

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, JSUM, Kurmanavicius, Lessoway, 

Marsal, Merz, Nicolaides, Osaka, 
Sabbagha, Shinozuka, Tokyo, EIK-NES 
2007, Kiserud, Verburg, Intergrowth21st 

CLAV Clavicle Length Yarkoni 

CM Cisterna Magna Nicolaides 

 
CRL 

 
Crown-Rump Length 

ASUM, Hadlock, Hansmann, JSUM, 
Marsal, Osaka, Robinson, Shinozuka, 
Tokyo, Intergrowth21st 

 

 
FL 

 

 
Femur Length 

ASUM, CFEF, Chitty, Hadlock, Hansmann, 

Jeanty, JSUM, Kurmanavicius, Lessoway, 
Marsal, Merz, Nicolaides, O’Brien, Osaka, 

Shinozuka, Tokyo, Warda, EIK-NES 2007, 
Kiserud, Verburg, Intergrowth21st 

FTA Fetal Trunk Cross-Sectional Area Osaka 

Fibula Fibula Length Jeanty 

GS Gestation Sac Length Hellman, Rempen, Tokyo 

 
 

HC 

 
 

Head Circumference 

ASUM, CFEF, Chitty, Hadlock, Hansmann, 
Jeanty, Kurmanavicius, Lessoway, 

Merz, Nicolaides, Kiserud, Verburg, 

Intergrowth21st 

Humerus Humerus Length ASUM, Jeanty, Merz, Osaka 

SL Spinal Length Tokyo 

MCA PI Middle Cerebral Artery Pulsatility Index Bahlman, JSUM, Schaffer 

MCA PS Middle Cerebral Artery Peak Systole Velocity Mari 

MCA RI Middle Cerebral Artery Resistive Index Bahlman, JSUM, Schaffer 

 

MAD 
 

Middle Abdomen Diameter 
EIK-NES, Kurmanavicius, EIK-NES 2007, 

Kiserud 

MSD Mean Gestational Sac Diameter Hellman, Rempen, Tokyo 

 

OFD 
 

Occipito-frontal Diameter 
ASUM, Hansmann, Jeanty, Kurmanavicius, 
Merz, Nicolaides 

Radius Radius Length Jeanty, Merz 

TAD Transverse Abdominal Diameter CFEF, Merz 

CEREB Transverse Cerebellar Diameter GoldStein, Hill, Nicolaides, Verburg 

Tibia Tibia Length Jeanty, Merz 
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Display item name Description Reference (Author) name 

TTD Transverse Trunk Diameter Hansmann 

Ulna Ulna Length Jeanty, Merz 

 

UmbArt PI 
 

Umbilical Artery Pulsatility Index 
JSUM, Merz, Schaffer, Shinozuka, Acharya, 
Harrington, Rizzo 

 

UmbArt RI 
 

Umbilical Artery Resistive Index 
JSUM, Kurmanavicius, Merz, Schaffer, 

Shinozuka, Acharya 

UmbArt SD Umbilical Artery Systolic Diastolid Ratio Acharya 

AO PI Aorta Pulsatility Index Schaffer 

AO RI Aorta Resistive Index Schaffer 

Uterine A PI Uterine Artery Pulsatility Index Schaffer, Merz, Bahlmman, O.GOMEZ 

Uterine A RI Uterine Arte Resistive Index Schaffer, Merz, Kurmanavicius, Bahlmman 

 

Ductus Venosus PI 
 

Ductus Venosus Pulsatility Index 
Baschat, Kessler, JSUM2012, Cemil, 

Fuanglada 

Ductus Venosus 

PLI 

 

Ductus Venosus Preload Index 
 

Baschat, Cemil, Fuanglada 

Ductus Venosus 
PVIV 

 

Ductus Venosus Peak Velocity Index for Veins 
 

Baschat, Cemil, Fuanglada 

Ductus Venosus 

S/a 

 

Ductus Venosus S/a 
 

Baschat, Cemil, Fuanglada, Turan 

CI Cephalic Index Hadlock 

 

HC/AC 
HC and AC ratio Ratio of Head Circumference 

to Abdominal Circumference 

 

Campbell 

FL/BPD Ratio of Femur Length to Biparietal Diameter Hohler, Kiserud 

 

FL/AC 
Ratio of Femur Length to Abdominal 

Circumference 

 

Hadlock 

FL/HC Ratio of Femur Length to Head Circumference Hadlock, Kiserud 
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Fetal growth curve graphs 

To start a curve graph, 

– Select Graph on the context menu. 

– While viewing the OB report, select Graph on the context menu. 
 

To view a curve graph, 
 

Figure 9-2 Curve Graph 
 

• The horizontal axis shows the fetal age in weeks. This age is determined by the entry data on the 
Patient screen. The vertical axis shows one of the followings: 

– For measurements: mm or cm 

– For ratios: percent 

– For fetal weight: gram 

• The fetal growth graph shows the following information for the selected measurement: 

– The normal fetal growth curve 

– The standard deviations or relevant percentiles 

– The gestational age of the fetus, using patient data and ultrasound age (vertical dotted line) 

– The current ultrasound measurement data, where the fetus is on the growth curve (symbol) 

• On the left of the fetal growth graph, the following additional information appears: 

– GA(AUA) or GA(CUA): The system allows you to use the composite ultrasound age (CUA) or 
average ultrasound age (AUA). Rotate the Select AUA/CUA soft key to select a gestational age. 

– GA(LMP) or GA(IVF): This data is determined by the LMP (or IVF) data on the Patient screen. 

– GA: This data is calculated based on the measured values for the fetus. 
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To select a measurement, 

1 The system shows a list of fetal growth measurements. 

2 The graph list is shown by the order of measurements you performed recently. The check mark ( ) 
is shown next to the measurement that has measured values. 

3 To select a specific measurement, use [Trackball] to move to the measurement field and press the 
[Set] key. 

4 To scroll through all fetal growth curve graphs, rotate the Select Graph soft key. 

 
To change the reference author, 

1 Use [Trackball] to move the cursor to the reference, and press the [Set] key. 

2 Select a reference from the drop-down list, and press the [Set] key again. 

 
To view fetus trending on graphs, 

– Select the History check box. The previous and current data are shown on the graph. 
 

To view multiple fetuses data on graphs, 

– Select the Compare check box. The multiple gestational data is shown on the current graph. 
 

NOTE 

The fetus number can be configured in the Patient > OB > Exam information > Fetus #. 

 
To view a quad graph, 

– Press the Quad soft key. The measured values and references are shown at the left of the graph. 
 

To change each graph in the quad view, 

1 Use [Trackball] to move the cursor to the change graph icon ( ), and press the [Set] key. 

2 Select a measurement from the measurement list, and press the [Set] key. The graph is changed. 

 

Fetal growth bar graphs 

To start a bar graph, 

– While viewing the OB graph, press the Bar soft key. 
 

To view a bar graph, 

– The horizontal axis shows the gestational weeks. 

– The blue vertical line shows the gestational age (GA) by the LMP data. 

– The blue dotted vertical line shows the CUA (or AUA) by the current measured values. 

– To select a gestational age, rotate the Select AUA/CUA soft key. 

– The yellow symbol mark (+) shows the ultrasound GA for each measurement. 

– The blue rectangle shows the normal age range for the measurement. 
 

NOTE 

You cannot view the fetal trending or multiple fetus data on the bar graph. 
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Anatomical Survey 

The Anatomical Survey page provides a checklist that indicates which anatomy was imaged and its 
appearance. 

 

Figure 9-3 Anatomical Survey (OB) 
 
 

 

Editing the Anatomical Survey 

To edit the anatomical survey, 

1 While viewing the OB report, select Anatomical Survey on the touch screen to activate the 
Anatomical Survey. 

2 Fill the required field. 

– To set all values in the list as default, select Default. 

– To clear all values in the list, select Clear. 

– To edit the lists in anatomical survey, use [Trackball] to move the cursor to the descriptive data 
field and press the [Set] key. The data field is highlighted, and you can enter the anatomy name. 

– To save the data as default, press the Save As Default soft key. 

– To set the anatomical survey list as default, press the Factory Default soft key. 

– To clear all input data in the option fields, press the Clear All soft key. 

3 Select Exit to return to the scan screen. 
Select Report to return to the Worksheet page. 

 

NOTE 

The patient specific contents input on the Anatomical Survey page are returned to the factory default settings 
after starting a new patient. 
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Anatomical survey lists 
 

Table 9-16 Anatomical survey (OB) 
 

List Descriptive data Options 

 
Head 

Lateral Ventricle, Cerebellum 

Cist. magma, Orbits, Face, Nose / Lips, 
Palate, NT 

 
(Blank), Normal 

 
Heart 

4-Chamber, LVOT, RVOT, 3-Vessel, 
Aortic Arch, Cardiac Axis, Cardiac 

Rhythm 

 
(Blank), Normal 

Spine C-Spine, T-Spine, L-Spine, Sacrum (Blank), Normal 

Chest Diaphragm, Lungs (Blank), Normal 

 

Abdomen 
Abdominal Wall, Stomach, Kidneys, 
Bladder, Cord Insertion, Genitalia 

 

(Blank), Normal 

Limbs Arms, Legs, Hands, Feet (Blank), Normal 

 
 
 
 

Description 

Fetal Position Vertex, Breech, Transverse 

Placenta Location Anterior, Posterior, Fundal, Lateral, Previa 

Placenta Grade 0, 1, 2, 3 

Umbilical Cord Normal, 2-vessel, Nuchal Cord 

Amniotic Fluid Normal, Oligohydramnios, Polyhydramnios 

 
 
 
 

 
Biophysical profile 

Fetal Movements 0, 1, 2 

Fetal Breathing 0, 1, 2 

Fetal Tone 0, 1, 2 

Reactive NST (Reactive non-stress test) 0, 1, 2 

Amniotic Fluid 0, 1, 2 

 

Score 
The system totals five data to calculate a 
score for the biophysical profile. 

Diagnosis Free Text (Blank) 
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Multiple Gestation 

X-CUBE 60 allows you to measure and report multiple fetus development. The system can report up to 
four fetuses. 

 
 

Entering the number of fetuses 

If two or more fetuses are imaged during the examination, enter the number of fetuses in the Patient 
screen. 

When you start an OB exam, the system automatically fills in the Fetus # field with 1. 

 
To change the number, 

1 Touch Patient on the touch screen to enter the Patient screen. 

2 Use [Trackball] to move the cursor to the Fetus # field and select the fetus number from the drop- 
down list. The Fetus Number Option dialog box appears. 

3 To identify each fetus, select A, B, C, or D checkbox and then click OK. 

4 Click Save & Exit to save the patient information. 
 

 

Identifying each fetus 

Each fetus is identified by a letter and the total number of fetuses. For example, fetus A/4 is fetus A from 
a total of 4. 

 
 

Selecting a fetus 

To change between fetuses during measurements and calculations, 

– Rotate the Fetus soft key. 
 

 

Viewing multiple fetuses data on graphs 

You can view multiple gestation data on fetal growth curve graphs. 
 

To view multiple fetuses data on graphs, 

– Select the Compare check box. 
The multiple gestational data is shown on the current graph. 
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Viewing multiple fetuses data on a worksheet 

With multiple fetuses, you can list and compare measurements of the fetuses on the worksheet. 
 

Figure 9-4 Fetus Compare 
 

To compare multiple fetuses data on a worksheet, 

– Select Fetus Compare on the touch screen. 
The measurement results for each fetus are shown on the worksheet. 
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Gynecology 

Gynecology Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the GYN report with measured result, 
when assigned. 

 
Table 9-17 2D mode measurement (GYN) 

 

Measurement Description 

Endo Thick. Endometrium Thickness 

Cervix L Cervix Length 

Follicle Follicle Volume 

Follicle # 1–30 Measurements of the left and right ovarian follicle 

Uterus Uterus Volume 

Uterus L Uterus Length 

Uterus H Uterus Height 

Uterus W Uterus Width 

Ovary Ovary Volume 

Ovary L Ovary Length 

Ovary H Ovary Height 

Ovary W Ovary Width 

Bladder Bladder Volume 

Bladder L Bladder Length 

Bladder H Bladder Height 

Bladder W Bladder Width 

Uterus Vol Uterus Volume 

Ovary Vol Ovary Volume 

Bladder Vol Bladder Volume 

Fibroid Follicle Volume 

Fibroid # 1–15 Measurements of the left and right ovarian follicle 

Pelvic Floor Pelvic Floor 

Detrusor wall thick. Detrusor wall thickness 

Urethral rotation Urethral rotation 

Uterine desc.max Uterine descent max 
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Measurement Description 

Re.amp.desc.max Rectal ampulla descent max 

Rectocele depth Bladder neck descent 

Bladder neck rest Bladder neck rest 

Bladder neck stress Bladder neck stress 

Bladder desc.max Bladder descent max 

Levator hiat.stress Levator hiatus stress 

Residual urine Residual urine 

Uterine A Uterine Artery 

Uterine A Diam. Uterine Artery Diameter 

Volume Flow Area Volume Flow Area 

Ovarian A Ovarian Artery 

Volume Flow Area Volume Flow Area 

 

NOTE 

To configure the 2D mode measurements, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > GYN > 2D > Default Measurement. 

 

❚ Endometrium Thickness 

1 Select Endo Thick. on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. 
The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the endometrium thickness (Endo Thick.) is shown on the 
Result window. 
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❚ Follicle Volume 

You can make the ovary follicle volume from one, two, or three distance measurements. 

 
1 Distance Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Follicle folder. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window. 

 
2 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Follicle folder. The start point appears. 

a. Move the marker to the start point using [Trackball]. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Move the marker to the end point using [Trackball]. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second distance in the same manner (a-d). 

4 When the second distances are measured, press the [Set] key. 

5 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window. 
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3 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Follicle folder. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 
When three distances are measured, the volume is calculated. 

4 The measured value is fixed, and the follicle volume (Rt or Lt Fo-Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 

(D1, D2) and press the [Clear] key. 

• To configure the follicle volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Follicle > Edit. 

 
❚ Ovary Volume (1) 

You can measure the length, width, and height for the left and right ovaries. Each measurement is a 
typical distance measurement made in appropriate scan plane. 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Ovary folder, and then select Ovary L, Ovary W, or Ovary H. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 After completing the length, width, and height measurement, the ovary volume is calculated. 

5 The measured value is fixed, and the ovary volume (Rt or Lt Ovary Vol) is shown on the Result 
window. 
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❚ Ovary Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Ovary Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 

4 The first point is fixed, and the second point appears. 

5 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

6 Measure the second and third distances in the same manner. 

7 When three distances are measured, the volume is calculated. 

8 The measured value is fixed, and the ovary volume (Rt or Lt Ovary Vol) is shown on the Result 
window. 

 
 

NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 

(D1, D2) and press the [Clear] key. 

• To configure the ovary volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Ovary Vol > Edit. 
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M mode measurements 

M mode measurements display in the context menu and the GYN report with measured result, when 
assigned. 

 
Table 9-18 M mode measurement (GYN) 

 

Measurement Description 

Ovarian Ovarian (Package) 

Time Time 

Vessel Diam. Vessel Diameter 

%Steno(Dist) Two Distances Percent Stenosis 

HR Heart Rate 

Uterine Uterine (Package) 

Time Time 

Vessel Diam. Vessel Diameter 

%Steno(Dist) Two Distances Percent Stenosis 

HR Heart Rate 

FHR Fetal Heart Rate (Package) 

FHR Fetal Heart Rate 

Atrial FHR Atrial Fetal Heart Rate 

 
NOTE 

To configure the M mode measurement, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > GYN > M > Default Measurement. 

 

❚ Heart Rate (HR) 

1 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 

MEAS. > HR cycle. 
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D mode measurements 

D mode measurements are shown in the context menu and in the GYN report with measured result, 
when assigned. 

 

Table 9-19 D mode measurement (GYN) 
 

Measurement Description 

Aorta Aorta 

Umbilical A Umbilical Artery 

Placenta Placenta 

Des. aorta Descending Aorta 

Uterine A Uterine Artery 

Ovarian A Ovarian Artery 

MCA Middle Cerebral Artery 

Vessel Vessel 

FHR Fetal Heart Rate 

HR Heart Rate 

 
NOTE 

To configure the D mode measurement, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > GYN > Doppler > Default Measurement. 

 

To select a package measurement, 

1 Select a package measurement folder. 

2 Select a desired measurement from the measurement list. 

 
In each package measurement for Doppler mode, you can use the following measurements: 

• Auto Trace 

• Semi Auto Trace 

• Manual Trace 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D or D/S Ratio (S/D or D/S) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Acceleration (Accel) 

• Acceleration Time (AT) 
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• Heart Rate (HR) 
 

NOTE 

To configure the default package measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > GYN > Doppler > Package measurement > a default measurement. 
 

❚ Peak Systole, End Diastole, or Minimum Diastole (PS, ED, or MD) 

1 Select PS, ED, or MD on the context menu. The vertical line and the horizontal line are 
perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window. 

 
❚ PS/ED or ED/PS Ratio 

1 Select S/D or D/S on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window. 

 

❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform, and press the [Set] key. 

4 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The end point is fixed and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window. 
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❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the maximum values of the desired portion for the spectrum. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window. 

 

❚ Acceleration (Accel) 

1 Select Accel on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window. 

 

❚ Acceleration Time (AT) 

1 Select AT on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points is displayed. The acceleration time (AT) is shown on 
the Result window. 
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GYN / Follicle Report 

The GYN and Follicle report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Exam date 

• Referring MD 

• LMP 

• Day of Cycle 

• Gravida 

• Para 

• Expected Ovul 

• Ectopics 

• Aborta 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 
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Cardiology 

Cardiology Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned. 

 
Table 9-20 2D mode measurement (Cardiology) 

 

Measurement Description 

Ao/LA Aortic Valve/Left Atrium Package 

RV Dm Right Ventricle Diameter 

Ao Dm Aortic Diameter 

LA Dm Left Atrium Diameter 

ACS Aortic Valve Cusp Separation 

LA Vol(Diam) Left Atrium Package 

LA Dm ant-post Left Atrium Anterior-Posterior Left Atrium Diameter 

LA Dm sup-inf Left Atrium Superior-inferior Left Atrium Diameter 

LA Dm med-lat Left Atrium Mid– lateral Left Atrium Diameter 

Aorta Diam Aorta Package 

Ao SV Dm Aorta – Sinus of Valsalva Diameter 

Ao ST Dm Aorta – Sino-tubular junction Diameter 

Ao ASC Dm Aorta – Ascending Diameter 

Ao Arch Dm Aorta – Arch Diameter 

Ao Desc Dm Aorta – Descending Diameter 

Ao Ring Dm Aorta – Annulus Diameter 

Pul.Diam Pulmonary Artety Package 

MPA Main Pulmonary Artery Diameter 

LPA Left Pulmonary Artery Diameter 

RPA Right Pulmonary Artery Diameter 

LUPV Left Upper Pulmonic Vein 

LLPV Left Lower Pulmonic Vein 

RUPV Right Upper Pulmonic Vein 

RLPV Right Lower Pulmonic Vein 

VenaCava Vena Cave Package 
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Measurement Description 

IVC Dm Inferior Vena Cave Diameter 

IVC Inspir. Inferior Vena Cave- Inspiration Diameter 

IVC Expir. Inferior Vena Cave- Expiration Diameter 

SVC Dm Superior Vena Cave Diameter 

SVC Inspir. Superior Vena Cave- Inspiration Diameter 

SVC Expir. Superior Vena Cave- Expiration Diameter 

RV Right Ventricle Package 

RVIDd Mid Mid- Right Ventricle Diameter - End Diastole 

RVIDd Base Base- Right Ventricle Diameter - End Diastole 

RVL Right Ventricle Length - End Diastole 

Simpson BP Left Ventricular Volume by Simpson method (Biplane) 

EDV4 Left Ventricle End Diastolic Volume (Apical four chamber) 

ESV4 Left Ventricle End Systolic Volume (Apical four chamber) 

EDV2 Left Ventricle End Diastolic Volume (Apical two chamber) 

ESV2 Left Ventricle End Systolic Volume (Apical two chamber) 

HR Heart Rate 

Simpson SP Left Ventricular Volume by Simpson method (Single plane) 

EDV4 Left Ventricle End Diastolic Volume (Apical four chamber) 

ESV4 Left Ventricle End Systolic Volume (Apical four chamber) 

EDV2 Left Ventricle End Diastolic Volume (Apical two chamber) 

ESV2 Left Ventricle End Systolic Volume (Apical two chamber) 

HR Heart Rate 

Modified Simpson Modified Simpson method 

LVLd Apical Left ventricular long-axis length at end diastole 

LVAd sax MV Left ventricular short-axis area at the level of the mitral valve at end diastole 

LVAd sax PM Left ventricular short-axis area at the level of the papillary muscle at end diastole 

LVLs Apical Left ventricular long-axis length at end systole 

LVAs sax MV Left ventricular short-axis area at the level of the mitral valve at end systole 

LVAs sax PM Left ventricular short-axis area at the level of the papillary muscle at end systole 

HR Heart Rate 

Area Length Left Ventricular Volume by Area-Length method 

LVAd 4 Left Ventricle End Diastolic Area (Apical four chamber) 
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Measurement Description 

LVAs 4 Left Ventricle End Systolic Area (Apical four chamber) 

LVAd 2 Left Ventricle End Diastolic Area (Apical two chamber) 

LVAs 2 Left Ventricle End Systolic Area (Apical two chamber) 

HR Heart Rate 

Teichholz Left Ventricular Dimensions by Teichholz method 

RVAWd Right Ventricle Anterior Wall - End Diastole 

RVDd Right Ventricle Diameter - End Diastole 

IVSd Interventricular Septum - End Diastole 

LVIDd Left Ventricle Internal Dimension - End Diastole 

LVPWd Left Ventricle - Posterior Wall - End Diastole 

IVSs Interventricular Septum - End Systole 

LVIDs Left Ventricle Internal Dimension - End Systole 

LVPWs Left Ventricle Posterior Wall - End Systole 

HR Heart Rate 

LV Mass T-E Left Ventricle Mass by Truncated Ellipse 

LVA Epi Left Ventricle End Diastolic Epicardial Area at the Papillary Muscle level 

LVA Endo Left Ventricle End Diastolic Endocardial Area at the Papillary Muscle level 

a Left Ventricle Semi-major Axis Diastolic Dimension 

d Left Ventricle Truncated Semi-major Axis Diastolic Dimension 

LV Mass A-L Left Ventricle Mass by Area-Length method 

LVAd Epi Left Ventricle End Diastolic Epicardial Area at the Papillary Muscle level 

LVAd Endo Left Ventricle End Diastolic Endocardial Area at the Papillary Muscle level 

LVLd Left Ventricle Length- End Diastole 

LVAs Epi Left Ventricle End Systolic Epicardial Area at the Papillary Muscle level 

LVAs Endo Left Ventricle End Systolic Endocardial Area at the Papillary Muscle level 

LVLs Left Ventricle Length- End Systole 

LA Vol(A-L) Left Atrium Volume by Area-Length method 

LA A4C Left Atrium End Systolic Area-Length (Apical four chamber) 

LA A2C Left Atrium End Systolic Area-Length (Apical two chamber) 

LA Vol(Simp) Left Atrium Volume by Simpson method (Biplane) 

ESV4 Left Atrium End Systolic Volume (Apical four chamber) 

ESV2 Left Atrium End Systolic Volume (Apical two chamber) 
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Measurement Description 

RA Vol(A-L) Right Ventricular Volume by Area-Length method 

RA A4C Right Ventricular End Systolic Area-Length (Apical four chamber) 

RA Vol(Simp) Right Ventricular Volume by Simpson method (Single Plane) 

RA Vol(Simp) Right Ventricular End Systolic Volume (Apical four chamber) 

TV Tricuspid Valve Package 

TR VC Dm Vena Contracta Diameter 

PISA Proximal Isovelocity Surface Area 

AR Radius Aortic Regurgitation Radius 

AR Aliasing Vel. Aortic Regurgitation Aliasing Velocity 

MR Radius Mitral Regurgitation Radius 

MR Aliasing Vel. Mitral Regurgitation Aliasing Velocity 

TR Radius Tricuspid Regurgitation Radius 

TR Aliasing Vel. Tricuspid Regurgitation Aliasing Velocity 

PR Radius Pulmonary Regurgitation Radius 

PR Aliasing Vel. Pulmonary Regurgitation Aliasing Velocity 

MV Mitral Valve Package 

EPSS Point Septal Separation 

MV Dm Mitral Valve Diameter 

LVOT Dm Left Ventricular Outflow Track Diameter 

MV Area Mitral Valve Area 

MR VC Dm Vena Contracta Diameter 

MR Jet Area Mitral Regurgitant Jet Area 

AV Aortic Valve Package 

AV Area Aortic Valve Area 

LVOT Dm Left Ventricular Outflow Track Diameter 

AR VC Dm Vena Contracta Diameter 

AR Jet Area Aortic Regurgitant Flow jet 

PV Pulmonary Valve Package 

PV Dm Pulmonary Valve Diameter 

Subvalvaular Dm Subvalvaular Diameter 

Supravalvular Dm Supravalvualr Diameter 

RVOT Dm Right Ventricular Outflow Track Diameter 
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Measurement Description 

Qp/Qs  

LVOT Dm Left Ventricular Outflow Track Diameter 

RVOT Dm Right Ventricular Outflow Track Diameter 

Auto EF Auto ejection fraction 

Auto EF (A4C) Automatic Ejection Fraction (Apical four chamber) 

Auto EF (A2C) Automatic Ejection Fraction (Apical two chamber) 

 

NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Cardiology > 2D > Default Measurement. 
 

❚ Aortic Root Diameter 

To measure the aortic root diameters, 

• Ao ST Dm 

• Ao SV Dm 

• Ao Ring Dm 

 
1 Select the Aorta Diam folder on the context menu. 

2 Select Ao ST Dm, AO SV Dm, or Ao Ring Dm. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the diameter measurement is shown on the Result window. 
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① Aortic Annulus – Ring Diameter 

② Aortic Sinuses of Valsalva Diameter 

③ Aortic Tubular Junction Diameter 
 

❚ Valve Area (Trace) 

To measure the valve area, 

• MV Area 

• AV Area 

 
1 Select the MV or AV folder on the context menu. 

2 Select MV Area or AV Area. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. A line shows the traced area. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the valve area measurement is shown on the Result window. 
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❚ Right Atrium – Single Plane Simpson’s Method 

This method allows you to calculate the volume of the right atrium on the four chamber cross- 
sectional image. RA Vol(Simp) indicates the Simpson measurement. 

1 During a Cardiology study, freeze a 4 chamber cross-sectional image. 

2 Press the [Measure] key on the control panel. 

3 Select the RA Vol(Simp) folder on the context menu. 

4 Select RA Vol(Simp). The start point appears. 

5 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

6 Use [Trackball] to create a trace of the structure with the second point, and press the [Set] key. 

7 When the start and end points are connected and a line representing the long axis is shown, 
press the [Set] key again. 

8 The measured value is fixed, and the measured value is shown on the Result window. 

 
❚ Right Ventricle Diameter 

The followings are right ventricle measurements: 

• RVIDd Mid 

• RVIDd Base 

• RVL 

 
1 Select the RV folder on the context menu. 

2 Select RVIDd Mid, RVIDd Base, or RVL. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the Right Ventricle diameter measurement is shown on the 
Result window. 
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❚ Left Atrium – Biplane Area Length Method 

This method allows you to calculate the volume of the left atrium on the two chamber and four 
chamber cross-sectional images. The followings are area length measurements: 

• LA A4C 

• LA A2C 

 
1 During a Cardiology study, freeze 4 chamber or 2 chamber cross-sectional images. 

2 Use [Trackball] to scroll through cine images. 

3 From the frame image of the end diastole, press the [Measure] key on the control panel. 

4 Select the LA Vol(A-L) folder on the context menu. 

5 Select LA A4C or LA A2C. The start point appears. 

a. Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

b. Use [Trackball] to create a trace of the structure with the second point, and press the [Set] 
key. The measured value is fixed. 

6 The measured value is fixed, and the measured value is shown on the Result window. 
 

NOTE 

When the length is measured in both the 4 chamber and 2 chamber cross-sectional views, the shortest 

value is used in the Area Length formula. 
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❚ Left Ventricle – Teichholz Method 

The followings are Teichholz measurements: 

• Diastole – IVSd, LVIDd, LVPWd 

• Systole – IVSs, LVIDs, LVPWs 

 
1 Select the Teichholz folder on the context menu. 

2 Select Diastole or Systole. The start point appears. 

a. Use [Trackball] to move the start point to the interventricular septum. 

b. To fix the point, press the [Set] key. 

c. As you move [Trackball], the second point and straight line appear on the display. 

d. Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed. 

3 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d). 

4 After three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window. 

 

NOTE 

When you select Diastole or Systole, you can perform the 3 length measurement with a straight line. 
Otherwise, when you select IVS, LVID, or LVPW, you can only perform 1 distance measurement. 
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❚ Left Ventricle – Biplane Simpson’s Method 

This method allows you to calculate the volume of the left ventricle on two chamber and four 
chamber cross-sectional images. The followings are Simpson BP measurements: 

• EDV2 

• ESV2 

• EDV4 

• ESV4 

 
1 During a Cardiology study, freeze a 4 chamber or 2 chamber cross-sectional images. 

2 Use [Trackball] to scroll through cine images. 

3 From the frame image of the end diastole, press the [Measure] key on the control panel. 

4 Select the Simpson BP folder on the context menu. 

5 Select EDV4 or EDV2. The start point appears. 

a. Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

b. Use [Trackball] to create a trace of the structure with the second point, and press the [Set] 
key. 

c. When the start and end points are connected and a line representing the long axis is shown, 
press the [Set] key again. The volume is calculated. 

6 Press the [Exit] key. 

7 Use [Trackball] to scroll through cine images. 

8 From the End systole frame image, press the [Measure] key on the control panel. 

9 Select the Simpson BP folder on the context menu. 

10 Select ESV4 or ESV2. 

11 Perform the measurement of the disk volume in the same manner (a-c). 

12 When the volume trace is completed, the measured value is fixed, and the measured value is 
shown on the Result window. 
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❚ Regurgitation Flow – Jet Area 

1 While performing a Cardiology study in Color Flow mode, press the [Freeze] key to freeze an 
image. 

2 Press the [Measure] key on the control panel. 

3 Select the AV or MV folder on the context menu. 

4 Select AR Jet Area or MR Jet Area. The start point appears. 

5 Use [Trackball] to move the marker to the start point. 

6 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

7 Use [Trackball] to move the marker to the end point. A line shows the traced regurgitant jet 
area. 

8 To complete the measurement, press the [Set] key. 

9 The measured value is fixed, and the regurgitant jet area is shown on the Result window. 

 
❚ Regurgitation Flow – Vena Contracta Diameter 

The followings are Vena Contracta measurements: 

• AR VC Dm 

• MR VC Dm 

 
1 While performing a Cardiology study in Color Flow mode, press the [Freeze] key to freeze an 

image. 

2 Use [Trackball] to scroll to the largest diameter of the vena contracta. 

3 Press the [Measure] key on the control panel. 

4 Select the AV or MV folder on the context menu. 

5 Select AR VC Dm or MR VC Dm. The start point appears. 

6 Use [Trackball] to move the marker to the start point. 

7 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

8 Use [Trackball] to move the marker to the end point. 

9 To complete the measurement, press the [Set] key. 

10 The measured value is fixed, and the vena contracta diameter is shown on the Result window. 
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2D mode calculations 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-21 2D mode calculations (Cardiology) 

 

Calculation Label Description Required 

Ao/LA Aortic Valve/Left Atrium Package 
 

Ao/LA Aortic Valve / Left Ventricle Ratio Ao Dm, LA Dm 

LA/Ao Left Artrium / Aortic Valve Ratio Ao Dm, LA Dm 

LA Vol(Diam) Left Atrium Package 
 

LA Vol 
 

LA Dm apt-post, LA Dm sup-inf, LA 

Dm med-lat 

LA Vol. index 
 

LA Vol, BSA 

Area Length, Area Length method, 
 

Simpson Method Simpson’s method of Disk volume 
 

EDV End Diastolic Volume LVLd, LVAd 

ESV End Systolic Volume LVLs, LVAs 

SV Stroke Volume EDV, ESV 

CO Cardiac Output EDV, ESV, HR 

EF Ejection Fraction EDV, ESV 

SI Stroke Index EDV, ESV, BSA 

CI Cardiac Index EDV, ESV, HR, BSA 

Teichholz Teichholz method 
 

EDV End Diastolic Volume LVIDd 

ESV End Systolic Volume LVIDs 

SV Stroke Volume EDV, ESV 

CO Cardiac Output EDV, ESV, HR 

EF Ejection Fraction EDV, ESV 

FS Fractional Shortening LVIDd, LVIDs 

SI Stroke Index EDV, ESV, BSA 

CI Cardiac Index EDV, ESV, HR, BSA 

LV(s) Mass Left Ventricular Mass IVS(d, s), LVID(d, s), LVPW(d, s) 

LV(s) Mass-c Left Ventricular Mass Corrected IVS(d, s), LVID(d, s), LVPW(d, s) 

LV(s) Mass index Left Ventricular Mass Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA 
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Calculation Label Description Required 

LV(s) Mass-c index Left Ventricular Mass Corrected Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA 

LV Mass T-E Left Ventricle Mass by Truncated Ellipse 
 

LV Mass(T-E) Left ventricular mass using a Truncated Ellipse LVA Epi, LVA Endo, a, d 

LV Mass index Left Ventricular Mass Index LV Mass(T-E), BSA 

LV Mass A-L Left Ventricle Mass by Area-Length method 
 

LV(d,s) Mass(A-L) Left ventricular mass using a Area-Length 

method 

LVA(d,s) Epi, LVA(d,s) Endo, LVL(d,s) 

LV(d,s) Mass index Left Ventricular Mass Index LV(d,s) Mass(A-L) BSA 

RA Vol(Simp) Right Ventricular Volume by Simpson method 
(Single Plane) 

RA Vol(Simp) Right Ventricular Volume Index RA Vol(Simp), BSA 

PISA Proximal Isovelocity Surface Area 
 

Flow Rate Peak Instantaneous Flow Rate Radius, Aliasing Vel 

ERO Effective Regurgitant Orifice Radius, Aliasing Vel, Vmax 

Auto EF Automatic Ejection Fraction 
 

Auto EF (Biplane) Automatic Ejection Fraction (Biplane method) 
 

 
Define as: 

• Area Length Method 

EDV =(8/(3π))xLVAd² / LVLd 

ESV =(8/(3π))xLVAs² / LVLs 

• Simpson’s Method 
 

 

ai : Radius of the i-th ellipse (2CH) 

bi : Radius of the i-th ellipse (4CH) 
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• Teichholz Method 

EDV= 7x(LVIDd³) / (2.4 + LVIDd) 

ESV= 7x(LVIDs³) / (2.4 + LVIDs) 

SV= EDV – ESV 

CO= SVxHR 

EF= (EDV - ESV) / EDV 

FS= (LVIDd - LVIDs) / LVIDd 

SI= SV / BSA 

CI= CO / BSA 
 

NOTE 

BSA is automatically calculated when you enter the height and weight of a patient from the Patient 

screen. 

LV Mass= 1.04x{(IVSd + LVIDd + LVPWd)³ - (LVIDd)³} 

LV Mass-c= 0.8xLV Mass+0.6 

LV Mass Index= LV Mass / BSA 

• PISA 

Flow Rate= 2πxRadius²xAliasing Vel 
 

NOTE 

When you select Aliasing Vel(edit) on the context menu, you can edit the velocity value by entering it on 

the color bar. 
 

❚ AO/LA Ratio 

1 Select the Ao/LA folder on the context menu. 

2 Select Ao Dm. The start point appears. 

a. Move the marker to the start point using [Trackball]. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 The aortic valve diameter is fixed. 

4 Select LA Dm. 

5 Perform the measurement of the left atrium diameter in the same manner (a-d). 

6 When two diameter measurements are completed, the measured value is fixed, and the ratio is 
shown on the Report or Mini Report page. 
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❚ Left Ventricular Mass – Area Length Method 

The followings are LV Mass measurements: 

• LVAd Epi, LVAs Epi 

• LVAd Endo, LVAs Endo 

• LVLd, LVLs 

 
1 Select LV Mass A-L folder on the context menu. 

2 Select the LVAd Epi or LVAs Epi. The start point appears. 

a. Use [Trackball] to move the marker to the start point and press the [Set] key. The first point 
is fixed, and the second point appears. 

b. Use [Trackball] to create a trace of the epicardial area with the second point and press the 
[Set] key. The measured value is fixed. 

3 Select LVAd Endo or LVAs Endo. 

4 Perform the measurement of the endocardial area in the same manner (a-b). 

5 Select LVLd or LVLs. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

6 When two area measurements and one diameter are completed, the measured value is fixed, 
and the LV mass is shown on the Report or Mini Report page. 
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Auto EF measurements 

Auto EF (Automated Ejection Fraction) is a semi-automatic measurement tool used for measurement of 
the global EF (Ejection fraction). 

 

Figure 9-5 Auto EF Display 
 

To perform an Auto EF measurement, 

1 Connect the ECG device and activate the ECG function to acquire a stable ECG trace. 

2 Acquire 2D cine images of an Apical 4 chamber view and an Apical 2 chamber view by pressing the 
[Freeze] key. 

3 After acquiring the cine images, press the [Measure] key and select Auto EF on the touch screen. 
The Auto EF screen appears. 

4 Select the name of current cadiac view (A4C, A2C) on the touch screen. 
An endocardial border will automatically be traced. 

5 If necessary, select the ECG cycle from the ECG Cycle drop-down list, and select Calc. to start the 
calculation. 
When the processing is completed, the Ejection fraction is automatically calculated again. 

6 If necessary, select Edit EDV or Edit ESV to edit the endocardial border trace. 
You may adjust the trace by moving the cursor over the endocardial border trace, select an 
anchor point and drag it to a new location. The shape of the endocardial border trace is updated 
accordingly. 

7 When the editing is completed, select Calc. to start the calculation. 

8 The resulting Ejection Fraction (EF) , the End Diastolic volume (EDV) and the End Systolic Volume 
(ESV) are displayed in a table on the right. 

 

NOTE 

The Biplane results will only appear on screen after measuring both A2C and A4C views. 

9 To save the result, select Save Result on the touch screen. The results are shown on the worksheet. 

10 To exit Auto EF, select Exit on the touch screen. 
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Auto IVC measurements 

Auto IVC (Automated inferior vena cava) is a semi-automatic measurement tool used for measurement 
of the inferior vena cava (IVC). 

 

 

Figure 9-5 Auto IVC Display 
 

To measure the Inferior Vena Cava (IVC) automatically, 

1 Scan the patient in the subcostal position to view the IVC on the 2D-mode screen. 

2 Acquire a IVC view by pressing the [Freeze] key on the control panel. 

3 Select AutoIVC on the touch screen. The Auto IVC screen appears. 

• The system displays 2D mode along with the M-mode timeline. 

• The cursor line appears over the IVC. 

• The cross-section of the IVC is traced along the M-mode timeline. 

• CTI markers appear as red /blue vertical lines at 4.0 sec. intervals. 

4 If the patient is ventilated, select Mechanical by rotating the Type soft key. 
The measurement is switched from CI to DI. 

• Spontenuous: For patients with spontaneous breathing. 

• Mechanical: For patients with mechanical ventilation. 

5 View the cursor line appearing and stabilizing automatically on the IVC. If the cursor line has not 
been positioned correctly, select EditROI and move the cursor line to the desired position by using 
[Trackball]. 

6 If necessary, adjust the angle of the cursor line by rotating the [Angle] key on the control panel. 

7 If necessary, adjust the sweep speed and cycles by using each soft key. 

8 Select Analyze/Pause to start measuring the IVC. 
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9 The system highlights the selected CTI on the M-mode timeline and display the maximum diameter 
measured frame in the 2D-mode screen. The results of the measurements appear in the result box, 
on the left upper side of the screen. 

10 To save the result, select Add Report on the touch screen. The results are shown on the Report 
screen. 

11 To exit Auto IVC, select Exit on the touch screen. 
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M mode measurements 

M mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned. 

 
Table 9-22 M mode measurement (Cardiology) 

 

Measurement Description 

Teichholz Left Ventricular Dimensions by Teichholz method 

RVAWd Right Ventricle Anterior Wall -End Diastole 

RVDd Right Ventricle Diameter - End Diastole 

IVSd Interventricular Septum - End Diastole 

LVIDd Left Ventricle Internal Dimension - End Diastole 

LVPWd Left Ventricle - Posterior Wall - End Diastole 

IVSs Interventricular Septum - End Systole 

LVIDs Left Ventricle Internal Dimension - End Systole 

LVPWs Left Ventricle Posterior Wall - End Systole 

LVET Left Ventricular Ejection Time 

MAPSE Mitral Annular Plane Systolic Excursion 

HR Heart Rate 

Ao/LA Aortic Valve/Left Atrium Package 

RV Dm Right Ventricular Diameter 

LA Dm Left Atrial Diameter 

Ao Dm Aortic Diameter 

ACS Aortic Cusp Separation 

LVET Left Ventricle Ejection Time 

LVPEP Left Ventricle Pre-Ejection Period 

MV Mitral Valve Package 

EPSS E Point Septal Separation 

DE slope Mitral Valve D-E point Slope 

DE Exc Mitral Valve D-E Excursion 

EF slope Mitral Valve E-F point Slope 

AC Imterval Mitral Valve A-C Interval 

CE Exc Mitral Valve E wave excursion 

CA Exc Mitral Valve A wave excursion 

RV Right Ventricle Package 
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Measurement Description 

RV Dm Right Ventricular Diameter – End Diastole 

RVOT Dm Right Ventricular Outflow Track Diameter 

RVET Right Ventricular Ejection Time 

RVPEP Right Ventricular Pre-ejection Period 

TAPSE Tricuspid Annular Plane Systolic Excursion 

Pul.Vein Pulmonary Vein Package 

Pul.Vein Dm Pulmonary Vein Diameter 

 

NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Cardiology > M > Default Measurement. 
 

❚ Diameter 

The followings are distance measurements: 

• Ao/LA – RV Dm, LA Dm, Ao Dm, ACS 

• MV – CE Exc, CA Exc, EPSS 

• RV – RV Dm, RVOT Dm, TAPSE 

 
1 Select a distance measurement on the context menu. The start point appears. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The measured value is fixed, and the distance measurement is shown on the Result window. 

 
❚ Time 

The followings are time measurements: 

• Ao/LA, Teichholz, RV – LVET, RVET 

• Ao/LA, RV – LVPEP, RVPEP 

 
1 Select a time measurement on the context menu. The start point appears. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and then press the [Set] key again. 

4 The time interval between the two points appears and the time measurement is shown on the 
Result window. 
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❚ Slope 

The followings are distance measurements: 

• MV – DE Exc, DE slope, EF slope 

 
1 Select the MV folder on the context menu. 

2 Select DE Exc, DE slope or EF slope. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 The oblique line is displayed and the slope is calculated. The slope measurement is shown on 
the Result window. 

 

❚ Heart Rate (HR) 

1 Select the Teichholz folder on the context menu. 

2 Select HR. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point, and press the [Set] key again. 

5 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window. 
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❚ Left Ventricle – Teichholz Method 

The followings are Teichholz measurements: 

• Diastole – IVSd, LVIDd, LVPWd 

• Systole – IVSs, LVIDs, LVPWs 

 
1 Select the Teichholz folder on the context menu. 

2 Select Diastole or Systole. The start point appears. 

a. Use [Trackball] to move the start point to the interventricular septum. 

b. To fix the point, press the [Set] key. 

c. As you move [Trackball], the second point and straight line appear on the display. 

d. Press the [Set] key. The first distance (IVSd or IVSs) measurement is fixed. 

3 Perform the measurement of the second (LVIDd or LVIDs) and third (LVPWd or LVPWs) distance 
in the same manner (a-d). 

4 When three length measurements are completed, the measured value is fixed, and the left 
ventricle dimension is shown on the Result window. 

 

NOTE 

When you select Diastole or Systole, you can perform the 3 lengths measurement with a straight line. 

When you select IVS, LVID, or LVPW, you can perform the 1 distance measurement. 
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M mode calculation 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-23 M mode calculations (Cardiology) 

 

Calculation Label Description Required 

Ao/LA Aortic Valve/Left Atrium Package 
 

Ao/LA Aortic Valve/ Left Ventricle Ratio Ao Dm, LA Dm 

LA/Ao Left Ventricle/ Aortic Valve Ratio Ao Dm, LA Dm 

LVSTI Left Ventricular Systolic Time Intervals LVPEP, LVET 

MV Mitral Valve Package 
 

CA Exc/CE Exc A wave excursion / E wave excursion Ratio CA Exc, CE Exc 

RV Right Ventricle Package 
 

RVSTI Right Ventricular Systolic Time Intervals RVPEP, RVET 

Teichholz Teichholz Method 
 

EDV End Diastolic Volume LVIDd 

ESV End Systolic Volume LVIDs 

SV Stroke Volume EDV, ESV 

CO Cardiac Output EDV, ESV, HR 

EF Ejection Fraction EDV, ESV 

FS Fractional Shortening LVIDd, LVIDs 

SI Stroke Index EDV, ESV, BSA 

CI Cardiac Index EDV, ESV, HR, BSA 

LV(s) Mass Left Ventricular Mass IVS(d, s), LVID(d, s), LVPW(d, s) 

LV(s) Mass-c Left Ventricular Mass Corrected IVS(d, s), LVID(d, s), LVPW(d, s) 

LV(s) Mass index Left Ventricular Mass Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA 

LV(s) Mass-c index Left Ventricular Mass Corrected Index IVS(d, s), LVID(d, s), LVPW(d, s), BSA 

mVcf Mean Velocity of Circumferential Fiber 

Shortening 

LVIDd, LVIDs, LVET 

RWT Relative Wall Thickness LVPWd, LVIDd 
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Define as: 

LVSTI= LVPEP/LVET 

 
Teichholz Method 

EDV= 7x(LVIDd³) / (2.4 + LVIDd) 

ESV= 7x(LVIDs³) / (2.4 + LVIDs) 

SV= EDV – ESV 

CO= SV x HR 

EF= (EDV - ESV) / EDV 

FS= (LVIDd - LVIDs) / LVIDd 

SI= SV / BSA 

CI= CO / BSA 
 

NOTE 

BSA is automatically calculated when you enter the height and weight of a patient from the Patient screen. 

LV Mass= 1.04x{(IVSd + LVIDd + LVPWd)³ - (LVIDd)³} 

LV Mass-c= 0.8xLV Mass+0.6 

LV Mass index= LV Mass / BSA 

mVcf= (LVIDd-LVIDs)/(LVIDdxLVET) 
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D mode measurements 

D mode measurements are shown in the context menu and in the cardiology report with measured 
result, when assigned. 

 
Table 9-24 D mode measurement (Cardiology) 

 

Measurement Description 

TV Tricuspid Valve Package 

TV VTI Tricuspid Valve Velocity Time Integral 

TV Vmax Tricuspid Valve Peak Velocity 

TV E Vel. Tricuspid Valve E point Velocity 

TV A Vel. Tricuspid Valve A point Velocity 

RVET Right Ventricular Ejection Time 

TCO Tricuspid Valve Close-Open Duration Time 

TV Dec. Time Tricuspid Valve Deceleration Time 

TR dP/dt Tricuspid Regurgitation Rate of change of pressure over time 

TR VTI Tricuspid Regurgitation Velocity Time Integral 

TR Vmax Tricuspid Regurgitation Peak Velocity 

RAP(edit) Right Atrium Pressure Selection (edit) 

Pul.Vein Pulmonary Vein Package 

P Vein S Pulmonary Vein Systolic Peak Velocity 

P Vein D Pulmonary Vein Diastolic Peak Velocity 

P Vein A Pulmonary Vein Atrial Contraction Reversal Peak Velocity 

Pul. A Dur. Pulmonary Vein a wave Duration Time 

TDI Left Ventricle Tissue Doppler Imaging 

MV E Vel. Mitral Valve E point Velocity 

Sep E' Septal TDI E point Velocity 

Sep A' Septal TDI A point Velocity 

Sep S' Septal TDI S point Velocity 

Sep AR/DR Mitral Lateral Annulus E wave Acceleration & Deceleration Time and Slope 

Lat E' Lateral TDI E point Velocity 

Lat A' Lateral TDI A point Velocity 

Lat S' Lateral TDI S point Velocity 

Lat AR/DR Mitral Medial Annulus E wave Acceleration & Deceleration Time and Slope 

RV E' Right Ventricle TDI E point Velocity 
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Measurement Description 

RV A' Right Ventricle TDI A point Velocity 

RV S' Right Ventricle TDI S point Velocity 

TV E Tricuspid Valve E point Velocity 

TV E' Tricuspid Valve TDI E point Velocity 

Sep E' VTI Septal TDI E point Velocity Time Integral 

Sep A' VTI Septal TDI A point Velocity Time Integral 

Lat E' VTI Lateral TDI E point Velocity Time Integral 

Lat A' VTI Lateral TDI A point Velocity Time Integral 

Sep E'(T) Septal TDI E point (Time) 

Sep S'(T) Septal TDI S point (Time) 

Lat E'(T) Lateral TDI E point (Time) 

Lat S'(T) Lateral TDI S point (Time) 

Sep IVRT Septal Isovolumetric Relaxation Time 

Sep IVCT Septal Isovolumetric Contraction Time 

Lat IVRT Lateral Isovolumetric Relaxation Time 

Lat IVCT Lateral Isovolumetric Contraction Time 

AV Aortic Valve Package 

AV VTI Aortic Valve Velocity Time Integral 

LVOT VTI Left Ventricular outflow Track Velocity Time Integral 

AV Vmax Aortic Valve Maximum Velocity 

LVOT Vmax Left Ventricular outflow Track Maximum Velocity 

IVCT Isovolumetric Contraction Time 

IVRT Isovolumetric Relaxation Time 

LVET Left Ventricular Ejection Time 

MCO Mitral Valve Close-Open Duration Time 

HR Heart Rate 

AR PHT Aortic Regurgitant Flow Pressure Half Time 

AR VTI Aortic Regurgitant Flow Velocity Time Integral 

AR Decel Slope Aortic Regurgitant Flow Deceleration Time and Slope 

PV Pulmonary Valve Package 

PV VTI Pulmonary Valve Track Velocity Time Integral 

PV Vmax Pulmonary Valve Peak Velocity 
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Measurement Description 

PV Acc Time Pulmonary Valve Acceleration Time and Slope 

RVOT VTI Right Ventricular outflow Track Velocity Time Integral 

RVOT Vmax Right Ventricular outflow Track Maximum Velocity 

RVET Right Ventricular Ejection Time 

HR Heart Rate 

PR VTI Pulmonary Regurgitation Velocity Time Integral 

PR Vmax Pulmonary Regurgitation Peak Velocity 

PR EDV Pulmonary Regurgitation End Diastole Velocity 

Qp/Qs Shunts 

LVOT VTI Left Ventricular Outflow Track Velocity Time Integral 

Systemic HR Systemic Heart Rate 

RVOT VTI Right Ventricular Outflow Track Velocity Time Integral 

Pulmonic HR Pulmonic Heart Rate 

PISA Proximal Isovelocity Surface Area 

AR VTI Aortic Regurgitant Flow Velocity Time Integral 

AR Aliasing Vel. Aortic Regurgitation Aliasing Velocity 

MR VTI Mitral Regurgitant Flow Velocity Time Integral 

MR Aliasing Vel. Mitral Regurgitation Aliasing Velocity 

TR VTI Tricuspid Regurgitant Flow Velocity Time Integral 

TR Aliasing Vel. Tricuspid Regurgitation Aliasing Velocity 

PR VTI Pulmonary Regurgitant Flow Velocity Time Integral 

PR Aliasing Vel. Pulmonary Regurgitation Aliasing Velocity 

MV Mitral Valve Package 

E Dur Mitral Valve E wave Duration Time 

A Dur Mitral Valve A wave Duration Time 

MV E/A Vel. Mitral Valve E point/A point Ratio 

MV E Vel. Mitral Valve E point Velocity 

MV Dec Time Mitral Valve Deceleration Time 

MV A Vel. Mitral Valve A point Velocity 

MVA(PHT) Mitral Valve Area (Pressure Half Time) 

MV VTI Mitral Valve Velocity Time Integral 

LVOT VTI Left Ventricular outflow Track Velocity Time Integral 
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Measurement Description 

IVCT Isovolumetric Contraction Time 

IVRT Isovolumetric Relaxation Time 

LVET Left Ventricular Ejection Time 

MCO Mitral Valve Close-Open Duration Time 

Sep E' Septal TDI E point Velocity 

Sep A' Septal TDI A point Velocity 

Sep S' Septal TDI S point Velocity 

HR Heart Rate 

MR Vmax Mitral Regurgitation Peak Velocity 

MR dP/dt Mitral Regurgitation Rate of change of pressure over time 

 

NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Cardiology > Doppler > Default Measurement. 
 

❚ Velocity 

The followings are velocity measurements: 

• MV – MV E Vel., MV A Vel., Sep E', Sep A', Sep S', MR Vmax 

• AV – AV Vmax, LVOT Vmax 

• TV – TV Vmax, TV E Vel., TV A Vel., TR Vmax 

• PV – PV Vmax, RVOT Vmax, PR Vmax, PR EDV 

• Pul.Vein – P Vein S, P Vein D, P Vein A 

• TDI – MV E Vel., Sep E', Sep A', Sep S', Lat E', Lat A', Lat S', RV E', RV A', RV S', TV E, TV E' 

 
1 Select a velocity measurement on the context menu. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity is shown on the Result window. 
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❚ Time 

The followings are time measurements: 

• MV – E Dur, A Dur, IVCT, IVRT, LVET, MCO 

• AV – IVCT, IVRT, LVET, MCO 

• TV – RVET, TCO 

• Pul.Vein – Pul. A Dur. 

• TDI –Sep E'(T), Sep S'(T), Lat E'(T), Lat S'(T) 

• PV – RVET 

 
1 Select a time measurement on the context menu. The start point appears. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears, and the time measurement is shown on the 
Result window. 

 

❚ VTI 

The followings are velocity-time integral measurements: 

• TV – TV VTI, TR VTI 

• AV – AV VTI, AR VTI 

• PV – PV VTI, RVOT VTI, PR VTI 

• PISA – AR VTI, MR VTI, TR VTI, PR VTI 

• MV – MV VTI, LVOT VTI 

• TDI – Sep E' VTI, Sep A' VTI, Lat E' VTI, Lat A' VTI 

 
1 Select a velocity-time integral measurement on the context menu. The start point appears. 

The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the waveform one cycle. 

4 To complete the measurement, press the [Set] key. 

5 The velocity-time integral is calculated, and the velocity-time integral is shown on the Result 
window. 
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❚ Heart Rate (HR) 

1 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated, and the heart rate is shown on the Result 
window. 

 

D mode calculation 

The calculation labels may not be available in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-25 D mode calculations (Cardiology) 

 

Calculation Label Description 

MV Mitral Valve 

E/A Mitral Valve E point /A point Ratio 

MV Vmean Mitral Valve Mean Velocity 

MV PGmax Mitral Valve Maximum Pressure Gradient 

MV PGmean Mitral Valve Mean Pressure Gradient 

MVA(VTI) Mitral Valve Area-Velocity Time Integral 

LV MPI Left Ventricle Index of Myocardial Performance 

SV Stroke Volume 

CO Cardiac Output 

SI Stroke Index 

CI Cardiac Index 

MV E/E'(S) Mitral Valve E point/Mitral Annulus Ea point Ratio 

MR PGmax Mitral Regurgitation Maximum Pressure Gradient 

MR dP/dt Mitral Regurgitation dP/dt derived from velocity 

AV Aortic Valve 

AV Vmean Aortic Valve Mean Velocity 

AV PGmax Aortic Valve Maximum Pressure Gradient 

AV PGmean Aortic Valve Mean Pressure Gradient 

LVOT Vmean Left Ventricular outflow Track Mean Velocity 

LVOT PGmax Left Ventricular outflow Track Maximum Pressure Gradient 
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Calculation Label Description 

LVOT PGmean Left Ventricular outflow Track Mean Pressure Gradient 

AVA(VTI) Aortic Valve Area-Velocity Time Integral 

AVA(Vmax) Aortic Valve Area- Maximum Velocity 

AVA index(VTI) Aortic Valve Area index by Velocity Time Integral 

AVA index(Vmax) Aortic Valve Area index by Maximum Velocity 

SV Stroke Volume 

CO Cardiac Output 

SI Stroke Index 

CI Cardiac Index 

Qp/Qs Pulmonary Valve Cardiac Output / Aortic Valve Cardiac Output Ratio 

Qp-Qs Pulmonary Valve Cardiac Output - Aortic Valve Cardiac Output 

LV MPI Left Ventricle Index of Myocardial Performance 

TV Tricuspid Valve 

TV Vmean Tricuspid Valve Mean Velocity 

TV PGmax Tricuspid Valve Maximum Pressure Gradient 

TV PGmean Tricuspid Valve Mean Pressure Gradient 

E/A Tricuspid Valve E point /A point Ratio 

RV MPI Tricuspid Valve-Right Ventricle Index of Myocardial Performance 

TR Vmean Tricuspid Valve Regurgitation Flow - Mean Velocity 

TR PGmax Tricuspid Valve Regurgitation Flow - Maximum Pressure Gradient 

TR PGmean Tricuspid Valve Regurgitation Flow - Mean Pressure Gradient 

RVSP Right Ventricular Systolic Pressure 

PV Pulmonary Valve 

PV Vmean Pulmonary Valve Mean Velocity 

PV PGmax Pulmonary Valve Maximum Pressure Gradient 

PV PGmean Pulmonary Valve Mean Pressure Gradient 

RVOT Vmean Right Ventricular outflow Track Mean Velocity 

RVOT PGmax Right Ventricular outflow Track Maximum Pressure Gradient 

RVOT PGmean Right Ventricular outflow Track Mean Pressure Gradient 

PVA(VTI) Pulmonary Valve Area-Velocity Time Integral 

PVA(Vmax) Pulmonary Valve Area-Maximum Velocity 

PVA index(VTI) Pulmonic Valve Area index by Velocity Time Integral 
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Calculation Label Description 

PVA index(Vmax) Pulmonic Valve Area index by Maximum Velocity 

SV Stroke Volume 

CO Cardiac Output 

SI Stroke Index 

CI Cardiac Index 

Qp/Qs Pulmonary Valve Cardiac Output/ Aortic Valve Cardiac Output Ratio 

Qp-Qs Pulmonary Valve Cardiac Output - Aortic Valve Cardiac Output 

PISA Proximal Isovelocity Surface Area 

RV Regurgitation Volume Flow 

TDI Tissue Doppler Imaging 

E'/A'(S) Left Ventricular Early Diastolic Velocity / Atrial Systolic Velocity Ratio 

MV E/E'(S) Mitral Valve E point/Mitral Annulus Ea point Ratio 

E'/A'(L) Left Ventricular Early Diastolic Velocity / Atrial Systolic Velocity Ratio 

MV E/E'(L) Mitral Valve E point/Mitral Annulus Ea point Ratio 

TV E/RV E' Tricuspid Valve E point / Right Ventricle TDI E point Ratio 

TV E/E'(R) Tricuspid Valve E point / Right Ventricle TDI E point Ratio 

 
Define as: 

PGmax= 4V2 

MVA(PHT)= 220/MV PHT 

MVA(VTI)= πx(LVOT Dm/2/10)2xLVOT VTI / MV VTI 

AVA(VTI)= πx(LVOT Dm/2/10)2xLVOT VTI / AV VTI 

LV MPI= (MV C-Odur – LVET) / LVET 

RV MPI= (TV C-Odur – RVET) / RVET 

RVSP= TR Vmax2x4 + RAP 

dP/dt=32 / dtx1000 

EO Area=2 πxRadius2xAliasing Vel / Vmax (Regurgitation flow) 

Flow Vol= EO AreaxVTI (Regurgitation flow) 
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• Mitral Valve 

SV= πxMV Dm2 / 4xMV VTI 

• Aortic Valve 

SV= πxLVOT Dm2 / 4xLVOT VTI 

• Pulmonary Valve 

SV= πxPV Dm2 / 4xPV VTI 

CO= SVxHR 

SI= SV / BSA 

CI= CO / BSA 

• Pressure Gradient – PGmax, PGmean 

The maximum pressure gradient is calculated from a maximum velocity using a velocity measurement 
method or from the tracing waveform. 

The mean pressure gradient is calculated from the mean velocity using the trace measurement 
method. 

 

❚ Valve Area by Pressure Half Time (PHT) 

• MV – MVA(PHT) 

• AV – AR PHT 

 
1 Select the MV or AV folder on the context menu. 

2 Select MVA(PHT) or AR PHT. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 Use [Trackball] to move the point to the e-wave velocity of the mitral valve, and press the [Set] 
key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the point to the half point of the PHT, and press the [Set] key again. 

5 The measured value is calculated, and the mitral valve area is shown on the Result window. 
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❚ Valve Area by the Continuity Equation (VTI) 

You can measure the mitral valve area and aortic valve area by using the velocity-time integral (VTI) of 
the Continuity Equation. 

1 During a Cardiology study in 2D mode, press the [Freeze] key to freeze an image. 

2 Use [Trackball] to scroll to the largest LVOT diameter. 

3 Press the [Measure] key on the control panel. 

4 Select the MV, AV, or PV folder on the context menu. 

5 Select LVOT Dm or RVOT Dm. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. The measured value is fixed. 

6 During a Cardiology study in D mode, freeze the Doppler spectrum. 

7 Press the [Measure] key on the control panel. 

8 Select the MV, AV, or PV folder on the context menu. 

9 Select LVOT VTI or RVOT VTI. The start point appears. 

a. The vertical line and the horizontal line are perpendicular to each other. 

b. Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] 
key. The end point appears. 

c. Use [Trackball] to trace one cycle of the waveform. 

d. To complete the measurement, press the [Set] key. The measured value is fixed. 

10 Perform the measurement of the second VTI (MV VTI, AV VTI, or PV VTI) in the same manner 
(a-c). 

11 After one diameter and two VTI are completed, the measured value is calculated and the mitral 
or aortic valve area is shown on the Result window, Report page, and Mini Report page. 
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❚ dP/dt 

1 Select the MV folder on the context menu. 

2 Select MR dP/dt. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

3 The horizontal line indicating regurgitation velocities of 1m/s and 3m/s. 

4 Move the marker to the start point using [Trackball] where the MR jet intersects the reference 
line at a velocity of 1m/s, and then press the [Set] key. 
The end point appears. 

5 Use [Trackball] to move the marker to the start point where the MR jet intersects the reference 
line at a velocity of 3m/s, and then press the [Set] key. 

6 The measured value is fixed, and the value for dP/dt is shown on the Result window, Report 
page, and Mini Report page. 
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Cardiology Report 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 
The cardiology report has two sections of information: 

• Patient information 

• Measurement information 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 

• BSA 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the measurement value type, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Edit > Method. 



9-98 Application Measurements and Calculations 

 

 

WMS Report 

To start a report, 

– Press the [Report] key on the control panel. 

– Select WMS Report on the context menu. 
 

NOTE 

You can view the WMS report after performing and saving the Stress echo function. 

 
To view more studies, use the combo box or the Exam soft key. 

To view another stage, select Next Stage. 
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Vascular 

Vascular Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned. 

 
Table 9-26 2D mode measurement (Vascular) 

 

Measurement Description 

Carotid Carotid Artery 

CCA Common Carotid Artery 

ICA Internal Carotid Artery 

ECA External Carotid Artery 

Vert. A Vertebral Artery 

Bulb Carotid Bulb 

UEA Upper Extremity Artery 

Subclav. A Subclavian A 

Axill. A Axillary Artery 

Basilar A Basilar Artery 

Brach. A Brachial Artery 

DBA Deep Brachial Artery 

Basilic A Basilic Artery 

Radial A Radial Artery 

Ulnar A Ulnar Artery 

SPA Superficial Palmar Arch 

Innom. A Innominate Artery 

UEV Upper Extremity Vein 

IJV Internal Jugular Vein 

Subclav. V Subclavian Vein 

Ceph. V Cephalic Vein 

Axill. V Axillary Vein 

Brach. V Brachial Vein 

DBV Deep Brachial Vein 

Basilic V Basilic Vein 
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Measurement Description 

Radial V Radial Vein 

Ulnar V Ulnar Vein 

Innom. V Innominate Vein 

LEA Lower Extremities Arteries 

CIA Common Iliac Artery 

EIA External Iliac Artery 

IIA Internal Iliac Artery 

CFA Common Femoral Artery 

DFA Deep Femoral Artery 

SFA Superficial Femoral Artery 

Pop. A Popliteal Artery 

PTA Posterior Tibial Artery 

ATA Anterior Tibial Artery 

Peron. A Peroneal Artery 

DPA Dorsalis Pedis Artery 

Prof. A Profunda Femoris Artery 

LEV Lower Extremities Veins 

CIV Common Iliac Vein 

EIV External Iliac Vein 

IIV Internal iliac vein 

CFV Common Femoral Vein 

DFV Deep Femoral Vein 

SFV Superficial Femoral Vein 

GSV Great Saphenous Vein 

LSV Lesser Saphenous Vein 

Pop. V Popliteal Vein 

PTV Posterior Tibial Vein 

ATV Anterior Tibial Vein 

Peron. V Peroneal Vein 

Prof. V Profunda Femoris Vein 

TCD Transcranial Doppler 

MCA Middle Cerebral Artery 
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Measurement Description 

ACA Anterior Cerebral Artery 

PCA P1 Posterior Celebral Artery P1 segment 

PCA P2 Posterior Celebral Artery P2 segment 

Vert. A Vertebral Artery 

Basilar A Basilar Artery 

ICA Internal Carotid Artery 

PComA Posterior Communicating Artery 

AComA Anterior Communicating Artery 

Renal Renal 

Renal A Renal Artery 

Renal V Renal Vein 

Segm. A Segmental Artery 

Interlob. A Interlobar Artery of Kidney 

Arcuate A Arcuate Artery of the Kidney 

Aorta Iliac Aorta Iliac 

Renal A Renal Artery 

CFA Common Femoral Artery 

Mesenteric Mesenteric 

Abd. Aorta Aorta 

Celiac A Celiac Artery 

SMA Superior Mesenteric Artery 

IMA Inferior Mesenteric Artery 

Hepatic A Common Hepatic Artery 

Portal V Portal Vein 

Splenic A Splenic Artery 

Bypass Graft Bypass Graft 

Straight Gft Straight Graft 

Loop Gft Loop Graft 

Cimino Gft Cimino Graft 

Comp Gft Composite Graft 
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NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Vascular > 2D > Default Measurement. 
 

To select a package measurement, 

1 Select a package measurement folder. 

2 Select the desired measurement from the measurement list. 

 
In each package measurement, you can use the following measurements: 

• Diameter (Diam) 

• Area 

• %Stenosis-Diameter (%Steno(Diam) and %Steno(Diam) dist) 

• %Stenosis-Area (%Steno(Area)) 

• Pre-Stent Diameter (Pre-Stent Diam.) 

• In-Stent Diameter (In-Stent Diam.) 

• Post-Stent Diameter (Post-Stent Diam.) 

• IMT/Auto IMT 

• Volume Flow Area 
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❚ %Stenosis (Diameter) 

1 Select %Steno(Diam) or %Steno(Diam) dist on the context menu. The start point appears. 

2 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key. 

3 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key. 

4 The two diameters percent stenosis (%Steno Diam or %Steno dist) are automatically shown on 
the Result window. 

 

ESCT method= (L-R)/Lx100 %, N/ASCET method= (D-R)/Dx100 % 

• %Steno(Diam): Stenosis Local Gradient Diameter (%), ESCT (European Carotid Surgery Trial) 
method 

• %Steno(Diam) dist: Stenosis Distal Gradient Diameter (%), NASCET (North American 
Symptomatic Carotid Surgery Trial) method 

 
❚ %Stenosis (Area) 

1 Select %Steno(Area) on the context menu. The start point appears. 

2 Measure the outer area (A1) of the stenosis using [Trackball], and press the [Set] key. 

3 Measure the inner area (A2) of the stenosis using [Trackball], and press the [Set] key. 

4 The two diameters percent stenosis (%Steno Area) are automatically shown on the Result 
window. 
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Intima-Media Thickness (IMT) measurements 

❚ IMT 

To measure the IMT manually, 

1 Acquire a longitudinal view of the carotid artery by pressing the [Freeze] key on the control 
panel. 

2 Press the [Measure] key on the control panel. 

3 Select IMT on the context menu. The start point appears. 

4 Use [Trackball] to move the marker to the start point. 

5 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

6 Use [Trackball] to move the marker to the end point. 

7 To complete the measurement, press the [Set] key. 

8 The measured value is fixed, and the intima-media thickness (IMT(D)) is shown on the Result 
window. 

 

❚ Auto IMT 

To measure the IMT automatically, 

1 Acquire a longitudinal view of the carotid artery by pressing the [Freeze] key on the control 
panel. 

2 Press the [Measure] key on the control panel. 

3 Select Auto IMT on the touch screen. The start point appears. 

4 From the point of the arterial branch about 5 mm away, draw a straight line of 10 mm by using 
[Trackball]. The end point appears. 

5 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

6 The system calculates the measured value and shows the Mean, Max, Distance, and QI on the 
Result window. 

 

NOTE 

The Auto IMT values are shown with an apostrophe mark (') on the worksheet. 

 
To measure the IMT manually, 

– Select Manual by rotating the Caliper soft key, and make one distance measurement. 
 

NOTE 

After the automatic measurement is completed, you can make one distance measurement manually, if 
necessary, to cross check the result. 
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M mode measurements 

M mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned. 

 

Table 9-27 M mode measurement (Vascular) 
 

Measurement Description 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Vascular > M > Default Measurement. 
 

❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 
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D mode measurements 

D mode measurements are shown in the context menu and in the vascular report with measured result, 
when assigned. 

 

Table 9-28 D mode measurement (Vascular) 
 

Measurement Description 

Carotid Carotid Artery 

CCA Common Carotid Artery 

ICA Internal Carotid Artery 

ECA External Carotid Artery 

Vert. A Vertebral Artery 

Bulb Carotid Bulb 

UEA Upper Extremity Artery 

Subclav. A Subclavian A 

Axill. A Axillary Artery 

Basilar A Basilar Artery 

Brach. A Brachial Artery 

DBA Deep Brachial Artery 

Basilic A Basilic Artery 

Radial A Radial Artery 

Ulnar A Ulnar Artery 

SPA Superficial Palmar Arch 

Innom. A Innominate Artery 

UEV Upper Extremity Vein 

IJV Internal Jugular Vein 

Subclav. V Subclavian Vein 

Ceph. V Cephalic Vein 

Axill. V Axillary Vein 

Brach. V Brachial Vein 

DBV Deep Brachial Vein 

Basilic V Basilic Vein 

Radial V Radial Vein 

Ulnar V Ulnar Vein 

Innom. V Innominate Vein 
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Measurement Description 

LEA Lower Extremities Arteries 

CIA Common Iliac Artery 

EIA External Iliac Artery 

IIA Internal Iliac Artery 

CFA Common Femoral Artery 

DFA Deep Femoral Artery 

SFA Superficial Femoral Artery 

Pop. A Popliteal Artery 

PTA Posterior Tibial Artery 

ATA Anterior Tibial Artery 

Peron. A Peroneal Artery 

DPA Dorsalis Pedis Artery 

Prof. A Profunda Femoris Artery 

LEV Lower Extremities Veins 

CIV Common Iliac Vein 

EIV External Iliac Vein 

IIV Internal iliac vein 

CFV Common Femoral Vein 

DFV Deep Femoral Vein 

SFV Superficial Femoral Vein 

GSV Great Saphenous Vein 

LSV Lesser Saphenous Vein 

Pop. V Popliteal Vein 

PTV Posterior Tibial Vein 

ATV Anterior Tibial Vein 

Peron. V Peroneal Vein 

Prof. V Profunda Femoris Vein 

TCD Transcranial Doppler 

MCA Middle Cerebral Artery 

ACA Anterior Cerebral Artery 

PCA P1 Posterior Celebral Artery P1 segment 

PCA P2 Posterior Celebral Artery P2 segment 
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Measurement Description 

Vert. A Vertebral Artery 

Basilar A Basilar Artery 

ICA Internal Carotid Artery 

PComA Posterior Communicating Artery 

AComA Anterior Communicating Artery 

Renal Renal 

Renal A Renal Artery 

Renal V Renal Vein 

Segm. A Segmental Artery 

Interlob. A Interlobar Artery of Kidney 

Arcuate A Arcuate Artery of the Kidney 

Aorta Iliac Aorta Iliac 

Renal A Renal Artery 

CFA Common Femoral Artery 

Mesenteric Mesenteric 

Abd. Aorta Aorta 

Celiac A Celiac Artery 

SMA Superior Mesenteric Artery 

IMA Inferior Mesenteric Artery 

Hepatic A Common Hepatic Artery 

Portal V Portal Vein 

Splenic A Splenic Artery 

Bypass Graft Bypass Graft 

Straight Gft Straight Graft 

Loop Gft Loop Graft 

Cimino Gft Cimino Graft 

Comp Gft Composite Graft 

 

NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Vascular > Doppler > Default Measurement. 
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To select a package measurement, 

1 Select a package measurement folder. 

2 Select a desired measurement from the measurement list. 

 
In each package measurement, you can use the following measurements: 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D Ratio (S/D) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Velocity Time Integral (VTI) 

• Maximum Velocity (Vmax Pre, Vmax Intra) 

• Stent Maximum Velocity (Vmax Pre-Stent, Vmax In-Stent, Vmax Post-Stent) 

• Stent Minimum Velocity (Ved Pre-Stent, Ved In-Stent, Ved Post-Stent) 

 
❚ Velocity 

1 Select a labeled measurement for velocity on the context menu. The vertical line and the 
horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity is shown on the Result window. 

 
❚ PS/ED Ratio 

1 Select S/D on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Measure the first point (S) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second point (D) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated. The two velocities (S, D) and S/D ratio (S/D) are shown on the Result 
window. 
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❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform, and press the [Set] key. 

4 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The end point is fixed, and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window. 

 

❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the maximum values of the desired portion for the spectrum. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window. 
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D mode calculations 

The calculation labels may not be available shown in the measurement menu. The system performs the 
calculations when the required measurements are made. The system also shows the calculated values in 
the measured results and transfers the values to the report. 

 
Table 9-29 D mode calculations (Vascular) 

 

Calculation Description Required 

 

PVR 
 

Peak Velocity Ratio 
Vmax Pre-Stent 
Vmax In-Stent 

 

%Steno PVR 
 

Stenosis using the peak velocity ratio 
Vmax Pre-Stent 

Vmax In-Stent 

S/D Peak Systole Velocity/End diastole Velocity Ratio PS, ED 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Vascular > Doppler > Default Measurement. 
 

Define as: 

PVR = Vmax (Stenosis intra) / Vmax (Stenosis pre) 

%Steno PVR = 1-(1/PVR) 
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Vascular Report 

The vascular report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five and the oldest value is automatically deleted. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 
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Vascular Summary 

To start a summary, 

– Select Summary on the context menu. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

On the Summary page, the result values are shown on the each side (left, right), if the measurement 
includes the both side values. 

 

NOTE 

You cannot edit the result values on the Summary page. 

 

Calculation information 

The calculation information is shown on the bottom of the Summary page. The following information is 
available: ICA PS/CCA PS, ICA ED/CCA ED, Bulb PS/CCA PS, Bulb ED/CCA ED 
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Urology 

Urology Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned. 

 
Table 9-30 2D mode measurement (Urology) 

 

Measurement Description 

Renal L Renal Length 

Renal Renal Volume 

Renal L Renal Length 

Renal H Renal Height 

Renal W Renal Width 

Bladder Bladder Volume 

Bladder L Bladder Length 

Bladder H Bladder Height 

Bladder W Bladder Width 

Testicle Testicle Volume 

Testicle L Testicle Length 

Testicle H Testicle Height 

Testicle W Testicle Width 

Prostate Prostate Volume 

Prostate L Prostate Length 

Prostate H Prostate Height 

Prostate W Prostate Width 

Residual Residual Volume 

Pre L Pre Bladder Length 

Pre H Pre Bladder Height 

Pre W Pre Bladder Width 

Post L Post Bladder Length 

Post H Post Bladder Height 

Post W Post Bladder Width 

Pre Vol Pre Bladder Volume 
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Measurement Description 

Post Vol Post Bladder Volume 

Void Vol Void Volume (Difference between Pre and Post Volume) 

Renal Vol Renal Volume 

Bladder Vol Bladder Volume 

Testicle Vol Testicle Volume 

Prostate Vol Prostate Volume 

 

NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Urology > 2D > Default Measurement. 
 

❚ Renal Volume (1) 

You can measure the length, width, and height for the left and right renal. Each measurement is a 
typical distance measurement made in the appropriate scan plane. 

1 Select the Rt (right) or Lt (left) on the context menu. 

2 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurement are completed, the renal volume is 
calculated. 

5 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 
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❚ Renal Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Renal Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

5 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

6 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2) and press the [Clear] key. 

• To configure the renal volume method, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Urology > Renal Vol > Edit. 

 
❚ Bladder Volume (1) 

You can measure the length, width, and height of the bladder. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane. 

1 Select the Bladder folder on the context menu. 

2 Select Bladder L, Bladder H, or Bladder W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the bladder volume is 
calculated. 

5 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window. 
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❚ Bladder Volume (2) 

1 Select Bladder Vol on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point, press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

4 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

5 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key. 

• To configure the bladder volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Urology > Bladder Vol > Edit. 

 
2D mode calculations 

 
NOTE 

The calculation labels are not shown in the measurement menu. 

 
The system performs the calculations when the required measurements are made. The system also 
shows the calculated values in the measured results and transfers the values to the report. 

 
Table 9-31 2D mode calculations (Urology) 

 

Calculation label Description Required measurements 

PSAD Prostatic Specific Antigen Density PSA 

Prostate Volume 

PPSA(1) Predicted Prostate 

Specific Antigen 

PPSA Coefficient (1) 

Prostate Volume 

PPSA(2) Predicted Prostate 

Specific Antigen 

PPSA Coefficient (2) 

Prostate Volume 

 
Define as: 

PSAD = PSA / Prostate Vol 

PPSA = Prostate Vol × PPSA Coefficient 
 

NOTE 

If you enter the value of PSA and PPSA Coefficient on the Patient screen, PSAD and PPSA are automatically 

calculated. 
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❚ Prostate Volume (1) 

You can measure the length, width, and height of the prostate. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane. 

1 Select the Prostate folder on the context menu. 

2 Select Prostate L, Prostate H, or Prostate W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the prostate volume is 
calculated. 

5 The measured value is fixed. The prostate volume (Prostate Vol) and calculations (PSAD and 
PPSA) are shown on the Result window. 

 

❚ Prostate Volume (2) 

1 Select Prostate Vol on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

4 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

5 The measured value is fixed, and the prostate volume (Prostate Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key. 

• To configure the prostate volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Urology > Prostate Vol > Edit. 
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M mode measurements 

M mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned. 

 
Table 9-32 M mode measurement (Urology) 

 

Measurement Description 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Urology > M > Default Measurement. 
 

❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 

 

D mode measurements 

D mode measurements are shown in the context menu and in the urology report with measured result, 
when assigned. 

 
Table 10-33 D mode measurement (Urology) 

 

Measurement Description 

Vessel Vessel 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Urology > Doppler > Default Measurement. 
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Urology Report 

The urology report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 

• PSA 

• PPSA Coef(1) 

• PPSA Coef(2) 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 
Measurement > Labeled MEAS. > Edit > Method. 
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Pediatrics 

Pediatrics Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned. 

 
Table 9-34 2D mode measurement (Pediatrics) 

 

Measurement Description 

Aorta Aorta Diameter 

Renal L Renal Length 

Renal Renal Volume 

Renal L Renal Length 

Renal H Renal Height 

Renal W Renal Width 

Renal Vol Renal Volume 

Hip Hip Angle 

Hip(BA) The system calculates and shows angles β and α. 

Hip(AB) The system calculates and shows angles α and β. 

Hip(Rotate) Hip Angle (Type to measure by rotating the [Angle] key) 

d:D The ratio of acetabular depth to diameter of the femoral head (d/D) 

 
NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Pediatrics > 2D > Default Measurement. 
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❚ Renal Volume (1) 

You can measure the length, width, and height of the left and right renal. Each measurement is a 
typical distance measurement made in the appropriate scan plane. 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Renal folder, and then select Renal L, Renal H, or Renal W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the renal volume is 
calculated. 

5 The measured value is fixed. The renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 

 

❚ Renal Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Renal Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

5 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

6 The measured value is fixed, and the renal volume (Rt or Lt Renal Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 

(D1, D2), and press the [Clear] key. 

• To configure the renal volume method, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Pediatrics > Renal Vol > Edit. 
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❚ Hip Joint (BA) 

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the beta angle (β). The third line establishes the alpha angle (α). 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Hip folder, and then select Hip(BA). 
The first distance measurement (baseline) is already selected. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The baseline is completed. 

5 Perform the measurement for the second (β) and third (α) distances. 

6 When all of the three lines are measured, the hip angle is calculated. 

7 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window. 

 
3 

 
 
 

 
1 

 
 

 

• To define the baseline, point a and b. 

• To define the α angle line, point c and d. 

• To define the β angle line, point e and f. 

 
❚ Hip Joint (AB) 

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the alpha angle (α). The third line establishes the beta angle (β). 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Hip folder, and then select Hip(AB). 
The first distance measurement (baseline) is already selected. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The baseline is completed. 

5 Perform the measurement for the second (α) and third (β) distances. 

6 When all of the three lines are measured, the hip angle is calculated. 

7 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window. 
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❚ Hip(Rotate) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Hip folder, and then select Hip(Rotate). 
The first distance measurement (baseline) is already selected. 

3 Rotate the [Angle] Key to adjust the angle of the baseline, and press the [Set] Key. 

4 Rotate the [Angle] Key to adjust the alpha angle (α), and press [Set] Key. 

5 Press the [Angle] Key to adjust the beta angle (β), press [Set] Key. 

6 When all of the three lines are measured, the hip angle is calculated. 

7 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window. 

 

❚ d:D Ratio 

To measure the percentage of the femoral head coverage under the bony roof, 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Hip folder, and then select d:D. 

3 Press the [Set] Key. A circle appears. 

4 Use [Trackball] to move the center of the circle and press the [Set] key to fix the circle. 

5 Use [Trackball] to draw a line across the circle, and press the [Set] key. 

6 The ratio of the long distance and the short distance is calculated. 

7 The measured value is fixed ,and the d:D ratio (d:D) is shown on the Result window. 
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M mode measurements 

M mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned. 

 
Table 9-35 M mode measurement (Pediatrics) 

 

Measurement Description 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Pediatrics > M > Default Measurement. 
 

❚ Heart Rate (HR) 

1 Select HR on the context menu. The start point appears. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 
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D mode measurements 

D mode measurements are shown in the context menu and in the pediatrics report with measured 
result, when assigned. 

 
Table 9-36 D mode measurement (Pediatrics) 

 

Measurement Description 

Aorta Aorta 

Renal A Renal Artery 

CHA Hepatic Artery 

IVC Inferior Vena Cava 

Hepatic V Hepatic Vein 

Mid HV Middle Hepatic Vein 

MPV Main Portal Vein 

Portal V Portal Vein 

Splenic A Splenic Artery 

Splenic V Splenic Vein 

SMA Superior Mesenteric Artery 

SMV Superior Mesenteric Vein 

IMA Inferior Mesenteric Artery 

Iliac A Iliac Artery 

Iliac V Iliac Vein 

Vessel Vessel 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Pediatrics > Doppler > Default Measurement. 
 

To select a package measurement, 

1 Select a package measurement folder. 

2 Select a desired measurement from the measurement list. 
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In each package measurement for Doppler mode, you can use the following measurements: 

• Auto Trace 

• Semi Auto Trace 

• Manual Trace 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D or D/S Ratio (S/D or D/S) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Acceleration (Accel) 

• Acceleration Time (AT) 
 

NOTE 

To configure the default package measurement for Doppler mode, go to Utility > Setup > SystemPreset 

> Measurement > Labeled MEAS. > Pediatrics > Doppler > Package measurement > desired default 
measurements. 

 

❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD) 

1 Select PS, ED, or MD on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window. 

 
❚ PS/ED or ED/PS Ratio 

1 Select S/D or D/S on the context menu. 

2 The vertical line and the horizontal line are perpendicular to each other. 

3 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key. 

4 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key. 

5 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window. 
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❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform. 

4 To complete the measurement, press the [Set] key. 

5 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The end point is fixed and the resistive index is calculated. The resistivity index (RI) is shown on 
the Result window. 

 

❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 To trace the maximum value of the desired portion for the spectrum, use [Trackball]. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated. The maximum time-average (TAmax) is shown on the 
Result window. 
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❚ Acceleration (Accel) 

1 Select Accel on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window. 

 

❚ Acceleration Time (AT) 

1 Select AT on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window. 
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Pediatrics Report 

The pediatrics report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 



Small Parts 9-131 

 

 

Small Parts 

Small Parts Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned. 

 
Table 9-37 2D mode measurement (Small parts) 

 

Measurement Description 

Thyroid Vol Thyroid Volume 

Testicle Vol Testicle Volume 

Thyroid Thyroid Volume 

Thyroid L Thyroid Length 

Thyroid H Thyroid Height 

Thyroid W Thyroid Width 

Testicle Testicle Volume 

Testicle L Testicle Length 

Testicle H Testicle Height 

Testicle W Testicle Width 

Isthmus Testicle Volume 

Isthmus H Isthmus Height 

Nodule Nodule Volume 

Nodule # 1–10 Measurements of the left and right Thyroid Nodule 

Lymph Node Lymph Node Volume 

Lymph Node # 1–10 Measurements of the Lymph Node 

Parathyroid Parathyroid Volume 

Parathyroid # 1–4 Measurements of the left and right Parathyroid 

Epididymis Epididymis Volume 

Epididymis L Epididymis Length 

Epididymis H Epididymis Height 

Epididymis W Epididymis Width 

Epididymis Cyst(s) Epididymis Cyst(s) Volume 

Epididymis Cyst(s) L Epididymis Cyst(s) Length 

Epididymis Cyst(s) H Epididymis Cyst(s) Height 
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Epididymis Cyst(s) W Epididymis Cyst(s) Width 

Testicular Cyst(s) Testicular Cyst(s) Volume 

Testicular Cyst(s) L Testicular Cyst(s) Length 

Testicular Cyst(s) H Testicular Cyst(s) Height 

Testicular Cyst(s) W Testicular Cyst(s) Width 

Testicular Nodule(s) Testicular Nodule(s) Volume 

Testicular Nodule(s) L Testicular Nodule(s) Length 

Testicular Nodule(s) H Testicular Nodule(s) Height 

Testicular Nodule(s) W Testicular Nodule(s) Width 

 

NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Small Parts > 2D > Default Measurement. 
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❚ Thyroid Volume (1) 

You can measure the length, width, and height for the left and right thyroid. The each measurement is 
a typical distance measurement made in the appropriate scan plane. 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Thyroid folder, and then select Thyroid L, Thyroid H, or Thyroid W. The start point 
appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the thyroid volume is 
calculated. 

5 The measured value is fixed, and the thyroid volume (Rt or Lt Thyroid Vol) is shown on the 
Result window. 

 

❚ Thyroid Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Thyroid Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

5 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

6 The measured value is fixed, and the thyroid volume (Rt or Lt Thyroid Vol) is shown on the 
Result window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key. 

• To configure the thyroid volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Small Parts > Thyroid Vol > Edit. 
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❚ Testicle Volume (1) 

You can measure the length, width, and height of the scrotum. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane. 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Testicle folder, and then select Testicle L, Testicle H, or Testicle W. The start point 
appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the testicle volume is 
calculated. 

5 The measured value is fixed, and the testicle volume (Rt or Lt Testicle Vol) is shown on the 
Result window. 

 

❚ Testicle Volume (2) 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Testicle Vol. The start point appears. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

5 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

6 The measured value is fixed, and the testicle volume (Rt or Lt Testicle Vol) is shown on the 
Result window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key. 

• To configure the testicle volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > Small Parts > Testicle Vol > Edit. 
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❚ TI-RADS Assessment 

1 Register the Patient ID. 

2 Press the [Measure] key on the control panel. 

3 Select the TI-RADS on the soft menu. 

4 Evaluation list of the TI-RADS appears on the context menu. 
 

5 After assessment of each item, enter the Report page. 
 

NOTE 

TI-RADS is not supported while using the Full Screen mode or X+ Assistant. 
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M mode measurements 

M mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned. 

 
Table 9-38 M mode measurement (Small parts) 

 

Measurement Description 

Distance Distance 

Time Time 

Slope Slope 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Small Parts > M > Default Measurement. 
 

❚ Distance 

1 Select Distance on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The measured value is fixed, and the distance (D) is shown on the Result window. 

 
❚ Time 

1 Select Time on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The time (T) is shown on the Result window. 

 
❚ Slope 

1 Select Slope on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window. 
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❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 

 

D mode measurements 

D mode measurements are shown in the context menu and in the small parts report with measured 
result, when assigned. 

 
Table 9-39 D mode measurement (Small parts) 

 

Measurement Description 

Thyroid Flow Thyroid Flow 

Testicle Flow Testicle Flow 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Small Parts > Doppler > Default Measurement. 
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Small Parts Report 

The small parts report has three sections of information: 

• Patient information 

• Measurement information 

• Thyroid analysis 
 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 
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Thyroid Analysis 

To start the thyroid analysis, 

– While viewing the thyroid report, select Analysis on the context menu. 
 

NOTE 

The patient specific contents input on the Analysis page are returned to the factory default settings after 
starting a new patient. 

 

Figure 9-6 Thyroid Analysis 
 
 
 

Analysis lists 
 

Table 9-40 Thyroid nodule analysis lists 
 

List Descriptive data Options 

Position Superior Anterior  

Superior Posterior 
 

Medium Anterior  

Medium Posterior 
 

Inferior Anterior 
 

Inferior Posterior 
 

Isthmus 
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List Descriptive data Options 

Shape Round 
 

Wider than tall 
 

Taller than wide 
 

Irregular 
 

Composition Solid 
 

Predominately Solid 
 

Predominately Cystic 
 

Cystic 
 

Spongiform 
 

Echogenecity Markedly Hypoechoic 
 

Hypoechoic 
 

Isoechoic 
 

Hyperechoic 
 

Echotexture Homogeneous 
 

Heterogeneous 
 

Calcifications Absent 
 

Micro Ca++ 
 

Macro Ca++ 
 

Peripheral rim Ca++ 
 

Margin Well-defined Regular, Irregular 

Ill-defined Regular, Irregular 

Halo sign Absent 
 

Complete Thin, Thick 

Partial Thin, Thick 

Vascularity Absent 
 

Perinodular 
 

Peri-Intranodular 
 

Lymph Nodes Normal 
 

Suspect Intramammary, Axillary 

Elasticity Assessment Soft 
 

Intermediate 
 

Hard 
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List Descriptive data Options 

Measurement Strain Ratio  

TI-RADS Classification TR1, TR2, TR3, TR4, TR5 
 

Assessment 
  

 

NOTE 

TI-RADS is a trademarks of the American College of Radiology. 

 

TI-RADS risk-stratification system 

Review the TI-RADS risk-stratification system, 

– While viewing the thyroid report, select TI-RADS on the context menu. 
 

 

Figure 9-7 TI-RADS risk-stratification system 
 
 

Table 9-41 TI-RADS classification lists 
 

Classification list Descriptive data Options 

Composition 
(Choose 1) 

Cystic or almost completely cystic 0 points 

Spongiform 0 points 

Mixed cystic and solid 1 points 

Solid or almost completely solid 2 points 
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Classification list Descriptive data Options 

Echogenicity 
(Choose 1) 

Anechoic 0 points 

Hyperechoic or isoechoic 1 points 

Hyperechoic 2 points 

Very hyperechoic 3 points 

Shape 

(Choose 1) 
Wider-than-tall 0 points 

Taller-than-wide 3 points 

Margin 

(Choose 1) 
Smoth 0 points 

Ill-defined 0 points 

Lobulated or irregular 2 points 

Extra-thyroidal extension 3 points 

Echogenic foci 

(Choose All That Apply) 

None or large comet-tail artifacts 0 points 

Macrocalcifications 1 points 

Peripheral (rim) calcifications 2 points 

Punctate echogenic foci 3 points 

 

 

Table 9-42 TI-RADS lesion Level lists 
 

Level list Descriptive data Options 

TR1 - 0 Points Benign 
 

TR2 - 2 Points Not Suspicious 
 

TR3 - 3 Points Midly Suspicious 
 

TR4 - 4 to 6 Points Moderately Suspicious 
 

TR5 - 7+ Points Highly Suspicious 
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Breast 

Breast Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned. 

 
Table 9-41 2D mode measurement (Breast) 

 

Measurement Description 

Mass# 1–10 Measurements of the left and right breast mass 

Mass L Mass Length 

Mass H Mass Height 

Mass W Mass Width 

Mass Nip-Mass D Mass Nipple Mass Diameter 

Mass Skin-Mass D Mass Skin Mass Diameter 

Mass Vol Mass Volume 

Duct Dilatation Duct Dilatation 

 
NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Breast > 2D > Default Measurement. 
 

❚ Mass Volume 

You can make the breast mass volume from one, two, or three distance measurements. 

1 Distance Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Mass folder. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the Mass volume (Rt or Lt Mass Vol) is shown on the Result 
window. 
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2 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Mass folder. The start point appears. 

a. Move the marker to the start point using [Trackball]. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Move the marker to the end point using [Trackball]. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second distance in the same manner (a-d). 

4 When the second distances are measured, press the [Set] key. 

5 The measured value is fixed, and the Mass volume (Rt or Lt Mass Vol) is shown on the Result 
window. 

 

3 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Mass folder. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). When 
three distances are measured, the volume is calculated. 

4 The measured value is fixed, and the Mass volume (Rt or Lt Mass Vol) is shown on the Result 
window. 

 

NOTE 

To configure the Mass volume method, go to Utility > Setup > SystemPreset > Measurement > Labeled 
MEAS. > Breast > Edit. 
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❚ BI-RADS Assessment 

1 Register the Patient ID. 

2 Press the [Measure] key on the control panel. 

3 Select the BI-RADS on the soft menu. 

4 Evaluation list of the BI-RADS appears on the context menu. 
 

5 After assessment of each item, enter the Report page. 
 

NOTE 

TI-RADS is not supported while using the Full Screen mode or X+ Assistant. 
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M mode measurements 

M mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned. 

 
Table 9-42 M mode measurement (Breast) 

 

Measurement Description 

Distance Distance 

Time Time 

Slope Slope 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > Breast > M > Default Measurement. 
 

❚ Distance 

1 Select Distance on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The measured value is fixed, and the distance (D) is shown on the Result window. 

 
❚ Time 

1 Select Time on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The time (T) is shown on the Result window. 

 
❚ Slope 

1 Select Slope on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed, and the slope is calculated. The distance (D), time (T) and slope 
(Slope) are shown on the Result window. 
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❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 

 

D mode measurements 

D mode measurements are shown in the context menu and in the breast report with measured result, 
when assigned. 

 
Table 9-43 D mode measurement (Breast) 

 

Measurement Description 

Breast Flow Breast Flow 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Breast > Doppler > Default Measurement. 
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Breast Report 

The breast report has three sections of information: 

• Patient information 

• Measurement information 

• Breast analysis 
 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report function, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 
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Breast Analysis 

To start the breast analysis, 

– While viewing the breast report, select Analysis on the context menu. 
 

NOTE 

The patient specific contents input on the Analysis page are returned to the factory default settings after 
starting a new patient. 

 

Figure 9-7 Breast Analysis 
 
 

 

Analysis lists 
 

Table 9-45 Breast mass analysis lists 
 

List Descriptive data Options 

Position (0–12):(00,30) o’clock  

Shape Round 
 

Oval 
 

Irregular 
 

Orientation Wider than tall 
 

Taller than wide  

Margin Circumscribed 
 

Not circumscribed Indistinct, Angular, Microlobulated, 
Spiculated 
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List Descriptive data Options 

Echo Pattern Anechoic 
 

Hyperechoic 
 

Complex cystic and solid 
 

Hypoechoic 
 

Isoechoic 
 

Heterogeneous 
 

Posterior Features No posterior feature 
 

Enhancement 
 

Shadowing 
 

Combined pattern 
 

Calcifications Not Present 
 

Macro Ca++ 
 

Micro Ca++ in a mass 
 

Micro Ca++ outside of a mass 
 

Intraductal Ca++ 
 

Associated Features Architectural distortion (Blank) 

Duct change 
 

Skin thickening 
 

Skin retraction 
 

Edema 
 

Vascularity Not present 
 

Vessels in rim 
 

Internal vascularity 
 

Lymph Nodes Normal 
 

Suspect Intramammary, Axillary 

Elasticity Assessment Soft 
 

Intermediate 
 

Hard 
 

Measurement Strain Ratio 
 

RI < 0.70, ≥ 0.70 
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List Descriptive data Options 

BI-RADS Classification Shape, Orientation, Margin, 
Echo Pattern, Posterior features, 

Calcifications, Associated features, 
Special cases 

 

Assessment 
  

 

NOTE 

BI-RADS is a trademarks of the American College of Radiology. 
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BI-RADS lesion classification 

Review the BI-RADS lesion classification, 

– While viewing the breast report, select BI-RADS on the context menu. 
 

 

Figure 9-9 BI-RADS lesion classification 
 
 

Table 9-47 BI-RADS classification lists 
 

Classification list Descriptive data Options 

Shape Oval  

Round 
 

Irregular 
 

Orientation Parallel  

Not Parallel 
 

Margin Circumscribed 
 

Not circumscribed Indistinct, Angular, Microlobulated, 
Spiculated 

Echo Pattern Anechoic 
 

Hyperechoic 
 

Complex cystic and solid 
 

Hypoechoic 
 

Isoechoic 
 

Heterogeneous 
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Classification list Descriptive data Options 

Posterior Features No posterior feature 
 

Enhancement 
 

Shadowing 
 

Combined pattern 
 

Calcifications Calcifications in a mass 
 

Calcifications outside of a mass 
 

Intraductal calcificatios 
 

Associated Features Architectural distortion 
 

Duct changes 
 

Skin changes Skin thickening, Skin retraction 

Edema 
 

Vascularity Absent, Internal vascularity, Vessels 

in rim 

Elasticity Assessment Soft, Intermediate, Hard 

Special cases Simple cyst 
 

Clustered microcysts 
 

Complicated cyst 
 

Mass in or on skin 
 

Foreign body including implants 
 

Lymph nodes - intramammary 
 

Lymph nodes - axillary 
 

Vascular abnormalities AVMs (Arteriovenous malformations/ 

pseudoaneurysms), Mondor disease 

Postsurgical fluid collection 
 

Fat necrosis 
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Musculoskeletal (MSK) 

MSK Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned. 

 
Table 9-46 2D mode measurement (MSK) 

 

Measurement Description 

Volume Volume 

Hip(BA) The system calculates and shows angles β and α. 

Hip(AB) The system calculates and shows angles α and β. 

Hip(Rotate) Hip Angle ( Type to measure by rotating the angle key ) 

d:D d/D (the ratio of acetabular depth to diameter of the femoral head) 

 
NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > MSK > 2D > Default Measurement. 
 

❚ Volume 

You can make the volume from one, two, or three distance measurements. 

1 Distance Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Volume. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window. 
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2 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Volume. The start point appears. 

a. Move the marker to the start point using [Trackball]. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point appears. 

c. Move the marker to the end point using [Trackball]. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second distance in the same manner (a-d). 

4 When the second distances are measured, press the [Set] key. 

5 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window. 

 
3 Distances Volume 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select the Volume. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When three distances are measured, the volume is calculated. 

5 The measured value is fixed, and the volume (Rt or Lt Vol) is shown on the Result window. 
 

NOTE 

To configure the volume method, go to Utility > Setup > SystemPreset > Measurement > Labeled MEAS. 

> MSK > Edit. 
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❚ Hip(BA) 

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the beta angle (β). The third line establishes the alpha angle (α). 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Hip(BA). The first distance measurement (baseline) is already selected. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. The 
baseline is completed. 

5 Perform the measurement for the second (β) and third (α) distances. 

6 When all of the three lines are measured, the hip angle is calculated. 

7 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window. 

 

❚ Hip(AB) 

The hip angle (α, β) between three lines is calculated. The first line is the baseline. The second line 
establishes the alpha angle (α). The third line establishes the beta angle (β). 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Hip(AB). The first distance measurement (baseline) is already selected. 

3 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

4 Use [Trackball] to move the marker to the second point, and press the [Set] key again. The 
baseline is completed. 

5 Perform the measurement for the second (α) and third (β) distances. 

6 When all of the three lines are measured, the hip angle is calculated. 

7 The measured value is fixed. The hip angles (Rt or Lt, Alpha and Beta) are shown on the Result 
window. 
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M mode measurements 

M mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned. 

 
Table 9-47 M mode measurement (MSK) 

 

Measurement Description 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > MSK > M > Default Measurement. 
 

❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 

 

D mode measurements 

D mode measurements are shown in the context menu and in the MSK report with measured result, 
when assigned. 

 
Table 9-48 D mode measurement (MSK) 

 

Measurement Description 

Vessel Vessel 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > MSK > Doppler > Default Measurement. 
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MSK Report 

The MSK report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit the patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item. If you make more than five measurements, the 
report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 
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Emergency Medicine (EM) 

EM Measurements and Calculations 

2D mode measurements 

2D mode measurements are shown in the context menu and in the EM report with measured result, 
when assigned. 

 
Table 9-49 2D mode measurement (EM) 

 

Measurement Description 

Aorta Aorta 

Renal L Renal Length 

Bladder Bladder Volume 

Bladder L Bladder Length 

Bladder H Bladder Height 

Bladder W Bladder Width 

Bladder Vol Bladder Volume 

 
NOTE 

To configure the default measurement for 2D mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > EM > 2D > Default Measurement. 
 

❚ Aorta Diameter 

1 Select Aorta on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point. 

3 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

4 Use [Trackball] to move the marker to the end point. 

5 To complete the measurement, press the [Set] key. 

6 The measured value is fixed, and the aorta diameter (Aorta) is shown on the Result window. 
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❚ Renal Length 

1 Select Rt (right) or Lt (left) on the context menu. 

2 Select Renal L. The start point appears. 

3 Use [Trackball] to move the marker to the start point. 

4 To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

5 Use [Trackball] to move the marker to the end point. 

6 To complete the measurement, press the [Set] key. 

7 The measured value is fixed, and the renal length (Rt or Lt Renal L) is shown on the Result 
window. 

 

❚ Bladder Volume (1) 

You can measure the length, width, and height of the bladder. Length is measured in the sagittal 
plane. Width and height are measured in the axial plane. 

1 Select the Bladder folder on the context menu. 

2 Select Bladder L, Bladder H, or Bladder W. The start point appears. 

a. Use [Trackball] to move the marker to the start point. 

b. To fix the point, press the [Set] key. The end point, overlapping the start point, appears. 

c. Use [Trackball] to move the marker to the end point. 

d. To complete the measurement, press the [Set] key. 

3 Perform the measurement of the second and third distance in the same manner (a-d). 

4 When the length, width, and height measurements are completed, the bladder volume is 
calculated. 

5 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window. 
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❚ Bladder Volume (2) 

1 Select Bladder Vol on the context menu. The start point appears. 

2 Use [Trackball] to move the marker to the start point, and press the [Set] key. 
The first point is fixed, and the second point appears. 

3 Use [Trackball] to move the marker to the second point, and press the [Set] key again. 
The first distance is measured. 

4 Measure the second and third distances in the same manner. 
When three distances are measured, the volume is calculated. 

5 The measured value is fixed, and the bladder volume (Bladder Vol) is shown on the Result 
window. 

 
NOTE 

• When you measure one distance (D1) and press the [Clear] key, the volume for D1 is calculated and 
shown on the Result window. For the volume of two distance (D2), measure one and two distances 
(D1, D2), and press the [Clear] key. 

• To configure the bladder volume method, go to Utility > Setup > SystemPreset > Measurement > 
Labeled MEAS. > EM > Bladder Vol > Edit. 
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M mode measurements 

M mode measurements are shown in the context menu and in the EM report with measured result, 
when assigned. 

 
Table 9-50 M mode measurement (EM) 

 

Measurement Description 

%Stenosis Two Diameters Percent Stenosis 

A/B Ratio Two Diameters Ratio 

HR Heart Rate 

 
NOTE 

To configure the default measurement for M mode, go to Utility > Setup > SystemPreset > Measurement > 

Labeled MEAS. > EM > M > Default Measurement. 
 

❚ %Stenosis (Diameter) 

1 Select %Stenosis on the context menu. The start point appears. 

2 Measure the larger diameter (D1) of the stenosis using [Trackball], and press the [Set] key. 

3 Measure the smaller diameter (D2) of the stenosis using [Trackball], and press the [Set] key. 

4 The two diameters percent stenosis (%Steno(Diam)) are shown on the Result window. 

 
❚ A/B Ratio (Diameter) 

1 Select A/B Ratio on the context menu. The start point appears. 

2 Measure the first diameter (A) of the ratio using [Trackball], and press the [Set] key. 

3 Measure the second diameter (B) of the ratio using [Trackball], and press the [Set] key. 

4 The ratio is calculated and two diameters ratio (A/B Ratio) are shown on the Result window. 

 
❚ Heart Rate (HR) 

1 Select HR on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The heart rate between the two points is calculated. The heart rate (HR) and time (T) are shown 
on the Result window. 

 

NOTE 

To configure the heart rate cycle, go to Utility > Setup > SystemPreset > Measurement > Advanced 
MEAS. > HR cycle. 
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D mode measurements 

D mode measurements are shown in the context menu and in the EM report with measured result, when 
assigned. 

 
Table 9-51 D mode measurement (EM) 

 

Measurement Description 

Aorta Aorta 

Renal A Renal Artery 

SMA Superior Mesenteric Artery 

IMA Inferior Mesenteric Artery 

IVC Inferior Vena Cava 

Uterine A Uterine Artery 

Ovarian A Ovarian Artery 

Vessel Vessel 

HR Heart Rate 

 
NOTE 

To configure the default measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > EM > Doppler > Default Measurement. 
 

To select a package measurement, 

1 Select a package measurement folder. 

2 Select the desired measurement from the measurement list. 

 
In each package measurements for Doppler mode, you can use the following measurements: 

• Auto Trace 

• Semi Auto Trace 

• Manual Trace 

• Peak Systole (PS) 

• End Diastole (ED) 

• Minimum Diastole (MD) 

• S/D or D/S Ratio (S/D or D/S) 

• Pulsatility Index (PI) 

• Resistive Index (RI) 

• Maximum Time-Average Velocity (TAmax) 

• Acceleration (Accel) 

• Acceleration Time (AT) 
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NOTE 

To configure the default package measurement for Doppler mode, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > EM > Doppler > Package measurement > a default measurement. 
 

❚ Peak Systole, End Diastole or Minimum Diastole (PS, ED, or MD) 

1 Select PS, ED, or MD on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 

3 The measured value is fixed, and the velocity (PS, ED, or MD) is shown on the Result window. 

 
❚ PS/ED or ED/PS Ratio 

1 Select S/D or D/S on the context menu. 

2 The vertical line and the horizontal line are perpendicular to each other. 

3 Measure the first point (S or D) of the ratio using [Trackball], and press the [Set] key. 

4 Measure the second point (D or S) of the ratio using [Trackball], and press the [Set] key. 

5 The ratio is calculated. The two velocities (S, D) and S/D or D/S ratio (S/D or D/S) are shown on 
the Result window. 

 

❚ Pulsatility Index (PI) 

1 Select PI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to manually trace the waveform. 

4 To complete the measurement, press the [Set] key. 

5 The pulsatility index is calculated, and the pulsatility index (PI) is shown on the Result window. 

 
❚ Resistive Index (RI) 

1 Select RI on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. The end point is fixed. 

4 The resistive index is calculated, and the resistivity index (RI) is shown on the Result window. 
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❚ Maximum Time-Average Velocity (TAmax) 

1 Select TAmax on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move the marker to the start point of the waveform, and press the [Set] key. 
The end point appears. 

3 Use [Trackball] to trace the maximum value of the desired portion for the spectrum. 

4 To complete the measurement, press the [Set] key. 

5 The maximum time-average is calculated, and the maximum time-average (TAmax) is shown on 
the Result window. 

 

❚ Acceleration (Accel) 

1 Select Accel on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The oblique line is displayed and the acceleration is calculated. The acceleration (Accel) and the 
acceleration time (AT) are shown on the Result window. 

 

❚ Acceleration Time (AT) 

1 Select AT on the context menu. 
The vertical line and the horizontal line are perpendicular to each other. 

2 Use [Trackball] to move to the point of intersection, and press the [Set] key. 
The start point is fixed, and the end point appears. 

3 Use [Trackball] to move the point, and press the [Set] key again. 

4 The time interval between the two points appears. The acceleration time (AT) is shown on the 
Result window. 
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EM Report 

The EM report has two sections of information: 

• Patient information 

• Measurement information 

To start a report, 

– Press the [Report] key on the control panel. 

– Select Report on the context menu. 
 

For report functions, see "Patient Worksheets (Reports)" on page 8-29. 

 

Patient information 

• ID 

• Name 

• Age 

• Sex 

• Exam date 

• Referring MD 
 

NOTE 

To edit tahe patient information, go to Patient screen. 

 

Measurement information 

• Value: The measured value. If more than one measurement was made for an item, the system 
uses the specified method (average, maximum, minimum, or last) to determine this value. See also 
"Editing a Worksheet" on page 8-32. 

• 1st–5th: The five measurement values for each item are available. If you make more than five 
measurements, the report uses the last five. 

• Method: This specifies the method used to calculate the measurement value listed in the value 
column. The method options are Last, Aver, Max, or Min. 

 

NOTE 

To configure the default method for the measurement value, go to Utility > Setup > SystemPreset > 

Measurement > Labeled MEAS. > Edit > Method. 
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Storing Images and Cine Loops 
The Images and cine loops that are stored during a current exam are displayed as thumbnails on the 
clipboard. 

When an image is stored, all information that is displayed is saved with it (i.e. transducer and application, 
image settings, annotations or measurement results). 

 
 

Storing an Image 

To store an image, 

1 While scanning, press the [Freeze] key on the control panel. 

2 Using [Trackball] to scroll through the cine loop and select the desired image. 

3 Press the [P1] key (or the assigned print key) on the control panel. 
The selected image is stored and a thumbnail is displayed on the clipboard. 

 
 

Storing a Cine Loop 

A cine loop is a sequence of images recorded over a certain time frame. The cine loops can be stored at 
any time during scanning. 

The system can be configured to perform one of the following: 

• Retrospective: The system stores cine for a specified time before you press the [P1] key (or the 
assigned print key). 

• Prospective: The system begins storing cine from when you press the [P1] key (or the assigned print 
key). 

 
To store a cine loop, 

1 Go to Utility > Setup > ImagePreset > General > Cine Loop Store, and define the number of cycles 
or seconds to store. 

• Cine Time Span(no ECG)[s]: Select the number of seconds of cine loop storage. The default is 3 
seconds. 

• Number of heart cycles: Select the number of heart cycles to store. 

• Cine Loop Store: Select to store a cine loop retrospectively or prospectively. (Prospective or 
Retrospective) 

2 When you have finished, click Save & Exit to save the changes and return to scanning. 

3 Perform the scan. 

4 While scanning, press the [P1] key (or the assigned print key) on the control panel. 

5 The last valid cine loop is stored in the archive and a thumbnail with the video icon ( ) is 
displayed on the clipboard. 
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Clipboard 
The clipboard displays thumbnail images of the data acquired in the current exam. 

 
 

Image Clipboard 
 

Figure 10-1 Image Clipboard 
 
 

1 Clipboard indicators 3 Clipboard icons 

2 Image clipboard 
  

 

• The number on the top left corner of the thumbnail image denotes the consecutive order for saving. 

• The video icon on the bottom right side of the thumbnail image denotes the cine loop that is possible 
to post processing. 

• On the top of the clipboard, the clipboard indicators show the total capacity and number of images. 

• To delete the selected thumbnail image, click the trash can icon ( ) on the bottom right. 

• To change the clipboard window layout, click the single layout icon ( ) or dual layout icon ( ) on 
the bottom right. 

 

 

 



10-4 Recording Images 

 

 

  

Saving Images to the Clipboard 

The active images are stored and placed on the clipboard when you press the print key. You can see 
thumbnail images on the clipboard. 

 

NOTE 

The print key is programmable. You can assign the P1, P2, P3 and P4 key functions in Utility > Setup > 

SystemPreset > User Setting > Print/Foot Switch. 
 
 
 

Previewing Clipboard Images 

1 To activate Thumbnail Preview, click the Thumbnail Preview icon ( ) on the bottom right. 

2 Move the cursor over the thumbnail images on the clipboard. The magnified thumbnail image is 
displayed in the screen. 

3 To deactivate Thumbnail Preview, click the Thumbnail Preview icon ( ) again. 

 
 

Recalling Images from the Clipboard 

To recall images from the clipboard, 

1 Press the [Cursor] key to obtain the cursor. 

2 Move the cursor over the image you want to reload by using [Trackball] and press the [Set] key. 

3 Press the [Set] key to reload the selected image on the full screen image. 
You can also double-click a thumbnail image to reload an image. To scroll the page, click the arrow 
mark of the scroll bar to move up and down. 

 
 

Deleting Images from the Clipboard 

To delete an image from the clipboard, 

1 Press the [Cursor] key to obtain the cursor. 

2 Move the cursor over the image you want to delete by using [Trackball] and press the [Set] key. 

3 Click the trash can icon ( ) on the bottom right. 

4 When the confirmation dialog box appears, click Yes to delete the image. 
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Saving Images Permanently 

1 Touch E-View on the touch screen. The images on the clipboard appear expanded. 

2 Use [Trackball] to select an image or multiple images and press the [Set] key. 
To select all images, select Select All. To reverse the current selection, select Select Inverse. 

3 Select Archive on the touch screen to save the image(s). 
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E-View 
The system provides the E-View feature that allows fast and easy image management. The E-View 
feature allows you to view the whole patient from local database or removable media, export/import, 
save as with PC friendly format and send DICOM images to remote server over the network. And it 
allows you to open an already existing patient exam. 

 
CAUTION 
You may lose patient information files such as patient’s basic information and scanned images because of 
physical shocks to the product or internal errors. Therefore, you should back up patient’s basic information  
and scanned images on a regular basis. See "Backup / Restore" on page 5-49 for more information. ALPINION 
MEDICAL SYSTEMS does not have the responsibility for data loss caused by the user’s carelessness. 

 
To activate the E-View feature, 

– Touch E-View on the touch screen. 

 

Figure 10-2 E-View Display 
 
 

1 Menu selection 4 Patient list/Study list 

2 Function selection 5 Image area 

3 Source information 6 Exit 
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Patient Browser 

Patient Browser allows you to search and quick view for patients and studies from the local hard disk 
drive (HDD) or a removable media. 

 

Figure 10-3 Patient Browser Display 
 
 

Figure 10-4 Patient Browser Touch Screen 
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Table 10-1 E-View (Patient Browser) touch screen description 
 

Parameter Description 

 

 
Function selection 

• Backup: Export the exam information. 

• Send To: Send the saved images through the network. 

• Report: Access Worksheet page. 

• Reopen Exam: Reopen an already existing exam. 

Lock/Unlock Lock the patient data or study. Prevent move and delete functions. 

Select All Exams Select all exams. 

Delete Delete the patient data or study. 

Exit Use to exit the E-View screen. 

 
To activate Patient Browser, 

1 Select a source from the Source drop-down list. 

2 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area. 

3 Select the desired patient from the patient list. 

 

Backup 

To move exam(s) between compatible systems or to back up and retrieve, use Backup menu. You can use 
the following types of media for performing data backup: CD, DVD, USB HDD, USB flash drive. 

 

NOTE 

Make sure that your media is appropriate for exporting or importing images. If any problem occurs, eject the 

media and retry the task. 

 
To export from the local HDD to a removable media, 

1 Insert your removable media to the media tray properly. 

2 Select Local HDD from the Source drop-down list. 

3 Select the patient(s) from the patient list. 

4 Select Backup on the touch screen, or select Backup on the function selection. 
The dialog box appears. 

 



E-View 10-9 

 

 

5 Select a media from the Device drop-down list. 

6 If you select USB or USB HDD from the Device drop-down list, you can enter the description such as 
information or comment. 

7 If you select CD/DVD from the Device drop-down list, you can use the following options: 

• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing. 

• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or 
DVD. 

8 Click Yes. The status information is displayed in the Backup Spooler during exporting files. 

 
❚ Backup Spooler 

Backup spooler displays all backups which have been sent or which have been failed. 

To enter the Backup spooler, press Utility > DICOM Spooler the [DICOM Spooler] key on the QWERTY 
keyboard, and then select the Backup tab. You can control or monitor backup jobs. From the Back 
spooler, you can retry, delete, or redirect job. 

 

Figure 10-5 Backup Spooler 
 

To restore from a removable media to the local HDD, 

1 Insert a media that contains patient data. 

2 Select a removable media from the Source drop-down list. 

3 Select the patient(s) from the patient list. 

4 Click Restore. The progress bar appears while importing files. 
 

5 To eject the removable media (for CD or DVD), press the [Eject] key on the QWERTY keyboard or 
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Eject on touch screen. 

 

Send To 

Send To allows you to save images or studies from your PC to a storage media such as CD, DVD, USB flash 
drive, USB hard disk, and network storage. Before saving, make sure that the removable media is placed 
in the right position. 

 

❚ CD/DVD, USB/USB HDD, Network 

1 Select Local HDD from the Source drop-down list. 

2 Select the patient(s) from the patient list. 

3 Insert your removable media to the media tray properly. 
 

NOTE 

To configure the network storage, go to Utility > Setup > SystemPreset > Connectivity > General > 

Network Storage. 

4 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears. 

 

5 Select a storage media type on the left of the dialog box. 

6 Select a media from the Device drop-down list. 
 

NOTE 

If you select USB, USB HDD, or Network Drive from the Device drop-down list, you can add or 

delete folders by using the add folder icon ( ) or delete folder icon ( ). 

7 If you select CD/DVD, USB/USB HDD or Network, you can use the following options: 

• Generate DICOMDIR file: Save the patient data as DICOMDIR file. 

• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing. 

• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD 
or DVD. 

8 The system automatically creates a file name. 
To change the file name, select the Edit File Name check box and enter a file name in the File 
Name field. 



E-View 10-11 

 

 

9 Select an image format in the Type field. 
To save cine images as a video file, skip to step 12. 

 
Table 10-2 Image format 

 

Format Function 

 

DCM 
Save a still image as standard DICOM format. 

It is possible to specify compression type and quality. 

BMP Save a still image as BMP format. 

 

JPEG 
Save a still image as JPEG format. 

It is possible to specify compression type and quality. 

 
NOTE 

To view a DICOM format image on your PC, you need a dedicated DICOM viewer. 

 

10 If you selected DCM in step 9, select a compression type in the Compression field. 

11 If you selected JPEG in step 9, select an image quality in the Quality field. 

12 Select a video file format. 

• 2D Cine: Save 2D cine Images as WMV or AVI format. 

• 4D Volume Cine(*AVI): Save 4D volume cine images as AVI format. 

13 When you have finished, click Save. 

 
❚ PACS 

PACS allows you to transfer patient(s) data to the DICOM device such as DICOM Storage or DICOM 
Print. 

 
To send from the local HDD to a DICOM device, 

1 Select Local HDD from the Source drop-down list. 

2 Select the patient(s) from the patient list. 

3 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears. 
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4 Select PACS on the left of the dialog box. 

5 Select a destination device from the DICOM Server drop-down list. 
 

NOTE 

You can configure the destination device. To configure, go to Utility > Setup > SystemPreset > 

Connectivity > Storage. 

6 Click Send. The progress bar appears during transferring files. 

 
❚ Printer 

1 Select Local HDD from the Source drop-down list. 

2 Select the patient(s) from the patient list. 

3 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears. 

 

4 Select Printer on the left of the dialog box. 

5 Select a standard (default) printer and set up the printing options. 
 

NOTE 

To configure the standard printer, go to Utility > Setup > SystemPreset > System > Peripheral > 

Standard Printer. 

6 When you have finished, click Print. 
The selected printer prints out the selected image(s). 

 

NOTE 

To invert color between images and background, select the Invert Image check box. 
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Report 

Report allows you to access Worksheet page. 

 

Reopen Exam 

Reopen Exam allows you to open an already existing exam. The reopened exam is now the current exam 
and can be closed by touching End Exam on the touch screen. 

 

NOTE 

You cannot reopen exams, which are older than 24 hours. 

 
To open the selected exam, 

1 Select a desired patient from the patient list. 

2 Select Reopen Exam on the touch screen, or select Reopen Exam on the function selection. 
The scan screen appears. 

3 Edit an image and save it. 

4 To end the current exam, touch End Exam on the touch screen. 
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Importing the Data from a DICOM Server (DICOM Q&R) 

Exams, patients and images from a DICOM server can be imported after DICOM Query/Retrieve was 
performed. It is only possible to import complete exams or patients, not single selected images. 

 

NOTE 

• For query/retrieve to find a patient, the patient must have a Patient ID. 

• Before retrieving data from a DICOM server, you need to configure DICOM Q&R settings. To configure 
DICOM Q&R settings, go to Utility > Setup > SystemPreset > Connectivity > DICOM Q&R. 

 

Figure 10-6 DICOM Q/R Screen Display 
 

To retrieve images from a DICOM server, 

1 Touch E-View on the touch screen. 
The Patient Browser page appears. 

2 Select the server from the Source drop-down list. 
The DICOM Q/R page appears. 

3 Enter data in either Patient ID, Patient Name, or Accession Number fields to search. 

4 Specify the exam date in the Exam Date field. 

5 Click Search to perform a search. 
Patient ID, Patient Name, Study UID, Image Cound, Modality, Exam Date, and Exam Time appear on 
the Study List search result. 

6 Select a study on the Study List to search series. 
Series Number, Series UID, Image Count, Modality, and Save Data appear on the Series List search 
result. 

7 Select the series you wish to retrieve, and select Retrieve on the touch screen. 
The progress bar appears during transferring files. 
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Image View 

Image View allows you to view the selected images from list view. You can change the display layout. 
 

Figure 10-7 Image View Display 
 
 

1 Layout selection 4 Delete 

2 Page selection 5 Order Edit 

3 Select All/Select Inverse 6 Exit 

 
 

Figure 10-8 Image View Touch Screen 
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Table 10-3 E-View (Image View) touch screen description 
 

Parameter Description 

 
 
 

Function selection 

• Review: Review an image. The image is shown on the scan screen. 

• Send To: Send the saved images through the network. 

• Report: Access Worksheet page. 

• Reopen Exam: Reopen an already existing exam. 

• E-View Compare: View images side-by-side from two different exams on the 
same patient. 

• X+ Compare: Compare the archived images to a live image. 

Archive Store the image(s) in the local hard disk. 

Select All Select all images. 

Select Inverse Reverse the current selection. 

Delete Delete the selected image(s). 

Order Edit Use to change the order of images. 

Exit Use to exit the E-View screen. 

Hide Banner Use to hide patient banner on acquired data. 

Layout Select a display format from 1X1, 1X2, 2X2, 3X3 and 4X4. 

Image Page Use to move to the next page. 

 
To activate Image View, 

1 Select a source from the Source drop-down list. 

2 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area. 

3 Select the desired patient from the patient list. 

4 Select ImageView on the touch screen, or select ImageView on the menu selection. 
 

 

Review 

To review an image, 

1 Select the desired image. 

2 Select Review on the touch screen. The image is shown on the scan screen. 
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Send To_CubeNote 

CubeNote allows you to send saved images to remote server and review the images through CubeNote 
app in your mobile device. 

 

NOTE 

For using this feature, you need an additional request to your local agent. 

 
To send saved images to CubeNote Control Server, 

1 Select the image(s). 

2 Select Send To on the touch screen, or select Send To on the function selection. 
The dialog box appears. 

 

3 Select CubeNote on the left of the dialog box. 

4 Enter an e-mail address. 

5 You can use the following options: 

• Hide Patient Information: The patient information is removed from the images. 

• Only sent as attachments when sending mail: The selected images can be sent only by e-mail 
attachment. 

6 Click Send. The status information is displayed in the Spooler during transferring files. 
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E-View Compare 
 

Figure 10-9 E-View Compare Display 
 

Figure 10-10 E-View Compare Touch Screen 
 
 

To view images side-by-side from two different studies on the same patient, 

1 Select the patient on the Patient Browser page. 

2 Select ImageView on the touch screen, or select ImageView on the menu selection. 
Image View page appears. 

3 Select E-View Compare on the touch screen, or select E-View Compare on the menu selection. 
The patient's exam lists and images appear on the touch screen. 

4 Select the desired image(s) on the touch screen. 

5 Select the desired comparison image(s) on the touch screen. 
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X+ Compare 
 

Figure 10-11 X+ Compare Display 
 

Figure 10-12 X+ Compare Touch Screen 
 
 

To compare the archived images to a live image, 

1 Select the patient on the Patient Browser page. 

2 Select ImageView on the touch screen, or select ImageView on the menu selection. 
Image View page appears. 

3 Select which specific image you would like to compare to the current image. 

4 Select X+ Compare on the touch screen. 

5 The selected image is shown in the right of the screen, and the live image is shown in the opposite 
side. 

6 Start scan and press the [Freeze] key to freeze the image at the same position to make a comparison. 
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Image History 

Image History allows you to review all previous studies for the selected patient. When you access Image 
History, the study information with the study date and location appears in a table. 

 

Figure 10-13 Image History Display 
 
 

Figure 10-14 Image History Touch Screen 
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To activate and exit Image History, 

1 Insert a media that contains patient data, if necessary. 

2 Select a source from the Source drop-down list. 

3 To search patients by using the searching filter, select a search method from the Search drop-down 
list. Or, you can manually enter a keyword in the search area. 

4 Select a desired patient from the patient list. 

5 Select Image History on the touch screen, or select Image History on the menu selection. 
All of the studies for the selected patient are listed by chronological order. 

6 Select an image in the desired study by using [Trackball]. The blue-colored frame appears on the 
selected image. 
To review multiple images between different studies, select desired images of the studies you want. 
You can select up to four images at one time. 

 

NOTE 

You can compare images by changing the image layout to dual imaging or quad imaging. Press the 

[Dual] key or [Quad] key on the control panel. 

7 Select Review on the touch screen to review the image. 

8 When you have finished, press the [2D] key to return to the scan mode. 

 

Ending a study 

To end a study immediately, 

– Touch End Exam on the touch screen. 

– Press the [End Exam] key on the QWERTY keyboard. 
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DICOM Spooler 
The DICOM spooler displays the current DICOM output jobs. It is used for checking the current job's 
status when a job is saved status. 

 

To start the DICOM spooler, 

– Press the [DICOM Spooler] on the QWERTY keyboard or Utility > DICOMSpooler. 
The DICOM spooler window is displayed. 

 
To exit the DICOM spooler, 

– Click Exit. 

– Press the Exit key on user-defined key. 
 

 

DICOM Spooler Window 
 

Figure 10-15 DICOM Spooler Window 
 
 

The following job status can be displayed on the DICOM spooler window. 

Table 10-4 DICOM job status 
 

Job status Description 

Hold Job process is on hold. 

Pending Job is currently sending and the system is waiting for the server’s response. 

Active Job is in progress. 

Failed Job is failed to send. 

Done Job is sent successfully. 
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NOTE 

When your system is connected to an MPPS* service, the following job status is available: In progress, 

Completed. 

*Modality Performed Procedure Step (MPPS) is a DICOM service that enables you to notify the status 

information of a study to PACS. 
 
 
 

Spooler Options 

On the DICOM spooler window, you can use the following options: 
 

Option Description 

Select All Select all jobs in the DICOM spooler. 

Retry Retry sending the selected job. 

Delete Quit the selected job. 

Suspend Suspend the selected job. 

Refresh Refresh the spooler. The completed jobs are deleted from the spooler. 

Cancel Exit the DICOM spooler. 

 

 
To delete a job, 

1 Select the job(s) to delete in the DICOM spooler window. 
 

NOTE 

Only jobs that failed or are in hold can be resent. 

2 Click Delete. 

 
To resend a job, 

1 Select the job(s) to re-send in the DICOM spooler window. 

2 Click Retry. 

 
To hold a job, 

1 Select the job(s) to hold in the DICOM spooler window. 
 

NOTE 

Only inactive jobs can be set on hold. 

2 Click Suspend. 

3 To undo hold, click Retry. 



10-24 Recording Images 

 

 

Printer 

Connecting to a Printer via USB Connection 

1 When the system power is off, connect a USB cable of the printer to the USB port at the rear of the 
system and turn the printer power on. 

2 Press the [Power On/Off] key on the control panel. 
 

NOTE 

Do not disconnect the USB cable when the system power is on. 

3 If necessary, install the printer driver. 
 

NOTE 

Only recommended printer drivers are installed as default. Refer to your printer manual for installation. 

4 Go to Utility > Setup > SystemPreset > System > Peripheral to set the printer as a default printer. 

5 Select Add Printers... to add a new printer driver via USB serial port. 
 

CAUTION 
When you select select the Cleanup Printer Jobs in Queue When System Bootup check box, all jobs in 
queue will be deleted whenever system reboots. 

6 To assign a printer to one of the print keys, go to Utility > Setup > SystemPreset > User Setting > 
Print/Foot Switch. 

7 Select the appropriate print key (P1, P2, P3, P4). 

8 From the printer list under Standard Printer, select a printer to be assigned on the print key and 
click >> to add the printer device. 

9 Select the printer from the Available Printer list and click >> to move it to the Selected Printer list. 

10 Click Save & Exit to save the changes and return to the scan screen. 

 
 

Setting up the Printer to Print Reports 

To set up the printer to print reports, 

1 Go to Utility > Setup > SystemPreset > System > Peripheral. 

2 If necessary, select Add Printers... to add a new printer driver via USB serial port. 

3 Select the printer from the Default Printer drop-down list. 

4 Click Save & Exit to save the changes. 

5 Press the print key on the control panel to print the report. 
 

NOTE 

The print key is programmable. To assign the print keys for printing the report, go to Utility > Setup > 

SystemPreset > User Setting > Print/Foot Switch. 
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DVR (Digital Video Recorder) 

Setting up the DVR 

To set up the DVR, 

1 Make sure that a DVR is connected to the system when the system power is off. 

2 Set up following parameters in Utility > Setup > SystemPreset > System > Peripheral > VCR. 

• VCR: VCR/DVR, USB storage 

• VCR Format: NTSC or PAL, MPEG or AVI 

• VCR Maximum Time (min.): 1 to 20 (Only available for USB.) 

3 If necessary, assign the DVR function to user-defined key in Utility > Setup > SystemPreset > User 
Setting > User Defined key > Assign User Key or Assign Numeric Key. 

4 If necessary, assign the Rec/Pause function to user-defined key in Utility > Setup > SystemPreset > 
User Setting > Print/Foot Switch. 

5 When you have finished, click Save & Exit to save the changes. 

 
 

DVR Touch Screen and Controls 
 
 
 
 
 
 
 

 

Figure 10-16 DVR Touch Screen 

Table 10-5 DVR controls 
 

Parameter Description 

Prev. Skip to the previous chapter. 

Next Skip to the next chapter. 

Play Play a video from DVD or USB storage device. 

Stop Stop playback or recording. 

Pause Pause recording and playback. 
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Parameter Description 

Record Start recording. 

Search Start the Search. The Search dialog appears. 

Format Delete all the record in the DVD+RW/-RW. 

Finalize Finalize a DVD-R. 

Eject Eject the DVD media/USB storage device. 

 
 
 

Using the DVR 
 

NOTE 

Before recording, make sure that the DVR power is on and the media is played in the tray. 

 
To record an image, 

1 Select Patient on the touch screen. 
The Patient screen appears. 

2 Create a new patient record or or open an existing one. 

3 Insert a DVD media or USB storage device. 

4 Touch Utility on the touch screen. 

5 Touch DVR on the touch screen. 
The DVR menu appears on the touch screen. 

6 Select Record on the touch screen to start recording. 
The DVR status icon ( ) turns light blue. 

7 Select Pause or Record to pause/resume recording. 

8 Select Stop on the touch screen to stop recording. 

9 When you have finished, select Finalize to finalize a DVD-R. 

10 Select Eject on the touch screen to eject. Or press the [Eject] key on the QWERTY keyboard. 

11 Select Exit to return to scanning. 
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DVR Spooler 

The DVR spooler displays the current recording jobs. You can control or monitor recording jobs. From the 
DVR spooler, you can retry, delete, or redirect job. 

 

Figure 10-17 DVR Spooler Window 
 
 

To start the DVR spooler, 

1 Press the [DICOM Spooler] on the QWERTY keyboard or Utility > DICOMSpooler. 
The DICOM spooler window is displayed. 

2 Select the DVR tab. 

 
To exit the DVR spooler, 

– Click Exit. 

– Press the Exit key on user-defined key. 
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This chapter describes the information about diagnostic features of the system. 
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Auto EF Measurements ............................................................................... 11-47 
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X+ Compare 
X+ Compare allows you to perform serial scans on a patient when you can compare the images from a 
patient’s previous exam(s) to the patient’s current exam. 

 
 

X+ Compare Display 
 

Figure 11-1 X+ Compare Display 
 

Figure 11-2 X+ Compare Touch Screen 
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General Workflow 

To compare the archived images to a live image, 

1 Touch X+ Compare on the touch screen. 
The patient's exam lists and images appear on the touch screen. 

2 Select the desired comparison image on the touch screen. 

3 The selected image is shown in the right of the screen, and the live image is shown in the opposite 
side. 

4 Start scan and press the [Freeze] key to freeze the image at the same position to make a comparison. 

5 To save the images, press the [P1] key (or the assigned print key) on the control panel. 
 

NOTE 

To assign the print keys for saving an image or volume data, go to Utility > Setup > SystemPreset > User 
Setting > Print/Foot Switch. 

6 When you have finished, press the [2D] key to exit from Dual Comparison Display mode. 
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X+ Assistant 
X+ Assistant provides an automated exam script that moves you through an exam step-by-step. This 
allows you to focus on performing the exam rather than on controlling the system and can help you to 
increase consistency while reducing keystrokes. 

The system automatically invokes the correct mode and imaging parameters, advances to the next 
step in an exam, annotates the image, initiates measurements, and assigns the measurements to the 
worksheet/report. 

 
 

X+ Assistant Manager 

The X+ Assistant Manager is used to import or export protocols created via the X+ Assistant Editor and to 
add or assign protocols to an exam category. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11-3 X+ Assistant Manager 

Table 11-1 X+ Assistant Manager 
 

Function Description 

 

Exam 
A list of available applications is shown. Selection of ABD, CARD, GYN, MSK, OB, 

PED, SMP, TCD, URO, or VAS is available. 

Protocols Provides a protocol list for the application. 

Create Create a new protocol. 

Move Up ( ) Move the protocol selected from the protocol list up one row. 

Move Down ( ) Move the protocol selected from the protocol list down one row. 

 

Add ( ) 
Create a new protocol on the row below the protocol selected from the protocol 

list. 



X+ Assistant 11-5 

 

 

 

Function Description 

Delete ( ) Delete a protocol selected from the protocol list. 

Summary The title of the protocol, Status, Description 

Next Protocols Select the next protocols performed after complete the selected protocol. 

 

Task List 
Provide a task list which belongs to the protocol selected from the protocol list. 

Edit Edit a protocol. 

Import Import the protocol data. 

Export Export the protocol selected from the protocol list. 

Exit Use to save all changes and exit the X+ Assistant Manager page. 

 

 

Importing the protocol data 

To import the protocol data, 

1 Insert the media with the saved protocols from the X+ Assistant Creator or exported protocols from 
another system. 

2 Touch X+ Assistant on the touch screen. 
The X+ Assistant Manager page appears. 

3 Click Import. The Import dialog box appears. 
 

4 Select the media that the protocol is stored on from the Target Device drop-down list. 

5 Select the protocol folder from the Folder list. 
If a folder is selected, all programs in the folder are displayed in the Protocols field. 

6 Select the protocol(s) to be imported. 

7 If you want to overwrite the existing protocol(s), select the Overwrite Protocol(s) check box. 

8 Click OK. The protocol(s) you selected are stored to the system. 
You can see the protocol(s) on the Protocols list on the X+ Assistant Manager page. 
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Exporting the protocol data 

To export the protocol data, 

1 Insert the media to save the protocol data to. 

2 Touch X+ Assistant on the touch screen. 
The X+ Assistant Manager page appears. 

3 Click Export. The Export dialog box appears. 
 

4 Select the media that the protocol is stored on from the Target Device drop-down list. 

5 Select the Protocol Directory if the desired Protocol Directory already exists on the media. 
If not, or if you want to export the protocol to a new Protocol Directory, click Create New Directory. 
A new protocol directory is created with the name "XAssist_System Date". 

6 Select the protocol(s) to be exported from the Protocols list. 

7 Click OK. The protocol(s) you selected are stored to the media. 
You can export it to another system. 
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X+ Assistant Editor 

The X+ Assistant Editor is used to build customized protocols that can be imported onto the X-CUBE 60. 
These protocols automate many of the steps normally performed manually by the user, thereby reducing 
the number of user actions and the amount of time to perform an exam. 

 
To access the X+ Assistant Editor, 

1 Touch X+ Assistant on the touch screen. The X+ Assistant Manager page appears. 

2 Select Edit on the X+ Assistant Manager page or touch Editor tab on the touch screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11-4 X+ Assistant Editor 

Table 11-2 X+ Assistant Editor 
 

Function Description 

Task List Provide a task list which belongs to the protocol. 

Create Add a task on the last row. 

Move Up ( ) Move a task selected from the task list up one row. 

Move Down ( ) Move a task selected from the task list down one row. 

Add ( ) Add a new task on the row below the task selected from the task list. 

Delete ( ) Delete a task selected from the task list. 

 

Task Parameter 
Provide the task parameters which belong to the protocol selected from the 

protocol list. 

Apply Save changes after add/update task parameters. 

New Add a task on the last row. 

Clone Copy a task selected from the task list. 
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Function Description 

Remove Delete a task selected from the task list. 

Undo Undo the last performed function. 

Task Parameter Provide a parameter which belongs to the protocol selected from the protocol list. 

Return Exit the X+ Assistant Editor page and return to the X+ Assistant Manager page. 

 

 

Creating new protocols 

To create a new protocol, 

1 Click Create under the Protocols field. Or click Add icon ( ). 
The system adds a new protocol with a name such as Protocol #. 

2 Use [Trackball] to move the cursor on the new protocol name, the protocol name is automatically 
highlighted. Type a name for the new protocol. 

3 Add your settings for the protocol: Status, Description, Next Protocols. 

4 When you have finished, click Edit to add tasks. 
The X+ Assistant Editor page appears. 

5 Click Create. The task name is shown on the left and the task parameters appear on the right. 

6 The system adds a new task with a name such as Task #. Type a name for the new task in the Title 
field. 

7 Set task parameters for the task. The task parameters are separated into four groupings: Imaging, 
Comment, Body Pattern, Measurement. 

8 When you have finished, select the task to highlight it. 

9 Click Clone to copy a selected task. 

10 Edit the task parameters for the copied task. 

11 If necessary, click Move Up/Move Down icon ( 
down one row. 

) to move a task selected from the task list up/ 

12 Repeat the same procedure to add more tasks to the protocol. 

13 When you have finished, click Return to exit the X+ Assistant Editor page. 
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Editing protocols 

When editing protocols, you can add, copy, insert, move, delete the tasks. Also, you can modify the task 
parameters for corresponding tasks. 

 

❚ Editing tasks 

You can insert, move up and down, and delete tasks. To move up and down the task, one or more 
consecutive steps must be selected. 

 
To add a new task on the last row of the protocol, 

– Select the last task of the protocol and click the Add icon ( ). 

– Click Create. 

– Click New. 
 

To add a new task on the row below the task selected from the task list, 

– Select the task of the protocol and click the Add icon ( ). 
 

To copy a task of the protocol, 

– Select the task of the protocol and click Clone. 
 

To delete a task of the protocol, 

– Select the task of the protocol and click the Delete icon ( ). 

– Select the task of the protocol and click Remove. 

 
❚ Editing task parameters 

To add/update a parameter to edit task parameters, 

– Select the value from a list. 

– Select or clear a check box. 
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Task parameters 

In the X+ Assistant Editor, the users can program the tasks in an exam and specific parameters for each 
task. All parameter names and descriptions are listed in the following table. 

 
❚ Imaging mode parameter 

 

Parameter Description 

Mode: CF, M, PW, CW, 

PDI, Live Dual, Panoramic, 
CEUS, 3D 

• On: When selected, the mode is on. 

• Off: When not selected, the mode is off. 

 

Dual 

• Default: Dual screen is not in use. 

• Off: Dual screen is off. 

• On: Dual screen is on. 

 

Quad 

• Default: Quad screen is not in use. 

• Off: Quad screen is off. 

• On: Quad screen is on 

 

HAR/INV 

• On: When selected, Harmonic is on. 

• Off: When not selected, the Harmonic is off. 

• Default: Not specified so X+ Assistant does not set this parameter. 

 

Depth(mm) 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Value: 1 cm 

• Max Value: 40 cm 

 

Spatial Compounding 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Index: 0 

• Max Index: 8 

 

Color Baseline 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Index: -100 

• Max Index: 100 

 

Color/PW Steer 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Index: -20 

• Max Index: 20 

 

Simultaneous 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Off: Simultaneous is off. 

• On: Simultaneous is on. 

 

Virtual 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Off: Virtual is off. 

• On: Virtual is on. 

 

Full SRI 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Index: 0 

• Max Index: 10 

 

SV Size 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Value: 0.5 mm 

• Max Value: 11.0 mm 
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PW Baseline 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Min Index: -8 

• Max Index: 8 

 

CEUS Timer 

• Default: Not specified so X+ Assistant does not set this parameter. 

• Off: CEUS Timer is off. 

• On: CEUS Timer is on. 

 

❚ Comment parameter 
 

Parameter Description 

 
 

Location 

Choose where the comment is located on the image area. 

• Left Top 

• Right Top 

• Left Bottom 

• Right Bottom 

 
 

Color 

Select a font color for the comment. 

• White 

• Yellow 

• Green 

• Orange 

 

Size 
Select a font size. 

• Index 1-10 

 
❚ Body Pattern parameter 

 

Parameter Description 

 
 

Location 

Choose where the body pattern graphic is located on the image area. 

• Left Top 

• Right Top 

• Left Bottom 

• Right Bottom 

 

Select 
Used to enable the Body Pattern dialog box so that the Body Pattern graphic can be 
selected and the position of the transducer marker can be set. 

Clear Delete Body Pattern and Location defined for the step. 

Available Items Select the desired body pattern. 

Pictogram The selected body pattern graphic is displayed. 

 

 
Probe Size 

Select the size of transducer marker. 

• Small 

• Medium 

• Large 

Close Use to save the changes and exit the Body Pattern dialog box. 

 

Show a probe protractor 
Select the check box to change the angle of transducer marker. 

The each level of the angle increment/decrement is 45 degrees. 
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❚ Measurement parameter 
 

Parameter Description 

 
 
 
 
 

 
Application 

• Abdominal 

• Breast 

• Cardiac 

• Emergency Medicine 

• Gynecology 

• MSK 

• Obstetrics 

• Pediatrics 

• Small Parts 

• Urology 

• Vascular 

 
 

 
Fetus 

When selected, the fetus measurement qualifier is set to: 

• A: Fetus A 

• B: Fetus B 

• C: Fetus C 

• D: Fetus D 

• Default: Not specified so X+ Assistant does not set this parameter. 

 
 

Side 

When selected, the side measurement qualifier is set to: 

• Rt: Right side of the body 

• Lt: Left side of the body 

• None: Not used (neither Right nor Left) 

• Default: Not specified so X+ Assistant does not set this parameter. 

 

Location 
When selected, the location measurement qualifier is set to: 

• Default: Not specified so X+ Assistant does not set this parameter. 

 

Measurement Items #1-3 
Specify the measurement package to be used for the X+ Assistant. 

(User-defined measurements are not available.) 
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Using X+ Assistant 

After you have set up X+ Assistant, the protocol is active when you exit the Patient screen. The protocol is 
located on the left-hand side of the display and as you can see in the example below, the annotation for 
the first step has been automatically noted on the image, ready for you to scan the specified anatomy. 

 
 

X+ Assistant display discription 
 

Figure 11-5 X+ Assistant Display 
 
 

1 Protocol name 3 Active step 

 

2 
Protocol step status, step number, step 
name 

 

4 
 

Navigation: Stop, Pause, Restart 

 

 

Starting an Exam with X+ Assistant 

To perform an exam with X+ Assistant, 

1 Touch Patient on the touch screen. The Patient screen appears. 

2 Register the patient or the new exam. 

3 Select the X+ Assistant checkbox. 

4 Select the desired protocol from the protocol list. 

5 Select Start Exam on the touch screen to start the exam. 
The scan screen with X+ Assistant protocol appears. 

6 Follow the tasks indicated in the X+ Assistant protocol; acquire images or perform measurements 
and press the [P1] key (or the assigned print key) on the control panel to move to the next task in 
the X+ Assistant protocol. 

7 To pause or unpause X+ Assistant, click Pause at the bottom of the X+ Assistant protocol. 
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8 To stop or restart a protocol, click Stop at the bottom of the X+ Assistant protocol. A Stop Protocol 
dialog box appears. 

 

• Continue Next Protocol: Select the checkbox to perform the exam with the selected protocol 
from the below protocol drop-down list. 

• End Exam: End the current exam immediately and save all images in the local hard disk. 

• Continue: Perform the exam with next protocol. 

• Stop: Stop the exam with the current protocol. 

• Cancel: Restart the exam with the current protocol. 

9 To skip a task or move to a certain task, select the task you want to move to using [Trackball] and 
the [Set] key. 

10 When the protocol is completed, a Stop Protocol dialog box appears. 

11 Click Stop. 
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Panoramic Imaging 
The panoramic imaging feature extends your field of view by piecing together multiple 2D images into a 
single, extended 2D image. For using this feature, you need an additional request to your local agent. 

After you acquire the extended image, you can rotate it, move it linearly, magnify it, add comments or 
body patterns, or perform measurements on the extended image. 

You can perform the panoramic imaging feature on 2D images with linear and convex transducers. 

 
CAUTION 
The panoramic imaging constructs an extended image from individual image frames. The quality of the  
resulting image is user-dependent and requires some additional skill and practice to develop proper 

technique and become fully proficient. To avoid technique-related artifacts and measurement inaccuracies, 
read this entire chapter before using the panoramic imaging feature. 

 
 

Transducer Compatibility 

The panoramic imaging is available on Convex and Linear transducers. The transducers that support the 
panoramic imaging are as follows: 

• Convex: SC1-7H 

• Volume Convex: SVC1-8H 

• Linear: L3-12X, L3-15H, L10-25H, SL3-19X, L3-8H 

 
 

General Workflow 

To perform the panoramic imaging, 

1 Connect the appropriate compatible transducer. 

2 Apply the enough ultrasound gel along the entire area to be scanned. 

3 Place the transducer on the desired scan area. 

4 Obtain a 2D image and optimize the image for the best quality. 

5 Select Panoramic on the touch screen to enter the acquisition preparation status. 

6 Select Start/Stop on the touch screen or press the [Set] key on the control panel to start the image 
acquisition. 

7 Select Start/Stop on the touch screen again or press the [Freeze] key on the control panel to stop 
the image acquisition. 

8 When you completed the image acquisition, you can perform operations such as adjusting image 
parameters or zooming in or out the panoramic image. 

9 Select Exit on the touch screen to exit the panoramic imaging mode and return to 2D mode. 
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Panoramic imaging Display 
 

Figure 11-6 Image Acquisition Preparation Status 
 

Figure 11-7 Panoramic Image Acquisition 
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Panoramic Imaging Controls 
 

Figure 11-8 Panoramic Imaging Touch Screen 
 

The following table describes the panoramic imaging controls. 
 

Parameter Description 

Start/Stop Start or stop the image capture. 

Gray Map Change the gray map. 

Colorize Colorize the 2D image. 

Rotation Rotate the image for the convenience of viewing the image. 

Exit Exit the panoramic imaging mode and return to 2D mode. 
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Acquiring the Panoramic Image 

To create a panoramic image, you need to obtain a 2D image and optimize the image. 

To acquire a panoramic image, 

1 Select Panoramic on the touch screen. 
You can access the Panoramic setup mode, and the blue-colored ROI appears. 

2 Press the [Set] key to start the image acquisition. 

3 Move the transducer linearly along the scan path. 
 

 
NOTE 

To acquire an optimal image, move the transducer slowly and steadily. 

4 If you restart the image acquisition, press the [Set] key again. 
You can access the Panoramic setup mode, and the blue-colored ROI appears. 

5 When you have finished acquiring an image, press the [Freeze] key on the control panel. 
The panoramic image is displayed. 

 
 

 TIPS 

For even movement, 
• Make sure there is enough ultrasound gel along the scan path. 

• Always move the transducer slowly and steadily. 

• Do not lift the transducer from the skin surface during the scan. 

• Always keep the transducer perpendicular to the skin surface. Do not rotate or tilt the transducer during 

the scan. 
• Keep the motion within the same scan plane, if possible. Do not slide the transducer laterally. 
• Deeper scans generally require reduced speed. 
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Viewing the Panoramic Image 

After completing the image acquisition, you can perform the following functions: 

• Image optimization 

• Image zooming 

• Image rotation 

• Measurement 

• Annotation: Comment, Body Pattern 

 

Optimizing the image 

To optimize the image, you can adjust the following parameters: 

• Gray Map 

Rotate the Gray Map soft key to change the gray map of the 2D image. 

 
• Colorize 

Rotate the Colorize soft key to change the color of the 2D image. 
 

Zooming in/out the image 

To zoom in the image, 

– Rotate the [Zoom] key clockwise. And use [Trackball] to change the position of the magnified image. 
 

To zoom out the image, 

– Rotate the [Zoom] key counter-clockwise. 

 

Rotating the image 

To rotate the image, 

– Select < or > of Rotation on the touch screen. 

 

Performing a measurement 

To perform a measurement, 

– Press the [Caliper] key on the control panel. 
 

NOTE 

2D measurement package is available. 
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Annotating the panoramic image 

To annotate the panoramic image, 

1 Press the [Text] key on the control panel to activate the annotation function. 
The comment library appears on the touch screen. 

2 Select the desired comment on the touch screen, or type the desired comment using the QWERTY 
keyboard. 

3 To activate Body Pattern, press the [Body Pattern] key on the control panel. 
A list of body patterns appears on the touch screen. 

4 Select the desired body pattern on the touch screen. 
The body pattern with a transducer marker is shown on the screen. 

 
 

Saving the Panoramic Image 

To save the panoramic image, 

– Press the [P1] key (or the assigned print key) to save the image. 
 

 

Exiting Panoramic Imaging 

To exit the panoramic imaging mode, 

– Select Exit on the touch screen or press the [2D] key on the control panel. 
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Needle Vision™ Plus 
Needle Vision™ Plus uses integrated Beam Steering technology for increased needle visualization with 
maintaining excellent image quality and enhancing the needle brightness. With the needle enhancement 
feature, you can see the needle more easily during clinical procedure. 

 

NOTE 

Needle Vision™ Plus is an optional feature. For using this feature, you need an additional request to your local 

agent. 
 
 
 

Transducer Compatibility 

Needle Vision™ Plus is available on Linear transducers. The transducers that support Needle Vision™ Plus 
are as follows: 

• Linear: L3-8H, L3-12X, L3-15H, SL3-19X, L10-25H 

 
 

Needle Vision™ Plus Display 
 

Figure 11-9 Needle Vision™ Plus Screen 
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Needle Vision™ Plus Controls 
 

Figure 11-10 Needle Vision™ Plus Touch Screen 
 

The following table describes the Needle Vision™ Plus controls. 
 

Parameter Description 

L/R Flip Flip the direction of beam steering horizontally. 

Angle Change the beem angle. 

OFF Exit Needle Visions™ Plus. 

 
 

General Workflow 

To activate Needle Vision™ Plus, 

1 Select NeedleVision on the touch screen. 
 

NOTE 

You can use user-defined key to activate Needle Vision™ Plus. To assign the Needle Vision™ Plus 
function to user-defined key, go to Utility > Setup > SystemPreset > User Setting > User Defined key > 

Assign User Key or Assign Numeric Key and select the Needle Vision™. 

2 If necessary, optimize the image by use the following options: 

• L/R Flip (Left/Right): Select the left or right flip icon on the touch screen to flip the direction of 
beam steering. 

• Angle (Shallow/Medium/Steep): Select the angle icon on the touch screen to change the 
angles. 

3 To exit Needle Visions™ Plus, select OFF on the touch screen. 
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Contrast Enhanced Imaging (CEUS) 
The contrast enhanced ultrasound imaging is used in conjunction with ultrasound contrast agents to 
enhance the imaging of blood flow and microcirculation. Blood containing the contrast agent stands out 
brightly against a dark background of normal tissue. 

With the contrast enhanced ultrasound imaging, you can see the micro-circulation in tissue easily during 
clinical procedure. For using this feature, you need an additional request to your local agent. 

 
WARNING 
Only physicians or echo technicians who have received appropriate training should perform Contrast Imaging. 

 
CAUTION 
• Cavitation may occur due to interactions between the ultrasonic waves and the contrast medium. Always 

perform examination using the ALARA (As Low As Reasonably Achievable) principle. 

• Stop the examination and perform appropriate treatment, if there is any abnormality with the patient 
during use of the contrast medium. 

 
 

NOTE 

• Handle the contrast medium as described in the operation manual supplied with the contrast medium. 

• Check the side effects of the contrast medium used with the manufacturer of the contrast medium. 

• ALPINION MEDICAL SYSTEMS is not liable for any damage or injury resulting from improper use of contrast 
media. 

 
 

Transducer Compatibility 

The contrast enhanced ultrasound imaging is available on Convex transducer. The transducer that 
supports the contrast enhanced ultrasound imaging is as follows: 

• Convex: SC1-7H 
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Abdominal Contrast Imaging 
 

Figure 11-11 Abdominal Contrast Acquisition Display 
 
 

1 2D imaging 4 Timer 

2 Contrast imaging 5 2D image info / Contrast image info 

3 MI and TI information 
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Abdominal Contrast Controls 
 

Figure 11-12 Abdominal Contrast Touch Screen 
 

The touch screen displays various image controls which help you to optimize the Contrast mode image. 
The following table describes available controls on the touch screen. 

 

Parameter Description 

 

Side Control 
Select the desired view on the dual images (contrast image and the reference 
image). 

 
Flash 

Activate to expose the higher acoustic power for a specified time duration by 

pressing a control once. 

Flash is available in live imaging only. 

 
Timer 

Activate to start a clock which is used to record the time of microbubble contrast 
delivery. You can use it at the time of injection. 

Timer is available in live imaging only. 

Output Power Set the output power of the system for Contrast Imaging. 

Flash Frame Adjust the length of the Flash specified in number of frames. 

 
NOTE 

Some image optimizing controls are shared between Contrast and 2D mode. 
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General Workflow 

To perform the contrast imaging, 

1 Select Contrast on the touch screen. 
The contrast image and 2D image are displayed side-by-side. 

2 Adjust the acoustic power experientially to obtain a good image. 

3 Observe the tissue image to find the target view. 

4 Inject the contrast agent, and select Timer on the touch screen to start the timing. 
When the timer begins to work, the time will be displayed on the screen. 

5 Observe the image. 

6 To save the images, press the print key on the control panel. 
 

NOTE 

The print key is programmable. To assign the print keys for saving an image or volume data, go to Utility 

> Setup > SystemPreset > User Setting > Print/Foot Switch. 

7 Perform several live captures if there are more than one sections of interest. 

8 At the end of the contrast imaging, press the [2D] key to exit the contrast imaging. 

9 Perform step 2–8 if necessary. 

 
 

 TIPS 

• Optimize the 2D mode image as usual. Then select Contrast on the touch screen. 

• Administer an amount of contrast agent advised by the contrast agent manufacturer for the targeted 

application. 
• Use a low Output Power to minimize microbubble destruction. 
• Remember to start the Timer when injecting contrast agent. 
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Time Intensity Curve (TIC) Analysis 
Time Intensity Curve (TIC) enables the user to perform the following analysis: 

• Time-Intensity analysis allows instant time-intensity calculation from up to eight regions of interest. 

• Curve fitting analysis for research studies of contrast agent concentration rates. 

 
The basic TIC workflow is as follows: 

1 Scan the patient after injecting the contrast agent. 

2 Observe the agent flow through the anatomy of interest. 

3 When the desired contrast effect has been visualized, press the [Freeze] key to freeze the image. 

4 Select a range of images for analysis. 

5 Use [Trackball] to position an ROI (region of interest) on one of those images where the contrast 
effect is visible, and press the [Set] key. 

6 The system then calculates the mean pixel intensity within that ROI for all frames in the user 
designated loop and plots the resulting data as a function of time. 

7 If necessary, press the print key on the control panel to print TIC data. 
The system captures a single still frame onto the clipboard. 

 
 

Activating TIC 

To activate Time Intensity Curve (TIC), 

1 Scan the patient in Contrast mode or select a desired cine loop from the stored images. 

2 Press the [Freeze] key to freeze the image. 
TIC Analysis displays on the touch screen. 

3 Select TIC Analysis on the touch screen. 
The TIC Analysis screen and the TIC Analysis tab display. 

 
 

Reviewing Contrast Cine Loop 

To review a contrast cine loop, 

1 Open an examination and select a contrast cine loop from the clipboard. 

2 Select TIC Analysis on the touch screen. 

 
 

Exiting TIC Analysis 

There are several methods to exit TIC Analysis. 

– Press the [Freeze] key or [2D] key to return to the scan mode. 

– Select Exit on the touch screen. 
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TIC Analysis Display 
 

Figure 11-13 TIC Analysis display 

 

1 Contrast cine loop window 7 Current frame marker 

2 2D mode cine loop window 8 Sample area drawing tools 

3 Sample area 9 Graph layout selection 

4 Time and velocity at cursor position 10 Cine control tools 

5 Frame marker 11 Trackball controls and status 

6 Analysis window - TIC graph 
  

  

  

 

 

 

  10 

11 
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The following table describes the TIC Analysis display. 

 

Display Description 

 

 
Contrast mode cine loop window 

Display Contrast cine loop with sample area. 

 

 
2D mode cine window 

Display 2D mode cine loop with sample area. 

 

 

Analysis window - TIC graph 

Display TIC graph. 

• X axis: Time(s), elapsed time from previous frame. 

• Y axis: Intensity scale(dB) or linear acoustic(AU). Press the Y Unit 

soft key. 

• Current frame: the current frame marker and the start and stop 

for the cine loop. 

• Display the time-intensity curve of up to eight sample areas. Each 
sample area display has a different color, and its corresponding 
trace data is plotted using that same color. 

• The time-intensity value of the Current frame is displayed at the 

top of the graph. 

 

 

 
Frames 

Disable/Enable the frame. 

• Use the [Trackball] to move the cursor to the frame on the frame 
marker which you want disable. 

• Press the left [Set] to disable the frame. The frame marker is 
changed from green to gray to indicate the frame has been 
disable. 

 

 
Sample area drawing tools 

Sample area drawing tool 

• Ellipse 
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Display Description 

 
 

 

 
Graph layout selection 

Select a graph layout. 

• Graph with Contrast and 2D mode images in vertical format 

• Graph with Contrast image and Small Data Layout 

• Graph with Contrast image and Large Data Layout 

• Everything Layout 

• Graph with Contrast image 

• Graph with Contrast and 2D mode images in horizontal format 

 

 
Cine control tools 

Use cine control tools. 

• Run/Stop: Start/Stop the cine loop review. 

• Move First Frame: Move to the first frame of cine loop. 

• Move Last Frame: Move to the last frame of cine loop. 

 

 
Max Gradient data 

Display the maximum gradient data. 

Max Gradient data is displayed when Small Data layout or 
Everything layout is selected while Curve fitting is off. 

 
 

 
Trackball controls and status 

Trackball controls and status 

• ROI Size: Press the [Priority] key. Move [Trackball] to adjust the 
ROI size. 

• Sample: Press the left [Set] key. Up to 8 sample areas can be set 
for the image. 

• Cine: Press the right [Set] key. Stop the cine run and you can 
move the frame by moving [Trackball]. 
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TIC Analysis Controls 

The following table description the TIC Analysis controls. 
 

Figure 11-14 TIC Analysis touch screen 
 

The following controls are available: 
 

Control Description 

 
 
 
 

 
Sample 

 
Add 

Add sample areas in the Contrast cine loop window and 

accompanying traces in the Analysis window. 

Up to 8 sample areas can be generated. 

 

Default 
Change the sample ROI to default size. 

Move the cursor over the sample ROI and select Default. 

 
 

Delete 

Remove the selected sample area from the Contrast cine 
loop window and accompanying trace in the Analysis 

window. The Trackball marker must be pointed at an 
anchored sample area. 

 
Delete All 

Remove all sample areas from the Contrast cine loop 
window and accompanying traces in the Analysis 
window. 

 

 
Anchor 

 
 

Delete 

 
 

Remove an anchor from a sample area. 

 
 

Delete All 

 
 

Remove all anchors from a sample area. 
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Curve Fit 

 

Off 
Remove the fitted curves from the plot and the fit 

parameters from the display. 

 

Gamma 
Display the gamma curve. 

Used to find and estimate the gamma variate. 

 
Wash In 

DIsplay the Wash In curve. 

Used to find and estimate the local perfusion rate using 

the contrast agent. 

 

Wash Out 
Display the Wash Out curve. 

Used to find and estimate the local wash-out rate. 

 

 
Trace 

 
Hide 

 
Hide the trace. 

 
 

Show All 

 
 

Show all traces. 

 

 

Show Graph 

 

Gradient 

 

Two graphs plot TIC and TIC gradient. 

 

Gradient Derivative 

 

Two graphs plot TIC and TIC gradient derivative. 

 

 

 
Motion Tracking 

Automatically adjust the sample ROI’s placement across 

multiple frames in order to accommodate patient 
breathing or body movements. 

 

 

 
Run/Stop 

 
Start/Stop the cine loop review. 

 

 

 
Show All Frames 

 
Re-enable disabled frames. 

 

 

 
Exit 

 
Exit TIC analysis. 

 

 

 

Select Sample 
Select a sample area. 

The current sample area is changed to white. 

 

 

 

Select Anchor 
Select an anchor. 

The current anchor is changed to white. 

 

 

 

Sweep 
 

Adjust the sweep speed. 

 

 

 

Unit 
 

Select the Y-axis unit. 
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Edit Start Frame 
 

Select the start frame and push to set the frame. 

 

Edit End Frame 
 

Select the end frame and push to set the frame. 

 

 

 

Frame by Frame 
 

Review the cine image frame by frame manually. 
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Generating a Trace 

Up to eight traces can be generated. 
 
 

Sample area 

The sample area can be in three different states: 

• Free sample area: Freely moving sample area before anchoring. 

• Static sample area: The free sample area is anchored by pressing the [Set] key. 

• Dynamic anchored sample area: The sample area is anchored in two or more frames. In these 
particular frames, the sample area is displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the cine loop. 

 

Trace from a pre-defined sample area (Ellipse ROI) 

1 Use [Trackball] to move the cursor to the Contrast cine loop window. 
The cursor is changed to a sample area. A preview of the trace is displayed in the Analysis window. 

2 Press the [Set] key to anchor the sample area. 
In this frame, the sample area is marked with an anchor. If the cine loop has more than one heart 
cycle, a sample area will also be anchored in the corresponding frame in the next heart cycle. 
The trace is updated accordingly in the Analysis window. 

 

Manual tracking of the sample area (dynamic anchored sample area) 

The sample area can be moved within the loop to ensure that data in the trace is generated from the 
same anatomical location during the cyclic motion of the heart. 

1 Place a sample area over a region of interest. Note the anatomical location of the sample area. 

2 Scroll to a new frame using [Trackball]. 

3 Use [Trackball] to move the cursor to the sample area, and press the [Set] key. 
The sample area is unanchored. 

4 Use [Trackball] to drag the sample area to the corresponding anatomical location in the new frame 
and press the [Set] key. 
When the sample area is anchored in more than one frame, linear interpolation is performed so 
that the sample area is smoothly moved between the anchored positions in the selected frames 
when running the cine loop. 

 

NOTE 

In the original frame and this particular frame, the sample area is marked with an anchor. 

5 Use [Trackball] to scroll through the cine loop and control that the sample area follows the moving 
anatomical structure. 

6 If necessary, select Add Sample to add new sample area and repeat the above procedures to add 
anchored sample areas in several frames. 
You can obtain a more accurate displacement of the sample area. 
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❚ Moving a dynamic anchored sample area 

1 Press the [Freeze] key to freeze the image. 

2 Select < or > of Select Anchor to browse through the cine loop to display one of the frames 
where the sample area was anchored. 

 

NOTE 

In these frames, the sample area is marked with an anchor. 

3 Use [Trackball] to move the cursor to the sample area, and press the [Set] key. 
The sample area is unanchored. 

4 Use [Trackball] to drag the sample area to a new location, and press the [Set] key. 
The sample area is anchored to the new location. 

 

Deleting a trace 

The user can delete all traces at once or one at a time. 

To delete a trace from the plot, 

1 Use [Trackball] to move the cursor over the sample area to delete and press the [Set] key. 

2 Select Delete on the touch screen. 

3 If necessary, select Delete All to delete all traces. 
 

NOTE 

The corresponding traces for the deleted sample areas are erased from the plot. 
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Disabling/Enabling the Frame 

Frame disabling excludes the actual frame from the cine loop display. Frame disabling is available only 
with contrast data. 

 
 

Disabling the frame from the frame marker 

To disable one frame from the frame marker, 

1 Use [Trackball] to move the cursor to the frame on the frame marker which you want disable. 

2 Press the [Set] key to disable the frame. 
The frame marker is changed to light grey to indicate the frame has been disabled. 

 

Enabling the frame 

To enable the frames, 

1 Use [Trackball] to move the cursor to the frame on the frame marker which you want enable. 

2 Press the [Set] key to enable the frame. 
The previously disabled frame is re-enabled. 

3 If necessary, select Show All Frames to all disabled frames are re-enabled. 
All previously disabled frames are re-enabled. 

 

Figure 11-15 Frame markers 

 

1 Analysis window 3 Enabled frame 

2 Frame marker axis 4 Disabled frame 
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Trace Measurement 

Gradient 

Gradient is displayed on the screen instead of Intensity (db or AU). The gradient calculates from 7 points 
(includes previous and next frames). 

 

TIC parameters 

Following parameters are automatically calculated and displayed with the graph. 

 

Parameter Description 

A, B, C, k, MSE The coefficients and the mean square error for fitting curve equation. These 

parameters are displayed only on Large Data Layout with curve fitting. 

TtoPK Time to Peak 

Area Area Under the Curve 

Grad Mean Gradient for the peak intensity 

Atm Arrival Time 

 
Max Gradient 

Max Gradient is displayed when Small Data Layout and Everything Layout is selected while Curve fitting is 
off. 

The time and gradient that becomes the maximum gradient between the cine start and end frame are 
displayed. 

 
 

Showing graphs 

To see TIC gradient graph, 

– Select Gradient on the touch screen. 
TIC and TIC gradient are plotted on two graphs respectively. 

• Unit of Y-axis is dB or AU in case of intensity. 

• The unit is d(db)/dt or d(AU)/dt in case of the intensity gradient. 

• Gradient values for the current frame are displayed in the upper right corner of the graph. 
 

To see TIC gradient derivative graph, 

– Select DeGradient on the touch screen. 
TIC and TIC gradient derivative are plotted on two graphs respectively. 

• The Y-axis units is d2(dB)/dt2 or d2(AU)/dts in case of the intensity gradient derivative. 

• Gradient derivative values for the current frame are displayed in the upper right corner of the 
graph. 
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Curve Fit 

To see the fitted curves, 

– Select Off, Wash In or Wash Out on the touch screen. 

• Off: Remove the fitted curves from the plot and the fit parameters from the display. 

• Wash In: Used to find and estimate the local perfusion rate using the contrast agent. 
Y(t) = A(1-exp(-kt)+B 

• Wash Out: Used to find and estimate a local wash-out rate. 
Y(t) = Aexp(-kt)+B 

• Gamma: Used to find and estimate the gamma variate. 

Y(t)=Atcexp(-kt)+B 

 

Parameters of Gamma curve fitting 
 

Figure 11-16 Gamma Curve 
 

• tc: Increasing function (C>0) for “Wash In”. 
For larger C, the intensity increases quickly before the peak. 

• exp(-kt): Decreasing function (k>0) for “Wash Out”. 
For larger k, the intensity decreases quickly after the peak. 

• B: Intercept intensity at t=0. 

• The peak intensity of the curve is affected by all parameters. 
Larger A, larger B, larger C, and smaller k make larger peak. 
The peak time is calculated by C/k. 

• MSE: Mean Square Error 
If the MSE is small, the difference of actual data and the fitted curve is small. 
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Printing TIC Data 

To print TIC data, 

1 Select Run/Stop on the touch screen to freeze the image. 
The still image can be get when cine loop is stopped by selecting Run/Stop on the touch screen. 

2 Press the [P1] key (or the assigned print key) on the control panel. 
The system captures a single still frame onto the clipboard. 
You can see a thumbnail image on the clipboard. 
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Strain Elastography 
Strain Elastography is a non-invasive method in which images demonstrating elasticity characteristics 
of tissue are used to help detect or classify tumors. It shows the spatial distribution of tissue elasticity 
properties in a region of interest by estimating the strain before and after tissue distortion caused by 
external or internal forces. 

Strain Elastography is an optional feature. For using this feature, you need an additional request to your 
local agent. 

 
 

Transducers and Intended Applications 

The transducers and applications that support Strain Elastography are as follows: 
 

Transducer type Transducer Application 

 
 
 
 

Linear 

L3-12X Thyroid, MSK, Breast 

L10-25H Thyroid, MSK, Breast 

L3-15H Thyroid, MSK, Breast 

SL3-19X Thyroid, MSK, Breast 

L3-8H Thyroid, MSK, Breast 

 

 
Endocavity 

EV2-11H OB, GYN, Urology 

EC2-11H OB, GYN, Urology 

VE3-10H OB, GYN, Urology 

 
NOTE 

It might be possible that some transducers or applications are NOT available in some countries. 
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Strain Elastography Display 
 

Figure 11-17 Strain Elastography Display 
 
 

1 2D imaging 4 Quality bar 

2 Strain Elastography imaging 5 Imaging parameters by mode 

3 Color bar 
  

 

 

Color bar 

The color bar indicates the stiffness of the tissue. The bottom of the color bar indicates that the target 
area is stiffer than the surrounding tissues, and the top of the color bar indicates that the target area is 
less stiff than the surrounding tissues. 

Soft Tissue 

 
Soft Tissue 

 
 

Averaging Tissue 
 
 
 

Hard Tissue 
 

Hard Tissue 
 

Figure 11-18 Color Bar 
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Quality bar 

The quality bar indicates the compression quality. The low section of the bar indicates inappropriate 
tissue deformation for a quality elastogram and the upper selection indicates appropriate tissue 
deformation for a quality elastogram. 

 
 

 TIPS 

Elastography requires virtually no external compression for reproducible strain imaging results, but, 
exceptionally manual compression is needed to acquire Elastography images, if you exam a denser nodule. 

 
 
 

Stable state for measurement 
 
 

 

 
Unstable state for measurement 

 
Figure 11-19 Compression Quality Bar 
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Strain Elastography Controls 
 

Figure 11-20 Strain Elastography Touch Screen 
 

The following table describes the Strain Elastography controls. 
 

Parameter Description 

Invert Invert the color bar. 

Persist Change the temporal averaging rate. 

Opacity Adjust the opacity of the Elastography image. 

Color Map Change the type of color map. 

 

Live Dual 
Change the Elastography display layout. 

Adjust the display format of the 2D image and the Elastography image. 
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Performing Strain Elastography 
 

CAUTION 
The results achieved in Elastography mode always depend on the accuracy of the procedure performed. Any 
clinically relevant decisions need to be verified with some other state of the art methods. 

 
To perform Strain Elastography, 

1 Select Elasto on the touch screen. 
The system displays two images on the screen in a live, dual format. The left image is a 2D mode 
image with a region of interest (ROI). The right image is a 2D image with a corresponding ROI 
showing the elastogram. 

 

NOTE 

You can use user-defined key to activate Elastography. To assign the Elastography function to user- 
defined key, go to Utility > Setup > SystemPreset > User Setting > User Defined key > Assign User Key 

or Assign Numeric Key and select Elasto. 

2 Perform the scan. Proper manual compression/decompression is displayed by the colored strain 
map. 

3 Adjust the image parameters to obtain an optimized image. 

• Invert: Select Invert on the touch screen to activate or deactivate the invert. 

• Persist: Rotate the Persist soft key to adjust the persist function. 

• Opacity: Rotate the Opacity soft key to adjust the opacity of the Elastography image. 

• Color Map: Rotate the Color Map soft key to change the type of color map. 

4 When you have finished acquiring an image, press the [Freeze] key on the control panel. 

5 To perform the measurement, press the [Caliper] key on the control panel. 

6 Save the image if necessary. 

7 To exit the Elastography mode, select Exit on the touch screen. 

 
 

Strain Elastography Display Layout 

To change the Elastography display layout, 

– Select Live Dual on the touch screen. The values are On and Off. 

 
❚ Elastography dual layout (Elastography Dual mode) 

The Elastography image and the 2D image are displayed side-by-side on the screen. The 2D image is 
shown on the left and the Elastography image is shown on the right. 

 

❚ Elastography single layout (Elastography Single mode) 

The Elastography image is displayed alone on the screen. 
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Performing a Measurement 

Elasto Size Compare 

Elasto Size Compare applies the measured data in 2D mode to Elastography mode. Size of lesion in 2D 
mode and Elastography mode can be compared to have more accurate diagnose result. 

 

NOTE 

Elasto Size Compare is only available to use on freezing in Elastography mode. 
 

Figure 11-21 Elasto Size Compare Display 
 

1 Press the [Caliper] key on the control panel. 

2 Select Elasto Size Compare on the touch screen. 

3 Use [Trackball] to move the marker to the start point on the 2D image, and press the [Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

5 The copied caliper appears on the Elastography image area. 

6 Use [Trackball] to move the marker of the copied start point to the desired position on the 
Elastography image, and press the [Set] key. 
The copied start point is fixed, and the copied end point appears. 

7 Use [Trackball] to move the marker of the copied end point to the desired position on the 
Elastography image, and press the [Set] key. 

8 The measured value is fixed. The two values and one ratio are shown on the Result window. 
 

NOTE 

Elasto Size Compare is not available through the factory default. To configure the Elasto Size Compare, go to 

Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Elasto Size Compare. 
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Elasto Strain Ratio 

Elasto Strain Ratio provides quantitative information. It is calculated by comparing the strain of a lesion 
to the surrounding normal tissue. Soft tissue will have higher strain values than stiff tissue. It is displayed 
as a real-time color map of the relative elasticity. 

 

NOTE 

Elasto Strain Ratio is only available to use on freezing in Elastography mode. 
 

Figure 11-22 Elasto Strain Ratio Display 
 

1 Press the [Caliper] key on the control panel. 

2 Select Elasto Strain Ratio on the touch screen. 

3 Use [Trackball] to move the marker to the start point on the Elastography image, and press the 
[Set] key. 
The start point is fixed, and the end point appears. 

4 Use [Trackball] to move the marker to the end point, and press the [Set] key. 
The target strain is shown on the Result window. 

5 The copied caliper appears on the Elastography image area. 

6 Use [Trackball] to move the marker of the copied caliper to the reference strain point on the 
Elastography image, and press the [Set] key. 
The reference strain is shown on the Result window. 

7 The measured value is fixed. The strain ratio is shown on the Result window. 
 

NOTE 

Elasto Strain Ratio is not available through the factory default. To configure the Elasto Strain Ratio, go to 

Utility > Setup > SystemPreset > Measurement > Basic MEAS. > Elasto Strain Ratio. 
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Strain bar graph 

The target and reference bars in graph are used to represent the levels of strain values. It is easy to 
compare the strain values of target and reference with the strain bar graph. 

 

Figure 11-23 Elastography Strain Bar Graph 
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Auto EF Measurements 
Auto EF (Automated Ejection Fraction) is a semi-automatic measurement tool used for measurement of 
the global EF (Ejection Fraction). 

Auto EF is an optional feature. For using this feature, you need an additional request to your local agent. 
 
 

Auto EF Result Display 
 

Figure 11-27 Auto EF Result Display 
 
 

 

Performing an Auto EF Measurement 

To measure the Ejection Fraction (EF) automatically, 

1 Connect the ECG device and activate the ECG function to acquire a stable ECG trace. 

2 Acquire 2D cine images of an Apical 4 chamber view and an Apical 2 chamber view by pressing the 
[Freeze] key. 

3 After acquiring the cine images, press the [Measure] key and select Auto EF on the touch screen. 
The Auto EF screen appears. 

4 Select the name of current cadiac view (A4C, A2C) on the touch screen. 
An endocardial border will automatically be traced. 

5 If necessary, select the ECG cycle from the ECG Cycle drop-down list, and select Calc. to start the 
calculation. 
When the processing is completed, the Ejection fraction is automatically calculated again. 
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6 If necessary, select Edit EDV or Edit ESV to edit the endocardial border trace. 
You may adjust the trace by moving the cursor over the endocardial border trace, select an 
anchor point and drag it to a new location. The shape of the endocardial border trace is updated 
accordingly. 

7 When the editing is completed, select Calc. to start the calculation. 

8 The resulting Ejection Fraction (EF), the End Diastolic volume (EDV) and the End Systolic Volume 
(ESV) are displayed in a table on the right. 

 

NOTE 

The Biplane results will only appear on screen after measuring both A2C and A4C views. 

9 To save the result, select Save Result on the touch screen. The results are shown on the Report 
screen. 

10 To exit Auto EF, select Exit on the touch screen. 

 
 

Reviewing EF Results 

The measurement results are summarized in the report. 

To reivew the values of Ejection Fraction, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of Ejection 
Fraction. 

 

Figure 11-28 Auto EF Results in Report 
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Stress Echo 
 
 

WARNING 
Stress Echo data are provided for reference only, not for confirming diagnoses. 

 

The X-CUBE 60 Ultrasound System provides a stress echo package that integrates image acquisition, 
image optimization, review, wall motion scoring and reporting for accurate and efficient stress echo 
examination. 

The stress echo package provides protocol templates for two types of stress echo examination (exercise 
and pharmacological stress). 

In addition to the preset factory protocol templates, you can create or modify templates according to 
your needs. 

To perform this function, you need to proceed the following procedure in serial order: Selection of 
protocol template, Acquisition/Selection, and Review/Scoring. The following table describes how each 
step takes a role: 

 

Procedure Description 

Selection of protocol template Select a protocol template. 

 

Acquisition/Selection 
Acquire a stress image according to the selected protocol template, and select 
stress images to be used for reviewing. 

Review/Scoring Review the previously saved images and assign scores to each cardiac segment. 



Stress Echo 11-51 

 

 

Protocol Editor 

Protocol Editor allows you to create, edit, and delete stress echo protocols. When you create or edit a 
protocol, you can set the number of stage, the number of loops acquired for each view in the stage, and 
the standard views to include. You can define the stage type (continuous or non-continuous) and names 
for protocol/stage/view. 

 
To access Protocol Editor, 

– Click Protocol Editor on the Protocol Selection window. 

– Go to Utility > Setup > SystemPreset > Advanced Cardiac > Protocol Editor. 
 

Figure 11-29 Protocol Editor 
 
 

1 Protocols category 3 Views category (max. 7 views) 

2 Stages category (max. 8 stages) 
  

 

 

Editing an existing protocol 

1 Double-click a stage to edit from the stage list. 

2 Change the stage settings and click OK. 

3 To change the stage or view order, click Up or Down from the Stages or Views category. 

4 To copy the protocol or stage, click Copy from the Protocols or Stages category. 

5 To delete the protocol, stage, or view, click Delete from the corresponding category. 

6 To save the changes, click Save. 

7 When you have finished, click Save & Exit to exit from the Protocol Editor page. 

  

 



11-52 Diagnostic Features 

 

 

Creating a new protocol 

1 On the Protocols category, click Add to create a new protocol and click OK. 
If necessary, change the default protocol name. 

 

2 From the Stages category, click Add to create a new stage and click OK. 
If necessary, edit or select a name for the new stage (Baseline, Pre exercise, Low dose, Peak dose, 
Peak exercise, Post exercise, Recovery). 

3 Set the following stage options: 
 

• Capture mode: Define the type of Capture mode. 

– Continuous: Acquisition runs for a defined time period. During this time, all views in a stage 
are acquired. 

– Prospective: After starting the acquisition, the next loop is acquired for one view in a stage. 

– Retrospective: After starting the acquisition, the last loop is stored for one view in a stage. 

• Clips per view: Define the clip number per each view (1 to 4 clips). 

• Preview: Configure to review and select cine loops before store. 

– After View: Configure to preview and select cine loop after completing image acquisition for 
each view. 

– After Stage: Configure the system to automatically acquire cine loops for one stage of the 
protocol. 

– None: Configure the system to automatically acquire cine loops for all stages of the 
protocol. 

• Kind of Capture length: Define the unit of the capture length (Cycles or Time). If you change 
the unit of the capture length to Time, you can operate the Stress Echo function with ECG 
deactivated. 

• Capture length: Define the capture length (up to 3 cycles and 3000 ms). 

• Capture Delay(ms): Define the capture delay time. 

• Timer Type: Define the timer type (On Entry, On Acquisition, None). 

4 From the Views category, click Add to create a new view and click OK. (A2C, A3C, A4C, PLAX, PSAX, 
SAX-APEX, SAX-BASE) 

5 To save the settings, click Save. 

6 When you have finished, click Save & Exit to exit from the Protocol Editor page. 
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Selecting a protocol template 

1 To acquire Stress Echo loops, activate the ECG function. 

2 On the touch screen, touch Utility and then touch Stress Echo. 
The Protocol Selection window appears. 

 

 
NOTE 

You can use user-defined key to activate Stress Echo. To assign the Stress Echo function to user-defined 
key, go to Utility > Setup > SystemPreset > User Setting > User Defined key > Assign User Key or Assign 
Numeric Key and select the StressEcho. 

3 The Protocol Selection window lists all the available protocols. The default list includes the 
following protocols: 

• Dobutamine Stress 

• Exercise stress 2-Stage 

• Pharm Stress 4-Stage 

4 Select the desired protocol by choosing the protocol name and click OK. 
The real-time imaging screen appears. 
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Image Acquisition 

Images are acquired in a pre-defined order, according to the selected template. 

 

Figure 11-30 Stress Echo Acquisition Display 
 
 

1 Selected protocol 3 Current view 

2 Current stage 4 Currently acquired image 

 

Figure 11-31 Stress Echo Acquisition Touch Screen 
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The following table describes available acquisition menus on the touch screen. 
 

Parameter Description 

StartAcquisition Start image acquisition. 

SkipView Select the next view in the current stage. You can cancel the view. 

SkipStage Select the next stage. You can cancel the stage. 

ROIPosition Adjust the ROI position during acquisition. 

Clock Display the elapsed time from the start of the stress exam. 

 
Starting image acquisition 

1 If necessary, optimize the image by use the following options: 

• Frequency: Adjust the operating frequency of the transducer. 

• DR: Adjust the dynamic range. 

• Line Density: Optimizes 2D-mode frame rate or spatial resolution for the best possible image. 

• Reject: Reduce noise in the image. 

• Power: Control the amount of acoustic power. 

• Gray Map: Adjust the gray map. 

2 To start image acquisition, press the [Freeze] key on the control panel or select StartAcquisition on 
the touch screen. 
The system displays the Protocol window on the left of the screen, listing the stages for the 
selected protocol along with the views of first stage. The system selects the first view for acquisition 
by default, indicating the selected view by placing an arrow mark (  ) to the left of the view name. 

3 Select Accept on the touch screen. Saved views are marked with a green check mark (  ). 

– If the system is configured to preview the cine loop before storing, select Accept to save the 
acquired cine loop for the selected view. 

– If you do not want to store the cine loop, select Reject on the touch screen and perform image 
acquisition again. 

 

NOTE 

If you select After Stage or None on the Stage category of the Protocol Editor, Accept and Reject on the 
touch screen are disabled. 

4 After storing the cine loop, the system automatically highlights the next available view to be 
acquired. 

5 Repeat previous step until all required views are completed. 

6 When image acquisition is completed for all views, select Scoring on the touch screen to perform 
review and scoring. 
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Continuous Capture Mode 

Activating Continuous Capture 

Continuous Capture mode enables the user to perform acquisition continuously for all views at any level 
depending on the selected template configuration. To run Continuous Capture, the user has to select a 
template where this feature is activated. 

1 To start image acquisition, press the [Freeze] key on the control panel or select StartAcquisition on 
the touch screen. Continuous is shown with an arrow mark (  ) and the progress bar appears. 

 

2 To stop capture, press the [Freeze] key on the control panel. 

3 When image acquisition is completed for all views and continuous stages, the system automatically 
stops capture and switches to Continuous Capture Selection screen. 

4 Assign the cine loops to the views. 

a. Use [Trackball] to select the desired view name. 

b. Press the [Set] key. The selected view name is highlighted. 

c. If necessary, rotate the [Select] key to advance to the next group of images in the current view. 

d. Use [Trackball] to select the desired loop to assign it to a particular view. 

e. Press the [Set] key. The frame of the selected image is highlighted. 

f. Repeat previous steps to assign loops to the other views. 

5 Select Scoring on the touch screen to perform review and scoring. 
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Image Selection 

When the image acquisition is completed, Selection screen is displayed automatically, and you can select 
the preferred loop for each view. 

The selected images are used for review and wall motion scoring. 
 

NOTE 

If you want to set clips per view, go to Utility > Setup > SystemPreset > Advanced Cardiac > Protocol Editor > 
select Protocol > double click Stage > set the Clips per view (1–4). 

 

Figure 11-32 Stress Echo Selection Display 
 
 

1 Protocol/Protocol Editor 4 Review 

2 Selected stage/view 5 Image selection controls (Toolbar buttons) 

3 Selected cine loops 
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On the Selection screen, the following toolbar buttons are available: 
 

Icon Name Description 

 

 

 

Enter Acquisition 
 

Go to the Acquisition screen. 

 

 

 
Selection Layout 

Select the image layout. 

(1X1, 2X1,2X2, 3X3, 4X3…) 

 

 

 

Auto layout 
Provide the automatically optimized layout for 

your selected images. 

 

 

 

Show/Hide Overlays 
Show or hide the overlaid window indicating the 

relevant stages or views. 

 

 

 
Sync Mode Selection 

 
Free, Start, Align 

 

 

 
Playback Mode Selection 

 
Loop, Once, Sweep 

 

 

 

R-R Full (Full heartbeat) 
 

Display the complete loop (all loops). 

 

 

 

Systole 
 

Display the systole segment only (all loops). 

 

 

 

Diastole 
 

Display the diastole segment only (all loops). 

 

 

 

Speed of loop playback 
 

Change the speed of loop playback. 

 

  

 

Toggle Play 
Play back the loops when enabled. When 
disabled, display one frame for each loop. 

 

 

 

Start of sequence 
 

Display the first frame of each loop. 

 

 

 

Step backward 
 

Display the previous frame of each loop. 

 

 

 

Step forward 
 

Display the next frame of each loop. 

 

 

 

End of sequence 
 

Display the last frame of each loop. 
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Figure 11-33 Stress Echo Selection Touch Screen 
 

The following table describes available selection menus on the touch screen. 
 

Parameter Description 

Acquisition Go to the Acquisition screen. You can acquire images until one stage is completed. 

 

Accept 
Save the acquired cine loop for the selected view. The selected view is marked with 

a green-colored check mark. 

 

Reject 
Cancel to save the acquired cine loop and return to the scanning. The selected 
view is marked with a red-colored arrow mark. 

 

 
Selecting preferred cine loops 

To select the preferred loops to assign to the stress protocol views, 

1 On the Selection screen, use [Trackball] to select the desired view name. 

2 Press the [Set] key. The selected view name is highlighted. 

3 Rotate the [Select] key to display the next group of images in the current view. 

4 Use [Trackball] to select the desired loop to assign it to a particular view of the stress template. 

5 Press the [Set] key. The frame of the selected image is highlighted. 

6 Repeat steps 1–5 to assign loops to the other views. 

7 When image selection is completed, select Scoring on the touch screen to perform review and 
scoring. 
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Review and Scoring (Wall Motion Scoring) 

Review/Wall motion scoring (WMS) consist of viewing previously saved loops and assigning scores to 
each cardiac segment, in order to quantify the function of the muscle or wall segment. 

The quad screen is the standard display for comparing heart cycles. 
 

Figure 11-34 Stress Echo Review Display 
 

Figure 11-35 Stress Echo Review Touch Screen 
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On the Review screen, the following icons are available: 
 

Icon Name Description 

 

 

 

Score point 

 
Indicate the each segment’s wall- 
motion score by color 

 

 

 

All Visible Loops Normal 
Assign a normal wall motion score to all 

currently displayed views. 

 

 

 

Selected Loop Normal 
Assign a normal wall motion score to 

the selected view. 

 

 
Reset All Visible Loops 

Normal 

Reset a normal wall motion score to all 

currently displayed loops. 

 

 
Reset Selected Loop 

Normal 

Reset a normal wall motion score to 

the currently selected view. 

 

 

 

Reset All View 
 

Reset wall motion scores to all views. 

 

 

 

Bull’s Eye 
 

View the LV motion scoring diagram. 

 
With scoring the wall motions, you can review and compare images between stages and views. 

1 Select Review on the left bottom of the screen. The Review screen appears. 

2 In Review mode, use the following options: 

• Sort by Stage: Sort images by stage. Select the gray check box next to each required stage. 

• Sort by View: Sort images by each image view. Select the gray check box next to each required 
view. 

• Compare: Compare between the images. Select the gray check box next to each required stage 
or view. 

 

NOTE 

Shuffle mode is available. The system displays all loops that represent the selected stage or view. 

3 Perform review and scoring the wall motion. 

4 When you have finished, select End Protocol on the touch screen. The Save window appears. 

5 To save the result, select Yes. The selected loops and their wall-motion scores are saved. 

6 To delete the result, select Cancel. All of the current results are deleted. 
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Scoring a LV wall motion 

Left Ventricle Wall motion scoring (WMS) represents the score results as the Left Ventricle images. 
Abnormal motions are scored by colorizing the segments in the symbol. 

1 Select a score point. 
 

Score Degree of abnormality of wall motion Color 

-1 Hyperkinesis Gray 

0 Not evaluated Colorless 

1 Normal Green 

1.5 Mild Hypokinesis Blue-green 

2 Moderate Hypokinesis Yellow 

2.5 Severe Hypokinesis Lemon 

3 Akinesis Blue 

3s Akinesis with Scar Purple 

4 Dyskinesis Red 

4s Dyskinesis with Scar Scarlet 

5 Aneurysm Pink 

2 Use [Trackball] to move the cursor to a segment in one of the scoring diagrams and press the [Set] 
key. 

3 The scored motion is colored and displayed in the relevant segment area in the diagram. 

4 To score the relevant segments, repeat steps 1–3. 
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WMS report 

In addition to the standard information included in the WMS report, you can include or exclude data to a 
specific stage. The WMS graphics of the each view on the report indicate the each segment’s wall-motion 
score by color or degree of shading. 

 

Figure 11-36 WMS Report 
 

To activate the WMS report, 

1 Select End Protocol to exit Stress Echo and save the current results. 

2 Touch Report on the touch screen. The Report screen appears. 

3 Select WMS Report on the context menu. 

 
To enter comments on the WMS report, 

1 Select Comment on the touch screen. The Comment screen appears. 

2 Enter comments in the Comments field. 

3 When you have finished entering comments, select Preview on the context menu to preview 
comments. You can see comments in the Comments field. 

 
To preview and print the WMS report, 

1 From the Report screen, select Preview on the context menu. 

2 Preview the report for the currently selected mode. 

3 To print the report, select Print on the touch screen. 
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Reviewing a stored Stress Echo 
 

Figure 11-37 Reviewing Stress Echo via E-view 
 

To review a stored Stress Echo, 

1 Touch E-View on the touch screen. 

2 To review the Stress Echo, select the image. 
The selected image is highlighted. 

 

NOTE 

The Stress Echo exam displays as a single image with a stress echo icon placed on the image. 

3 Select Review on the touch screen. 

 
 

Image Compression 

Stress Echo supports a four-level image compression. (High, Medium, Low, Uncompressed). 
 

Figure 11-38 Image Compression 
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Cube Strain™ 
Cube Strain™ is an optional cardiac application that provides advanced motion and velocity information 
of the myocardial tissue. On a basis of 2D speckle tracking technology, the angle independent analysis of 
this function allows you to assess accurate strain and calculate strain rate of the myocardium, especially 
for fetal heart. With the enhanced graphic display, you can easily and quickly identify wall motion 
change. 

 
 

Acquiring Images and Activating Cube Strain 

1 Connect the ECG device and make sure to obtain a stable ECG trace. 

2 Acquire 2D mode cine loops of cardiac view. 
 

3 If necessary, optimize the image by using imaging optimization controls. 

4 Adjust the width and depth to increase the frame rate. 
The frame rate should be more than 60 frames per second. A higher frame rate is recommended for 
high heart rate. 

5 To activate Cube Strain, select Cube Strain on the touch screen. 
The View selection window appears. 

 

NOTE 

You can use user-defined key to activate Cube Strain. To assign the Cube Strain function to user-defined 
key, go to go to Utility > Setup > SystemPreset > User Setting > User Defined key > Assign User Key or 
Assign Numeric Key and select the Cube Strain™. 
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Selecting an Image 
 

Figure 11-39 View Selection Window 
 
 

1 Clipboard (Thumbnails) 3 View selection menu 

2 Preview 4 Next icon 

 

1 Select the desired cine image from the clipboard. 
The selected cine images is displayed in the Preview field. 

2 Select the corresponding view on the view selection menu to assign to the selected cine image. 
You can choose one to three clips simultaneously according to your analysis group. 

 

3 Click the Next icon ( ). The Sequence/M mode selection window appears. 

4 Define the position of the R wave. 
If the study has ECG data, the system automatically detects cardiac cycle, heart rate, and R wave 
position. 

5 Click the Next icon ( ). The Contour window appears. 
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Contouring and Starting Analysis 
 

Figure 11-40 Contouring at ES Frame 
 
 

1 Place landmarks at the endocardium in the end-systolic(ES) frame by using [Trackball], and press 
the [Set/Cur] key. 

– Anterior annulus: Press the right [Set/Cur] key. 

– Posterior annulus: Press the right [Set/Cur] key. 

– Apex: Press the left [Set/Cur] key. 

2 Click the Start Analysis icon ( ) to start the analysis. The end-diastolic(ED) frame appears. 

3 If necessary, adjust the contour select. 

– To edit the trace for the end systole, click the Correct ES Border icon ( ). The new tracking 
will be initiated. 

– To edit the trace for the end diastole, click the Correct ED Border icon ( ). The contour of end 
systolic(ES) remains untouched. 

4 If necessary, editing the contour by drag and drop the red points. 

5 When tracing and editing contour are completed, click the Next icon ( ) to start calculation 
processes. 

6 The Analysis window appears. A comprehensive array of data is displayed on the screen. 
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Cube Strain Analysis Window 
 

Figure 11-41 Cube Strain Analysis Window 
 
 

1 Selected image(loop) 5 Volume gragh 

2 3D contour 6 Bull’s eye diagram 

3 EF & Strain resulting gragh 7 Tool selection (Icons) 

4 Longitudinal strain values 8 Image clipboard 
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The following table describes the optional icons that you can use for the Cube strain™ function. 
 

Icon Name Description 

 

 

Sequence/M mode 

selection 

 
Open the Sequence/M mode selection screen. 

 

 

 
Start Analysis 

 
Start the velocity strain analysis. 

 

 

 
New Trace 

 
Start a new contour tracing. 

 

 

 
Correct ES Border 

 
Edit trace for the end systole. 

 

 

 
Correct ED Border 

 
Edit trace for the end diastole. 

 

 

 

Go To End Systole 
 

Move the frame to "End Systole" on the 2D mode display. 

 

 

 
Go To End Diastole 

 
Move the frame to "End Diastole" on the 2D mode display. 

 

 

Toggle contour/vector/ 
orbit line/2D mode 

 

Select the icon until the display shows the desired function. 

 

 

 
Segmental Analysis 

 
Go to Segmental Analysis page. 

 

 

 

Zoom in/Out 
 

Zoom in or out the 2D mode display. 

 

 

 

Pictures Mirroring 
 

Mirroring the 2D mode display. 

 

 

 
Image Select View 

 
Return to Image Select View. 

 

 

 
Delete Selected Contour 

 
Delete the selected contour. 
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Exporting the Result 

You can save the data to an external file. 

To export the result, 

1 Insert your removable media to the media tray properly. 

2 Select Data Storage on the touch screen. The dialog box appears. 
 

3 Select the desired media from the Device drop-down list. 

4 If you select CD/DVD from the Device drop-down list, you can use the following options: 

• Verification after CD burning: Verify your patient data in a CD or DVD after burning the CD or 
DVD. 

• Finalization of CD/DVD: Finalize the CD or DVD to prevent from further writing. 

5 Select the data format. 

• Text data file: Eexport to a text file. 

• Secondary capture file: Creates a screen capture of the entire screen. 

• Avi file: Save the cine loop in AVI format 

6 When you have finished, click Save. 

 
 

Ending an Exam 

1 When you have finished, select Exit on the touch screen. 
The Save window appears. 

2 To save the results, click Yes. 
The scan screen appears and you can see thumbnail images on the clipboard. 

 
 

Reviewing an Exam 

To review a stored Cube Strain image, 

1 Touch E-View on the touch screen. 

2 Select the desired image. 
The selected image is highlighted. 

3 Select Review on the touch screen. 



Electrocardiograph (ECG) 11-71 

 

 

Electrocardiograph (ECG) 
ECG is an optional function that provides physiological trace by obtaining ECG signals. While scanning a 
cardiac image in M or Doppler mode, you can view the systolic and diastolic point on the ECG line of the 
display. This helps you study an image and perform a measurement correctly. 

 
 

ECG Cable 

The optional ECG cable consists of two different cables: One end is for the system cable, the other end is 
for the electrode cable. The electrode cable has a three-pronged electrode connector for connecting to 
your patient’s body. 

There are two types of electrode cables. Depending on your country, the colors and names defined on 
each cable connector may be different: 

 

 
Table 11-3 ECG Color Code on Electrodes 

 

Standard IEC(I) type 
European standard 

AHA(A) type 
American standard 

 
Position of the human body 

surface 
Electrode Mark Color Code Electrode Mark Color Code 

L Yellow LA Black Left arm 

R Red RA White Right arm 

F Green LL Red Left leg 

N Black RL Green Right leg 
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ECG Trace Display 

The scanned image is synchronized with the ECG trace. 
 

Figure 11-42 ECG Trace Display 
 
 

1 Current view 3 ECG trace 

2 Respiratory trace 4 Auto Heart Rate display 
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ECG/Respiration Optimization Controls 

In ECG/Respiration mode, you can use the controls on the touch screen. 
 

Figure 11-43 ECG/Respiration Mode Touch Screen 
 
 

The following controls are available: 
 

Control Description 

ECG Lead Select the desired lead. 

Source Select the source of the waveform. You can adjust the amplitude or position of the 
selected waveform by using the soft keys. 

Time Trig. Set to show a frozen image each time you specified in Delay Time. 

If this option is activated, ECG Trig. is automatically set to none. 

ECG Trig. Select an active ECG trigger. You can activate both two triggers at the same time. 

ECG Display Hide or display the ECG and/or Respiratory trace. 

ECG Invert Invert the current ECG trace. 

Sweep Speed Change the speed of the ECG trace. 

Delay Time Set the time delay of the ECG trigger. 

Trig. Period Set the cycle number of the ECG trigger. 

Heart Cycles Select the number of heart cycles to store. 

ECG Gain Adjust the amplitude of the ECG/Respiratory trace. 

ECG Pos Adjust the vertical position of the ECG/Respiratory trace. 
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Setting the Applications for ECG Display 

To set the application(s) to show or hide the ECG on the screen, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the ImagePreset tab on the touch screen. 
The Image Preset screen appears. 

4 Select Application on the touch screen. 

5 Select the desired application check boxes under ECG Display configuration. 

6 When you have finished, click Save & Exit to save the changes and return to scanning. 

 
 

Activating ECG and/or Respiratory Trace 

To activate ECG and/or respiratory trace(s), 

1 Connect the ECG cable into the ECG port. 

2 Hook up 3 stick-on electrodes (disposable) to each connector of the electrode cable until they click 
into place. 

3 Attach the each connector of the electrode cable to the corresponding body parts. 

4 Touch the ECG tab on the touch screen. 

5 Adjust the ECG and/or respiratory tace(s). 
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Auto NT Measurements 
Auto NT allows you to automatically measure the nuchal translucency thickness. 

 
 

Auto NT Display 
 

Figure 11-44 Auto NT Display 
 
 

 

Auto NT Controls 
 

Figure 11-45 Auto NT Touch Screen 
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The following controls are available: 
 

Parameter Description 

Caliper Switch the caliper options between Auto NT and Manual. 
Manual NT is same as one distance (1 Distance) measurement. 

NT Position Select the fetal position (Face Up or Face Down). 

Method Select the NT calculation algorithm. 

• In-In: Measure between inner border and inner border. 

• In-Mid: Measure between inner border and middle border. 

 
 

Performing an Auto NT Measurement 
 

NOTE 

Automatic Nuchal Translucency is not available through the factory default. To configure the Auto NT, go to 
Utility > Setup > SystemPreset > Measurement > Labeled MEAS. > OB1 or OB2/3 > 2D > select Auto NT and 
click Add. 

 
To measure the thickness of the nuchal translucency (NT) of the fetus automatically, 

1 Acquire the magnified mid-sagittal view of the fetus by pressing the [Freeze] key on the control 
panel. 

2 Press the [Measure] key on the control panel. 

3 Select Auto NT on the touch screen. 
The start point appears. 

 

NOTE 

According to the fetal position, you can select Face Up or Face Down by rotating the NT Position soft 

key. 

4 Use [Trackball] to move the marker to the start point, and then press the [Set] key to fix the marker. 
The second point appears. 

5 Use [Trackball] to move the marker at the diagonal edge of the NT ROI to the end point, and then 
press the [Set] key. 
The nuchal translucency diameter (NT) is shown on the Result window. 

6 To complete the measurement, press the [Set] key. 
The measured value is fixed and summarized in the report. 

 

NOTE 

After the automatic measurement is completed, you can make one distance measurement manually, if 

necessary, to cross check the result. 
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Reviewing NT Results 

The measurement results are summarized in the report. 

To reivew the values of NT thinkness, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of NT 
thickness. 

 

NOTE 

The Auto NT value is shown with an apostrophe mark (') on the Report screen. 

 

Figure 11-46 NT Results in Report 
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X+ Auto Biometry 
X+ Auto Biometry allows you to automatically detect the Biparietal Diameter (BPD), Head Circumference 
(HC), Abdominal Circumference (AC), Femur Length (FL), and Hemerus Length (Humerus) by tracing the 
borders of specified OB measurements. The system measures the BPD, HC, AC, FL, and Humerus, which 
need to be confirm by the user or can be edited manually if necessary. 

 
 

X+ Auto Biometry Display 
 

Figure 11-47 X+ Auto Biometry Display 
 
 

 

Preparing to use X+ Auto Biometry 

To set up X+ Auto Biometry, 

1 Touch Utility on the touch screen. 

2 Touch Setup on the touch screen. 

3 Touch the SystemPreset tab on the touch screen. 
The System Preset screen appears. 

4 Select Measurement on the touch screen. 

5 Select OB Meas. on the touch screen. 

6 Select the desired fetal biometry parameter check boxes under X+ Auto Biometry configuration. 

7 When you have finished, click Save & Exit to save the changes and return to scanning. 
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Performing X+ Auto Biometry 

To measure the fetal biometry automatically, 

1 Select the Fetal Biometry folder on the touch screen. 

2 Select the desired measurement (e.g. BPD, HC, AC, FL or Humerus). 
The trace is generated automatically on the display, and the calculation process starts. 

3 The measured value is fixed, and the result is shown on the Result window. 
If the result is not correct, rotate the Mode soft key to select Manual, and then proceed with 
manual measurement. 

4 To complete the measurement, press the [Set] key. 
The measured value is fixed and summarized in the report. 

 

NOTE 

If the system was not able to detect the anatomy automatically, the following message appears in the 
message area: "No valid Auto measurement was found. Please proceed with manual measurement." 

 
 
 

Reviewing Fetal Biometry Results 

The measurement results are summarized in the report. 

To reivew the values of fetal biometry, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of fetal 
biometry. 
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X+ Auto Follicle 
X+ Auto Follicle helps to detect follicles in an ovary and analyze follicular number and size. 

 
 

X+ Auto Follicle Display 
 

Figure 11-48 X+ Auto Follicle Display 
 

 

Performing X+ Auto Follicle 

To perform an Auto Follicle measurement, 

1 Acquire 2D images of ovary follicles by pressing the [Freeze] key. 
 

NOTE 

Make sure the image quality is sufficient in order to detect the follicles within the ovary. 

2 After acquiring the ovary follicle image, press the [Measure] key and select Rt (right) or Lt (left). 

3 Press the X+Auto Follicle soft key. 

4 The follicles that are detected from the image are traced automatically. 

5 Select the follicle that is valid by Set key. 
Only selected follicle is color-coded and numbered, and the volume of selected follicles are shown 
on the screen. 

6 To save the result, select Report on the touch screen. 
Save message box "Do you want to save data? (If there is existing data, it may be overwritten)" 
appears. 

7 Select Yes to save the result. 
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Reviewing Follicle Measurement Results 

The measurement results are summarized in the report. 

To reivew the values of the follicle volume, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of the 
follicle volume. 

Figure 11-49 Follicle Results in Report 
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Auto IMT Measurements 
Auto IMT allows you to automatically measure the intima-media thickness of the wall in the carotid 
artery. When you place the start and end points in a line, the system shows the mean, max, standard 
deviation and quality index. The IMT measurement should be done on 2D mode images, not on Color 
mode images. 

 

NOTE 

The IMT measurement is available with linear transducers only. 

 
For optimal recognition and results, it is recommended to follow the conditions below: 

• Acquire a central plane through the vessel 

• Frequency range between 7 MHz and 12 MHz 

• Imaging depth between 30 mm and 45 mm 

• Optimize the gain control 

• Minimize artifacts in the lumen of the vessel 

 
 

Auto IMT Display 
 

Figure 11-50 Auto IMT Display 
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Performing an IMT Measurement 

To measure the IMT automatically, 

1 Acquire a longitudinal view of the carotid artery by pressing the [Freeze] key on the control panel. 

2 Press the [Measure] key on the control panel. 

3 Select Auto IMT on the touch screen. The start point appears. 

4 From the point of the arterial branch about 5 mm away, draw a straight line of 10 mm by using 
[Trackball]. The end point appears. 

5 Use [Trackball] to move the marker to the end point, and press the [Set] key. 

6 The system calculates the measured value and shows the Mean (Mean), Max (Max), Distance (D), 
and Quality Index (QI) on the Result window. 

7 Touch Report on the touch screen. The Report screen appears and you can view more 
measurement information including standard deviation. 

 

NOTE 

The Auto IMT values are shown with an apostrophe mark (') on the worksheet. 

 
To measure the IMT manually, 

– Select Manual by rotating the Caliper soft key, and make one distance measurement. 
 

NOTE 

After the automatic measurement is completed, you can make one distance measurement manually, if 

necessary, to cross check the result. 
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Reviewing IMT Results 

The measurement results are summarized in the report. 

To reivew the values of intima-media thickness, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of IMT 
thickness. 

 

NOTE 

The Auto IMT value is shown with an apostrophe mark (') on the worksheet. 

 

Figure 11-51 IMT Results in Report 
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IMT Analysis 

To start the IMT anaysis, 

– While viewing the vascular report, select IMT Analysis on the touch screen. 
 

NOTE 

The patient specific contents input on the IMT Analysis page are returned to the factory default settings after 
starting a new patient. 

 

Figure 11-52 IMT Analysis Graph (AXA IMT) 
 
 

To analyze an IMT measurement, 

1 Select IMT Analysis on the touch screen. 
The IMT Analysis page displays. 

2 Select the desired analysis graph (PARC IMT, AXA IMT, Framingham Score, Risk factore). 

3 Set the measurement options by using the soft key. 

• IMT Measurement: CCA IMT, ICA IMT, Bulb IMT 

• Side: Rt, Lt 

• Location: Prox, Mid, Dist, Off 
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X+ Auto IVC 
Automated inferior vena cava (IVC) measurements provide parameters for assessing fluid responsiveness 
in shock patients. The Collapsibility Index (CI) represents the collapsibility of the inferior vena cava and is 
calculated by the ratio between the maximal and minimal diameters of the IVC. The Distensibility Index 
(DI) represents the distensibility of the IVC in the artificialy ventilated patient. 

X+ Auto IVC is an optional feature. For using this feature, you need an additional request to your local 
agent. 

 
 

Auto IVC Display 
 

 

Figure 11-53 Auto IVC Display 

 

1 Anatomical M-Mode cursor 3 IVC border trace 

2 Calculation Time Interval (CTI) zone 4 Dmax and Dmin within CTI 
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Auto IVC Controls 
 
 

 

 

 

Figure 11-54 Auto IVC Touch Screen 
 

The following controls are available: 
 

Parameter Description 

EditROI Edit the position of the cursor line. 

Analyze/Pause Start/Stop measuring the IVC. 

Add Report Save the measurement result. You can see the results in the worksheet. 

Run/Stop Start/Stop the cine loop review. 

Exit Exit Auto IVC. 

Cine Range Specify time to store cine. 

Cycle(s) Adjust the time intervals for displaying CTI markers. 

Sweep Change the speed at which the timeline is swept. 

Type Select the patient's type (Spontanuous or Mechanical). 

Edit Start Frame Define new beginning point of a cine loop. 



11-88 Diagnostic Features 

 

 

Performing an Auto IVC Measurement 

To measure the Inferior Vena Cava (IVC) automatically, 

1 Connect the appropriate Auto IVC-compatible transducer. 

2 Select Transducer on the touch screen. 
The dialog box for transducer and application selection appears. 

3 Select the desired transducer, application and preset on the touch screen. 

4 Click Exit to complete the transducer selection. 

5 On the control panel, press the [2D] key to activate 2D mode. 

6 Scan the patient in the subcostal position to view the IVC on the 2D-mode screen. 

7 Acquire a IVC view by pressing the [Freeze] key on the control panel. 

8 Select AutoIVC on the touch screen. The Auto IVC screen appears. 

• The system displays 2D mode along with the M-mode timeline. 

• The cursor line appears over the IVC. 

• The cross-section of the IVC is traced along the M-mode timeline. 

• CTI markers appear as red /blue vertical lines at 4.0 sec. intervals. 

9 If the patient is ventilated, select Mechanical by rotating the Type soft key. 
The measurement is switched from CI to DI. 

• Spontenuous: For patients with spontaneous breathing. 

• Mechanical: For patients with mechanical ventilation. 

10 View the cursor line appearing and stabilizing automatically on the IVC. If the cursor line has not 
been positioned correctly, select EditROI and move the cursor line to the desired position by using 
[Trackball]. 

11 If necessary, adjust the angle of the cursor line by rotating the [Angle] key on the control panel. 

12 If necessary, adjust the sweep speed and cycles by using each soft key. 

13 Select Analyze/Pause to start measuring the IVC. 

14 The system highlights the selected CTI on the M-mode timeline and display the maximum diameter 
measured frame in the 2D-mode screen. The results of the measurements appear in the result box, 
on the left upper side of the screen. 

15 To save the result, select Add Report on the touch screen. The results are shown on the Report 
screen. 

 

NOTE 

After the automatic measurement is completed, you need to approve the measurement by visual 
inspection before storing the results into the worksheet database. 

16 To exit Auto IVC, select Exit on the touch screen. 
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Reviewing IVC Results 

The measurement results are summarized in the report. 

To reivew the values of Inferior Vena Cava, 

– Touch Report on the touch screen. The Report screen appears and you can see the values of Inferior 
Vena Cava. 
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12 
Transducer and Biopsy 

 
 
 

 

This chapter describes the transducer overview and biopsy preparations. 
 
 

Transducer ..................................................................................................... 12-2 

Biopsy ............................................................................................................ 12-7 

Transducer Accessories ............................................................................... 12-17 
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Transducer 
The ultrasound system uses transducers to obtain graphic data of the human body and then displays it 
on the screen. Always use application-specific transducers in order to obtain the best quality images. It is 
also important to use a preset that is best suited to the particular organ being scanned. 

 

Transducer Components 
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Figure 12-1 Transducer Components 

 

No. Component No. Component 

1 Connector electrical contacts 5 Transducer strain relief 

2 Connector housing 6 Transducer handle 

3 Connector strain relief 7 Transducer lens 

4 Transducer cable 8 Transducer neck 
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Compatible Transducers 

The following transducers are compatible with the X-CUBE 60 ultrasound system: 
 

NOTE 

• The user manual refers to transducers that can be connected to the system. It might be possible that some 
transducers or applications are NOT available in certain countries. 

• Some biopsy guides may not be available in certain countries. 

 
Table 12-1 Transducer application and features 

 

Transducer Type Application Additional Features 

 

 
L3-12X 

 
 
 

Linear 

MSK, Vascular, Small Parts, 

Breast, EM 

• L3-12X Biopsy Starter Kit 

• Multi-angle 

• Panoramic Imaging 

• Needle Vision™ Plus 

• Strain Elastography 

 

 
L3-8H 

 
 
 

Linear 

EM, Vascular, Breast • L3-12 Biopsy Starter Kit 

• Multi-angle 

• Panoramic Imaging 

• Needle Vision™ Plus 

• Strain Elastography 

 

 
L3-15H 

 
 

Linear 

Breast, MSK, EM, Vascular, 

Small parts 

• L3-12 Biopsy Starter Kit 

• Multi-angle 

• Panoramic Imaging 

• Needle Vision™ Plus 

• Strain Elastography 

 

 

SC1-7H 

 
 

 
Convex 

Abdomen, GYN, OB, 
Urology, MSK, EM 

• SC1-6 Biopsy Starter Kit 

• Multi-angle 

• Panoramic Imaging 

• Contrast Enhanced Imaging (CEUS) 

 

 

SC2-11H 

 
 

 
Convex 

Abdomen, EM 
 

 

 

P1-5CT 

 
 

Sector 
Phased 

Abdomen, Cardiology, EM, 

TCD 

• Stress Echo 

• Cube Strain™ 
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Transducer Type Application Additional Features 

 

 
EC2-11H 

 
 
 

Endocavity 

GYN, OB, Urology, EM • EV2-11H Reusable BiopsyStarter Kit 
(May not be available in all countries.) 

• Strain Elastography 

 

 
EV2-11H 

 
 

Endocavity 

GYN, OB, Urology, EM • EV2-11H Reusable BiopsyStarter Kit 
(May not be available in all countries.) 

• Strain Elastography 

 

 

SVC1-8H 

 
 

Volume 

Convex 

Abdomen, GYN, OB, EM • 3D/4D imaging 

• Panoramic Imaging 

 

 
VE3-10H 

 

 
Volume 

Endocavity 

GYN, OB, Urology, EM • VE3-10H Disposable Biopsy Starter Kit 

• VE3-10H Reusable Biopsy Starter Kit 

• 3D/4D imaging 

• Strain Elastography 

 

 
SL3-19X 

 
 
 

Linear 

MSK, Vascular, Small Parts, 

Breast, EM 

• L3-12X Biopsy Starter Kit 

• Multi-angle 

• Panoramic Imaging 

• Needle Vision™ Plus 

• Strain Elastography 

 

 

L10-25H 

 
 
 

Linear 

MSK, Vascular, Small Parts, 

EM 

• Panoramic Imaging 

• Needle Vision™ Plus 

• Strain Elastography 

 

 

CW2.0 

 
 

Pencil 
Doppler 

Cardiology 
 

 

 
 

CW5.0 

 
 

Pencil 
Doppler 

Cardiology 
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Transducer Type Application Additional Features 

 

 
 

CW8.0 

 
 

Pencil 
Doppler 

Cardiology 
 

 
CAUTION 

Transducers for transvaginal and transrectal applications require special handling. Transvaginal or transrectal 

examinations and transducer insertions should be performed only by personnel with adequate training. 
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Transducer- specific Features 

Table 12-1 Transducer features 
 

Feature 

 
Model 

 
Harmonics 

(THI) 

Speckle 
Reduction 

Imaging 
(SRI) 

 
Multi- 

beam 

 
 

Biopsy 

 
 

4D 

 
Easy 

3D 

 
Virtual 

Convex 

 
Spatial 

Compounding 

L3-12X o o o o x x o o 

L3-15H o o o o x x o o 

L3-8H o o o o x x o o 

SC1-7H o o o o x x x o 

SC2-11H o o o x x x x o 

P1-5CT o o o x x x x x 

EV2-11H o o o o x x x o 

EC2-11H o o o o x x x o 

SVC1-8H o o o x o o x o 

VE3-10H o o o o o o x o 

SL3-19X o o o o x x o o 

L10-25H o o o x x x o o 

CW2.0 x x x x x x x x 

CW5.0 x x x x x x x x 

CW8.0 x x x x x x x x 
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Biopsy 
A biopsy is a medical procedure that obtains a tissue sample of a very specific area of the body for 
diagnostic testing. The transducer and the biopsy kit are used together when conducting a biopsy with 
the ultrasound system. 

Using ultrasound for needle placement assures accuracy of the cell retrieval by verifying the exact site of 
biopsy and minimizes the risk to the patient. 

 
 

Biopsy Kit Components 

The biopsy kit components vary depending on the transducer type. The components are as following: 
 

 

Figure 12-2 Biopsy Starter Kit 

 

No. Component No. Component 

1 Needle guide bracket 4 Sheath 

2 Needle guide & Needle barrel 5 Rubber band 

3 Gel 
  

 
NOTE 

The biopsy starter kit can be purchased from ALPINION MEDICAL SYSTEMS. 
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Precautions Concerning the Use of Biopsy Procedure 
 

WARNING 
Do not freeze the image during a biopsy procedure. The image must be live to avoid a positioning error. 

Biopsy guidezones are intended to assist the user in determining optimal transducer placement and 
approximate the needle path. However, actual needle movement is likely to deviate from the guideline. 
Always monitor the relative positions of the biopsy needle and the subject mass during the procedure. 

 

 
WARNING 
Biopsy procedures should not be used for In vitro fertilization (IVF), Chronic villus sampling (CVS), and 
Percutaneous umbilical blood sampling (PUBS). 

 

 
CAUTION 
The use of biopsy devices and accessories that have not been evaluated for use with this equipment may not 
be compatible and could result in injury. 

 

 
CAUTION 
The invasive nature of biopsy procedures requires proper preparation and technique to control infection and 
disease transmission. Equipment must be cleaned as appropriate for the procedure prior to use. 

• Follow the transducer cleaning and disinfection procedures and precautions to properly prepare the 

transducer. 
• Follow the manufacturer's instructions for the cleaning of biopsy devices and accessories. 

• Use protective barriers such as gloves and transducer sheaths. 

• After use, follow proper procedures for decontamination, cleaning, and waste disposal. 

Failure to follow these instructions could lead to exposure to infectious agents. 

 

 
CAUTION 
Improper cleaning methods and the use of certain cleaning and disinfecting agents may cause damage to the 
plastic components that will degrade imaging performance or increase the risk of electric shock. For details, 
"Transducer Safety" on page 2-11. 

 

 
CAUTION 
A biopsy must only be performed by physicians with adequate experiences under all circumstances the 
necessary safety precautions and sterility measures have to be respected. 
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The Biopsy Guidezone Display 
 

WARNING 
• Do not freeze the image during a biopsy procedure. The image must be live to avoid a positioning error. 

• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. It is 
the user's responsibility to verify correct positioning of the needle during a biopsy procedure. 

 
The biopsy guidezone represents a path of the needle. Colored markers in each dotted guideline show 
the actual increments in the area of the anatomy. 

• Yellow marker is represented by 1 cm increment of the needle depth. 

• Blue marker is represented by 5 cm increment of the needle depth. 
 

NOTE 

When Enable 0.5cm markers in Image Preset is selected, each yellow maker represents 0.5 increment. 
 

The display should be carefully monitored during a biopsy for any needle deviation from the center line 
and the guidezone. The biopsy guidezone appears along with image adjustments such as image invert, 
rotation, zoom, and depth change. 

 

Figure 12-3 Biopsy Guidezone 
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Preparing the Biopsy Guide Attachment 

The each transducer (convex, sector, and linear transducers) has the optional biopsy guide attachment. 
The guide consists of a non-disposable bracket to attach to the transducer, disposable needle clip to 
attach to the bracket, sheath, coupling gel, and disposable needle guide. 

The disposable needle guides are available for a variety of needle sizes. 

The bracket is packed non-sterile and is reusable. To avoid possible patient contamination, ensure 
bracket is properly cleaned, disinfected, or sterilized before each use. 

The disposable components are packed sterile and are single-use only. Do not use if expiration date has 
passed. 

 

NOTE 

Please refer to the manufacturer's instructions included in the biopsy kit. 
 
 
 

Assembling the Multi-angle Biopsy Guide 
 

WARNING 
DO NOT attempt to use the biopsy bracket and needle guide until the manufacturer's instructions, provided 
with the biopsy bracket and needle guide in the kit, have been read and thoroughly understood. 

 
NOTE 

For detailed information on a biopsy guide, please contact the manufacturer(CIVCO) of the biopsy guide. 
 

1 Scan the patient and identify the target for biopsy. Move the transducer to locate the target to the 
center of the image. Enable the system biopsy guidezone and try guidezone angles 1 to 3 to decide 
the best angle setting for the needle path. 

2 Prepare the appropriate biopsy guide bracket by matching the transducer label on the bracket with 
the transducer to be used. 

3 Orient the guide bracket toward the orientation mark of the transducer, and then attach the 
bracket by sliding it over the end of the transducer until it clicks in place. 

Convex transducer Linear transducer 
 

 

NOTE 

Depending on the transducer you are using, attaching the guide bracket may be different. Refer to the 
manufacturer’s instruction included in the biopsy kit. 
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4 Pull up the knob to release to move the needle guide attachment. Align the knob with a desired 
angle position (angle 1, 2, or 3) and push the knob down to secure the angle position. 

 

 
CAUTION 
Hold the bracket in place on the transducer when pushing the knob to secure the angle position of the 
needle guide attachment. Excessive force may cause the bracket to release from the transducer. 

5 Place the ultrasound gel inside a sanitary sheath. 
 

6 Cover the transducer and biopsy bracket with the sanitary sheath. Use the rubber bands to tighten 
the sheath. 

 

7 Snap the needle guide onto the biopsy guide bracket. 
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8 Push the locking mechanism towards the bracket to secure the lock. Make sure that the needle 
guide is firmly attached to the bracket. 

 

9 Select a desired size of the needle barrel from the plastic tree. Twist the needle barrel back and 
forth to remove it. 

 

10 Place the needle barrel into the needle guide until it clicks into place. 
 

 
CAUTION 
Before performing a biopsy, ensure that all guide parts are seated properly. 
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Assembling the Single-angle Biopsy Guide 
 

WARNING 
DO NOT attempt to use the needle guide until the manufacturer's instructions, provided with the needle 
guide in the kit, have been read and thoroughly understood. 

 
NOTE 

For detailed information on a biopsy guide, please contact the manufacturer(Aspen Surgical Products, Inc.) of 

the biopsy guide. 

 

Reusable biopsy guide (Metal) 

1 Place the ultrasound gel inside the sheath and/or on the transducer scanning surface. 
Place the transducer sheath over the transducer and secure the sheath with bands. 

 
 
 

 

2 Place the needle guide (styles vary) onto the transducer as shown. 

 

 

3 Make sure the needle guide is securely attached to the transducer. 
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4 Place the second sheath over the transducer and needle guide. Secure the sheath with bands. 

 

 
Disposable biopsy guide (Plastic) 

1 Place the ultrasound gel inside the sheath and/or on the transducer scanning surface. 
Place the transducer sheath over the transducer and secure the sheath with bands. 

 
 
 

 

2 Place the needle guide onto the transducer and snap into position. 
Make sure the needle guide is securely attached to the transducer. 

 

 

3 Place the second sheath over the transducer and needle guide. Secure the sheath with bands. 
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Verifying the Biopsy Needle Path 
 

WARNING 
• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. It is 

the user's responsibility to verify correct positioning of the needle during a biopsy procedure. 

• The path of the needle must display within the guideline. Do not use a needle guide if the path of the 
needle is not accurately displayed by the on-screen guidelines. 

 
Before performing any patient procedure using a biopsy guide, you must verify that the path of the 
needle is accurately displayed by the on-screen guidelines. 

1 Attach the biopsy guide to the transducer. 

2 Set the system to the depth of the intended puncture procedure. 

3 Immerse the head of the transducer into the water and insert the needle into the needle guide. 

4 Verify that the path of the needle displays according to the guidelines shown on the screen. 

5 If the needle image is out of the guideline, check the needle guide or the needle guide bracket. 

 
 

Performing the Biopsy Procedure 
 

WARNING 
• Biopsy procedure must be performed on a live image to avoid positioning error. 
• Before starting a biopsy, make sure that all patient information is entered and the study is saved. 

 
CAUTION 
• The biopsy guidelines that display on the system monitor are not intended as an absolute reference. 

It is the user's responsibility to verify correct positioning of the needle during an out-of-plane biopsy 

procedure. 

• When performing an out-of-plane biopsy, i.e. without a biopsy guide, it is the user's responsibility to 
use appropriate equipment. Ensure that the needle (especially the needle tip) is always visible in the 
ultrasound image during the whole biopsy procedure. 

• Always only use basic modes when performing an out-of-plane biopsy. 

 
When the biopsy guide assembly is completed, perform the following biopsy procedure. 

1 Scan an image. When you find a target image, place the target in the middle of the guidezone. 
 

NOTE 

Enabling Color Flow mode would allow for visualization of vascular structure around the area to take a 

biopsy. 

2 When the target image is prepared, press the Biopsy key once, twice, or three times on 
touchscreen that corresponds to the selected angle. The biopsy guidezone appears on the display. 

– Press the key once for angle 1. 

– Press the key twice for angle 2. 

– Press the key three times for angle 3. 
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CAUTION 

Ensure that the selected angle on the biopsy guide corresponds to the selected guide line of the 
guidezone. 

3 Place the needle in the guide line between the needle barrel and the needle guide. Direct it into 
the area of interest. 

 
CAUTION 
Always use a straight, new and sterile needle for each biopsy procedure. 

 
NOTE 

To configure the biopsy guidezone settings, press the [Image Preset] key and go to General. 
 
 
 

Releasing the Needle 

After performing a biopsy, release the needle from a transducer and an assembly by following the 
procedure. 

 

1 Push the knob portion of the sleeve in the direction of the arrow ①. 
The needle is released from the assembly. 

2 Push the transducer and assembly in the direction of the arrow ② to remove the needle. 
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Transducer Accessories 

Transducer Sheath 

Transducer sheaths help to prevent contamination from blood or body fluids during the examination, 
operation, or biopsy. Sheaths should be used for clinical application that may indicate the need for such 
care, and during endocavity scanning; during biopsy or puncture procedures; or when scanning patients 
with open wounds. 

 
WARNING 
• Always keep sheaths in a sterile state. 

• Sheaths are disposable. Do not reuse them. 

• If sheaths are torn or soiled after use, clean and disinfect the transducer. 
• Some sheaths contain natural rubber latex and talc, which can cause allergic reactions in some individuals. 

 
CAUTION 
• Make sure that you do not use an expired sheath. 
• Using pre-lubricated condoms as a sheath might damage the transducer. 

 
Applying the sheath 

 
 

WARNING 
After placing the sheath over the transducer, visually inspect the sheath to ensure there are no defects. 
Do not use the sheath if it has any holes or tears. 

1 Remove the packaging and unfold the transducer sheath. 

2 Before applying any ultrasound gel to the sheath, remove any powder in the sheath by rinsing with 
water. 

3 Apply a water-based ultrasound gel to the inside of the sheath and onto the face of the transducer. 

4 Hold the transducer by the cable relief and unroll the sheath onto the transducer. 
If necessary, cover the transducer cable as well. 

5 Pull the transducer sheath tightly over the face of the transducer to remove wrinkles. 

6 Secure the sheath to the transducer housing or cable relief with the adhesive tapes or elastic bands 
provided. 
If necessary, secure the sheath to the transducer and the transducer cable. 

 

Disposing the sheath 

While wearing protective gloves, remove the transducer sheath from the transducer and dispose of it 
according to medical regulations for biohazardous waste. 
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Ultrasound Gel 

The ultrasound gel helps to transfer the sound waves into the body during the examination. 

Using appropriate ultrasound gels may cause damage to the transducer. To prevent transducer damage, 
only use ultrasound gels approved or recommended by ALPINION. Refer to Resource on website (http:// 
www.alpinion.com) for the latest list of compatible ultraound gels. 

 
WARNING 
• Do not use mineral oil, lubricant oil, oil-based lotions, or other non-approved materials, as they may cause 

damage to the transducer. Using damaged or defective transducer could cause electric shock in users or  
patients. 

• Do not use ultrasound gels that contain the following contents: 
– Oils such as mineral oil, cooking oil, gasoline, solvents, rust inhibitors, lanolin, paraffin-based grease, 

ester and excessive silicon-based release agent 

– Alcohols such as acetone, methanol, plasticizer (dioctylphtalate) or denatured alcohols 

– Glacial acetic acid and iodine 
– All types of lotions or gels that contain aromatic substances 
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This chapter describes the followings: 
 
 

System Care and Maintenance ...................................................................... 13-2 

Battery Care and Maintenance ..................................................................... 13-6 

Transducer Care and Maintenance ............................................................... 13-8 
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System Care and Maintenance 
It is the responsibility of the user to verify that the ultrasound system is safe for diagnostic operation on 
a daily basis. Each day, prior to using the system, perform each of the steps in the daily checklist. 

All exterior parts of the system, including the control panel, keyboard, and transducers, should be 
cleaned and/or disinfected as necessary or between uses. Clean each component to remove any surface 
particles. Disinfect components to kill vegetative organisms and viruses. 

The air filter on the ultrasound system must be cleaned regularly to maintain proper system cooling. 
Remove and check the air filter weekly, and clean as needed. 

 
CAUTION 
• The system does not contain any operator serviceable internal components. Ensure that unauthorized 

personnel do not tamper with the unit. 

• When defects or malfunctions occur, do not operate the system until the problems are resolved. Contact 
your local service representative. 

 
 

Expected Service Life Description 

The expected service life for the X-CUBE 60 system and transducers is identified in this table: 
 

Equipment / Accessory Expected Service Life 

 
X-CUBE 60 system 

The expected service life for the X-CUBE 60 system is at least seven 

(7) years from the manufacturing date under the provision of regular 
maintenance by authorized service personnel. 

 
 

X-CUBE 60 transducers 

The expected service life for the X-CUBE 60 transducers meets or 
exceeds five (5) years from the date the transducer is placed in service, 

under the provision that the customer follows the care instructions 
provided on the X-CUBE 60 User Manual. 
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Daily Checklist 

Perform the following each day before using the ultrasound system: 

• Visually inspect all transducers. Do not use a transducer which has a cracked, punctured, or 
discolored casing or frayed cable. 

• Visually inspect all power cords. Do not turn on the power if a cord is frayed or split, or shows signs 
of wear. If your system’s power cord is frayed or split, or shows signs of wear, contact your ALPINION 
service representative for power cord replacement. 

• Visually inspect that the trackball and other controls on the control panel to make sure that they are 
clean and free from gel or other contaminants. 

• Visually inspect the ECG connector and cables. Do not use the ECG connector and cables if they are 
damaged. 

 

WARNING 
To avoid electrical shock, you must visually inspect the transducer prior to use. Do not use the transducer that 
has a cracked, punctured, or discolored casing or a frayed cable. 

 
 

Monthly Checklist 

To inspect the system, examine the following on a monthly basis. 

• Connectors on cables for any mechanical defects 

• Entire length of electrical and power cables for cuts or abrasions 

• Control panel and keyboard for defects 

• Casters for proper locking operation 
 

NOTE 

To maintain the safety and functionality of the ultrasound system, maintenance must be performed every 
12 months. Electrical safety tests must also be performed at regular intervals as specified by local safety  
regulations. Refer to the service manual for the electrical leakage test. 

 
WARNING 
When the LED lamp needs to be replaced, contact the ALPINION service representative. 

 
CAUTION 
To avoid electrical shock hazard, do not remove panels or covers from the console. This service must be 
performed by qualified service personnel. Failure to do so could cause a serious injury. 

 
 
 

Weekly Maintenance 

The system requires weekly care and maintenance to function safely and properly. Clean the following: 

• Monitor 

• Control panel 

• Footswitch 

Failure to perform required maintenance may result in unnecessary service calls. 
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Cleaning the System 

Prior to cleaning any part of the system: 

– Turn off the system power. If possible, disconnect the power cord. 

 

Cleaning the surface of the ultrasound system 
 
 

CAUTION 
Do not spray any liquid directly into the unit when cleaning the system. 

1 Use a clean gauze pad or lint-free cloth, lightly moistened with a mild detergent, to wipe the surface 
of the ultrasound system. Take particular care to clean the areas near the trackball and the slide 
controls. Ensure these areas are free of gel and any other visible residue. 
Ensure that cleaning solution does not seep into the control panel, keyboard, or any other 
openings. 

2 After cleaning, use a clean, lint-free cloth to dry the surface. 

3 After cleaning, reconnect the power cord of the system into the power outlet. 

 

Cleaning the liners of the transducer holders 

1 Use the tab to remove the liner from the transducer holder. 

2 Clean the liner under the running water, using a mild detergent and dry with a lint-free cloth. 

3 Reinsert the liner into the transducer holder. 

 

Cleaning the trackball 
 
 

CAUTION 
Do not drop or place foreign objects inside the trackball assembly. This may affect the trackball’s operation 
and damage the system. Avoid other solvents that may damage the mechanical parts of the trackball 

assembly. 

1 Remove the front panel bezel by rotating the bezel counter-clockwise. 

2 Remove the trackball and the teflon ring. 

3 Clean the trackball and the teflon ring with tissue and isopropyl alcohol. 

4 Clean the inside of the trackball assembly with a cotton swab and isopropyl alcohol. 

5 Allow the assembly parts to completely dry before the reassembly. 

6 Replace the trackball and front panel bezel. 
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Cleaning the monitor face 

Use a soft, folded cloth and a glass cleaner solution. Apply the glass cleaner to the cloth. Gently wipe the 
monitor face. 

Do NOT use a glass cleaner that has a hydrocarbon base (such as Benzene, Methyl Alcohol or Methyl 
Ethyl Ketone) on monitors with the filter (anti-glare shield). Prolonged use of such cleaners will damage 
the filter (anti-glare shield). Hard rubbing will also damage the filter. 

 
CAUTION 
When cleaning the monitor, make sure not to scratch the monitor. 

 
Removing and cleaning the air filter 

The air filter on the ultrasound system must be cleaned regularly to maintain the proper system cooling. 
Remove and check the air filter weekly, and clean as needed. 

 
CAUTION 
Do not scrub, stretch, or bend the filter, or apply heat to the filter, as doing so could damage the filter. 

1 Power off and unplug the power cord from the power outlet. 

2 Grasp the air filter and pull it out of the system. 

3 Rinse the air filter with running water and allow the filter to completely dry. To hasten drying, you 
may gently shake the filter, or blot the filter with a clean, lint-free cloth. 

4 Reinsert the filter into the ultrasound system. 

5 Plug the power cord into the power outlet. 
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Battery Care and Maintenance 
The battery is a consumable item. The battery will gradually lose its capacity for charging after repeated 
use and after time has passed. Alpinion Medical Systems recommends that you replace the battery once 
in one year or after 500 recharging cycles, whichever comes first. 

 

NOTE 

• For the replacement or disposal of the battery, contact an authorized agent or an ALPINION MEDICAL 

service engineer. 

• The warranty period for the battery is six months. 

 

 

Recharging the Battery 

Connecting AC power automatically begins charging the battery. To charge the battery faster, please 
power off the system. 

 
CAUTION 
Do not recharge the battery using a non-recommended method, as this may cause an explosion or a fire. 

 
The battery that are not used for several weeks at a time should be recharged at regular intervals. 
Alpinion Medical Systems recommends that you recharge the battery every 1 or 2 months even without 
use. 

 
The battery must be charged and discharged within the following temperature ranges: 

 

State Ambient Temperature 

Charging 0 – 45 °C 

Discharging -10 – 60 °C 

 
 

Storing the Battery 

The battery must be stored within the following temperature ranges: 
 

Period Temperature 

Less than 1 month 0 – 60 °C 

1 – 3 months 0 – 45 °C 

4 – 12 months 0 – 23 °C 
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Disposing of the Battery 

This system uses lithium ion batteries. Used battery must be discarded as chemical waste. An authorized 
agent or an ALPINION MEDICAL service engineer must replace and dispose of the battery. 

 
WARNING 
Do not incinerate the battery, as this may cause an explosion or a fire. 
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Transducer Care and Maintenance 
It is the responsibility of the user to verify that the transducer is safe for diagnostic operation. After each 
use, inspect the transducer's lens, cable, and casing. Look for any damage that would allow liquid to 
enter the transducer. If any damage is found, do not use the transducer until it has been inspected and 
repaired/replaced by ALPINION Service Representative. 

 
WARNING 
Always place a sterile, non-pyrogenic transducer sheath on a transducer used in procedures requiring sterility. 

 

 
WARNING 
There have been reports of severe allergic reactions to medical devices containing latex (natural robber).  
Health care professionals are advised to identify latex-sensitive patients and to be prepared to treat allergic 
reactions promptly. 

 

 
WARNING 
During neurosurgical procedures, if a transducer becomes contaminated with tissue or fluids of a patient 
known to have Creutzfeld-Jacob disease, the transducer should be destroyed, as it cannot be sterilized. 

 

 
WARNING 
When using an endocavity transducer with a CF type applied part, the patient leakage currents may be 
additive. Prior to each use, the leakage current test must be done. 

 

 
WARNING 
To avoid electrical shock and damage to the system, disconnect the transducer prior to cleaning or 
disinfecting. 

 

 
WARNING 
The list of disinfectants and cleaning methods are recommended by ALPINION for the compatibility with  
product materials, not for the biological effectiveness. Refer to disinfectant label instructions for the guidance 
on disinfection efficacy and appropriate clinical uses. 

 

 
CAUTION 
Transducers are sensitive instruments – irreparable damage may occur if they are dropped, knocked against 
other objects, cut, or punctured. Do not attempt to repair to alter any part of a transducer. 

 

 
CAUTION 
To avoid cable damage, do not roll the system over transducer cables. 

 

 
CAUTION 
To avoid damage to the transducer, do not use transducer sheaths containing on oil-based coating or 
petroleum-or mineral oil-based ultrasound coupling agents. Use only a water-based ultrasound coupling 

agent. 
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CAUTION 

DO NOT place or store the transducer in the side pocket or the storage area on the system to prevent 
damaging it from accidently falling off. 

 

 
CAUTION 
To avoid damage to the transducer, observe the immersion levels indicated for each transducer type. Do not 
immerse or allow the cable or connector of a transducer to become wet. See "Transducer Immersion Level" 

on page 13-14 for more detailed information. 
 

 
CAUTION 
The transducer have been designed and tested to be able to withstand high-level disinfection as 
recommended by the manufacturer of the disinfectant product. Carefully follow the disinfectant 
manufacturer’s instructions. Do not immerse for more than one hour. 
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Transducer Handling and Infection Control 

This information is intended to increase user awareness of the risks of disease transmission associated 
with using this equipment and provide guidance in making decisions directly affecting the safety of the 
patient as well as the equipment user. 

Diagnostic ultrasound systems utilize ultrasound energy that must be coupled to the patient by direct 
physical contact. Depending on the type of examination, this contact occurs with a variety of tissues 
ranging from intact skin in a routine exam to recirculating blood in a surgical procedure. The level of risk 
of infection varies greatly with the type of contact. 

One of the most effective ways to prevent transmission between patients is with single use or disposable 
devices. However, ultrasound transducers are complex and expensive devices that must be reused 
between patients. It is very important, therefore, to minimize the risk of disease transmission by using 
barriers and through proper processing between patients. 

Proper cleaning and disinfection between patient cases are necessary to prevent disease transmission. 
All transducers must be thoroughly cleaned prior to disinfection. The level of disinfection required 
depends on the degree of patient contact. 

• The transducers that contact mucous membranes (e.g., Endocavitary, Transesophageal) or non-intact 
skin require cleaning followed by High-Level Disinfection either soaking or use of a trophon® EPR or 
V-PRO. 

• The transducers that contact intact skin require cleaning followed by Intermediate-Level Disinfection 
(wipe or spray). 

 
NOTE 

• To verify transducer chemical compatibility, please refer to "List of Compatible Disinfectants and Cleaning 
Solutions" on page 13-15. 

• The latest full list of compatible cleaning solutions and disinfectants tested is available at the ALPINION 
MEDICAL SYSTEMS Resource website (http://www.alpinion.com). 

http://www.alpinion.com/en/support/resource.do
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Cleaning and Disinfecting Transducers 

All transducers must be cleaned and disinfected after each use. Cleaning is an important procedure that 
must be carried out before disinfecting the transducer. For cleaning and disinfecting the transducer, 
carefully follow the proper disinfectant and disinfectant method recommended by ALPINION MEDICAL 
SYSTEMS. Using an inappropriate cleaning or disinfecting agent may damage the transducer. 

 
WARNING 
• To avoid electrical shock and damage to the system, disconnect the transducer before cleaning and 

disinfecting. 
• Always use protective eyewear and gloves when cleaning and disinfecting transducers. 

• Check the housing, strain relief, lens and seal for damage, and check for any functional problem after 
cleaning and disinfecting the transducer. 

 
CAUTION 
• Do not use a surgical brush when cleaning transducers. 

• Do not use a cleaning brush when cleaning the transducer lens. Even the use of soft brushes can damage 

the transducer lens. 

• Do not use paper products or products that are abrasive when cleaning the transducer. They damage the 

lens of the transducer. 
• Be sure to use the proper concentration of enzymatic cleaner and rinse thoroughly. 

• Before storing transducers, ensure that they are thoroughly dry. 

• The use of 70% isopropyl alcohol (rubbing alcohol) and alcohol-based products on all transducers is 
restricted. On non-TEE transducers, the only parts that may be cleaned with isopropyl alcohol are the 

connector housing and the transducer housing and lens. Do not wipe any other part of a transducer with 
isopropyl alcohol (including cables or strain reliefs), as it can damage those parts of the transducer. This 
damage is not covered by the transducer warranty. 

 
 

Figure 13-1 Cleaning/Disinfection of Transducer Components 

 

No Component Description 

1 Connector housing Cleaning only 

2 Transducer cable Cleaning only or cleaning and disinfection 

3 Transducer housing, Lens Cleaning followed by appropriate level of disinfection 
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Cleaning the transducer 

Cleaning is an important procedure that is carried out before disinfecting the transducer. The transducer 
must be cleaned after each use. 

 

1 Disconnect the transducer from the system. 

2 Moisten a clean gauze pad with purified water and wipe the transducer to remove any gel or 
particles remaining on the transducer. If purified water is not effective, then you can use an 
approved pre-cleaner or low-level disinfectant such as wipe or enzymatic detergent. Follow the 
solution manufacturer's instructions for the cleaning of transducers. 

3 Carefully wipe the entire transducer, including the cable and connector. 
When cleaning the connector, do not allow any type of fluid to enter through the connector strain 
relief, electrical contacts or areas surrounding the locking-lever shaft and the strain relief. 

4 To remove remaining particulate and cleaning residue, use cleaning wipes according to the 
manufacturers’ instructions, or rinse thoroughly with water up to the immersion point. 
Do not immerse the connector, connector strain relief, or cable that is within 5 cm of the connector 
strain relief. 

 

NOTE 

If you place the transducer into the water or cleaning solution, make sure not to immerse the 

transducer into the liquid beyond the immersion level. See "Transducer Immersion Level" on page 13-14 
for more information. 

5 If remaining particulate and cleaning residue have dried onto the transducer surface, scrubbing 
with a soft bristle brush may be necessary. 

 

NOTE 

Do not use a cleaning brush when cleaning the transducer lens. Even the use of soft brushes can 

damage the transducer lens. 

6 Dry the transducer using a sterile cloth or gauze after rinsing. Do not dry the transducer by heating 
it. 

 

NOTE 

To dry the lens, use a soft cloth and a blotting motion instead of a wiping motion. 

7 Examine the housing, strain relief, lens and seal for damage, and check for any functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent. 

 
NOTE 

The transducer is determined not to be visually clean at the end of the cleaning step, repeat the 

relevant previous cleaning steps of the transducer. 

In addition, if the visual inspection reveals unacceptable deterioration such as corrosion, discoloration, 
pitting, cracked seals, safely dispose of the transducer. 
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Disinfecting the transducer 
 
 

WARNING 
• If a pre-mixed solution is used, be sure to observe the solution expiration date. 

• The type of tissue it will contact during use dictates the level of disinfection required for a device. Ensure 
that the solution strength and duration of contact are appropriate for disinfection. 

 
CAUTION 
• Only wipe the cable, strain relief and parts of the transducer. Do not wipe the connector of the transducer. 

• Do not immerse transducers in a solution for longer than one hour, unless under disinfectant 
manufacturer's instructions. 

• Using a non-recommended disinfectant or not following the recommended disinfection method can 
damage and/or discolor the transducer and will void the transducer warranty. 

 
To intermediate-level disinfect a transducer, 

1 Disconnect the transducer from the system. 

2 Thoroughly clean, rinse, and dry the transducer. 

3 After cleaning, choose a intermediate-level disinfection solution compatible with your transducer. 

4 Intermediate-level disinfect the transducer by following the disinfection method recommended by 
the disinfection solution manufacturer. 

5 After disinfecting, examine the housing, strain relief, lens and seal for damage, and check for any 
functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent. 

 

To high-level disinfect a transducer, 

1 Disconnect the transducer from the system. 

2 Thoroughly clean, rinse, and dry the transducer. 

3 After cleaning, choose a high-level disinfection solution compatible with your transducer. 
If a pre-mixed solution is used, be sure to observe the solution expiration date. 

4 Disinfect or high-level disinfect the transducer by following the disinfection method recommended 
by the disinfection solution manufacturer. High-level disinfection is recommended for general 
transducers and is required for endocavity transducers. 

 

NOTE 

If you place the transducer into the water or disinfection solution, make sure not to immerse the 
transducer into the liquid beyond the immersion level. See "Transducer Immersion Level" on page 13-14 
for more information. 

5 Rinse the transducer with plenty of sterile water to remove all chemical residues on it. Or follow the 
rinsing method recommended by the disinfectant manufacturer to rinse the transducer. 

6 Wipe off the water on the transducer with sterile cloth or gauze after rinsing it. Do not dry the 
transducer by heating. 

7 Examine the housing, strain relief, lens and seal for damage, and check for any functional problem. 
If any damage is found, do not use a transducer and contact your ALPINION MEDICAL service 
engineer or an authorized agent. 
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Transducer Immersion Level 
 
 

CAUTION 
• Make sure not to immerse the transducer into any liquid beyond the immersion level specified for that 

transducer. 
• Do not immerse the transducer connector and cable in liquid. 

 

 
SC2-11H SC1-7H L3-15H 

L3-8H 

L3-12X 

SL3-19X 

L10-25H 

 
 

 

 
P1-5CT SVC1-8H EC2-11H EV2-11H VE3-10H CW2.0 CW5.0 

CW8.0 
 

Figure 13-1 Transducer Immersion Level 
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List of Compatible Disinfectants and Cleaning Solutions 

ALPINION MEDICAL SYSTEMS routinely reviews new cleaning and disinfection solutions for compatibility 
with the materials used in the transducer housing, cable and lens in order to provide users with options 
in choosing a cleaning or disinfection solution. Refer to Resource on website (http://www.alpinion.com) 
for the latest list of compatible cleaning solutions and disinfectants. 

 
 
 

Storing the Transducer 

It is recommended that all transducers be stored in the provided carrying case. 

To store the transducer in the carrying case, 

1 Place the transducer connector into the carrying case. 

2 Carefully wind the cable into the carrying case. 

3 Carefully place the transducer head into the carrying case. DO NOT use excessive force or impact 
the transducer head. 

 
 

Storage/Transportation 

It is recommended that each transducer should be placed in each own transducer holder on the console. 
If the carrying case is provided with the transducer, always use the carrying case to transport the 
transducer from one site to another. 

Secure the transdcuer in its holder for moving short distances. 

When transporting a transducer a long distance, store it in its carrying case. 
 
 

Cable Handling 

Take the following precautions with transducer cables: 

• Keep free from wheels 

• Do not bend the cable acutely 

• Avoid crossing cables between transducers 

 
 

Planned Maintenance 

The following maintenance schedule is suggested for the transducer to ensure the optimum operation 
and safety. 

• Daily: Inspect transducers 

• After each use: Clean transducers 

• After each use: Disinfect transducers 
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Appendix A. Biopsy Guide 
The system supports biopsy capability for the transducers listed in the table below. 

 

Biopsy Guide Transducer Type Dimension Manufacturer 

 

L3-12 Biopsy 
L3-8H 

L3-15H 

 

Multi-angle 
 

90.5(W)×48.3(D)×22.9(H) mm 
CIVCO Medical 

Solutions 

 

L3-12X Biopsy 
L3-12X 

SL3-19X 

 

Multi-angle 
 

109.2(W)x45.0(D)x30.5(H) mm 
Aspen Surgical 

Products, Inc. 

 

SC1-6 Biopsy 
 

SC1-7H 
 

Multi-angle 
 

106.7(W)×55.8(D)×27.9(H) mm 
CIVCO Medical 

Solutions 

EV2-11H Biopsy 

(Reusable) 

EV2-11H 
EC2-11H 

 

Single-angle 
 

150.92(W)x26.81(D) mm 
Aspen Surgical 
Products, Inc. 

VE3-10H Biopsy 

(Disposable) 

 

VE3-10H 
 

Single-angle 
 

148.3(W)x35.5(D) mm 
Aspen Surgical 

Products, Inc. 

VE3-10H Biopsy 

(Reusable) 

 

VE3-10H 
 

Single-angle 
 

142.4(W)x40.9(D) mm 
Aspen Surgical 
Products, Inc. 

 
WARNING 
The biopsy option is intended for use by a duly licensed physician who has received the appropriate training  

in biopsy techniques as dictated by current relevant practices, as well as in proper operation of the ultrasound 
unit. 
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Biopsy Starter Kit for Linear and Convex Transducers 

Convex and Linear transducers have an optional biopsy kit specific for each transducer. The biopsy kit 
consists of: 

• A reusable non-sterile bracket 

• Disposable sterile Ultra-Pro II™ Needle guide kits (CIVCO Medical Solutions) consisting of: 

– Sets with needle inserts covering gauge size 14 through 23 (2.1 mm to 0.6 mm) 

– Sterile sheath 

– Rubber bands 

– Gel 

• Instructions 

In addition sterile Ultra-Pro II™ Needle guide kits can be ordered as replacement kit. 

 
WARNING 
Read the instructions and the user’s guide for the Ultra-Pro II™ Needle guide kits before using the biopsy 
equipment. 

 
 

Biopsy Starter Kit for Endocavity Transducers 

The endocavity transducer has an optional specific biopsy kit. The biopsy kit consists of: 

• Disposable sterile needle guide/ Reusable non-sterile needle guide 

• Sterile sheath 

• Rubber bands 

• Gel 

• Use Instructions for Disposable Endocavity Needle Guide/ Use Instructions for Reusable Endocavity 
Needle Guide 

In addition disposable sterile endocavity needle guide can be ordered as replacement kit. 

 
WARNING 
Read the instructions for the Disposable/Reusable Endocavity Needle Guide from Aspen Surgical Products, 
Inc. before using the biopsy equipment. 
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Appendix B. IPX8 Immersion Levels 
 
 

CAUTION 
To avoid damage to the transducer, observe the immersion levels indicated for each transducer type. 
Transducers with the protection level IPX8 are indicated by the presence of the “IPX8” symbol on the 
connector of the transducer. 

 

Transducers meet Ingress Protection IPX8 of EN 60529 and IEC 60529 to the depth of the immersion line 
shown in the illustration only for transducers with the “IPX8” symbol on the connector of the transducer. 

 

NOTE 

Test Standard of IPX8: 

Immersion for 90 minutes at a depth of 1 meter. 
 
 

 

Connector 

 
Connector strain relief 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14-1 IPX8 Immersion Level 
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Appendix C. Copyrighted Third Party 
Software License Information 

X-CUBE 60 contains copyrighted material. 
 
 

Copyright (c) 2004-2020 Jaroslaw Kowalski <jaak@jkowalski.net>, Kim 

Christensen, Julian Verdurmen 

 
All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions 

are met: 

 
* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

 
* Redistributions in binary form must reproduce the above copyright notice, 

this list of conditions and the following disclaimer in the documentation 

and/or other materials provided with the distribution. 

 
* Neither the name of Jaroslaw Kowalski nor the names of its 

contributors may be used to endorse or promote products derived from this 

software without specific prior written permission. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 

AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 

INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 

CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 

THE POSSIBILITY OF SUCH DAMAGE. 

mailto:jaak@jkowalski.net
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